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viii 머리말
‘완벽 가이드로 배워보는 DaVinci Resolve 15’을 구매해주셔서 감사합니다.
DaVinci Resolve 15에서 가장 흥미로운 점은 편집과 색보정, 오디오 후반 제작, 그리고 이제 시각 
효과까지 하나의 소프트웨어 응용 프로그램에서 작업할 수 있다는 점입니다. DaVinci Resolve 15
에 새로운 Fusion 페이지가 추가되어 노드 기반의 첨단 시각 효과 합성 및 모션 그래픽을 위한 250
여개 이상의 도구와 더욱 향상된 색보정 및 편집 기능, 그리고 완벽한 Fairlight 디지털 오디오 
워크스테이션을 사용할 수 있습니다. 다시 말해, 다른 소프트웨어로 파일을 보내기 하거나 변환하지 
않고도 크리에이티브 작업을 전환 해 가며 사용할 수 있습니다.

가장 훌륭한 점은 DaVinci Resolve 15를 무료로 사용할 수 있다는 점입니다! 이뿐만 아니라 무료 
버전의 DaVinci Resolve는 다른 어떤 유료 편집 시스템보다 다양한 기능을 제공합니다. 이는 모든 
사람들이 프로그램 구입에 수백만 원을 쓰지 않고도 할리우드 수준의 전문 콘텐츠를 제작할 수 
있어야 한다는 저희 Blackmagic Design의 철학이 반영된 결과입니다.

DaVinci Resolve 15을 적극 활용해 훌륭한 작품을 많이 제작하시길 손꼽아 기다립니다!

Blackmagic Design의 CEO 
그랜트 패티 올림
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시작하기
Blackmagic Design 공식 교육 및 인증 프로그램용 교재인 ‘완벽 가이드로 배워보는 DaVinci  
Resolve 15’을 구매해주셔서 감사합니다. 이 책은 편집가와 아티스트, 학생들이 DaVinci Resolve
를 사용해 편집, 합성, 색보정, 오디오 믹싱 등의 작업을 배워볼 수 있는 실전 교재입니다. Mac 또는 
Windows 컴퓨터와 무료 버전의 DaVinci Resolve 15, 그리고 배움에 대한 열정만 있다면 다른 건 
걱정할 필요가 없습니다.

기본적인 편집, 시각 효과, 모션 그래픽, 색보정, 오디오 작업을 단계별로 설명하는 공식 실무 가이드로, 
할리우드 수준의 영화 및 영상을 지금 바로 제작할 수 있습니다.

소개 내용
 � 프로젝트 설정하기, 미디어 불러오기, 메타데이터를 사용해 업무 속도 높이기.

 � 선택 부분 표시하기, 타임라인에서 클립 편집하기, 콘텍스트 센서티브 트리밍.

 � 클립 리타이밍, 트랜지션 추가, 사진 패닝 및 스캐닝.

 � 새로운 Text+ 타이틀로 작업하기, 자신만의 타이틀 생성하기, 애니메이션 효과 추가하기.

 � Fusion 페이지 검색하기, 노드 기반 인터페이스 사용하기, 클립 안정화 및 클립 페인팅.

 � Resolve의 전설적인 컬러 도구를 사용한 프라이머리 및 세컨더리 색보정.

 � 숏 매칭, 컬러 매니지먼트 사용하기, 영상룩 생성하기, 여러 개의 클립 색보정 하기.

 � 파워 윈도우 사용하기, 숏에서 피사체 트래킹하기, 커브 사용하기, ResolveFX 추가하기.

 � Fairlight 오디오 도구를 사용한 오디오 스위트닝 및 오디오 믹싱. 

 � 타임라인에서 보이스 오버 녹음하기.

 � 새로운 FairlightFX를 사용해 오디오 음질 개선하기.

 � 다양한 포맷으로 프로젝트 딜리버리하기.

 � 작업 방식을 향상시킬 수 있는 수십 가지의 유용한 정보.
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x Blackmagic Design의 교육 및 공인 프로그램 
Blackmagic Design은 DaVinci Resolve 15의 사용법을 좀 더 깊이 있게 배워볼 수 있도록 다음과 
같은 실무 교재를 출간했습니다.

 � 완벽 가이드로 배워보는 DaVinci Resolve 15

 � Advanced Editing with DaVinci Resolve 15

 � Color Correction with DaVinci Resolve 15

 � Introduction to Fairlight Audio Post with DaVinci Resolve 15

 � Fusion Visual Effects with DaVinci Resolve 15

 � 향후 새로운 교재 추가 예정

저희 공인 교육 프로그램을 통해 첨단 편집 기술과 컬러 그레이딩, 음향 믹싱에 대한 자세한 정보를 
확인하세요.

이 책의 내용을 다 살펴본 후 50개의 질문으로 구성된 1시간짜리 온라인 인증 시험에 응시할 경우 
Blackmagic Design에서 교부하는 수료증을 발급받을 수 있습니다. 해당 시험을 위한 링크는 이 
책의 맨 마지막 부분에 나와 있습니다. 

교육 및 공인 프로그램에 대한 상세 정보와 인근 교육 파트너 관련 정보는 
www.blackmagicdesign.com/kr/products/davinciresolve/training에서 확인할 수 있습니다.

시스템 요구 사항
이 책에서는 Mac 및 Windows 지원 DaVinci Resolve 15에 대한 내용을 다룹니다. 오래된 버전의 
DaVinci Resolve를 사용 중인 경우 최신 버전을 다운로드해야 책에 소개된 실습 내용을 따라가실 
수 있습니다.

Download DaVinci Resolve 15 다운로드하기
다음 방법에 따라 Blackmagic Design 웹사이트에서 무료 버전의 DaVinci Resolve 15을 다운로드하세요.

1 Mac 또는 Windows 컴퓨터에서 웹 브라우저를 엽니다.

2 웹 브라우저 주소창에 다음의 주소를 입력하세요. 

www.blackmagicdesign.com/kr/products/davinciresolve

3 DaVinci Resolve 페이지에서 다운로드 버튼을 누르세요.
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4 다운로드 페이지에서 현재 사용 중인 컴퓨터 운영 체제에 따라 Mac 또는 Windows 버튼을 
선택하세요.

5 설치 안내에 따라 소프트웨어 설치를 완료하세요.

소프트웨어 설치를 마치고 나면 아래 [Lesson 파일 복사하기] 부분에 나온 방법에 따라 이 교재와 
함께 사용할 콘텐츠를 다운로드하세요.

Lesson 파일 복사하기
이 책에 나온 내용을 직접 실행해보려면 Mac 또는 Windows 컴퓨터에 DaVinci Resolve Lesson 
파일을 다운로드해야 합니다. 파일을 하드 디스크에 저장한 다음 파일을 추출하고 해당 폴더를 
도큐멘트 폴더에 복사합니다.

DaVinci Resolve Lesson 파일 다운로드 및 설치 방법
Lesson 파일을 다운로드할 준비가 완료되면 다음 단계를 따르세요.

1 인터넷에 접속해 아래의 주소로 이동하세요. 

https://www.blackmagicdesign.com/dvres/intro-to-resolve-15 

곧바로 파일 다운로드가 시작됩니다.

IntroToDaVinciResolve15Tutorials.zip 파일의 크기는 약 5GB입니다.

2 Mac 또는 Windows 컴퓨터에 압축 파일을 다운로드한 후 압축이 자동으로 해제되지 않을 경우 
다운로드 폴더를 열고 IntroToDaVinciResolve15Tutorials.zip 파일을 더블 클릭하세요.

3 도큐먼트 폴더에서 새로운 폴더를 생성한 다음 폴더 이름을 R15 intro to resolve lessons로 
지정하세요.

4 다운로드 폴더에서 IntroToDaVinciResolve15Tutorials 파일을 도큐먼트 폴더에 있는 R15 intro 
to resolve lessons 폴더로 드래그하세요.

이제 제1과, [퀵스타트: 1분짜리 영상 편집하기]를 시작할 준비가 완료되었습니다.



감사의 말
이 책에 사용된 미디어를 제공해주신 아래의 모든 분들께 감사의 말을 전합니다.

 � Citizen Chain

 � Editstock - <Gnarly in Pink>

 � Terwilliger Productions의 브라이언 J. 텔위리서 - <리빙 인 디 에이지 오브 에어플레인즈>

 � Second Tomorrow Studios의 뉴엔 안 응우옌 - <Hyperlight>



제1과

퀵스타트: 1분짜리 
영상 편집하기 

DaVinci Resolve 15는 편집과 창의적인 시각 
효과, 색보정, 사운드 믹싱이 가능하여 프로젝트의 
시작부터 마지막까지 모든 작업을 한 곳에서 
수행할 수 있는 유일한 소프트웨어입니다. 본 
가이드북은 영상 편집과 효과 합성, 이미지 
색보정, 오디오 스위트닝, 오디오 믹싱 작업 
방식을 설명합니다.

Mac 또는 Windows 컴퓨터 사용에서 프로젝트 
시작을 위한 셋업부터 최종 출력에 이르기까지 
모든 작업 과정을 배울 수 있습니다. 기본적인 
편집 및 합성, 색보정, 오디오 스위트닝 워크플로뿐만 
아니라 프로그램 메뉴와 버튼 사용에도 금방 
익숙해질 수 있습니다.

제1과에서는 1분짜리 프로그램 영상의 편집 
작업을 통해 전반적인 편집 도구 사용법을 익힐 
수 있습니다. 

예상 소요 시간 

이 과를 학습하는 데는 약 45분 
정도의 시간이 소요됩니다.

학습 목표

프로젝트 시작하기 2

타임라인에서 클립 모으기 4

내러티브 편집하기 8

사운드트랙 추가하기 12

오디오 레벨 조절하기 13

타임라인에서 클립 삭제하기 14

클립 트리밍하기 15

사진의 패닝 및 줌 기능 17

타이틀 추가하기 21

전체 화면으로 재생하기 23

복습하기 25
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프로젝트 시작하기
시작하기에 앞서 먼저 컴퓨터에 DaVinci Resolve 15 설치를 완료하고 도큐먼트 폴더에 저장된 
Getting Started 속에서 본 가이드북을 찾으실 수 있습니다. 이제 컴퓨터에서 DaVinci Resolve를 
열고 프로젝트에 사용하려는 미디어를 불러오기 합니다.

1 다음과 같이 DaVinci Resolve 프로그램을 실행하세요.

 � macOS에서 작업할 시, 도크에 있는 DaVinci Resolve 아이콘을 클릭하세요.

 � Windows에서 작업할 시, 시작 메뉴에 있는 DaVinci Resolve 아이콘을 클릭하세요.

Project Manager 창이 나타납니다. 지금까지 생성한 모든 프로젝트를 여기서 확인할 수 있습니다. 
프로젝트는 하나의 작업을 의미하며, 여기에는 하드 드라이브에 저장된 미디어와 관련된 타임라인과 
클립이 포함되어 있습니다. 현재 나타나는 기본 제목(Untitled Project)의 빈 프로젝트를 예시로 
사용해 보겠습니다.

참고 사용하는 컴퓨터 화면의 해상도에 따라 실제로 사용하는 화면 속 
레이아웃의 모습과 사진 속 레이아웃의 모습이 다르게 나타날 수 있습니다.

2 Untitled 썸네일을 더블 클릭하여 새로운 프로젝트를 엽니다.
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Edit 페이지는 기본적으로 프로젝트 편집 과정에 사용하는 네 가지 구역으로 구분됩니다.

3 프로젝트에 사용하려는 클립을 임포트하려면 File > Import File > Import Media 순서대로 
선택합니다.

4 대화창이 나타나면 R15 Lessons 폴더가 있는 도큐먼트 폴더로 이동합니다.

5 도큐먼트 폴더에 있는 Lesson 01 폴더를 엽니다.

6 Lesson 01 폴더에 있는 모든 파일을 선택한 다음, Open을 클릭합니다.

Media Pool에는 현재 
프로젝트에서 사용 중인 모든 
미디어가 포함되어 있습니다.

왼쪽 소스 뷰어에는 선택된 소스 클립의 이미지가 
오른쪽 타임라인 뷰어에는 선택된 타임라인 이미지가 나타납니다.

타임라인 상단에 있는 툴바 버튼을 통해 다양한 
편집 도구를 선택할 수 있습니다.

타임라인은 편집한 프로젝트를 그래픽으로 표현합니다.
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선택된 모든 미디어가 DaVinci Resolve 인터페이스 왼쪽에 있는 Media Pool로 임포트됩니다. 이제 
임포트된 클립을 사용하여 간단한 프로젝트로 편집할 수 있습니다.

제1과에서는 인터페이스 사용법을 간단히 훑어보실 수 있습니다. 이 과에서는 기본적인 편집 작업에 
초점을 맞춰 프로젝트를 빠르게 구성하고 핵심 편집 도구를 사용하는 방법을 다룹니다.

보다 더 자세한 사용 방식은 뒤쪽에 설명되어 있습니다. 제1과는 맛보기 단계로 더욱 다양한 옵션 
기능 및 키보드 단축키, 결과물은 뒤편에 설명되어 있습니다.

타임라인에서 클립 모으기
미디어 풀(Media Pool)에 클립을 불러오면 원하는 재생 순서대로 클립 정렬하기를 시작하실 수 
있습니다. 미디어 풀에서 클립을 분류한 다음, 타임라인으로 드래그하여 옮기면 더욱 손쉽게 작업할 
수 있습니다.

1 미디어 풀 상단에 있는 정렬 순서를 나타내는 팝업 메뉴에서 클립명(Clip Name)을 선택하세요.

미디어 풀의 썸네일이 클립명 알파벳 순서대로 정렬됩니다.

첫 단계 편집은 스틸 사진 하나를 사용할 것이므로 아주 간단합니다.

2 미디어 풀에서 01_warmer를 드래그하여 타임라인 가장 윗줄 중간 지점에 배치시킵니다.
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첫 단계 편집 작업이 완성되었습니다. 타임라인에 클립을 드래그해서 옮기면 타임라인 시작 
점에 클립 세그먼트로 나타납니다. 지금 사용한 사진은 5초짜리입니다.

정보 사용자 환경 설정의 Editing 카테고리에 있는 스틸 사진의 표준 길잇값을 
변경하여 기본 설정 길이를 조절할 수 있습니다.

난이도를 조금 높여 영상 클립을 추가해보도록 하겠습니다. 소스 뷰어를 통해 해당 클립을 
미리보기하면 어떤 영상 클립 부분을 추가하는지 정확히 알 수 있습니다.

3 미디어 풀에서 02_interview 클립을 더블 클릭하면 소스 뷰어에 해당 클립이 로딩됩니다

4 소스 뷰어에 있는 재생 버튼을 클릭하면 클립이 처음부터 재생됩니다.
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인터뷰 내용과 숏의 화질을 봤을 때 두 번째 영상으로 사용하기 훌륭합니다. 미디어 풀에서 
클립을 다시 드래그할 필요 없이 소스 뷰어에서 드래그할 수 있습니다.

5 소스 뷰어에서 중간 지점에서 02_interview 클립을 드래그하여 타임라인에 있는 01_warmer 
클립 옆에 배치시킵니다.

클립을 드래그해서 타임라인 클립 옆에 가까이 가져가면 클립 오른쪽 끝에 딱 붙습니다. 클립에 
자동으로 붙어 타임라인 속 클립 사이에 공백이 생기지 않게 클립을 정렬할 수 있습니다.

타임라인에 있는 세로 방향의 주황색 막대는 플레이헤드라고 부릅니다. 타임라인 속 플레이헤드의 
위치는 타임라인 뷰어에 나타나는 현재 프레임 위치와 상응합니다.

6 타임라인 뷰어 밑에 있는 재생 버튼을 누르면 타임라인이 재생됩니다.

타임라인 속 두 개의 클립이 재생되고 클립이 끝나면 재생을 멈춥니다.

미디어 풀에 있는 여러 개의 클립을 선택하여 타임라인에 드래그하면 여러 클립을 한 번에 
추가할 수 있습니다. 다음 11개의 클립을 같은 방법으로 추가하세요.

7 미디어 풀에 있는 네 번째 썸네일(04_at_bench)을 선택한 다음, [shift] 키를 누른 상태에서 
마지막 썸네일(14_finished)을 클릭하면 11개의 영상 클립이 모두 선택됩니다.
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선택된 11개의 클립에 빨간 테두리가 나타납니다. 선택한 클립을 타임라인 맨 끝에 배치시키거나 
덮어쓰려는 클립 위에 놓아 타임라인에 추가할 수 있습니다.

8 첫 번째 인터뷰 클립에 있는 플레이헤드를 맨 앞쪽으로 드래그한 다음 스페이스 바를 누르면  
해당 클립만 재생됩니다.

오디오는 그대로 둔 채 영상에만 새로운 클립을 덮어쓰기 하여 추가할 수 있습니다. 플레이헤드를 
인터뷰 마지막 문장인 “They call us glass blowers, but really we are heat managers.”로 
옮기세요.

9 타임라인 플레이헤드를 “Reallywe are heat managers.”라는 문장이 끝나는 곳으로 드래그하여  
다시 옮깁니다.

10 플레이헤드 위치를 가이드 삼아 미디어 풀에서 플레이헤드로 클립을 드래그합니다.

11 미디어 풀에서 클립을 드래그하여 타임라인에 있는 플레이헤드로 옮긴 뒤, 플레이헤드에 클립이 
옮겨붙으면 마우스 버튼에서 손을 떼세요.

이제 타임라인에 11개의 클립이 새롭게 추가되었습니다. 사용하는 컴퓨터 화면 해상도에 따라 
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타임라인 창에서 전부 보이지 않을 수도 있습니다. 다행히 DaVinci Resolve는 타임라인 
디스플레이 방식을 관리할 수 있는 몇 가지 유용한 도구를 지원합니다. 이 중 하나는 타임라인을 
확대할 수 있는 간단한 메뉴 선택 기능으로 화면에서 모든 클립을 볼 수 있습니다.

12 View > Zoom > Zoom To Fit 순서로 선택하거나, [shift] 키와 [z] 키를 함께 누르세요.

이제 타임라인 화면에서 프로그램 전체를 확인할 수 있어 손쉽게 모든 클립을 확인하고 이동할 
수 있습니다.

플레이헤드를 드래그하면 타임라인에서 편집 영상을 빠르게 훑어볼 수 있습니다.

13 타임라인 눈금자를 따라 플레이헤드를 타임라인 끝으로 그리고 다시 시작 부분으로 천천히 
드래그하면서 방금 추가한 클립을 확인합니다.

현재 사용 중인 클립은 보기 좋은 여러 클립을 모아 놓은 것에 불과합니다. 여기에 약간의 이야기 
구성이 필요한데요. 다른 인터뷰 세그먼트를 추가하여 인터뷰 내용에 맞게 클립 순서를 정렬하겠습니다.

내러티브 편집하기
먼저 인터뷰 영상 하나를 추가하겠습니다. 단순한 이야기 전달이 아닌 인터뷰 주제를 잘 설명하는 
클립이 많기 때문에 이 인터뷰 클립은 오디오만 사용하도록 하겠습니다.

1 미디어 풀에서 03_interview 클립을 더블 클릭하면 소스 뷰어에 클립이 나타납니다.

2 소스 뷰어 밑에 있는 다음 프레임으로 점프하기 버튼을 클릭하면 다음 클립의 시작 부분으로 
넘어갑니다.



9

내
러

티
브

 편
집

하
기

소스 뷰어 아래 있는 버튼 클릭 대신에 키보드 단축키를 사용하여 클립을 재생할 수도 있습니다.

3 스페이스바를 누르면 소스 뷰어에 있는 클립이 재생됩니다.

1분짜리 영상은 근본적으로 제한이 있기 마련입니다. 짧은 영상 길이 때문에 인터뷰 클립의 
일부분만 사용할 수 있습니다. 원하는 영상 부분을 사용하려면 시작점인 인 포인트와 끝나는 
지점인 아웃 포인트를 설정해야 합니다. 뷰어에 있는 파형 오버레이와 소스 뷰어의 조그 바를 
사용하여 인/아웃 포인트를 손쉽게 설정할 수 있습니다.

4 소스 뷰어 우측 상단에 있는 옵션 메뉴에서 Show Zoomed Audio Waveform을 선택하세요.

오디오 파형은 소스 뷰어 아래에 오버레이 형태로 나타납니다. 이 오버레이를 사용하여 
사운드트랙에 맞춰 클립의 위치를 정확하게 조절할 수 있습니다.

5 소스 뷰어 밑에 있는 건너뛰기 버튼을 클릭하면 다음 클립의 시작 부분으로 넘어갑니다.

클립 중간 지점에 인터뷰하는 사람이 “Also, you can’t touch or sculpt”라고 말하는 부분에서 
내레이션이 시작하도록 해야 합니다. 조그바를 사용하면 영상을 재생하여 원하는 편집 지점을 
찾는 대신 인터뷰 내용을 들으면서 클립을 천천히 훑어볼 수 있습니다.

6 소스 뷰어 아래에 있는 조그바 플레이헤드를 “Also, you can’t touch or sculpt”가 들릴 때까지 
오른쪽으로 드래그한 다음, 다시 왼쪽으로 ‘you’가 시작되는 곳에 드래그하여 옮깁니다. 오디오 
파형을 확인하면서 ‘also’라는 단어와 ‘you’라는 단어 사이에 플레이헤드를 정확하게 배치합니다.

7 소스 뷰어 아래 있는 마크 인 버튼을 클릭하여 인 포인트를 설정합니다.

이제 클립이 끝나는 지점을 표시하는 아웃 포인트를 표시해야 합니다. 영상 속 여성이 “And it’s 
a huge adrenaline rush”라고 시작하는 부분에 아웃 포인트를 표시하면 됩니다.

일일이 영상을 뒤져서 이 부분을 찾아야 하지만, DaVinci Resolve에서는 더욱 간편하게 작업할 
수 있습니다. 소스 뷰어 우측 상단에 보면 타임코드 형식의 숫자 표시가 있는 것을 볼 수 있습니다. 
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이 숫자는 시간:분:초:프레임 타임코드 단위로 표시되어 클립 위치를 확인할 수 있습니다.  
이 타임코드를 사용하여 영상 속 대사의 위치를 설정할 수 있습니다.

8 소스 뷰어의 타임코드가 15:38:38:00에 오도록 조그바 플레이헤드를 드래그하세요.

9 스페이스바를 누르고 “And it’s a huge adrenaline rush”라는 문장이 끝날 때 스페이스바를 
다시 누르면 재생이 멈춥니다.

10 소스 뷰어 아래 있는 마크 아웃 버튼을 클릭하세요.

인/아웃 포인트를 설정하고 나면 클립이 어느 곳에 오게 될지 확인하는 것이 좋습니다. 타임라인 
플레이헤드를 사용하여 확인할 수도 있습니다.

11 타임라인 플레이헤드를 타임라인 속 네 번째 클립 마지막까지 드래그하세요.

타임라인 바로 앞에 있는 인터뷰 세그먼트 사이에 적절한 공간이 생깁니다. 이곳이 다음 
나레이션을 추가하기 적절한 위치입니다.

타임라인에 이미 여러 좋은 영상이 있으므로 인터뷰의 오디오만 사용해도 충분합니다.

12 소스 뷰어에 마우스 포인터를 가져갑니다.
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소스 뷰어 위에 마우스 포인터를 움직이면 뷰어 상단에 두 개의 오버레이가 나타납니다. 왼쪽에 
있는 오버레이는 타임라인에 비디오만 드래그해 옮기며, 오른쪽 오버레이는 오디오만 옮기는 
기능을 제공합니다.

13 소스 뷰어에서 오디오 오버레이를 타임라인에 드래그하여 플레이헤드가 있는 곳에 오도록 
배치하세요.

이제 타임라인에 있는 모든 영상 밑에 오디오가 추가된 것을 확인하실 수 있습니다. 편집한 
영상을 재생하여 지금까지의 작업을 확인해 보는 것이 좋습니다.

14 타임라인 플레이헤드를 타임라인 시작점에 드래그하여 놓은 다음, 스페이스바를 눌러 전체 
타임라인을 재생합니다.

타임라인에 몇 개의 사진과 두 개의 내레이션 오디오를 추가했을 뿐인데 벌써 멋진 영상의 모습을 
갖췄습니다. 여기에 음악을 더해 영상을 한 단계 향상시켜 보겠습니다.



12
제

1과
 퀵

스
타

트
: 

1분
짜

리
 영

상
 편

집
하

기
 

사운드트랙 추가하기
대부분 제작 과정에는 여러 개의 오디오 트랙이 사용됩니다. 지금 사용하는 짧은 영상에는 내레이션에 
해당하는 오디오 트랙과 음악에 해당하는 오디오 트랙 총 두 개만 필요합니다. 타임라인에 추가하기 
전에 먼저 음악을 들어보겠습니다.

1 미디어 풀에서 One Min Sound Track 클립을 더블 클릭하면 소스 뷰어에 오디오 트랙이 
나타납니다.

영상이 없고 오디오만 있는 클립은 뷰어에 다른 모습으로 나타납니다. 뷰어 상단에는 전체 
오디오 파형이 나타나고 그 밑에는 확대된 일부 파형이 나타납니다.

2 스페이스바를 눌러 약 2초 정도 클립의 음악을 재생한 뒤, 다시 스페이스바를 눌러 재생을 
멈추세요.

전체 음악 트랙의 길이가 작업 중인 단편 영상 프로젝트와 정확하게 일치하는 1분짜리이므로 
이 트랙을 추가하여 사용할 수 있습니다. 현재 내레이션이 포함된 오디오 트랙은 한 개밖에 
없지만, DaVinci Resolve에서 사용 중인 오디오 트랙 아래 다른 오디오 트랙을 드래그하면 
자동으로 그 밑에 추가됩니다. 

3 소스 뷰어 중간 지점에서 One Min Sound Track 클립을 드래그하여 타임라인 내레이션 트랙 
아래로 옮기세요. 해당 클립을 타임라인 맨 왼쪽 끝에 놓아야 타임라인 시작 지점부터 오디오가  
재생됩니다.
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두 번째 오디오 트랙은 자동으로 뮤직 트랙에 추가됩니다. 영상과 오디오가 어떻게 어우러지는지 
한번 들어보겠습니다.

4 타임라인 플레이헤드를 타임라인 시작 부분으로 드래그하여 옮긴 다음, 스페이스바를 누르면 
전체 타임라인을 영상으로 확인하실 수 있습니다.

사운드 트랙을 추가할 경우 프로젝트를 완성하기 전에 몇 가지 문제점을 해결해야 합니다. 가장 
먼저 해결해야 할 일은 내레이션에 비해 음악 소리의 세기가 크지 않도록 고치는 것입니다.

오디오 레벨 조절하기
타임라인을 재생하면 내레이션 소리가 음악에 묻혀 깨끗하게 들리지 않습니다. 이러한 경우 음악의 
볼륨을 낮추면 내레이션 음성이 음악에 묻히지 않는 멋진 영상을 만들어낼 수 있습니다.

1 타임라인에서 One Min Sound Track 클립을 클릭합니다.

음악 트랙 선택이 완료되면 Inspector에서 볼륨을 조정할 수 있습니다.

2 화면 오른쪽 상단에 있는 Inspector 버튼을 클릭하여 패널을 엽니다.
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인스펙터 패널에는 다양한 오디오 및 비디오 컨트롤 기능이 있습니다. 타임라인에서 선택한 
트랙에 따라 조절할 수 있는 상황별 파라미터가 나타납니다. 음악 클립이 선택되면 Inspector에  
오디오 컨트롤이 나타나므로 타임라인에서 오디오를 재생하면서 동시에 볼륨을 조절할 수 
있습니다.

3 플레이헤드를 타임라인 시작점에 드래그하세요.

4 스페이스바를 누르면 재생됩니다.

5 Inspector에서 볼륨 슬라이더를 내레이션 음성에 적당한 -15와 -20 사이의 볼륨으로 조절하세요.

6 볼륨 설정이 완료되면 스페이스바를 눌러 타임라인 재생을 멈춥니다.

7 화면 오른쪽 상단에 있는 Inspector 버튼을 클릭하여 패널을 닫으세요.

DaVinci Resolve에서 오디오를 조절하는 방법에는 여러 가지가 있지만, 가장 간단한 방식은 Inspector를 
사용하는 것입니다. 오디오에 관한 더욱 자세한 설명은 제7과에서 확인하실 수 있습니다.

타임라인에서 클립 삭제하기
타임라인에 음악이 추가되어 음악이 끝난 뒤에도 영상이 계속해서 재생되는 것을 볼 수 있습니다. 
1분짜리 영상에 딱 맞는 오디오를 사용했기 때문에 이에 맞춰 클립 하나를 제거해 영상의 길이를 
줄이는 방법을 알아보겠습니다.

1 타임라인 끝에 있는 플레이헤드를 세 번째 클립 시작점에 드래그하여 옮깁니다.

프로젝트 마지막 부분으로 가면 이전에 봤던 필요 없어 보이는 숏 하나를 찾을 수 있습니다. 

2 스페이스바를 눌러 타임라인 마지막까지 영상을 재생합니다.

도구의 모습이 와이드숏으로 담긴 이 장면은 불필요해 보이는데요, 이 숏을 제거해도 이야기 
전개에는 아무런 문제가 없습니다.
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3 타임라인에서 13_tools 클립을 클릭한 다음, [delete] 또는 뒤로 가기 키를 눌러 해당 클립을 
제거하세요.

[delete] 또는 뒤로 가기 키를 누르면 도구가 나오는 클립은 삭제되지만, 그 공간은 그대로 
남습니다. 공백을 없애려면 마지막 클립을 옮겨 빈 공간을 채워줍니다. 타임라인에서 클립을 
옮기는 방법은 매우 간단합니다. 그냥 드래그하여 옮길 수 있습니다.

4 14_finished 클립을 왼쪽으로 드래그하면 12_liquid_fin 클립에 딱 붙습니다.

이제 클립 마지막 부분이 음악이 끝나는 부분과 거의 맞닿아 있지만, 아직 완벽하진 않습니다.

타임라인 끝을 보면 음악이 끝나는 부분과 거의 나란하지만, 조금 더 수정이 필요합니다.

클립 트리밍하기
대게 클립 전체를 제거하는 것은 좋은 해결책이 되지 않습니다. 대부분의 경우 타임라인에 있는 
클립 길이를 줄이거나 늘리는 것이 필요합니다. DaVinci Resolve에서 클립 길이를 줄이는 방법은 
다양하지만, 가장 간단한 방식은 클립 시작점 또는 끝 지점을 드래그하여 원하는 프레임을 추가하거나 
줄이는 것입니다.

1 12_liquid 클립 시작점에 플레이헤드를 두고 스페이스 바를 눌러 클립을 재생합니다.

위 클립은 액체 유리를 보여주는 시각적인 요소가 많지만, 클립 길이가 다소 깁니다. 새로운 
시작점으로 설정하려는 곳으로 플레이헤드를 가져가세요.

2 12_liquid 클립에서 프레임 위쪽 손이 나타나기 시작하는 지점에 플레이헤드를 드래그하여 
옮깁니다. 그런 다음, 더 이상 손이 프레임에 나타나지 않을 때까지 프레임 한 두개를 뒤로 
넘깁니다.
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여기가 클립의 시작점이므로 이전에 있는 모든 프레임은 삭제합니다.

3 타임라인 속 12_liquid 클립 시작점 바로 앞으로 마우스 포인터를 가져갑니다.

클립 시작점에서 마우스 포인터를 움직이면 프레임을 추가 또는 제거할 수 있는 트리밍 커서로 
바뀝니다.

4 플레이헤드가 있는 곳까지 클립의 시작점을 오른쪽으로 드래그합니다.

오른쪽으로 드래그하면 클립의 첫 프레임부터 제거되어 타임라인에 빈 공간이 생깁니다.

5 11_torching an eye 클립의 시작점으로 플레이헤드를 가져간 다음 스페이스바를 누르면 클립 
중간에 있는 공백 부분과 함께 클립이 재생됩니다.

새롭게 편집한 영상의 플레이가 좋아 보이지만, 중간에 있는 공백 부분을 제거해야 합니다. 전에 
했던 방식대로 클립을 드래그해서 제거할 수도 있지만, 더욱 간단한 방식이 있습니다.

6 타임라인에 해당 공백 부분을 클릭하여 선택합니다.
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7 마우스 오른쪽 버튼을 클릭한 다음, 리플 제거(Ripple Delete)를 선택하세요.

리플 제거 기능은 타임라인 속 우측에 있는 클립을 끌어당겨 빈 공간을 삭제합니다.

다음으로 소개할 기능인 트리밍은 가장 기본적인 편집 기능 중 하나로 DaVinci Resolve에서 사용할  
수 있는 다양한 트리밍 기능 중 한 가지를 소개해 드리겠습니다. 더욱 다양한 트리밍 방식은  
제5과에서 확인하실 수 있습니다.

사진의 패닝 및 줌 기능
이제 기본적인 형태를 갖춘 영상이 준비되었으므로 다른 편집 기술을 사용해 시각적인 부분을 
향상시킬 차례입니다. 타임라인에 있는 맨 첫 번째 클립은 사진이므로 몇 가지 흥미로운 요소를 
시작 부분에 추가해도 됩니다. 이 사진의 크기와 위치를 조절할 수도 있지만, DaVinci Resolve만의 
독특한 자동 패닝 효과를 사용하면 사진이 자동으로 패닝 및 확대할 수 있습니다.

1 타임라인 시작점으로 플레이헤드를 가져간 다음 01_warmer 클립을 클릭하여 선택하세요.

Inspector에 있는 Dynamic Zoom 컨트롤은 사진을 자동으로 패닝 및 확대할 수 있는 기능입니다.

2 화면 우측 상단에 있는 Inspector 버튼을 클릭하고 아래로 스크롤해서 내리면 Dynamic Zoom
이 나타납니다.
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Dynamic Zoom 컨트롤 기능은 비활성화로 기본 설정돼 있어 먼저 이를 활성화해야 합니다.

3 Dynamic Zoom 왼쪽에 있는 회색 동그라미 버튼을 클릭하여 해당 컨트롤 기능을 활성화합니다.

Dynamic Zoom 버튼에 빨간불이 들어오고 효과가 적용되면 클립을 재생하여 해당 효과를 
확인해볼 수 있습니다.

플레이헤드를 타임라인 시작점으로 가져갑니다.

4 스페이스바를 눌러 결과물을 확인하세요.

Dynamic Zoom을 추가하면 클립이 부드럽게 줌 아웃됩니다.

사진을 단순히 축소하는 것이 아니라 역방향으로 사진을 줌인하는 효과를 주면 더욱 시선을 
끌 수 있습니다.

5 Inspector에서 Dynamic Zoom 컨트롤 구역에 있는 Swap 버튼을 클릭하세요.

Swap 버튼을 클릭하면 애니메이션 방향이 바뀝니다. 여러 사진을 보여주는 애니메이션 효과가 
아닌 선택한 사진의 일정 부분으로 줌인하는 애니메이션 효과가 적용되었습니다.

6 화면 우측 상단에 있는 Inspector 버튼을 클릭하면 해당 패널이 닫힙니다.

7 플레이헤드를 타임라인 시작점으로 가져갑니다.

8 스페이스바를 눌러 변경된 애니메이션 효과를 확인해보세요.

정보 다이나믹 줌 효과는 사진뿐만 아니라 영상에도 사용할 수 있습니다.

사진에 시선을 고정시킬 수 있는 움직임이 추가되었습니다. 하지만, 사진 속에서 가장 중요한  
부분에 줌인 효과가 적용되도록 애니메이션 효과를 약간 수정할 필요가 있습니다.
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Dynamic Zoom 수정하기
다이나믹 줌 애니메이션 효과의 사용은 매우 간단하여 수정이 불가능할 것이라고 생각할 수 있지만, 
그렇지 않습니다. 이 효과의 속도를 원하는 대로 조절하고, 줌인 기능을 사용할 사진 프레임 속 
원하는 부분을 정확하게 선택할 수 있습니다.

1 01_warmer 사진이 선택되어 있는지 확인한 다음, 타임라인 시작점으로 플레이헤드를 가져가세요.

사진 속 애니메이션 효과는 조절이 가능하므로 프레임 중심이 아닌 용광로 방향으로 줌인하는 
효과로 수정할 수 있습니다. 이렇게 수정하려면 뷰어에 Dynamic Zoom 컨트롤이 나타나도록 
해야 합니다.

2 타임라인 뷰어 좌측 하단에 있는 팝업 메뉴 아이콘을 클릭하면 온스크린 컨트롤 메뉴가 
나타납니다.

3 온스크린 컨트롤 목록에서 Dynamic Zoom을 선택하세요.
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Dynamic Zoom 온스크린 컨트롤이 타임라인 뷰어에 있는 이미지 위에 나타납니다. 초록색 
테두리 상자는 애니메이션 효과가 시작되는 프레임이라는 것을 나타내며, 빨간색 테두리 상자는 
애니메이션 효과가 끝나는 프레임이라는 것을 나타냅니다. 초록색 테두리가 두꺼워지면 현재 
해당 프레임이 선택되었음을 나타냅니다. 끝나는 프레임을 다시 설정하려면 먼저 마지막 
프레임을 선택하세요.

4 빨간색 테두리 상자 모서리에 있는 흰색 컨트롤 핸들을 클릭하세요.

정보 타임라인 왼쪽 상단 모서리 쪽에 있는 스케일 팝업 메뉴에서 뷰어에 
나타나는 이미지 크기를 조절하면 온스크린 컨트롤을 더욱 크게 볼 수 
있습니다. 마우스 및 트랙패드, 태블릿의 스크롤 컨트롤 기능을 사용하여 
이미지를 줌 인/아웃 할 수도 있습니다.

테두리 상자가 선택되면 원하는 곳으로 드래그하여 위치를 재설정할 수 있습니다.

5 빨간색 테두리 상자 안을 클릭하여 용광로가 정 가운데 오도록 조절하세요.

이제 영상을 재생하여 변경 사항을 확인하세요.

6 Transform/Crop/Dynamic Zoom 버튼을 클릭하여 온스크린 컨트롤 기능을 끄세요.
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버튼이 회색으로 변하며 비활성화되었음을 나타내고, 뷰어에서 온스크린 컨트롤이 사라집니다.

7 플레이헤드를 타임라인 시작점으로 가져가세요.

8 스페이스바를 눌러 클립에 사용한 애니메이션 효과를 확인하세요.

섬세한 애니메이션 효과가 사진에 추가되어 고정된 온스크린 이미지보다 전체 영상에 훨씬 시선을 
끕니다.

타이틀 추가하기
현재 작업하는 프로그램에는 타이틀이 필요합니다. 메인 타이틀 시퀀스 제작은 타이포그라피와 
색상, 애니메이션 효과를 창의적인 방식으로 사용한 예술 형태 중 하나로 지난 몇 세기 동안 사용되어 
온 그래픽 디자인의 원리에서 유래되었습니다. 1분짜리 영상에 관객이 거는 기대는 높지 않기 때문에 
정확한 맞춤법의 간단한 타이틀을 만들어 보겠습니다.

1 화면 좌측 상단에 있는 Effects Library 버튼을 클릭하세요.

미디어 풀 아래 Effects Library 화면이 열리고 왼쪽에 효과 카테고리 목록이 나타납니다. 모든 
타이틀 템플레이트는 타이틀 카테고리에 있습니다.

2 Effects Library 목록에서 Titles 카테고리를 클릭하세요.

타이틀 카테고리 상단에는 다섯 가지의 타이틀 템플레이트가 있고 그 아래는 고급 애니메이션 
효과를 가진 Fusion 타이틀 템플레이트가 있습니다. 원하는 템플레이트를 타임라인에 드래그한 
뒤, 필요에 맞게 수정합니다.
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3 Viewer > Zoom > Zoom to Fit 순서로 선택하거나, Shift와 Z 키를 함께 누르면 타임라인을 전체 
화면으로 볼 수 있습니다.

4 Effects Library를 맨 아래로 스크롤하면 더욱 다양한 Fusion 타이틀을 볼 수 있습니다.

5 Title Rise Fade 템플레이트를 타임라인에 있는 세 번째 클립에 드래그합니다.

클립 위에 놓인 타이틀은 배경이 투명해 뷰어에서 두 개의 클립을 모두 볼 수 있습니다.

6 타임라인에서 플레이헤드를 타이틀 클립으로 옮기면 뷰어를 통해 타이틀 애니메이션 효과를 
볼 수 있습니다.

타이틀 템플레이트에는 Inspector 안에서 교체할 수 있는 기본 텍스트가 포함되어 있습니다.

7 화면 우측 상단에 있는 Inspector 버튼을 누르면 타이틀 제어 장치와 함께 Inspector 패널이 
나타납니다.

8 Main Text란에 1분짜리 영상을 위한 타이틀로 Taryn Jayne Glass를 입력하세요.

타이틀 단어 입력이 완료되었으므로 이제 텍스트 크기를 조절하세요. 타이틀이 TV 안전 영역 
안에 위치하여 어떤 화면에서도 잘 나타날 수 있도록 텍스트 크기를 조절하기 전에 뷰어에 
있는 안전 영역 그리드 기능을 활성화하세요.

9 View > Safe Area > On 순서로 선택하세요.

뷰어에 실제 프레임 크기의 가이드와 함께 안정 연기 영역과 안전 타이틀 영역을 위한 그리드가 
나타납니다.
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10 Inspector 맨 위에 있는 Size 슬라이더를 왼쪽으로 드래그하여 텍스트를 뷰어 속에 있는 안정  
영역 그리드 중심부로 옮기세요.

정보 텍스트를 직접 입력하는 애니메이션 효과이기 때문에 텍스트 전체를 
보려면 플레이헤드를 클립 중간 부분으로 옮겨야 할 수도 있습니다.

11 View > Safe Area > On 순서대로 선택하면 그리드가 사라집니다.

마지막으로 텍스트 색상을 변경하겠습니다.

12 컬러 슬라이드 바를 초록색에서 청록색 방향으로 드래그한 다음, 컬러 필드 안을 드래그하여 
원하는 색상 톤을 설정하세요.

13 Inspector 버튼을 클릭하면 해당 창이 닫힙니다.

14 플레이헤드를 타이틀 클립 앞으로 이동하고 스페이스바를 눌러 수정된 애니메이션 효과를 
확인하세요.

Fusion 템플레이트를 사용하면 별다른 노력 없이 잘 만들어진 타이틀 애니메이션 효과를 추가할 
수 있습니다. Fusion 타이틀 애니메이션 템플레이트를 직접 제작하는 방법은 제9과에서 더욱 
자세하게 다룰 예정입니다. 이제 비디오와 오디오가 완성되었으므로 영상을 재생하여 편집 작업한 
것을 확인해보도록 하겠습니다.

전체 화면으로 재생하기
이제 작업한 프로젝트를 처음으로 미리보기할 차례입니다. 한 대의 컴퓨터 화면에서 작업하거나 
노트북으로 작업하여 비디오 전용 모니터가 없을 경우 DaVinci Resolve 인터페이스를 사용하는 
화면에서 미리보기할 수 있습니다.

1 플레이헤드를 타임라인 시작점으로 이동하세요.

2 Workspace >Viewer Mode > Cinema Viewer 순서로 선택하거나, [command + F] (MacOS) 키 
또는 [control + F] (Windows) 키를 동시에 누르세요.

뷰어가 컴퓨터 전체 화면으로 나타납니다. 마우스를 움직이면 재생 버튼과 타임라인을 앞으로 
감기 및 뒤로 감기할 수 있는 조그바가 있는 오버레이가 화면에 나타납니다.
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3 스페이스바를 누르면 타임라인이 재생되어 영상을 감상할 수 있습니다.

마지막으로 지금까지 작업한 것을 저장합니다.

4 조그바 오버레이 위를 마우스로 움직이면 나타나는 확장 버튼을 클릭하여 DaVinci Resolve 
인터페이스로 되돌아갑니다.

5 File > Save Project를 선택하세요.

6 프로젝트명을 Glass blowing으로 설정한 다음, Save를 클릭합니다.

이제 모든 작업이 완료되었습니다! 제1과에서는 앞으로 계속해서 언급될 DaVinci Resolve의 편집 
인터페이스 기능과 다양한 컨트롤 패널 기능에 관해 다뤄보았습니다. 지금까지 작업한 과정이 
확실하게 이해되지 않더라도 다음에 이어질 과를 통해 편집 기술을 반복해서 습득할 기회가 많이 
남아 있으므로 걱정하지 않으셔도 됩니다.
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복습하기
1 새로운 프로젝트는 어디서 생성하나요?

2 프로젝트에 추가할 타이틀 템플레이트는 어디서 찾을 수 있나요?

3 오디오 레벨은 어디서 조절할 수 있나요?

4 타임라인에서 클립을 선택하고 [delete] 또는 뒤로 가기 키를 누르면 어떻게 되나요?

5 사진의 패닝 및 줌 기능을 자동화할 수 있는 기능은 어디에 있나요?
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정답
1 새로운 프로젝트는 Project Manager에서 생성할 수 있습니다.

2 타이틀 템플레이트는 Effects Library에 있습니다.

3 오디오 클립 볼륨은 Inspector에서 조절할 수 있습니다.

4 타임라인에 있는 클립이 삭제되며 그 곳에 빈 공간이 생깁니다.

5 Dynamic Zoom 기능은 Inspector에 있습니다.



제2과

새로운 프로젝트 
구성하기 

영화 및 영상 콘텐츠를 제작하는 일은 굉장히 
창의적이고 흥미로운 작업입니다. 제1과에서는 
이러한 작업 과정을 간략하게 살펴 보았는데요,
이제 DaVinci Resolve 15으로 편집/색보정/오디오 
믹싱 등의 작업을 효율적으로 진행하는데 필요한 
기본기를 다지기 위해 다시 원점으로 돌아와 좀 
더 자세한 내용을 살펴보도록 하겠습니다.

먼저 프로젝트 설정, 미디어 불러오기, 클립 
그룹별 폴더 정리, 메타데이터 및 스마트 빈 
사용하기 등을 통해 푸티지를 쉽게 검색 및 
분류해보겠습니다.

예상 소요 시간

이 과를 학습하는 데는 약 45분 
정도의 시간이 소요됩니다.

학습 목표

핵심 기능 설정하기 28

DaVinci Resolve 인터페이스 둘러보기 32

클립 불러오기 33

클립 리뷰 및 스크러빙하기 36

클립 메타데이터 보기 38

커스텀 메타데이터 추가하기 40

새로운 빈 만들기 42

스마트 빈 생성하기 43

커스텀 빈 뷰 저장하기 46

클립명 변경하기 47

복습하기 49
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핵심 기능 설정하기
1과에서 프로젝트를 생성했을 때는 아무런 설정도 변경하지 않았습니다. 사실 마지막 순간까지 
프로젝트 이름도 입력하지 않고 넘어갔는데요. 그 프로젝트에서는 사실 지루한 프로젝트 설정 업무를 
건너뛰고 재미난 부분으로 바로 넘어갔습니다. 이제 다시 처음으로 돌아가 제대로 된 프로젝트를 
새롭게 설정해 보겠습니다. 이를 위해 프로젝트 매니저 창으로 돌아가 보겠습니다.

1 DaVinci Resolve를 사용하고 있지 않을 경우 프로그램을 실행해 프로젝트 매니저를 엽니다. 
이미 DaVinci Resolve를 실행 중인 경우 File > Project Manager로 이동하거나 [shift+1] 키를 
동시에 누르세요.

프로젝트 매니저를 열면 1과에서 생성한 프로젝트 썸네일이 나타납니다. 이번 과정에서도 새로운 
프로젝트를 생성하게 됩니다.

2 프로젝트 매니저 창 하단에 있는 New Project 버튼을 클릭하세요.

3 Create New Project 창이 나타나면 거기에 My New Project라고 입력한 다음 Create 버튼을 
클릭하세요.

그러면 편집 페이지에 새로운 프로젝트가 열립니다.

4 1과에서 열어둔 모든 추가 패널을 닫으려면 Workspace > Reset UI Layout을 선택하세요.

DaVinci Resolve는 프로젝트 설정에 기본값으로 설정된 재생 프레임 레이트 및 출력 해상도를 
사용합니다. 사용자는 프로젝트 설정(Project Settings) 창에서 이러한 설정값을 변경할 수 
있습니다. 

5 파일 > Project Settings를 선택하면 프로젝트 설정 창이 열립니다.
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이번 과에서는 23.976fps에 크기가 1280 x 720 픽셀인 클립을 사용할 예정입니다. 그럼 여기에 
맞게 프로젝트 설정을 조정해보겠습니다.

6 Timeline resolution 팝업 메뉴에서 1280 x 720 HD 720P를 선택하세요.

Timeline resolution 아래쪽에 보시면 타임라인 프레임 레이트(Timeline frame rate) 항목이 
있습니다. 프로젝트 프레임 레이트는 추후 변경이 불가능하기 때문에 미디어를 불러오기 전에 
해당 항목을 올바르게 설정하는 것이 굉장히 중요합니다.

7 Timeline frame rate 메뉴에서 23.976을 선택하세요.

8 프로젝트 설정 창에서 Save를 클릭해 변경 사항을 저장한 다음 편집 페이지로 돌아갑니다.

클립을 불러오기 전에 두 개의 다른 항목 또한 설정해야 합니다. 이제 DaVinci Resolve 설정 
조정에 사용되는 환경 설정(Preferences) 창을 사용해볼 텐데요, 보통 이런 설정은 프로젝트마다 
변경하지 않고 일괄 조정합니다.

9 DaVinci Resolve > Preferences를 선택하거나 [command + ,] (Mac) 키 또는 [Ctrl + ,] (Windows) 
키를 함께 누르면 환경 설정 창이 나타납니다.
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환경 설정 창 좌측엔 프로젝트 설정 창과 마찬가지로 설정 카테고리가 나타납니다. 환경 설정 
창을 열면 자주 설정하는 항목인 Media Storage 카테고리가 나타납니다.

DaVinci Resolve를 사용할 경우 Media Storage 카테고리를 통해 ‘스크래치 디스크’라고 불리는 
드라이브를 시스템에 추가할 수 있습니다. DaVinci Resolve에서 프로젝트를 진행하는 동안 
하드 드라이브에 반드시 저장해야 할 미디어가 종종 생성됩니다. 여기엔 재생 성능 향상에 
최적화된 캐시 및 렌더링 파일과 스틸 프레임, 다양한 미디어 등이 포함됩니다. 이러한 파일은 
Media Storage 설정 카테고리에 나열된 첫 번째 하드 드라이브에 저장됩니다.

10 캐시 콘텐츠에 사용할 드라이브를 변경하고자 할 경우 Add 버튼을 눌러 속도가 가장 빠르고 
용량이 제일 큰 하드 드라이브를 선택하세요.

컴퓨터에서 사용할 수 있는 드라이브 중 용량이 가장 크고 속도가 가장 빠른 하드 드라이브를 
스크래치 디스크로 설정할 것을 권장합니다. 스크래치 디스크를 구체적으로 명시하지 않을 
경우 시스템 디스크를 사용하도록 기본 설정되어 있습니다. 

환경 설정 창 상단에는 두 개의 탭이 있습니다. System 탭이 선택되도록 기본 설정되어 있습니다. 
Media Storage와 같은 설정은 모든 프로젝트의 컴퓨터 하드웨어에 따라 달라집니다. User 탭을 
보면 프로젝트에는 저장되지 않았지만 이 워크스테이션에서 사용하기 위해 저장된 환경 설정이 
나타납니다.

11 환경 설정 창 상단에 있는 User 탭을 클릭하세요.
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12 환경 설정 창 왼편에 있는 Project Save and Load 카테고리를 클릭하세요.

Project Save and Load 설정을 통해 프로젝트를 주기적으로 백업할 수 있을 뿐 아니라 작업 
내용을 실시간으로 계속 저장할 수도 있습니다. 새로운 프로젝트에서는 Live Save 기능이 
자동적으로 활성화되지만 Project Backups 설정은 따로 활성화해야 합니다.

13 Project Backups 버튼을 클릭해 해당 기능을 활성화하세요.

정보 Keyboard Mapping 설정을 통해 키보드 단축키를 사용자 지정하면 다른 
인기 편집 시스템 또는 자신이 원하는 레이아웃과 동일하게 사용할 수 
있습니다.

14 Save 버튼을 눌러 환경 설정 창을 닫으세요.

정보 환경 설정에서 일부 옵션을 변경하고 나면 DaVinci Resolve를 재실행해야 
합니다.

이제 설정이 완료되었습니다. 하지만 클립 불러오기 방법을 알아보기에 앞서 DaVinci Resolve 
인터페이스만의 특별한 점들을 살펴보겠습니다.
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DaVinci Resolve 인터페이스 둘러보기
DaVinci Resolve는 Media, Edit, Fusion, Color, Fairlight, Deliver 등 여러 개의 인터페이스 페이지로 
구성되어 있으며, 페이지 순서는 가장 일반적인 필름 및 비디오 후반 제작 워크플로를 따릅니다. 
화면 하단의 6개 버튼 중 하나를 눌러 각 페이지에 접속할 수 있습니다.

1 Media 페이지 버튼을 누르면 미디어 페이지로 전환됩니다.

미디어 페이지는 미디어 불러오기 및 정리하기, 클립 동기화, 메타데이터 추가, 카메라 원본 
미디어 복제 등의 작업을 가장 효율적으로 진행할 수 있는 페이지입니다.

2 Edit 페이지 버튼을 클릭하면 편집 페이지로 전환됩니다.

편집 페이지에는 프로그램을 한데 모으고 타이틀/트랜지션/효과를 추가하는데 필요한 모든 
전문 편집 도구가 포함되어 있습니다.

3 Fusion 페이지 버튼을 누르면 Fusion으로 전환됩니다.

Fusion 페이지는 시각 효과 및 모션 그래픽 작업에 완벽한 2D/3D 합성 소프트웨어입니다.

4 Color 페이지 버튼을 클릭하면 컬러 페이지로 전환됩니다.

DaVinci Resolve 컬러 페이지에는 세계적인 수준의 색보정 도구와 창의적인 컬러 그레이딩 
도구뿐 아니라 키잉 기능, 안정화 기능, 필터 효과까지 포함되어 있습니다.

5 Fairlight 페이지 버튼을 누르면 Fairlight 페이지로 전환됩니다.

Fairlight 페이지는 고품질의 시네마 사운드트랙 딜리버리에 필요한 모든 기능을 지원하는 완벽한 
디지털 오디오 워크스테이션입니다.

6 Deliver 페이지 버튼을 클릭하면 Deliver 페이지로 전환됩니다.

Deliver 페이지에서는 테이프에 마스터링하기, 웹용 파일 생성하기, 극장 배급용 고해상도 파일 
출력하기 등의 작업이 가능합니다.

이처럼 페이지를 자유롭게 오가며 파일 불러오기 및 관리하기, 타임라인 편집 작업, 시각 효과 
생성, 색보정, 오디오 믹싱, 프로그램 출력 등의 작업을 수행할 수 있습니다. 그럼 이제 미디어 
페이지로 넘어가 보겠습니다.
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미디어 페이지는 5개 영역으로 구성되어 있습니다.

미디어 페이지에서는 가장 유연하고 다양한 방식으로 하드 드라이브에서 미디어를 불러오기할 수 
있습니다. 이뿐만 아니라 미디어 관리, 클립 관리, 오디오 및 비디오 클립 동기화, 오프라인에서 
예기치 않게 발생하는 클립 관련 문제 해결 등의 기타 업무도 수행할 수 있습니다.

클립 불러오기
프로젝트에 클립을 불러올 준비가 완료된 경우에는 미디어 페이지에 있는 라이브러리 브라우저를 
사용하는 것이 가장 효율적입니다. 이 브라우저에서 원하는 미디어가 저장된 모든 폴더 또는 하드 
드라이브를 검색할 수 있습니다. 프로젝트에 불러온 파일은 미디어 풀에 있는 빈에 저장됩니다.

참고 다음 과정은 R15 lessons 폴더를 복사해 도큐먼트 폴더로 옮긴 경우를 전제로 
합니다. 파일을 다른 장소에 복사한 경우 라이브러리 브라우저를 사용해 해당 
장소를 검색하세요.

라이브러리 브라우저에는 연결된 모든 
드라이브 및 드라이브에 저장된 파일이 

나타납니다. 

미디어 풀에는 현재 프로젝트를 위한 모든 
미디어가 빈에 정돈되어 나타납니다. 라이브러리 
브라우저에서는 드라이브에 저장된 파일을 각 
프로젝트용 미디어 풀로 불러올 수 있습니다.

영상 미리보기용 뷰어

클립 메타데이터를 확인, 
추가, 편집할 수 있는 
메타데이터 편집기

오디오 레벨 확인용 
오디오 미터
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1 라이브러리 브라우저 좌측의 사이드바에서 컴퓨터 내부의 하드 드라이브 아이콘을 클릭하세요.

2 우측 패널에 있는 도큐멘트 폴더를 검색하세요.

3 도큐멘트 폴더에서 R15 lessons 폴더를 더블 클릭하세요.

R15 lessons 폴더 내 7개의 하위 폴더가 나타납니다. Lesson 02 폴더에 있는 Video Clips 폴더 
속 클립을 불러오기하겠습니다.

4 Lesson 02 폴더를 더블 클릭한 다음 Video Clips 폴더를 더블 클릭해 해당 폴더를 엽니다.

라이브러리 우측 패널에는 불러오기 하려는 각 클립의 이미지 아이콘이 썸네일 크기로 나타납니다. 
각 클립은 뷰어에서 미리보기할 수 있습니다.

5 뷰어에서 확인하고자 하는 썸네일을 클릭하세요.

6 스페이스 바를 누르면 해당 클립의 재생이 시작되고 스페이스 바를 다시 한 번 누르면 재생이 
정지됩니다.

클립 미리보기를 마친 후 한 개 이상의 클립을 선택해 프로젝트로 불러올 수 있습니다.

7 라이브러리에 있는 모든 클립을 선택하려면 Edit > Select All을 선택하거나 [Cmd+A] 키(macOS) 
또는 [Ctrl+A] 키(Windows)를 함께 누르세요.
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8 라이브러리의 첫 번째 클립을 No clips in media pool이라고 표시된 미디어 풀로 드래그하세요.

정보 macOS Finder 또는 Windows 익스플로러에서 미디어 풀로 클립을 직접 
드래그할 수 있습니다.

선택한 모든 클립이 미디어 풀 내 Master 빈으로 추가됩니다. 모든 프로젝트에는 Master 빈이 
포함되어 있습니다. Master 빈에는 추가한 모든 클립과 새로 만든 파일이 포함됩니다. 또한 
여기서 중요한 점은 파일을 불러오더라도 복사/이동/트랜스코딩하지 않는다는 것입니다. DaVinci 
Resolve의 가장 큰 장점은 하드 드라이브에 있는 파일을 옮기지 않고 간단히 연결해 원본 
영상에는 아무런 영향을 끼치지 않는다는 점입니다.

폴더 불러오기
불러오려는 파일을 하나씩 선택해 마스터 빈에 추가하는 대신 전체 폴더를 불러올 수 있으며 커스텀 
빈이 자동으로 생성됩니다.

1 라이브러리 상단의 뒤로 가기 화살표를 눌러 R15 lessons 폴더의 콘텐츠를 볼 수 있습니다.
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2 Audio 폴더를 우클릭한 다음 Add Folders and SubFolders to Media Pool (Create Bins)을 
선택하세요.

이 메뉴 항목을 선택하면 폴더명과 함께 빈이 생성되며 마스터 빈에 추가됩니다. 폴더에 있는 모든 
클립을 새로운 빈에 불러올 수 있습니다.

클립 리뷰 및 스크러빙하기
다른 사람이 촬영해 아직 익숙치 않은 푸티지를 편집하는 프로젝트의 경우에는 불러온 클립을 검토 
및 확인해야 할 수 있습니다.

1 미디어 풀 사이드바에서 Master 빈을 선택하세요.

2 해당 빈에서 마우스 포인터를 아무 비디오 클립 위로 가져갑니다.

마우스 포인터를 빈 안에 있는 아무 클립 위로 가져가면 뷰어에서 해당 클립의 실시간 미리보기를 
확인할 수 있습니다. 썸네일 위에서 마우스를 앞뒤로 움직이면 클립 영상을 신속하게 스크러빙할 
수 있습니다.

참고 사용자마다 화면 및 윈도우 크기가 모두 다르기 때문에 빈에 있는 클립 
순서가 이 과에 제시된 것과 약간 다를 수 있습니다.
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3 마우스 포인터를 썸네일 위에서 앞뒤로 움직이면 클립 영상을 신속하게 스크러빙할 수 있으며 
뷰어에서 해당 내용을 확인할 수 있습니다.

정보 실시간 미리보기 기능은 뷰어 우측 상단에 있는 옵션 메뉴에서 
비활성화할 수 있습니다.

실시간 미디어 미리보기 기능을 통해 클립을 재생하지 않고도 신속하게 훑어볼 수 있습니다. 
하지만 클립을 가장 효율적으로 편집하려면 콘텐츠에 대해 자세히 알고 있어야 합니다. 이를 
위해서는 클립을 처음부터 끝까지 보는 수밖에는 없습니다.

4 마우스 포인터가 썸네일 위에 있을 때 스페이스 바를 누르면 클립이 재생됩니다.

클립은 기본 프레임 속도로 재생됩니다.

5 스페이스 바를 다시 한번 누르면 재생이 종료됩니다.

뷰어 트랜스포트 버튼에는 재생 버튼뿐 아니라 파일을 거꾸로 재생하는 버튼과 플레이 헤드를 
클립 맨 앞 또는 맨 뒤로 이동할 수 있는 버튼 등이 포함되어 있습니다.

대표 썸네일 선택하기
썸네일에는 클립 맨 첫 번째 프레임이 나타납니다. 간혹 첫 번째 프레임이 클립을 나타내기에 
적당하지 않을 경우 원하는 프레임으로 변경할 수 있어 상당히 유용합니다.

1 미디어 풀 우측 상단에 있는 스케일 조정 슬라이더를 드래그해 썸네일 크기를 조절할 수 있습니다.

2 마우스 포인터를 07_ KENYA라고 적힌 썸네일 위로 가져가세요.

3 썸네일 위에서 마우스 포인터를 좌우로 움직이세요.

마우스 포인터를 좌우로 움직이면 마치 클립을 빨리 감거나 되감는 것처럼 DaVinci Resolve에 
다양한 프레임이 나타납니다.
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4 노란 비행기가 나타날 때까지 썸네일 위에서 마우스 포인터를 움직이세요. 

푸른 물보다는 비행기 이미지가 대표 프레임으로 더욱 적합합니다.

5 썸네일을 우클릭한 다음 메뉴에서 Set Poster Frame을 선택하세요.

적절한 포스터 프레임으로 설정하면 클립 검색에 도움이 되지만, 사용하는 콘텐츠에 제대로 
익숙해지려면 반드시 클립을 확인해야 합니다. 이번 과를 마치면 클립을 다시 살펴보며 최적의 대표 
프레임이 설정되지 않은 다른 모든 클립의 포스터 프레임을 설정해 보시기 바랍니다.

클립 메타데이터 보기
오디오 및 비디오 콘텐츠 이외에도 클립 콘텐츠에 대한 정보가 담긴 메타데이터를 클립에 포함시킬 
수 있습니다. 메타데이터는 다른 데이터 중에서 파일 포맷과 프레임 속도, 해상도를 구별합니다.
일부 메타데이터의 경우 카메라 및 오디오 레코더에서 자동 생성되기도 합니다. 프로젝트를 좀 더 
효율적으로 관리하는데 사용 가능한 키워드 등의 커스텀 메타데이터를 추가할 수도 있습니다.

Metadata 에디터를 사용해 클립의 메타데이터를 확인하고 부가 정보를 추가할 수 있습니다. 

1 마스터 빈에서 클립을 클릭하면 해당 클립이 뷰어에 로딩됩니다.

선택한 클립의 상세 정보가 미디어 페이지 우측 하단의 Metadata 에디터에 나타납니다.
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Metadata 에디터 상단에 클립명, 길이, 프레임 크기 등의 일부 필수 클립 정보가 나타납니다. 
하지만 제작 과정에서 모든 클립에 엄청난 양의 메타데이터가 생겨나므로 Metadata 에디터 
우측 상단의 팝업 메뉴를 통해 메타데이터 카테고리를 선택할 수 있습니다.

2 Metadata 에디터 우측 상단의 팝업 메뉴에서 Shot & Scene을 선택하세요.

팝업 메뉴의 각 카테고리에는 추가 필드와 확인란이 포함되어 있습니다. 일부의 경우 카메라 또는 
다른 장비에서 자동 입력된 메타데이터가 나타날 수 있는 반면 다른 필드를 통해 클립 관리에 
도움이 되는 사용자 지정 정보를 추가할 수 있습니다. 다음 단계에서는 더욱 간편한 클립 검색을 
위해 일부 메타데이터를 클립에 추가해보도록 하겠습니다.
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커스텀 메타데이터 추가하기
제작 도중 촬영 현장에서 캡처 및 자동 생성된 표준 메타데이터는 클립을 관리하는 데 도움이 되는 
것은 확실하지만 자신만의 메타데이터를 추가하는 것 역시 중요합니다. 거의 모든 프로젝트에서 
일부 메타데이터를 사용해 콘텐츠를 관리하게 됩니다. 일부 메타데이터의 경우 DaVinci Resolve에서  
수동으로만 추가할 수 있습니다.

사실 이번 과에는 짧은 장면으로 이루어진 일부 숏만 나오기 때문에 관리하기가 그렇게 어렵지 
않습니다. 하지만 수백 개 또는 수천 개의 클립이 포함된 대규모 프로젝트를 작업할 경우 메타데이터를 
추가해 사용하면 편집 작업 시 클립을 검색 및 분류하는데 걸리는 수많은 시간을 절약할 수 있습니다.

1 마스터 빈에서 AA0113_01 클립을 선택하세요.

이 클립은 앞으로 사용하게 될 세 개의 인터뷰 클립 중 하나입니다. 따라서 인터뷰 클립으로 
분류하는 것이 좋습니다. 그럼 해당 정보를 키워드로 추가하겠습니다.

2 Metadata 에디터의 Keywords 입력란에 Interview라고 입력하세요.

나머지 두 개의 인터뷰 클립에도 Interview라는 키워드를 사용할 수 있습니다. 두 개의 클립에 
키워드를 동시에 입력하면 훨씬 효율적입니다.

3 마스터 빈에서 AB0102_01을 선택한 다음 [Cmd] 키(macOS) 또는 [Ctrl] 키(Windows)와 함께 
AC0113_01을 누르면 해당 파일도 함께 선택됩니다.
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4 두 파일을 모두 선택한 다음 Metadata 에디터의 Keyword 입력란에 INT를 입력하세요.

그러면 표준 키워드 목록과 I-N-T로 시작하는 기존에 입력한 키워드가 나타납니다. 가능한 
목록에 나타나는 키워드를 선택하여 잘못된 스펠링이 입력되지 않도록 하는 것이 좋습니다.

5 팝업 메뉴에서 추가하려는 Interview 키워드를 선택하세요.

6 메타데이터 패널 하단에 있는 Save 버튼을 클릭하면 해당 키워드가 두 개의 클립에 일괄 
적용됩니다.

이제 인터뷰 클립에 콘텐츠 관련 주요 정보가 태그되었습니다. DaVinci Resolve에서는 이런 방식으로 
추가된 메타데이터를 사용해 클립을 관리합니다. 그럼 이어서 메타데이터를 추가해 클립 관리를 
시작하는 방법에 대해 알아보겠습니다.
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새로운 빈 만들기
빈은 클립을 저장하는 폴더 또는 보존 용기와 같습니다. 불러온 모든 비디오 클립이 마스터 빈으로 
들어가도록 기본 설정되어 있지만, 모든 클립을 하나의 빈에서만 관리하는 것은 효율적이지 않습니다. 
이는 서류 정리 캐비닛이 있는데 한 폴더에 안에 모든 서류를 채우는 것과 마찬가지입니다. 커스텀 
폴더나 빈을 생성해 나중에 쉽게 찾아볼 수 있는 방식으로 클립을 관리하는 것이 훨씬 효율적입니다.

1 미디어 풀에 있는 Master 빈을 선택하세요.

현재 마스터 빈에 있는 모든 비디오 클립을 콘텐츠 별로 관리하면 클립을 신속하게 검색할 수 
있어 더욱 수월하게 작업이 가능합니다. 예를 들어, 모든 비행기 장면을 B롤 빈으로 옮겨 Interview 
빈에 있는 인터뷰 클립과 구별할 수 있습니다.

2 새로운 빈을 생성하려면 File > New Bin을 선택하거나 [Cmd + Shift + N](macOS) 또는 [Ctrl + 
Shift + N](Windows) 키를 동시에 누르세요. 

기본 설정에 의해 Bin 1이라는 이름의 새로운 빈이 생성되어 미디어 풀에 추가됩니다. 그럼 
프로젝트에 맞는 이름으로 변경해 보겠습니다. 새로운 빈의 이름은 즉시 변경 가능합니다.

3 빈의 이름을 Ending Credits로 입력하세요.

새롭게 생성한 모든 빈은 마스터 빈 안쪽에 나타납니다. 새로운 빈을 생성해 프로젝트에 맞는 
이름으로 변경하고 나면 클립을 빈에 정리할 준비가 완료됩니다.

4 마스터 빈을 선택한 다음 11_MOVIE_CREDITS 썸네일을 빈 목록 사이드 바에 있는 Ending 
Credits 이름 위로 드래그하세요. Ending Credits라는 빈 이름이 하이라이트되면 마우스 
버튼에서 손을 떼세요.

정보 빈 목록 사이드 바에서 빈 이름을 우클릭한 다음 Open As a New Window
를 클릭하면 여러 개의 빈을 동시에 열 수 있습니다.

5 미디어 풀 사이드 바에서 Ending Credits 빈을 클릭하면 해당 콘텐츠를 볼 수 있습니다.

이제 클립을 한 빈에서 다른 빈으로 옮기는 작업을 성공적으로 마쳤습니다. 클립을 관리하는 방법이 
아주 간단하기는 하지만 노동 집약적인 작업이 될 수도 있습니다. 그럼 이제 클립을 효율적으로 
관리하는 방법에 대해 살펴보겠습니다.
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스마트 빈 생성하기
스마트 빈은 지정한 메타데이터를 기반으로 모든 프로젝트를 검색해 클립을 그룹별로 분류합니다. 
예를 들어, 스마트 빈을 생성해 프로젝트에 있는 모든 오디오 클립 또는 특정 카메라로 캡처된 
클립을 자동 검색하도록 할 수 있습니다. 가장 눈에 띄는 점은 프로젝트에 새로운 푸티지가 추가될 
때마다 스마트 빈의 콘텐츠가 지속적으로 업데이트된다는 점입니다. 다시 말해, 메타데이터와 스마트 
빈을 사용할 경우 푸티지를 수동으로 관리할 필요가 없습니다.

1 미디어 풀 사이드바에서 Smart Bins 글자 아래 부분을 마우스로 우클릭하세요..

2 메뉴에서 Add Smart Bin을 선택하세요.

Create Smart Bin이라는 대화 상자가 나타납니다. 여기서 스마트 빈에 어떤 클립을 자동으로 
추가할지 설정할 수 있습니다. 여러 가지 검색 기준을 통해 다양한 자동 생성 및 수동 입력 
메타데이터를 기반으로 클립을 그룹화하는 스마트 빈을 생성할 수 있습니다.

3 Create Smart Bin 대화 상자의 Name 입력란에 Interview라고 입력하세요.

4 Media Pool Properties를 클릭한 다음 메뉴에서 Metadata - Shot & Scene을 선택하세요. 이는 
키워드 입력 시 선택한 메타데이터 카테고리입니다.

5 메타데이터 유형 팝업 메뉴를 Keywords로 설정한 다음, 맨 끝에 있는 메타데이터 검색 기준 
팝업 메뉴를 Contains로 설정하세요.

6 텍스트 입력란에 interview를 입력한 뒤, Create Smart Bin 버튼을 누르세요.
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그러고 나면 미디어 풀 하단에 스마트 빈이 나타나며 해당 키워드가 포함된 모든 클립이 
자동으로 업데이트됩니다.

스마트 빈에서 다양한 검색 기준 사용하기
아주 간단한 스마트 빈이 생성되었지만, 이 스마트 빈에서 아주 다양한 작업을 할 수 있습니다. 여러 
개의 검색 기준 레이어를 추가하면 클립의 세부 선택이 가능합니다.

1 Interview Smart Bin 아래쪽을 우클릭한 다음 메뉴에서 Add Smart Bin을 선택하세요.

이 스마트 빈에서는 인터뷰 클립이 아닌 모든 클립을 검색합니다.

2 Create Smart Bin 대화 상자의 Name 입력란에 B-Roll이라고 입력하세요.

3 Interview 빈과 같은 방식으로 스마트 빈을 설정합니다. Metadata - Shot & Scene, Keywords를 
선택한 다음 맨 마지막 필드에 interview라고 입력하세요.

4 contains 메뉴를 클릭한 뒤, does not contain을 선택합니다. 그런 다음 Create Smart Bin을 
클릭하세요.

이제 Interview라는 키워드와 관련 없는 모든 클립이 담긴 스마트 빈이 생성되었습니다. 이를 
통해 원하는 대부분의 클립을 확인할 수 있지만 여기엔 프로젝트의 오디오 클립 또한 포함되어 
있습니다. 스마트 빈의 검색 범위를 한 단계 좁혀 해당 오디오 클립을 제외시킬 수 있습니다.

5 스마트 빈 검색 기준을 편집하려면 B-Roll Smart Bin을 더블 클릭하세요.

스마트 빈에 검색 기준을 추가해 클립을 좀 더 전략적으로 선택할 수 있습니다.
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6 대화 상자 맨 오른쪽에 있는 검색 필터 추가 버튼을 눌러 부가적인 검색 기준 필드를 추가할 수  
있습니다.

7 Metadata - Shot & Scene을 Media Pool Properties로 변경하세요.

8 File Name을 Clip Type으로 변경하세요.

9 마지막 두 개 메뉴를 is not과 Audio로 설정하세요.

이제 스마트 빈의 모든 오디오 클립이 제외되었습니다. 하지만 모든 타임라인 역시 제거해야 
합니다.

10 검색 필터 추가 버튼을 클릭해 다른 검색 기준을 추가하세요.

새로운 필드는 기존과 유사한 검색 기준을 사용하기 때문에 맨 마지막에 있는 두 개 항목만 
변경하면 됩니다.

11 is를 is not으로 바꾸고 맨 마지막 항목을 Video에서 Timeline으로 변경하세요.

12 OK를 클릭하면 대화 상자가 사라지고 스마트 빈이 업데이트됩니다.

추후 프로젝트에 있는 새로운 클립에 interview 키워드를 추가하면 해당 클립이 자동으로 Interview 
스마트 빈에 추가되고 B-Roll 스마트 빈에서 제외됩니다. 이것이 바로 스마트 빈의 장점입니다. 설정한 
검색 기준을 바탕으로 클립을 수집하며 지속적인 업데이트를 통해 클립을 관리합니다. 
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커스텀 빈 뷰 저장하기
빈에서 클립을 관리하는 것 뿐만 아니라 해당 빈에 콘텐츠가 나타나는 방식을 설정할 수도 있습니다. 
빈에 있는 클립을 목록 보기 및 썸네일 보기로 나타나게 할 수 있으며 원하는 만큼의 메타데이터를 
표시할 수 있습니다.

1 B-Roll 빈을 선택하세요.

2 미디어 풀 우측 상단에 있는 목록 보기 버튼을 클릭하세요.

미디어 풀이 썸네일 클립 보기에서 클립 목록 보기 방식으로 전환됩니다.

목록 보기에 나타나는 칼럼 중에서 모든 프로젝트에 해당하는 더욱 중요한 칼럼이 있기 
마련입니다. 가장 필요한 정보가 표시되도록 하려면 빈에서 원하는 칼럼만 나타나고 원치 않는 
것은 감춰지도록 선택한 뒤, 이를 레이아웃으로 저장합니다.

3 [Ctrl] 키를 누른 채 칼럼 제목을 클릭하거나(macOS), 마우스로 우클릭하면(Windows) 빈에 
해당하는 컨텍스트 메뉴가 나타납니다.

해당 메뉴에는 빈에 표시할 수 있는 모든 목록이 나타나며 현재 사용 중인 것에는 확인란이 
선택되어 있습니다.

4 메뉴에서 Audio CH, Duration, End TC, Resolution, Start TC를 제외한 모든 확인란 선택을 
해제하세요.

선택을 해제한 칼럼은 목록에서 사라집니다.

칼럼을 정렬할 수도 있기 때문에 칼럼 정보를 기반으로 클립 역시 정리 가능합니다.

5 Start TC라는 이름 옆의 작은 화살표가 위쪽을 향하도록 해당 메뉴명 클릭하세요.
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메뉴명을 클릭하면 해당 검색 기준을 바탕으로 칼럼이 정렬됩니다. Start TC 헤딩을 클릭하면 
빈에 있는 콘텐츠가 각 클립의 타임코드 숫자를 기반으로 오름차순 정렬됩니다. 위쪽을 가리키는 
작은 화살표가 메뉴명 옆에 나타나 해당 메뉴가 현재 정렬에 사용 중이라는 사실과 정렬 순서를 
알려줍니다.

변경을 마치고 나면 메뉴명이 간소화되어 확인하고자 하는 필수 정보만 표시됩니다. 필요에 
따라 여러 개의 보기 방식을 저장하고 나중에 메뉴에서 불러오기 할 수 있습니다. 같은 컨텍스트 
메뉴에서 빈 보기 방식을 저장할 수 있습니다.

6 [Ctrl]을 누른 채(macOS) 칼럼 제목 중 하나를 클릭 하거나, 또는 마우스로 우클릭(Windows) 한 
다음 메뉴에서 Create Column Layout을 선택하세요. 

7 칼럼 레이아웃 이름을 Basic View로 입력한 다음 OK를 클릭하세요.

이제 빈에 원하는 모든 칼럼이 표시됩니다.

클립명 변경하기
일부 클립의 파일명은 설명이 잘 되어있고 쉽게 이해할 수 있지만 대부분의 경우 특정 카메라에서만 
통용되는 난해한 파일명이 생성됩니다. DaVinci Resolve에서는 프로젝트 작업 도중 언제든지 
클립명을 바꿀 수 있습니다. Clip Name 칼럼에 원본 파일명이 표시되도록 기본 설정되어 있지만, 
해당 칼럼의 클립명을 긴 설명 형태로 바꿀 수 있습니다. (Clip Name을 변경해도 하드 디스크에 
있는 파일명은 바뀌지 않기 때문에 걱정할 필요가 없습니다.)

1 Interview Smart Bin을 선택하세요.

Clip Name 칼럼에는 DaVinci Resolve 내에서 사용될 이름이 편집 가능한 형태로 나타납니다.

그럼 이제 클립명을 인터뷰에 나온 문장으로 바꿔보겠습니다.

2 AA0113_01 클립을 클릭하면 해당 클립이 뷰어에 로딩되며, 이를 재생해 인터뷰 대상자가 하는 
말을 들어 볼 수 있습니다.

이 클립에서 중요한 부분은 인터뷰 대상자가 “It was really important to shoot the real world.”라고 
말하는 부분입니다.
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3 Clip Name 입력란에 01_shoot the real world라고 입력하세요.

4 AB0102_01 클립을 더블 클릭하면 해당 클립이 뷰어에 로딩됩니다.

클립은 일반적인 속도로 재생되지만 [J] 키와 [L] 단축키를 사용해 빨리 감기 또는 되감기 모드로 
재생할 수도 있습니다.

5 [L] 키를 두 번 누르면 재생 속도가 2배로 빨라집니다. [J] 키를 누르면 되감기 모드로 재생되며 
이 상태에서 [L] 키를 다시 한 번 누르면  일반 속도로 재생됩니다. 

여기서 중요한 인터뷰 내용은 “If it was possible to shoot it, you wanted to go shoot it.” 라는 
부분입니다. 

6 Clip Name란에 있는 두 번째 클립을 클릭한 다음 02_if it was possible이라고 입력하세요.

이제 인터뷰 빈에서 이름을 변경해야 할 클립이 하나 남았습니다.

7 AC0113_01 클립을 더블 클릭하면 해당 클립이 뷰어에 로딩됩니다.

8 [L] 키를 두 번 누르면 클립이 빠르게 재생됩니다.

여기서 중요한 인터뷰 내용은 “It was really important that every shot was original and every 
shot was real.” 라는 부분입니다. 

9 Clip Name란에 있는 세 번째 클립을 클릭한 다음 03_every shot was original이라고 입력하세요.

이제 모든 빈 설정과 클립 정렬, 자세한 클립명 설정뿐 아니라 변경한 이름이 애플리케이션에 계속 
표시되도록 선택하는 과정까지 모두 마쳤습니다. 이제 영화 트레일러를 편집할 준비가 완료되었습니다. 
다음 과에서는 Edit 페이지로 이동해 타임라인에서 클립 어셈블하는 방법을 배워보겠습니다.
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1 DaVinci Resolve 15의 한 타임라인에서 여러 해상도를 각기 다르게 설정해 사용할 수 있습니다. 

T(진실) 또는 F(거짓)로 답하세요.

2 클립을 불러온 다음에 프레임 레이트를 변경할 수 있습니다. T(진실) 또는 F(거짓)로 답하세요. 

3 자동 저장 또는 프로젝트 백업을 생성하는 설정은 어디에서 찾을 수 있나요?

4 원본 미디어 파일을 미디어 풀에 추가하고 나면 해당 파일이 어디에 저장되나요?

5 미디어 풀에 클립을 추가하기 전에 반드시 빈을 생성해야 합니다. T(진실) 또는 F(거짓)로 답하세요.
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정답
1 F. 타임라인 해상도는 언제든지 변경 가능하지만 모든 타임라인에는 같은 해상도가 적용됩니다.

2 F. 클립을 미디어 풀에 추가한 다음에는 타임라인 프레임 레이트를 변경할 수 없습니다.

3 Live Save와 Project Backups 기능은 User Preferences > Project Save and Load 패널에서 
찾을 수 있습니다.

4 미디어 파일을 미디어 풀에 추가하더라도 저장 장소가 바뀌지 않습니다. 해당 파일은 원본 포맷 
및 해상도를 그대로 유지한 채 처음 저장된 장소에 저장됩니다.

5 F. 미디어 풀에 다른 빈이 생성되어 있지 않은 경우 클립은 마스터 빈에 추가됩니다.



제3과

러프 컷 어셈블 편집 

임포트한 영상 콘텐츠가 모두 정렬되었으므로 
이제 편집 작업을 시작할 수 있습니다. 타임라인을 
생성하는 1단계 작업을 러프 컷(Rough Cut)
이라고 합니다. 러프 컷 작업은 프로그램에 
사용할 최종 클립을 대략적인 순서로 정렬하는 
과정을 말합니다. 그림 그리기를 시작하기 전에 
먼저 스케치하는 작업과 같습니다. 3과에서는 
편집 페이지로 되돌아가 러프 컷 작업을 수행하는 
여러 가지 방법을 살펴볼것입니다.

예상 소요 시간

이 과를 학습하는 데는 약 50분 
정도의 시간이 소요됩니다.

학습 목표

타임라인 생성하기 52

1차 편집본 만들기 53

J/K/L 키로 스크러빙하기 57

타임라인에 클립 삽입하기 59

타임코드 사용하기 64

비디오만 덮어쓰기 67

타임라인 끝에 클립 합치기 73

빈에서 편집하기 74

숏 교체하기 77

복습하기 81
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타임라인 생성하기
편집을 시작하기 전에 반드시 원하는 순서대로 클립이 정렬되어 있는 타임라인을 먼저 생성해야 
합니다. DaVinci Resolve 15 프로젝트에는 한 개 이상의 편집된 타임라인을 마스터 빈에 저장할 수 
있습니다. 하지만, 다양한 버전의 타임라인을 작업하면서 자신이 생성한 빈에 이러한 중복되는 
타임라인을 저장해두면 유용하게 사용할 수 있습니다. 이렇게 하면 자신이 작업한 타임라인으로 
되돌아가 서로 비교하고 정확한 편집 위치를 지정하는 일이 훨씬 수월해집니다.

1 DaVinci Resolve가 꺼져 있는 경우 프로그램을 시작하여 Project Manager로 이동하세요.

2 제2과에서 생성했던 My New Project 썸네일을 더블 클릭합니다. 

이 프로젝트에서 나가면 나타나는 미디어 페이지에서 러프 컷 작업을 위해 편집 페이지로 
이동하세요.

3 화면 아래에 있는 Edit 페이지 버튼을 클릭하세요.

타임라인과 이를 저장할 빈을 먼저 생성합니다.

4 Media Pool 사이드바에 있는 Master 빈을 선택하고 File > New Bin을 선택하여 마스터 빈에 
새로운 빈을 생성하세요.

5 새로 생성한 빈의 이름을 Rough Cuts로 설정하고 [return] 또는 [Enter] 키를 누르세요.

6 Rough Cuts 빈이 선택된 상태에서 File > New Timeline을 선택하거나, [command + N] 키 
(macOS) 또는 [control + N] 키(Windows)를 선택하세요. 

새로운 타임라인 창이 나타나면 타임라인 이름을 새롭게 설정할 수 있습니다.

7 새로운 타임라인명을 First Rough Cut으로 설정한 다음, Create를 클릭하세요.

타임라인 편집 영역에 빈 타임라인이 추가되며 새로 설정한 타임라인 이름이 소스 뷰어의 
클립명으로 타임라인 뷰어 상단에 나타납니다. Rough Cuts 빈에는 타임라인 아이콘이 추가로 
나타납니다.

Rough Cuts 빈에 색상을 지정하면 목록에 있는 다른 빈과 구별할 수 있어 더욱 쉽게 타임라인 
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위치를 지정할 수 있습니다.

8 빈 목록에서 마우스를 우클릭하여 Rough Cuts를 선택하세요.

9 메뉴에서 Color Tag > Cyan 순서로 선택하면 Rough Cut 빈이 청록색으로 설정됩니다.

현재 빈이 검은색으로 나타나는 이유는 해당 빈이 선택되었기 때문입니다. 다른 빈을 선택하면 방금 
설정한 청록색으로 나타납니다. 계속해서 타임라인에 클립을 추가해 보도록 하겠습니다.

1차 편집본 만들기
편집 과정에서 가장 큰 부분을 차지하는 것이 바로 숏을 선택하는 것입니다. 프로젝트에 포함할 
클립을 선택하는 것뿐만 아니라 사용하려는 클립의 범위를 설정해야 합니다. 제 1과에서는 인/아웃 
버튼을 사용해 원하는 범위를 설정하는 법을 배웠으므로 본 과에서는 더욱 신속하게 이를 수행할 
수 있는 방법을 소개하도록 하겠습니다.

1 Interview Smart Bin을 선택하고 썸네일 보기 버튼을 클릭하면 클립이 썸네일로 나타납니다.
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2 스마트 빈(Smart Bins)에서 01_shoot the real world 클립을 더블 클릭하면 소스 뷰어에 클립이 
로딩됩니다.

이 클립에는 대사가 있으므로 파형 오버레이를 사용하면 타임라인에 포함하려는 클립의 오디오 
범위를 더욱 빠르게 설정할 수 있습니다. 파형 오버레이는 제1과에서 사용한 그대로 나타납니다.

3 파형 오버레이가 소스 뷰어 하단에 나타나지 않을 경우 소스 뷰어 위에 있는 옵션 메뉴에서 
Show Zoomed Audio Waveform을 선택하세요.

4 클립 시작 부분으로 이동하여 스페이스바를 다시 눌러 클립을 재생한 다음, ‘In this film’ 대사가 
시작되는 부분에서 다시 스페이스바를 눌러 재생을 정지하세요. (오디오 파형이 이 부분부터 
시작되는 것을 알 수 있습니다.)

5 왼쪽 화살표 키를 눌러 플레이헤드의 위치를 10 프레임 앞으로 이동하여 ‘In’이라는 단어가 
시작되는 곳으로 옮기세요. 

1과에서 소스 뷰어 아래 있는 버튼을 클릭하여 인 포인트를 설정했던 방식 대신에 이번에는 
키보드 단축키를 사용해보겠습니다.
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6 [I] 키를 눌러 인 포인트를 표시합니다.

7 인 포인트가 설정되면 남자가 “Making all the things possible”이라는 말을 시작할 때까지 클립을 
약 10초 동안 재생합니다. 스페이스 바를 누르면 재생이 멈춥니다.

8 화살표 키를 다시 사용하여 “possible”이라는 단어 바로 앞에 플레이헤드를 옮긴 다음, [O] 키를 
눌러 아웃 포인트를 설정하세요.

정보 [option+I] 키 또는 [Alt+I] 키를 누르면 인 포인트가 사라지고 [option+O] 키 
또는 [Alt+O] 키를 누르면 아웃 포인트가 사라지며, [option+X] 키 또는 [Alt+X] 
키를 누르면 인/아웃 포인트가 모두 사라집니다.

인 포인트와 아웃 포인트 사이에 있는 클립을 재생하여 선택한 영상 범위를 항상 확인하는 것이 
좋습니다.

9 메뉴에서 Playback > Play Around/To > Play In to Out 순으로 선택하거나, [option + /] 키(macOS)  
또는 [Alt + /] 키(Windows)를 누르세요. 

인 포인트에서 아웃 포인트까지의 클립을 재생하여 올바른 범위를 선택했는지 확인하세요. 
이를 다시 설정해야 할 경우 뒤로 돌아가서 인/아웃 포인트를 재설정할 수 있습니다.

타임라인에 첫 번째 클립을 추가할 준비가 완료되면 편집 오버레이에서 모든 편집 기능을 쉽게 
사용할 수 있습니다.

10 소스 뷰어 중심에서 타임라인 뷰어로 영상을 드래그한 다음, 마우스 버튼을 누른 상태를 그대로 
유지합니다.



56
제

3
과

 
러

프
 컷

 어
셈

블
 편

집
 

타임라인 뷰어에 나타나는 편집 오버레이에는 7가지의 편집 기능이 있습니다.

 � 오버라이트(Overwrite) 타임라인에 있는 부분 클립 또는 전체 클립 위에 새로운 클립을 
덮어쓰는 편집 방식입니다.

 � 인서트(Insert) 타임라인 속 플레이헤드가 있는 곳에 클립이 추가됩니다. 클립이 갈라져 
새로운 클립이 들어올 수 있도록 뒤로 이동합니다.

 � 리플레이스(Replace) 인/아웃 포인트와 상관없이 타임라인에 있는 클립이 새로운 클립으로 
교체됩니다.

 � 핏-투-필(Fit to Fill) 클립이 특정 길이에 맞도록 클립의 속도를 변경합니다.

 � 겹쳐놓기(Place on Top) 블랜딩 또는 합성 효과를 위해 클립을 다른 클립 위에 
겹쳐놓습니다.

 � 리플 오버라이트(Ripple Overwrite) 기존의 클립 길이와 다른 길이의 클립을 덮어쓰는 
경우 타임라인에 맞게 클립 길이가 조절됩니다.

 � 끝에 합치기(Append at End) 타임라인 위치와 상관없이 타임라인 마지막 클립 끝에 
새로운 클립이 추가됩니다.

오버라이트 편집 기능은 기본 설정으로 되어 있어 타임라인 뷰어 안에 마우스 버튼을 떼면 
편집이 수행됩니다. 타임라인에 다른 클립이 없기 때문에 오버라이트 기능을 사용하면 됩니다.

11 마우스 버튼을 떼면 오버라이트 편집 기능이 수행됩니다.

12 플레이헤드를 타임라인 시작점에 드래그하여 옮긴 다음, 스페이스 바를 눌러 앞부분을 조금만 
재생해보세요.

정보 작업 도중 실수할 경우에는 DaVinci Resolve에서 언제든 마지막 실행 작업을 
취소할 수 있습니다. Edit > Undo를 여러 번 선택하여 최근 작업을 취소하거나, Edit 
> Undo List를 선택하여 이전 작업 목록에서 취소하려는 작업을 선택하세요.

타임라인에는 편집한 클립이 한 개밖에 없지만, 인/아웃 포인트를 표시하는 과정과 편집 오버레이에서 
원하는 편집 기능을 선택하는 과정은 1차 편집에서 반복적으로 사용될 것입니다. 이번에는 같은 
편집 과정이지만, 더욱 빠른 방식으로 길이가 긴 클립을 추가하는 편집 방법을 배워보겠습니다.
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J/K/L 키로 스크러빙하기
J/K/L 키를 사용하면 클립을 빠르게 스캔할 수 있습니다. DVR의 빨리 감기 버튼과 되감기 버튼 사용 
방식과 같아 정확한 프레임을 찾아낼 수 있습니다. [L] 키를 누르면 앞으로 감기고 [J] 키를 누르면 
뒤로 감기며, [K] 키를 누르면 재생이 멈춥니다. [L] 또는 [J] 키를 한 번 이상 누르면 배속 재생을 
사용할 수 있습니다. [L] 또는 [J] 키를 누른 상태에서 [K] 키를 길게 누르면 슬로우 모션으로 재생됩니다. 
그럼 한번 시도해 보겠습니다. 

1 인터뷰 장면이 있는 스마트빈에서 02_if it was possible 클립을 더블 클릭하여 소스 뷰어에 
클립을 로딩하세요.

클립이 시작하는 지점 근처에 화면 속 남성이 “If it was possible to shoot it, we wanted to go 
shoot it”이라고 말하는 부분이 있습니다. [J] 키와 [L] 키를 사용하면 클립을 두 배속으로 
스크러빙하거나 또는 속도를 반으로 줄일 수 있어 일반 클립 속도로 재생할 때보다 원하는 
지점을 훨씬 신속하게 찾아낼 수 있습니다. 먼저 키보드 단축키를 찾아 손가락을 올려놓으세요. 
클립이 시작하는 지점 근처에 화면 속 남성이 “If it was possible to shoot it, we wanted to go  
shoot it”이라고 말하는 부분이 있습니다. [J]키와 [L]키를 사용하면 클립을 두 배속으로 
스크러빙하거나 또는 속도를 반으로 줄일 수 있어 일반 클립 속도로 재생할 때보다 원하는 
지점을 훨씬 신속하게 찾아낼 수 있습니다. 먼저 키보드 단축키를 찾아 손가락을 올려놓으세요. 

2 오른손잡이일 경우에는 오른손으로 마우스를 사용하고 왼손 약지를 [J] 키에, 중지를 [K] 키에, 
검지를 [L] 키에 놓으세요. 왼손잡이일 경우에는 오른손 검지를 [J] 키에, 중지를 [K] 키에, 약지를 
[L] 키에 놓으세요.

정보 사용자 환경 설정에서 키보드를 리맵핑하면 사용자 편리에 맞는 기능을 
J-K-L 키에 설정할 수 있습니다.

손의 위치가 익숙해지는 데에는 어느 정도의 시간이 필요합니다. 먼저 앞으로 감기를 해보겠습니다.

3 [L] 키를 눌러 클립을 일반 속도로 재생한 다음, “Ah, if it was poissible to shoot it”이 시작되는 
부분에서 [K] 키를 눌러 재생을 중지하세요.

대부분의 경우 대사가 시작되는 부분을 놓치기 마련인데요, [J] 키를 사용해 클립을 되감으면 
됩니다.

4 [J] 키를 눌러 문장이 시작되는 부분으로 움직이면 [K] 키로 재생을 중지하세요. 오디오 파형을 
참고하면 문장이 시작하는 부분을 쉽게 찾을 수 있습니다.
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원하는 위치를 찾으면 단축키 조합을 사용해 속도를 절반으로 낮춰 더욱 정확하게 제어할 수 
있습니다. [J] 키와 [K] 키를 함께 누르면 반 속력으로 뒤로 감기고, [K] 키와 [L] 키를 함께 누르면 
반 속력으로 앞으로 감겨 훨씬 손쉽게 원하는 타임라인의 위치를 찾아낼 수 있습니다. 

5 [J] 키와 [K] 키를 함께 눌러 반 속력으로 뒤로 감기한 다음, 문장이 시작되는 지점이 나타날 
때까지  [K] 키와 [L] 키를 함께 눌러 반 속력으로 앞으로 감기하세요. 

화살표키 대신 이러한 키보드 단축키를 사용해 프레임을 하나씩 앞뒤로 움직일 수도 있습니다.

6 [K] 키를 누른 상태에서 [J] 키를 누르면 한 프레임씩 뒤로 움직이고 [K] 키를 누른 상태에서 [L] 
키를 누르면 한 프레임씩 앞으로 움직입니다. 원하는 대사가 시작되는 지점을 정확하게 찾을 
때까지 단축키 사용을 반복하고 문장 시작점에 ‘아’하는 소리가 포함되지 않도록 주의하세요. 

7 [I] 키를 눌러 인 포인트를 표시합니다.

J/K/L 스크러빙 기술을 사용하여 같은 방식으로 아웃 포인트를 표시합니다. 시작점에서 약 10초 
정도 떨어진 “Every shot was original and every shot was real”이라고 말한 지점에 설정하면 
됩니다.

8 [L] 키를 눌러 클립을 두 배속으로 재생한 다음, “Every shot was original and every shot was 
real.”라는 대사가 시작되면 [K] 키를 눌러 재생을 멈추세요. 

정확한 위치에 가까워지면 반 속력으로 재생을 전환하고 한 프레임씩 움직여 조절하세요. 

9 [J] 키와 [K] 키 또는 [K] 키와 [L] 키를 함께 눌러 문장이 끝나는 지점에 맞추세요. 

10 [K] 키를 누른 상태에서 [J] 또는 [L] 키를 누르면 한 번에 한 프레임씩 움직여 “Every shot was 
original and every shot was real.” 문장을 정확하게 찾아낼 수 있습니다. 

11 [O] 키를 눌러 아웃 포인트를 표시합니다.

12 Playback > Play Around/To > Play In to Out 순으로 선택하거나, [option + /] 키(macOS) 또는 
[Alt + /] 키(Windows)를 눌러 편집 범위를 확인하세요. 

이제 선택한 클립 부분을 타임라인에 편집할 수 있습니다. J/K/L 키를 사용해 효율적인 방식으로 
인/아웃 포인트를 지정했으므로 이제 편집 툴바를 사용해 실제 편집 작업 속도를 높일 수 
있습니다.

13 플레이헤드를 타임라인의 마지막 클립 끝부분으로 가져가세요.

타임라인에 인/아웃 포인트를 표시할 수 있지만, 이것이 없을 경우 타임라인 플레이헤드가 
절대적인 인 포인트 역할을 하게 됩니다.

소스 뷰어와 타임라인 뷰어 밑에 있는 툴바에는 편집 작업에 가장 많이 사용되는 기능이 
포함되어 있습니다. 여기에는 편집에서 가장 많이 사용되는 세 가지 기능인 인서트, 오버라이트, 
리플레이스 기능이 포함되어 있습니다.
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14 소스 뷰어와 타임라인 뷰어 밑에 있는 툴바에서 오버라이트 버튼을 클릭하거나 키보드의 [F10] 
키를 누르세요.

두 번째 클립은 타임라인 속 첫 번째 클립 바로 뒤에 추가됩니다. 편집 오버레이를 사용하거나, 
툴바에 있는 세 개의 편집 버튼 중 하나를 클릭하여 타임라인에 있는 클립을 편집할 수 있습니다. 
자신의 편집 방식에 맞는 방법을 선택해 사용하세요. 이번 과에서는 이러한 두 가지 편집 방식뿐 
아니라 다른 편집 방법 또한 계속해서 언급되므로 지산의 작업에 가장 적합한 편집 방식을 사용하실 
수 있습니다.

타임라인에 클립 삽입하기
타임라인에 순차적으로 클립을 나열하는 것에는 한계가 있으므로 결국 두 개의 기존 타임라인 클립 
사이에 새로운 클립을 추가해야 하는 상황이 생깁니다. 타임라인에 표시된 인 포인트가 없는 경우 
플레이헤드를 대신 사용할 수 있습니다. 타임라인에 클립을 추가할 경우 플레이헤드가 있는 곳에 
해당 클립이 추가됩니다. 

1 타임라인 시작 부분에 플레이헤드를 위치시키고 지금까지 추가된 두 개의 클립을 재생하세요.

두 개의 인터뷰 클립은 매우 비슷하여 오히려 자연스럽게 연결되지 않는 컷이 생성됩니다. 
이러한 것을 점프컷이라고 부르는데 화면 속 사람이 한 지점에서 다른 지점으로 갑작스럽게 
이동하는 것처럼 보이기 때문에 이렇게 불립니다. 두 개의 인터뷰 클립 사이에 다른 클립을 
추가하여 원치 않는 점프컷 현상을 제거할 수 있습니다.

2 플레이헤드를 타임라인 속 두 개의 인터뷰 클립 사이로 옮기세요. 플레이헤드를 드래그하면 
컷 포인트에 플레이헤드가 스내핑되어 정확한 지점을 찾을 수 있습니다.
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정보 툴바에 있는 스내핑 버튼 또는 [N] 키를 눌러 스내핑 속성을 비활성화할 수 
있습니다.

3 빈 목록에서 B-Roll Smart Bin을 클릭하고 08_SOUTH_POLE_DC3 클립을 더블 클릭하여 
소스 뷰어에 로딩하세요. 

4 클립 시작점으로 이동해 스페이스 바를 누르면 클립이 재생됩니다.

화면 속 남성이 불가능한 숏 촬영을 언급했기 때문에 비행기가 이륙하는 장면을 인터뷰 클립 
사이에 추가하면 자연스럽게 연결시킬 수 있습니다.

5 클립 시작점에서 소스 뷰어의 조그바를 움직여 화면 속 푯말 뒤로 비행기 꼬리가 드러나는 
지점에서 멈추세요.
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그러면 이 지점에 맨 첫 번째 프레임을 위한 버퍼 공간이 생겨 인 포인트로 사용할 수 있습니다.

6 [I] 키를 눌러 소스 뷰어에 인 포인트를 표시하세요.

이 숏에는 움직임이 많지 않고 길이가 짧아서 편집 없이 그대로 사용하겠습니다.

아웃 포인트를 따로 설정하지 않을 시 DaVinci Resolve는 클립의 마지막 부분까지 사용합니다.

7 편집을 하려면 소스 뷰어 중심부를 타임라인 뷰어로 드래그하세요. 편집 오버레이가 나타나면 
[Insert] 단어 위로 드래그한 다음 마우스 버튼을 떼세요.

편집 오버레이에서 인서트 기능을 선택하면 타임라인에 있는 두 번째 클립이 오른쪽으로 
밀려나면서 소스 클립이 타임라인에 추가됩니다. 타임라인의 전체 길이가 추가된 클립 길이만큼  
늘어납니다.

8 타임라인 플레이헤드를 타임라인 시작점에 드래그하여 옮긴 다음, 스페이스 바를 눌러 앞부분 
일부를 재생해보세요. 

정보 [home] 키를 누르면 타임라인 시작점으로, [end] 키를 누르면 타임라인 
마지막 지점으로 이동합니다. 일부 Mac용 키보드에서는 [home] 키와 [end] 키가 
지원되지 않습니다. Mac용 키보드를 사용할 경우에는 타임라인 시작점으로 
이동할 시 [fn] 키와 왼쪽 화살표 키를, 끝으로 이동할 시에서는 [fn] 키와 오른쪽 
화살표 키를 함께 누르세요.
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인서트 방식으로 클립 분할하기
항상 두 개의 클립 사이에 편집 영상을 삽입해야 하는 것은 아닙니다. 간혹 원래 있는 클립을 반으로 
쪼개 두 개의 클립으로 만들어야 하는 상황이 있습니다. 이런 상황에서 사용할 수 있는 편집 방식을 
알아보겠습니다.

1 플레이헤드를 두 번째 인터뷰 영상의 시작점으로 가져가세요. 

2 스페이스 바를 눌러 클럽 영상과 오디오를 확인하세요.

클립의 길이가 길어 두 개의 짧은 클립으로 나누는 것이 좋습니다. 마지막 대사인 “It was really 
important, every shot was original and that everything was real.” 부분이 이 영상 맨 마지막에 
따로 분리되어 있으면 훨씬 강렬한 인상을 줄 수 있습니다.

3 [J + K] 키와 [K + L] 키를 사용하여 지나간 두 문장을 천천히 재생하면서 “It didn’t make the 
movie”와 “It was really important” 사이에 있는 공간을 찾아냅니다.

이러한 두 문장 사이에 있는 짧은 공간이 새로운 클립이 들어갈 공간입니다. 타임라인 파형을 
확대하면 짧은 공간을 찾을 더욱 쉽게 찾을 수 있습니다.

4 도구바에서 줌 슬라이더를 오른쪽으로 드래그하여 인터뷰 클립을 확대하고 오디오 파형에서 
디테일을 확인하세요.
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5 [J + K] 키와 [K + L] 키를 사용하여 “It didn’t make the movie”와 “It was really important” 문장 
사이의 정확한 위치를 찾으세요. 

그런 다음 이곳으로 플레이헤드를 가져가 소스 클립의 인/아웃 포인트를 설정하세요. 

6 B롤 스마트 빈에서 06_MILKYWAY 클립을 더블 클릭하여 소스 뷰어에 로딩하세요.

7 클립 시작 부분으로 이동하고 스페이스 바를 눌러 클립을 재생시킨 다음, 중간 즈음에서 재생을 
멈추세요. 

이 편집에서는 전체 클립을 사용하겠습니다. 소스 클립에 어떤 마크도 표시하지 않으면 DaVinci 
Resolve는 전체 클립을 사용합니다.

편집 오버레이에서 편집 기능을 선택하는 대신 이번에는 툴바 편집 버튼을 사용하여 인서트 
편집을 수행해 보겠습니다. 인서트 편집 버튼은 오버레이에 있는 인서트와 같은 편집 기능을 
제공합니다. 선호하는 편집 스타일에 맞는 방식을 선택합니다.

8 툴바에 있는 인서트 버튼을 클릭하거나, F9 키를 누르세요.

정보 macOS에서 키보드 단축키를 사용하려면 시스템 환경설정 > 키보드로 
이동하여 ‘F1, F2 등의 키를 표준 기능 키로 사용’ 확인란을 선택하세요.

인서트 편집은 플레이헤드가 있는 곳을 중심으로 타임라인 클립을 분할하여 새로운 클립이 
생성되는 편집 방식입니다. 타임라인을 축소하면 더욱 쉽게 확인할 수 있습니다.

9 Viewer > Zoom > Zoom to Fit 순으로 선택하거나, [Shift + Z] 키를 함께 누르면 전체 타임라인으로 
확인할 수 있습니다.
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10 타임라인 플레이헤드를 두 번째 인터뷰 클립 맨 앞으로 가져간 다음 스페이스 바를 눌러 
타임라인 후반부를 확인하세요. 

인서트 편집은 가장 기본적으로 사용되는 편집 방식 중 하나입니다. 하지만, 새로운 클립이 추가되면 
새로운 클립을 위한 공간 확보를 위해 타임라인에 있는 다른 모든 클립이 뒤로 밀려난다는 점을 
기억하세요. 전체 타임라인의 길이가 늘어나게 됩니다.

타임코드 사용하기
지금까지 타임라인에 클립의 위치를 정하는 1차적인 편집 작업을 수행했습니다. 다른 방법으로 
타임코드 숫자를 사용할 수도 있습니다. 타임코드를 사용하면 클립의 정확한 위치를 찾아 타임라인에서 
편집 작업을 수행할 수 있습니다.

1 B-롤 빈에서 05_BAY_AREA_LIGHTS 클립을 더블 클릭하여 소스 뷰어에 로딩하세요.

오프셋 숫자를 입력하면 소스 뷰어의 조그바 또는 타임라인의 플레이헤드가 입력한 프레임 수 
또는 초만큼 앞/뒤로 이동합니다. 플레이헤드를 어느 방향으로 움직일 지를 먼저 결정합니다. 
앞으로 움직이려면 키패드에서 + 키를 누르세요.
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2 클립 시작점으로 이동하고 +100을 입력하세요. [return] 또는 [enter] 키를 누르면 1초 간격으로 
플레이헤드가 앞으로 이동합니다.

정보 숫자판이 없는 키보드를 사용하는 경우 [shift] 키와 [=] 키를 함께 눌러  
+(더하기표)를 입력하세요.

이 프레임을 인 포인트로 사용합니다.

3 [I] 키를 눌러 인 포인트를 표시합니다.

정확한 타임코드 값이 있으면 정확한 초 및 프레임 수 만큼 플레이헤드를 움직일 수 있습니다. 
이 클립에서는 4초 또는 10 프레임 만큼 앞으로 옮기겠습니다.

4 +410을 입력한 다음, [return] 또는 [enter] 키를 누르세요.

플레이헤드가 4초 또는 10프레임 만큼 앞으로 이동합니다. 이 프레임을 아웃 포인트로 사용하세요.

5 [O] 키를 눌러 아웃 포인트를 표시합니다.
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클립을 삽입하려는 곳에 플레이헤드 위치를 옮기세요.

6 타임라인에서 플레이헤드를 06_MILKYWAY 클립 맨 끝으로 옮깁니다.

7 툴바에서 인서트 버튼을 클릭하거나 F9 키를 눌러 클립을 삽입합니다.

8 [Shift + Z] 키를 누르면 전체 타임라인을 볼 수 있습니다. 타임라인 속 플레이헤드를 두 번째 
인터뷰 클립의 맨앞으로 올긴 다음 스페이스 바를 눌러 타임라인 후반부를 확인하세요. 

키보드 단축키를 사용하여 편집 작업을 할 경우에는 어떤 뷰어가 사용 중인지 알고 있어야 
합니다. 올바른 뷰어에서 플레이헤드를 움직이고 인/아웃 포인트를 표시했는지 확인한 다음 
키보드 키를 사용해야 정확한 곳에 인/아웃 포인트를 설정할 수 있습니다. 어떤 뷰어가 현재 
사용 중인지 알 수 있는 가장 쉬운 방법은 뷰어 위에 나타나는 클립 또는 타임라인 이름을 
확인하는 것입니다. 현재 사용 중인 뷰어의 이름이 빨간색으로 나타납니다.



67

비
디

오
만

 덮
어

쓰
기

9 [Q] 키를 누르면 소스 뷰어가 활성화됩니다.

[Q] 키는 토글 기능을 가져 타임라인과 소스 뷰어 사용을 전환할 수 있습니다.

지금까지 사용한 인서트 편집과 오버라이트 편집 기능은 가장 많이 사용되는 두 가지의 편집 
기능입니다. 편집 작업을 여러 번 수행을 해 보면 인서트 편집 기능이 유용한 이유를 확인하실 수 
있습니다. 그럼 이제 오버라이트 편집 기능을 살펴보겠습니다.

비디오만 덮어쓰기
러프 컷이 생성되면 인터뷰 영상을 인터뷰 내용과 관련된 이미지를 담은 B-롤 영상으로 대체하고 
싶을 수가 있습니다. 관객의 주의를 다시 집중시키거나, 영상 속 문제점을 숨기거나, 어떤 대상에 
관한 설명을 더욱 드러나게 할 경우 이러한 방식을 사용합니다. 이러한 편집 방식의 주요 액션에서 
시각적인 요소를 일시적으로 잘라내기 때문에 컷 어웨이라고 부릅니다. 오버라이트 편집을 사용하여 
컷 어웨이를 수행할 수 있습니다.

1 타임라인에서 08_SOUTH_POLE_DC3 클립과 02_if it was possible 인터뷰 클립 사이로 
플레이헤드를 가져가세요. 

2 스페이스 바를 눌러 인터뷰를 재생하세요.

첫 번째 대사는 “If it was possible to shoot it you wanted to go shoot it.”입니다. 인터뷰 남성의 
모습이 계속해서 화면에 나오는 것보다 인상적인 촬영숏을 추가하면 훨씬 영상이 돋보이게 
됩니다. 새로운 숏의 길이를 첫 문장 길이와 같게 설정하길 원하기 때문에 타임라인에 인/아웃 
포인트를 설정하겠습니다.

3 타임라인에서 08_SOUTH_POLE_DC3 클립과 02_if it was possible 인터뷰 클립 사이로 
플레이헤드를 가져가세요. 

4 [I] 키를 눌러 인 포인트를 표시합니다.

5 스페이스 바를 눌러 인터뷰 영상을 재생하고 “If it was possible to shoot it, you wanted to go  
shoot it.”이 끝나는 지점에서 재생을 멈추세요.

6 [O] 키를 눌러 아웃 포인트를 표시합니다.



68
제

3
과

 
러

프
 컷

 어
셈

블
 편

집
 

이제 해당 위치에 사용할 클립을 선택하세요.

7 B-롤 빈에서 04_JET_LANDING_2 를 더블 클릭하여 소스 뷰어에 로딩하세요.

8 클립 시작점으로 이동하고 스페이스 바를 누르면 클립이 재생됩니다.

착륙하고 있는 커다란 제트기의 모습에 프레임이 잘 맞춰진 숏입니다. 착륙하면서 바퀴가 화면 
위쪽에 나타나는 순간을 인 포인트로 설정하세요. 

9 소스 뷰어의 조그바를 드래그하여 프레임 속 비행기 바퀴가 나타나는 곳으로 옮기세요.
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클립 길이는 타임라인에 이미 설정되어 있으므로 소스 클립의 인 포인트만 표시하면 됩니다.

10 [I] 키를 눌러 인 포인트를 표시합니다.

오버라이트 편집 기능을 사용하여 타임라인에 표시된 영역을 대체하세요. 해당 클립의 오디오 
트랙에는 덮어쓰기 기능이 적용되는 것을 원하지 않을 경우 인터뷰 내용을 계속 유지한 상태에서 
새로운 04_JET_LANDING_2 숏이 나타나게 할 수 있습니다. 바로 이때 원본 클립의 오디오는 
그대로 유지한 상태에서 영상만 교체하는 편집 방법이 필요합니다.

타임라인에는 소스 클립의 어떤 오디오 트랙이 타임라인에 편집되었는지 보여주는 데스티네이션 
컨트롤이 있습니다. V1(Video 1)과 A1(Audio 1) 소스 트랙에는 데스티네이션 컨트롤 기능이 기본 
설정으로 활성화되어 있으며, 이는 트랙 번호 주변의 주황색 테두리를 통해 확인할 수 있습니다.

11 타임라인 트랙 헤더에서 A1 데스티네이션 컨트롤을 클릭하면 해당 기능이 비활성화됩니다.

데스티네션 컨트롤이 비활성화되면 주황색 테두리가 사라집니다. 결과적으로 A1의 오디오 
소스를 타임라인에 편집할 수가 없습니다.
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12 툴바에서 오버라이트 편집 버튼 또는 F10 키를 누르세요.

오버라이트 편집 기능으로 인해 인터뷰 영상의 몇 초 분량이 새로운 04_JET_LANDING_2 
클립으로 덮어 쓰였습니다. 인터뷰 영상의 오디오는 그대로 유지되어 컷 어웨이가 나타나도 
클립의 원본 오디오가 재생됩니다. 

13 타임라인에서 플레이헤드의 위치를 08_SOUTH_POLE_DC3 클립과 04_JET_LANDING 
클립 사이로 옮기세요.

14 스페이스 바를 눌러 인터뷰를 재생하세요.

V2 컷 어웨이 만들기
영상만 편집하는 컷 어웨이 방식에 가장 많이 사용하는 방법은 오버라이트 편집 방식이지만, 이것이 
유일한 편집 방식은 아닙니다. DaVinci Resolve에서는 비디오 트랙을 층층이 겹쳐 사용할 수 있습니다. 
이 편집 기능은 효과 생성에 유용한 기능이지만, 간단한 컷 어웨이 생성에도 사용할 수 있습니다.

1 타임라인의 플레이헤드를 04_JET_LANDING_2 클립과 02_if it was possible 인터뷰 클립 
사이로 옮기세요. 

이전 제트기 착륙 장면인 컷 어웨이 클립 바로 뒤에 새로운 클립을 추가한 다음,  타임라인을 
재생하여 아웃 포인트 위치를 찾습니다.

2 [I] 키를 눌러 인 포인트를 표시합니다.

3 스페이스 바를 눌러 인터뷰 클립을 재생하고 “If you couldn’t get the shot or the weather wasn’t 
right.”라고 말을 마치는 지점에서 재생을 멈추세요.

4 [O] 키를 눌러 ‘right’이라는 단어 바로 뒤에 아웃 포인트를 설정하세요.

이제 두 번째 컷 어웨이로 추가할 클립을 검색합니다.
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5 B-롤 빈에서 03_AERIAL_SFO 클립을 더블 클릭하면 소스 뷰어에 클립이 로딩됩니다.

6 클립 시작점으로 이동하고 스페이스 바를 누르면 클립이 재생됩니다.

아스팔트 포장도로 위의 비행기를 길게 줌 아웃한 장면이 나타납니다. 원하는 곳 어디든 인 
포인트 설정이 가능하지만, 비행기가 적절하게 나타나는 지점을 찾아보겠습니다.

7 클립 시작점에서 “+2.(마침표 포함)”을 입력하여 플레이헤드를 2초 앞당기세요.
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이 지점은 클립의 시작 부분에서 충분히 떨어져 있기 때문에 나중에 시작점을 조절하고 싶을 
경우 유연하게 작업할 수 있을 뿐만 아니라 장면 속 비행기 모습 또한 적당한 거리를 유지하고 
있습니다.

8 [I] 키를 눌러 인 포인트를 표시합니다.

컷 어웨이에 Place on Top 편집 기능을 사용하여 오버라이트와 비슷한 편집 방식으로 수행해 
보겠습니다. 소스 클립이 인터뷰 클립 중간 부분 위에 있는 두 번째 비디오 트랙 위에 덮어씁니다.

9 소스 뷰어에서 타임라인 뷰어로 클립을 드래그하여 Place on Top 메뉴로 마우스 포인터를 
옮기면 하이라이트가 표시됩니다.

10 누르고 있던 마우스 버튼을 떼면 해당 편집이 수행됩니다.

DaVinci Resolve에서 클립을 겹쳐 작업할 경우 밑에 있는 클립은 그 위에 있는 비디오 클립 
때문에 뷰어에 나타나지 않습니다. 여기서 Place on Top 편집을 사용하면 쉽게 컷 어웨이를 
생성할 수 있습니다.

11 타임라인에서 플레이헤드를 04 JET LANDING 2 숏의 시작 부분으로 이동한 다음, 이를 재생하여 
새롭게 추가된 컷 어웨이를 직접 확인하세요.

Place on Top 편집 기능을 사용하면 타이틀 및 다른 클립을 간단하게 겹쳐놓기 할 수 있습니다. 
여기서는 간단하게 컷 어웨이 장면을 생성하는 동시에 이를 이동하고 비디오 트랙1에서 아래 있는 
인터뷰 장면이 드러나게 하기 위해 사용했습니다.

타임라인 끝에 클립 합치기
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가끔은 아주 간단한 편집 방식으로도 원하는 작업을 완성할 수 있습니다. Append at End 편집 
기능이 바로 이에 해당합니다. 이 기능은 인/아웃 포인트나 플레이헤드 위치와 상관없이 타임라인 
맨 끝에 있는 클립에 선택한 클립을 추가하는 방식입니다.

1 엔딩 크레딧 빈을 선택하고 11_MOVIE_CREDITS 를 더블 클릭하여 소스 뷰어에 해당 클립을 
로딩하세요. 

2 스페이스 바를 누르면 짧은 크레딧 장면이 재생됩니다.

클립 전체를 사용하기 때문에 인/아웃 포인트가 필요하지 않습니다. Append at End 기능은 
항상 타임라인 맨 끝에 클립을 추가하므로 플레이헤드 또한 사용하지 않아도 됩니다.

3 소스 뷰어 중심부를 타임라인 뷰어로 드래그하세요. 마우스 화살표를 편집 오버레이의 Append 
at End로 가져간 다음 누르고 있던 마우스 버튼에서 손을 떼세요.

타임라인 끝에 영화 크레딧이 추가됩니다.

4 타임라인에서 플레이헤드 위치를 05_BAY_AREA_LIGHTS 숏과 마지막 인터뷰 클립 사이에 
놓고 스페이스 바를 누르면 추가된 크레딧 클립을 확인할 수 있습니다.
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가장 간단한 편집 방식입니다. 사소한 작업 같아도 타임라인이 길면 앞/뒤로 스크롤 해 내려갈 필요 
없이 Append at End 기능으로 간편하게 원하는 작업을 수행할 수 있습니다.

빈에서 편집하기
작업하는 클립에 중요한 오디오가 없어 몇 가지 클립을 짜깁기하여 타임라인에 추가하려면 각 
클립을 소스 뷰어에 로딩하는 대신 미디어 풀 썸네일에서 마크를 설정할 수 있습니다. 프로그램에 
추가할 마지막 세 가지 클립으로 이 작업을 수행해 보겠습니다.

1 미디어 풀 맨 위에 있는 크기 조절 슬라이더를 오른쪽으로 드래그하여 썸네일 크기를 높이세요.

빈에 있는 썸네일 사용 시 크기를 키워 사용하는 것이 좋습니다.

2 B-Roll 스마트 빈을 선택하고 마우스 포인터를 01 A380 TAXI 위로 가져가세요.

3 썸네일 위로 마우스 화살표를 움직이면 뷰어에서 프레임을 미리보기 할 수 있습니다.

이는 클립을 빠르게 미리보기하고 뷰어에 클립을 로딩하지 않고도 인/아웃 포인트를 설정할 수 
있는 한 가지 방법입니다.

4 마우스 포인터를 썸네일을 지나 클립 맨 시작점으로 옮긴 뒤, [I] 키를 눌러 인 포인트를 설정하세요.
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썸네일 안에 인 포인트를 나타내는 얇은 흰색 선이 표시됩니다.

5 프레임 속 비행기가 위를 향하는 장면이 나타날 때까지 썸네일 오른쪽으로 마우스를 움직인 
다음, [O] 키를 눌러 아웃 포인트를 설정하세요.

썸네일 안에 표시되는 흰색 선을 통해 전체 클립 길이에 비례하는 인/아웃 설정 길이를 확인할 
수 있습니다. 같은 방식으로 나머지 두 개의 클립에도 인/아웃 포인트를 설정해 보겠습니다.

6 마우스 포인터를 02_A380_TAKE OFF 클립 위에 가져가세요.

7 썸네일 맨 왼쪽 클립 시작점까지 마우스 포인터를 옮기고 [I] 키를 눌러 인 포인트를 설정하세요.

8 화면 속 비행기의 Lufthansa 로고 명이 보이지 않을 때까지 썸네일 오른쪽으로 마우스를 이동하고 
[O] 키를 눌러 아웃 포인트를 설정합니다.

9 09_HAWAIIAN_LANDING 위에서 마우스 포인터를 움직이세요.
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10 클립 시작점에 인 포인트를 표시하고 클립 중간 지점에 아웃 포인트를 설정합니다.

타임라인에 이 클립을 옮기려면 1과에서 배운 대로 빈에서 바로 타임라인에 드래그하여 옮길 
수 있지만, 이 방법은 오버라이트 편집에 해당됩니다. 더욱 유연하게 작업하기 위해 클립을 
빈에서 타임라인 뷰어에 있는 편집 오버레이에 드래그합니다.

11 타임라인 플레이헤드를 11_MOVIE_ CREDITS 클립 시작 지점으로 가져가세요.

12 미디어 풀에 있는 01_A380_TAXI 클립을 클릭하고 [command] 키(macOS) 또는 [Ctrl] 키(Windows)를 
누른 상태에서 02_A380_TAKE OFF 클립과 09_HAWAIIAN_LANDING 클립을 클릭하세요. 
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선택된 세 개의 클립에 빨간 테두리가 나타납니다.

13 타임라인 뷰어에 클립을 바로 드래그하고 편집 오버레이가 나타나면 마우스 포인터를 Insert 로 
가져간 다음 마우스 버튼에서 손을 떼세요. 

세 개의 모든 클립이 빈에 나타나는 순서대로 타임라인에 추가됩니다. 타임라인을 전체 화면 
크기로 확대하여 처음부터 프로그램을 재생해 보세요.

14 Viewer > Zoom > Zoom to Fit 순서로 선택하거나, [Shift+Z] 키를 함께 누르면 타임라인을 전체 
화면 크기로 볼 수 있습니다.

15 타임라인 시작점으로 이동하고 Workspace > Viewer Mode > Cinema Viewer 순서로 선택하거나, 
[command] 키(macOS) 또는 [Ctrl] 키(Windows)와 [F] 키를 함께 눌러 프로그램을 전체 화면 
보기로 재생하세요.

인 포인트를 표시 방법과 편집 오버레이 옵션을 함께 사용하면 드래그-앤-드롭 형식의 편집 작업을 
훨씬 유연하고 다양한 고급 편집 기술로 사용할 수 있습니다.

숏 교체하기
1차 편집본을 확인하다 보면 처음 선택한 숏을 바꾸고 싶을 때가 있습니다. 편집 작업은 많은 
시행착오의 연속이기 때문이지요. 클립의 위치 및 속도, 병치를 다양하게 바꿔가며 최선의 선택을 
내립니다. 이렇게 작업하면 더욱 적절한 숏으로 교체하여 타임라인 클립을 편집하게 됩니다. Replace 
편집 기능은 편집 과정을 더욱 간단하게 만들어 주는 기능입니다.

1 타임라인에서 플레이헤드를 04_JET_LANDING_2 클립이 있는 곳으로 옮기세요.
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완벽한 프레임을 가진 숏일지라도 트레일러에서는 이 지점에서 극적인 숏을 필요로 합니다. 
다행히도 B롤 스마트 빈에 이에 적절한 숏이 있습니다.

2 B롤 스마트 빈에서 10_MALDIVES 클립을 더블 클릭하고 스페이스 바를 눌러 소스 뷰어에서 
해당 클립을 확인하세요.

클립의 1/3 지점에서 비행기가 날아 들어오는 장면을 추가할 수 있습니다. Replace 편집을 
사용할 경우 아무런 표시를 하지 않더라도 타임라인 속 프레임에 맞게 소스 뷰어 속 프레임이  
조정되어 숏이 교체됩니다. 

3 타임라인에서 플레이헤드를 04_JET_LANDING_2 클립 위에 옮기세요.
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타임라인에 있는 클립을 확대하면 플레이헤드의 위치를 더욱 정확하게 조정할 수 있습니다. 

4 툴바에서 줌 슬라이더를 오른쪽으로 드래그하여 클립을 확대하거나, [command + =] 키(macOS) 
또는 [Ctrl + =] 키(Windows)를 누르세요. 

정보 줌인 기능은 항상 화면에 나타나지 않더라도 플레이헤드 위치를 중심으로 
확대됩니다.

5 04_JET_LANDING_2 클립의 1/3 정도 위치로 플레이헤드를 옮기세요. 그 지점 부근에서 제트기 
엔진이 프레임 안에 나타나기 시작합니다. 
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10_MALDIVES 숏에서 프레임 속에 비행기가 들어오는 지점을 이곳에 추가합니다.

6 소스 뷰어에서 비행기가 프레임 안으로 들어오는 지점까지 조그바를 드래그하세요.

플레이헤드 위치가 조정되면 툴바에 있는 리플레이스(Replace) 편집 버튼을 사용합니다.
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7 툴바에서 리플레이스 편집 버튼 또는 [F11] 키를 누르세요.

리플레이스 편집 기능은 교체하려는 타임라인 클립을 기반으로 인/아웃 포인트를 찾아냅니다.

8 Viewer > Zoom > Zoom to Fit 순으로 선택하거나, [Shift + Z] 키를 함께 누르면 전체 타임라인으로 
확인할 수 있습니다.

9 타임라인 시작점으로 플레이헤드를 드래그하고 지금까지 생성한 프로그램을 재생해 확인하세요.

편집 작업 도중 틈틈이 한 발짝 물러나 전체 프로그램을 확인해보는 것이 좋습니다. 특정 클립만을 
계속 작업하다 보면 자신이 원하는 전체적인 그림을 잊게 될 수 있습니다.

복습하기
1 클립을 편집할 때 앞/뒤로 다른 클립이 있는 경우 어떤 편집 방식을 사용하나요?

2 현재 사용 중인 뷰어는 어떻게 확인할 수 있나요?

3 [K] 키와 [J] 키를 함께 누르면 프로젝트가 1/2 속도로 역재생됩니다. T(진실) 또는 F(거짓)로 답하세요.

4 빈에서 여러 개의 클립을 동시에 타임라인에 추가할 수 있는 방법은 무엇인가요?

5 양수(+)를 입력하면 플레이헤드가 타임라인 시작점인 왼쪽으로 움직입니다. T(진실) 또는  
F(거짓)로 답하세요.
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정답
1 인서트 편집 방식은 두 개의 클립 사이에 새로운 클립을 위한 공간을 마련하는 방식으로 

타임라인에 새 클립을 추가합니다.

2 현재 사용 중인 뷰어는 클립 또는 타임라인 이름이 뷰어 위에 빨간색으로 표시됩니다.

3 T. [J] 키를 누르면 영상이 반대로 재생됩니다. [K + J] 키를 누르면 1/2 속도로 반대로 재생됩니다.

4 빈에 있는 클립 여러 개를 타임라인 뷰어로 드래그하여 옮기고 편집 오버레이를 사용하여 
인서트 등 원하는 편집 기능을 선택합니다.

5 F. 양수 값을 입력하면 플레이헤드가 타임라인 끝지점인 오른쪽으로 이동합니다.
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타임라인에서 클립 
이동하기 

타임라인에서는 편집 영상 확인을 비롯한 수많은 
다른 작업을 수행할 수 있습니다. 프로젝트를 
한 데 모으고 나면 모든 활동의 중심지가 
타임라인으로 신속하게 전환됩니다. 세그먼트를 
이동하고 클립을 반으로 자르거나 세그먼트를 
모두 삭제하는 등의 작업이 이루어집니다. 
타임라인 사용법을 익혀 편집 기술을 향상시킬 
수 있습니다.

예상 소요 시간

이 과를 학습하는 데는 약 30분 
정도의 시간이 소요됩니다.

학습 목표

프로젝트 불러와 미디어 다시 연결하기 84

클립에 색상 표시하기  86

간격 남기지 않고 클립 삭제하기 88

클립 분할하기 93

클립 자르기 및 붙이기  96

복습하기 99
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프로젝트 불러와 미디어 다시 연결하기
다른 컴퓨터에서 DaVinci Resolve 15 프로젝트를 전송받거나 다른 컴퓨터로 프로젝트를 전송하고자 
할 경우, 프로젝트 파일을 불러와 미디어를 다시 연결해야 합니다.

예를 들어, 데스크톱 컴퓨터에서 노트북 컴퓨터로 옮겨 이동 중에 편집하고자 할 경우, 데스크톱 
컴퓨터 프로젝트를 보내기 한 다음 노트북 컴퓨터에서 불러와야 합니다.

이번 과에서는 이전 과에서 생성한 타임라인과는 약간 다른 여러 개의 타임라인이 포함된 프로젝트를 
불러와 볼 예정입니다. 이번 과를 위한 타임라인이 이미 설정되어 있어 클립을 이동/삭제/분할하는 
방법을 배워볼 수 있습니다.

1 DaVinci Resolve 15를 실행하세요. 이미 DaVinci Resolve를 실행한 경우 File > Project Manager
로 이동하세요.

2 Project Manager에서 빈 공간을 마우스로 우클릭한 다음 메뉴에서 Import를 선택하세요.

참고 프로젝트를 보내기 하려면 Project Manager에 있는 프로젝트를 우클릭한 
다음 Export를 선택하세요.

3 펼쳐진 대화 상자에서 R15 lessons folder > Lesson 04 > Age of Airplanes.drp를 선택하세요. 
프로젝트를 불러오더라도 클립에 아직 미디어가 연결되어 있지 않을 수 있습니다. 이 프로젝트에는 
클립 및 타임라인 메타데이터만 포함되어 있고 미디어는 연결되어 있지 않습니다. 한 컴퓨터에서 
다른 컴퓨터로 미디어를 복사 및 이동하거나 폴더명을 변경하면 클립/타임라인 메타데이터와 
미디어 간의 연결이 끊어질 수 있습니다. 필요에 따라 프로젝트 내 모든 클립 및 타임라인과 
미디어를 다시 연결할 수 있습니다.

4 Age of Airplanes 프로젝트를 더블 클릭하면 해당 프로젝트가 열립니다.

5 미디어 풀(Media Pool) 사이드 바에서 Master 빈을 선택한 다음 아무 클립이나 더블 클릭해 
열면 해당 영상이 뷰어에 나타납니다.
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이 클립들은 현재 오프라인 상태입니다. DaVinci Resolve에서 미디어와 클립을 프로젝트로 
다시 연결할 수 있도록 미디어의 위치를 알려줘야 합니다. 오프라인 클립이 포함된 빈을 
선택하기만 하면 됩니다. 여기서는 프로젝트 내 모든 빈이 선택 범위에 해당합니다.

프로젝트 내 모든 빈과 클립이 Master 빈에 포함되어 있기 때문에 Master 빈에서 다시 연결할 
수 있습니다.

6 [ctrl] 키를 누른 상태에서 Master 빈을 클릭(macOS)하거나 또는 마우스로 우클릭(Windows)
하면 나타나는 메뉴에서 Relink Clips for Selected Bins를 선택하세요.
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7 Select Source Folder 창에서 Documents > R15 lessons 폴더를 선택하세요. OK를 클릭합니다.

Master 빈을 다시 연결하면 모든 빈에 있는 클립뿐만 아니라 타임라인까지 자동으로 다시 
연결됩니다.

8 Rough Cuts 빈에서 Cut Copy Paste 타임라인을 더블 클릭하면 타임라인 뷰어에 로딩됩니다.

9 이번 과에서 작업할 영상을 검토하려면 해당 타임라인을 재생하세요.

이 타임라인은 3과에서 생성한 타임라인을 축소한 버전입니다. 하지만 앞으로 다루게 될 새로운 
음악 트랙이 포함되어 있어 타임라인에서 편집, 복사, 붙여 넣기를 시작할 때 몇 가지 문제가 발생할 
수도 있습니다. 

클립에 색상 표시하기 
한 타임라인에 클립이 추가되면서 원하는 숏을 찾기가 어려울 수 있습니다. 여러 클립 그룹에 색상을 
지정하면 더욱 쉽게 원하는 숏을 찾을 수가 있는데요. 색상이 지정된 클립 그룹을 사용할 때마다 
타임라인에 지정된 색상이 나타납니다.

1 빈 목록에서 Interview Smart Bin을 선택하세요.

2 미디어 풀에서 원하는 클립을 클릭한 다음 Edit > Select All를 선택하거나, [command + A] 키
(macOS) 또는 [ctrl + A] 키(Windows)를 함께 눌러 빈에 있는 모든 클립을 선택하세요.

3 선택한 클립 중 하나를 마우스로 우클릭한 다음 메뉴에서 Clip Color > Navy를 선택하세요.
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이제 모든 B롤 클립을 컬러 코딩하겠습니다.

4 빈 목록에서 B-Roll Smart Bin을 선택하세요.

5 미디어 풀에서 원하는 클립을 클릭한 다음 Edit > Select All를 선택하거나, [command + A] 키
(macOS) 또는 [ctrl + A] 키(Windows)를 함께 눌러 빈에 있는 모든 클립을 선택하세요. 

6 선택한 클립 중 하나를 마우스로 우클릭한 다음 메뉴에서 Clip Color > Brown을 선택하세요.
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이제 Interview 및 B-Roll 빈의 모든 타임라인 클립에 블루 네이비와 브라운 색상이 표시되었습니다. 
타임라인에서 파일을 수정하면 색깔이 변해 클립 카테고리를 쉽게 찾을 수 있습니다.

간격 남기지 않고 클립 삭제하기
클립을 언제, 어떻게 삭제해야 할지 아는 것은 클립을 타임라인 내 어느 곳에 두어야 할지를 아는 
것만큼이나 중요합니다. 제1과에서 배운 대로 클립을 삭제하고 공간을 그대로 비워두거나 클립을 
지우고 나서 공간이 자동으로 메꿔지도록 합니다. 타임라인 속 음악에 맞춰 영상을 나열하면 너무 
많은 수의 영상을 사용해야 하므로 최소한 1개 이상의 클립을 삭제할 필요가 있습니다.

1 플레이헤드를 타임라인 중간 부분에 있는 인터뷰 클립의 맨 끝부분으로 가져가세요.

2 스페이스 바를 누르면 영상이 끝까지 재생됩니다.

마지막 세 개의 클립이 거의 비슷하기 때문에 이 중 하나는 지워도 됩니다. 삭제하기 가장 무난한 
것이 Hawaiian Landing 클립입니다. 제1과에는 타임라인에서 선택한 클립을 제거하는 방법이 
소개되어 있습니다. delete 키를 누르고 타임라인에 공간을 남겨두세요. 공간을 남겨두고 싶지 
않은 경우에는 해당 클립을 삭제하되 오른쪽에 있는 모든 클립을 왼쪽으로 이동해 빈 공간을 
채워야 합니다. 이렇게 타임라인 전체에 반영되는 삭제 기능을 리플 딜리트라고 부릅니다.

3 타임라인에서 09_HAWAIIAN_LANDING 클립을 선택하세요.

오디오 및 비디오 트랙이 같은 클립에 속해 있기 때문에 타임라인에서 두 트랙 모두 선택됩니다.

4 Edit > Ripple Delete를 선택하거나 [shift + delete] 키 또는 [shift + backspace] 키를 함께 누르세요.
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타임라인에서 오디오 및 비디오 트랙을 삭제 또는 추출하더라도 빈이나 하드 드라이브에는 
그대로 남아있습니다. 이뿐만 아니라 09_HAWAIIAN_LANDING 클립 이후에 있는 모든 클립이 
왼쪽으로 이동되어 공간이 채워집니다.

비디오 또는 오디오 콘텐츠 개별적으로 삭제하기
세 개의 제트 여객기 관련 영상을 재생하면 승무원들이 이야기하는 배경 소음이 들립니다. 그렇다면 
타임라인에 있는 클립의 비디오 콘텐츠는 그대로 둔 채 오디오 콘텐츠만 삭제하고자 할 경우에는 
어떻게 해야할까요? 

1 플레이헤드를 타임라인 중간 부분에 있는 인터뷰 클립 위로 가져가세요.

2 타임라인을 재생한 다음 01_A380_TAXI 의 오디오를 주의 깊게 들어보세요.

비행 방향에 대한 이야기와 불쾌한 헬리콥터 소음이 들립니다. 타임라인 내 클립에서 영상은 
그대로 보존한 채 오디오만 제거할 수 있습니다. 이전 과에서는 클립을 선택하면 DaVinci Resolve에서 
자동으로 비디오와 오디오 트랙이 선택된다는 사실을 살펴봤습니다. 승무원들의 목소리를 
제거하되 클립의 비디오 트랙은 타임라인에 남겨 두려면 두 트랙을 개별적으로 선택할 수 있도록 
트랙 링크를 분리해야 합니다.

3 툴바에서 링크 연결 버튼을 클릭하거나, [command + shift + L](macOS) 또는 [ctrl + shift + L]
(Windows) 키를 동시에 누르세요. 

링크 연결 버튼에 하이라이트가 사라지면 해당 기능이 해제되었음을 나타냅니다. 비디오 및 
싱크 오디오 트랙 연결이 일시 해제되어 있기 때문에 각각 개별적으로 삭제할 수 있습니다.

정보 툴바로 돌아가지 않고도 링크 연결 버튼을 일시적으로 비활성화시킬 수 
있습니다. [option] 키(macOS) 또는 [Alt] 키(Windows)를 누른 상태에서 클립을 
클릭하세요.

4 타임라인에서 01_A380_TAXI 클립의 오디오 트랙을 선택하세요.
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오디오 트랙에만 빨간 테두리가 나타납니다.

5 [delete] 또는 [backspace] 키를 누르면 오디오 트랙이 제거됩니다. 

현재 오디오 트랙은 삭제되고 비디오 트랙만 남아 있는 상태입니다.

6 링크를 다시 연결하려면 툴바에서 링크 연결 버튼을 클릭하거나, [command + shift + L](macOS) 
또는 [ctrl + shift + L](Windows) 키를 동시에 누르세요. 

보통 링크 연결 버튼을 활성화 상태로 두어야 클립의 오디오와 영상 싱크가 실수로 분리되지 
않습니다.

클립의 일정 범위 삭제하기
인터뷰 내용이 담긴 클립의 경우 전체 클립을 삭제하기 보다는 같은 말을 반복하거나 말을 더듬는 
장면을 더 많이 삭제하게 됩니다. 이를 위해서는 한 클립 내 일부 오디오만 삭제해야 합니다.

1 플레이헤드를 타임라인에 있는 10_MALDIVES 클립의 시작 부분으로 가져가세요.

2 타임라인을 재생한 다음 인터뷰 클립의 오디오를 주의 깊게 들어보세요.

“Stay at that location longer”라는 중복되는 부분을 삭제해 인터뷰 영상 길이를 줄일 수 있습니다. 
클립 내 좁은 범위를 삭제할 경우 작업할 타임라인 영역을 확대하는 것이 좋습니다.

3 툴바에서 02_if it was possible 인터뷰 클립이 전체 타임라인 윈도우를 채울 때까지 줌 
슬라이더를 오른쪽으로 드래그하세요.

줌인 기능을 사용할 경우 더욱 자세한 오디오 파형이 제공되어 문장을 쉽게 구별할 수 있습니다. 
파형을 가이드로 사용하면 인/아웃 포인트로 삭제하고자 하는 부분을 표시할 수 있습니다.

4 “Stay at that location longer”라는 문장 도입 부분을 찾을 때까지 J/K/L 키를 사용해 인터뷰 
클립을 앞뒤로 천천히 이동할 수 있습니다.
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5 ‘stay’라는 단어 앞으로 플레이헤드가 옮겨가면 [I] 키를 눌러 인 포인트를 표시하세요.

이 포인트가 앞으로 삭제할 범위의 첫 부분입니다. 이제 아웃 포인트를 찾아보겠습니다.

6 “Stay at that location longer”라는 문장의 끝부분을 찾을 때까지 J/K/L 키를 눌러 인터뷰 클립을 
앞뒤로 천천히 이동할 수 있습니다.

7 ‘longer’라는 단어 앞으로 플레이헤드가 옮겨가면 [O] 키를 눌러 아웃 포인트를 표시하세요.

범위를 확인한 다음 해당 부분을 삭제하거나 좀 더 정확한 리플 딜리트 기능을 사용하여 
타임라인에 공간을 남기지 않을 수 있습니다. 하지만 해당 범위를 바로 삭제하면 문제가 
발생합니다. 이를 확인하기 위해 해당 범위를 삭제해 문제를 확인한 다음 해결 방법에 대해 
알아보겠습니다.

8 [shift + delete] 키 또는 [shift + backspace] 키를 눌러 해당 범위를 삭제하세요.
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인/아웃 포인트 사이의 범위가 인터뷰 클립에서 삭제되면서 음악 트랙까지 함께 삭제됩니다. 
삭제하려는 클립의 범위 뿐만 아니라 이에 해당하는 오디오 트랙까지 찾아야 하기 때문에 
DaVinci Resolve에는 이를 위한 자동 선택 버튼이 포함되어 있습니다.

9 Edit > Undo를 선택한 다음 [command + Z] 키(macOS) 또는 [Ctrl + Z] 키(Windows)를 함께 
누르면 이전 작업이 취소됩니다. 

10 Audio 2 트랙의 타임라인 헤더에 있는 자동 선택 버튼을 눌러 해당 트랙을 비활성화하세요.

자동 선택 버튼은 다양한 기능을 가지므로 타임라인 편집 작업 시에 이러한 기능에 대해 잘 
알고 있어야 합니다. 현재 작업에서는 이 버튼이 활성화된 경우에는 해당 오디오 트랙을 찾아내고, 
비활성화된 경우에는 해당 오디오 트랙이 제외된다는 사실만 알고 있으면 됩니다.

11 [shift + delete] 키 또는 [shift + backspace] 키를 눌러 트랙 V1과 트랙 A1에 있는 부분을 제거하세요. 

그럼 삭제 과정을 복습해보겠습니다.

12 플레이헤드를 10_MALDIVES 클립의 시작 부분으로 옮기고 스페이스 바를 눌러 삭제된 부분을 
재생하세요. 

생성된 점프컷은 나중에 수정할 수 있기 때문에 너무 신경쓰지 않아도 됩니다. 주로 편집 
작업에서는 오디오를 먼저 정확하게 편집한 다음, 모든 오디오 위치가 정해졌을 때 점프 컷을 
수정합니다.

13 나중에 해당 작업을 기억할 수 있도록 A2 트랙의 타임라인 트랙 헤더에 있는 자동 선택 버튼을 
클릭하세요.
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이번 연습 프로젝트에서는 백업 파일을 생성하는 것이 그렇게 중요하지는 않지만, 러프 컷처럼 많은 
클립을 삭제하며 대규모 편집 작업을 진행하는 경우에는 이전 버전으로 되돌릴 수 있도록 복사본을 
만들어 두는 것이 좋습니다.

클립 분할하기
경우에 따라 이야기의 흐름을 향상 시키기 위하여 문장 사이에 공백을 생성하기도 합니다. 여기서는 
삭제하려는 범위 대신 분할하려는 곳의 프레임을 찾을 것입니다. 가장 쉽게 찾는 방법은 레이저 
편집 모드를 사용하는 것입니다.

1 타임라인 아래있는 스크롤 바를 드래그하여 10_MALDIVES와 02_if it was possible 인터뷰 
클립의 연결 지점이 화면 중앙에 오도록 하세요. 

2 타임라인 플레이헤드를 10_MALDIVES 클립의 시작 부분으로 드래그하세요.

3 스페이스 바를 눌러 타임라인을 재생한 다음 인터뷰 오디오가 “If the weather wasn’t right” 라고 
말하는 지점에서 멈추세요.

첫 번째 문장 “If it was possible to shoot it, you wanted to go shoot it”이 바로 시청자에게 
전달하려는 핵심 메세지를 가지므로 이곳을 분할하는 것이 적당해 보입니다. 해당 문장을 
클립의 나머지 부분과 분리시킵니다.
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4 플레이헤드를 10_MALDIVES와 02_if it was possible 인터뷰 클립의 연결 지점으로 가져가세요. 
그곳이 바로 해당 문장이 끝나는 지점입니다.

레이저 편집 모드에서 클립을 여러 부분으로 분할할 수 있습니다. 여기서는 오디오 트랙을 
분할하는데 사용할 수 있습니다.

5 툴바에서 레이저 편집 모드(Blade Edit Mode) 도구를 클릭하거나 [B] 키를 누르세요.

레이저 편집 모드 도구를 선택한 다음 타임라인 아무 곳이나 클릭하면 해당 클립이 분할됩니다.

6 레이저 블레이드 포인터 왼쪽 끝부분을 오디오 트랙에 있는 플레이헤드 위로 직접 가져간 다음 
클릭하면 클립이 분할됩니다.

마우스를 클릭하면 레이저 블레이드 포인터 왼쪽 끝부분이 있던 위치를 기반으로 클립이 
분할됩니다. 이제 클립이 분할되었으며 해당 클립의 위치를 조정할 수 있습니다.

정보 자동 선택 기능이 활성화된 트랙에서 플레이헤드가 위치한 곳의 클립을 
분할하려면 Timeline > Split Clip을 선택하거나 [command + \ ](macOS) 또는 
[Ctrl + \ ](Windows) 키를 함께 누르세요.

7 셀렉션 모드(Selection Mode) 버튼을 클릭하거나 [A] 키를 누르세요.
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클립 분할이 성공적으로 이루어지면 인터뷰 클립 바로 옆에 따로 클립이 분할됩니다.

8 타임라인에서 분할된 오디오 트랙을 선택하세요.

정보 툴바로 돌아가지 않고도 링크 연결 버튼을 일시적으로 비활성화시킬 수 
있습니다. [option] 키(macOS) 또는 [Alt] 키(Windows)와 함께 클립을 선택하세요. 

1초간의 오디오 묵음을 생성하고자 할 경우 소스 뷰어의 플레이헤드를 옮기기 위해 타임코드 
값을 입력하는 기술을 동일하게 사용할 수 있습니다.

9 타임라인에서 1초 앞으로 클립을 옮기려면 -1.(마이너스 부호 + 1 + 마침표) 을 입력한 다음 [enter] 
또는 [return] 키를 누르세요.

정보 선택한 클립의 프레임을 한 번에 하나씩 움직일 수 있습니다. ‘,(콤마)’를 
누르면 왼쪽으로 ‘.(마침표)’를 누르면 오른쪽으로 한 프레임씩 이동합니다. [shift 
+ ,(콤마)] 또는 [shift = .(마침표)] 키를 함께 누르면 플레이헤드가 각각 왼쪽/
오른쪽으로 다섯 프레임씩 이동합니다.

오디오가 타임라인 시작점 방향으로 1초 이동됩니다.
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10 툴바에서 링크 연결 버튼을 클릭하거나 [command + shift + L](macOS) 또는 [ctrl + shift + L]
(Windows) 키를 동시에 누르면 다시 활성화됩니다. 

11 View > Zoom > Zoom to Fit로 이동하거나 [shift + Z] 키를 동시에 누르면 전체 타임라인을 볼 
수 있습니다.

정보 [shift + Z] 키를 함께 누르면 줌 기능을 켜고 끌 수 있습니다. 해당 키 
조합을 한 번 누르면 전체 타임라인이 나타나고 다시 누르면 이전 줌 단계로 
되돌아갑니다.

12 플레이헤드를 첫 번째 인터뷰 클립의 끝부분으로 가져간 다음 스페이스 바를 누르면 뷰어에 
01_A380_TAXI 클립이 나타날 때까지 타임라인이 재생됩니다.

클립을 분할한 결과가 완벽할 수도 있고 그렇지 않을 수도 있습니다. 이 결과는 컷 포인트를 얼마나 
정확하게 선택했는지에 따라 달라집니다. 앞으로 제5과에서 다루게 될 트리밍 옵션을 통해 정확한 
조정 작업을 좀 더 쉽게 진행할 수 있습니다.

클립 자르기 및 붙이기 
클립 하나만 작업하는 경우엔 타임코드 값을 드래그 또는 입력하는 것이 가장 좋은 방법입니다. 
하지만 타임라인에 다른 클립이 있는 경우에는 클립을 이동해 발생할 결과뿐만 아니라 이런 이동으로 
인해 타임라인에 있는 다른 클립에 끼칠 영향까지 생각해야 합니다. 한 클립을 드래그하거나 옮겨 
다른 클립에 덮어쓰기할 목적이 아니라면 타임라인에 리플 기능을 적용해야 합니다.

1 플레이헤드를 타임라인에 있는 01_A380_TAXI 클립의 시작 부분으로 가져가세요.

2 스페이스 바를 누르면 타임라인 끝부분까지 재생됩니다.

DaVinci Resolve는 타임라인에서 선택한 클립에서 사용 가능한 잘라내기/복사하기/붙여넣기 
기능을 지원합니다. 이러한 기능은 클립을 타임라인 한쪽 끝에서 다른 곳으로 이동시킬 때 아주 
유용합니다. 타임라인 끝부분에 있는 두 개의 A380 제트기 영상을 예로 들 수 있습니다.

3 타임라인에서 01_A380_TAXi 클립을 클릭해 선택한 다음 [command] 키(macOS) 또는 [Ctrl] 
키(Windows)와 함께 02_A380_TAKE_OFF을 누르면 두 파일을 동시에 선택할 수 있습니다.
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클립을 현재 위치에서 다른 곳으로 이동하기 위해 제거할 경우 타임라인에서 해당 클립을 
제거할 수 있습니다.

4 Edit > Ripple Cut을 선택하거나 [command + shift + X](macOS) 또는 [Ctrl + shift + X](Windows) 
키를 동시에 누르세요. 

리플 컷 기능을 사용해 클립을 타임라인에서 추출하고 공간을 채울 수 있습니다. 리플 딜리트와는 
달리 클립이 메모리에 저장되어 있어 언제든 다른 곳으로 붙여넣기할 수 있습니다.

5 플레이헤드를 타임라인에 있는 첫 번째 인터뷰 클립의 맨 끝부분으로 가져가세요.

6 타임라인에서 Audio 2 오디오 선택 버튼을 클릭.
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7 Edit > Paste Insert를 선택하거나 [command + shift + V](macOS) 또는 [Ctrl + shift + V](Windows) 
키를 동시에 누르세요. 

플레이헤드가 있는 곳에 클립이 삽입됩니다. 복사 삽입 기능은 툴바 또는 Edit 오버레이를 
사용해 클립을 복사하는 것과 동일한 방식을 사용합니다.

클립 위치 바꾸기
클립을 2~3개 이상 옮길 필요가 없는 경우 간단히 해당 클립의 위치만 바꿀 수 있습니다.

1 타임라인에서 05_BAY_AREA_LIGHTS 클립을 클릭하세요.

2 클립을 오른쪽으로 드래그하세요. 11_MOVIE_CREDITS 클립 시작 부분에 이를 때까지 
드래그하면서 [command + shift](macOS) 또는 [Ctrl + shift](Windows) 키를 길게 누르세요. 

05_BAY_AREA_LIGHTS 클립과 마지막 인터뷰 클립 위치가 바뀌었습니다.

지금까지 많은 부분을 바꾸었기 때문에 이제는 편안하게 전체 영화를 감상할 차례입니다. 

3 플레이헤드를 타임라인 시작 부분으로 드래그한 다음 [command + F](macOS) 또는 [Ctrl + F]
(Windows) 키를 함께 누르면 타임라인이 재생되어 변경한 부분을 확인할 수 있습니다. 

이 편집본은 아주 훌륭해 보이지만 아직 음악과 완벽하게 맞아 떨어 지지 않고 일부 장면은 너무 
길기도 합니다. 이러한 타이밍 문제는 클립 위치를 옮기는 것만으로는 해결할 수 없습니다. 다음 
과에서 배우게 될 트리밍 기술을 사용해 클립을 연장 및 축소시켜야 합니다.
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복습하기
1 마스터 빈에서 리링크 기능을 사용해 얻을 수 있는 장점은 무엇인가요? 

2 타임라인에 있는 비디오 또는 오디오만 선택 할 수 있는 링크 연결 버튼은 어디에 있나요?

3 툴바에서 레이저 블레이드 아이콘을 클릭하면 타임라인에서 어떤 작업을 할 수 있나요? 

4 Shift + Z 키를 함께 누르면 어떤 작업이 수행되나요?

5 Edit 페이지 타임라인에서 클립을 이동시키려면 반드시 shift 키를 길게 눌러야 합니다. T(진실) 
또는 F(거짓)로 답하세요. 
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정답
1 마스터 빈에서 리링크 기능을 사용하면 모든 빈에 있는 클립이 다시 연결됩니다.

2 링크 연결 버튼은 Edit 페이지 툴바에 배치되어 있습니다.

3 타임라인에 있는 클립을 여러 부분으로 분할할 수 있습니다.

4 윈도우에서 전체 타임라인을 보여주거나 이전의 확대된 상태로 되돌아갑니다.

5 F. 셀렉션 모드 도구가 툴바에서 활성화되어 있는 한 다른 어떤 키보드 모디파이어를 사용하지 
않고도 클립을 옮길 수 있습니다.



제5과

타임라인 조정하기

편집 기술의 핵심은 바로 타임라인에 나열된 
클립 사이의 리듬을 조절하는 것입니다. 여기서 
리듬이란 클립을 초 또는 프레임 단위로 줄이거나 
늘려서 두 클립 사이의 완벽한 타이밍을 찾는 
작업을 말합니다.

클립을 다듬어 이러한 타이밍을 맞춥니다. 
DaVinci Resolve 15는 정교한 트리밍 도구를 
제공하여 다양한 편집 방식을 선택할 수 있고 
이를 신속하게 확인하여 창의적으로 표현할 수 
있습니다. 이번 과에서는 이러한 여러 가지 
트리밍 방식을 사용하여 프로그램의 리듬을 
완벽하게 조절하는 방법을 살펴보겠습니다.

예상 소요 시간

이 과를 학습하는 데는 약 50분 
정도의 시간이 소요됩니다.

학습 목표

트리밍을 위한 레이아웃 사용자 지정하기 102

플레이헤드로 트리밍하기 103

리플 트리밍  107

트리밍할 트랙 선택하기 111

롤 트리밍 사용하기 115

슬립 편집하기  116

셀렉션 도구를 사용해 빈 공간 만들기 119

복습하기 123
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트리밍을 위한 레이아웃 사용자 지정하기
DaVinci Resolve에서는 사용자 인터페이스 레이아웃을 설정하고 저장할 수 있어 다양한 워크플로 
방식을 손쉽게 구성할 수 있습니다. 예를 들면 현재 사용하는 인터페이스 레이아웃은 두 개의 뷰어가 
나타나 트리밍에 적합하지 않습니다. 트리밍 작업을 본격적으로 시작하기 전에 먼저 레이아웃을 
작업 방식에 맞게 변경하겠습니다.

1 DaVinci Resolve를 열고 Age of Airplanes 프로젝트를 여세요.

2 Rough Cuts 빈에서 Trim Rough Cut 타임라인을 더블 클릭하면 타임라인 뷰어에 로딩됩니다.

이 타임라인은 앞으로 배울 트리밍 작업을 위한 것으로 4과에서 사용한 타임라인과 비슷합니다.

트리밍 작업에서는 타임라인 속 클립만 사용하므로 미디어 풀과 소스 뷰어는 화면에 나타나지 
않도록 감추어 두면 훨씬 작업이 편리합니다. 이렇게 하면 타임라인과 타임라인 뷰어를 더욱 
크게 볼 수 있습니다.

3 사용자 인터페이스 툴바 왼쪽 상단에 있는 Media Pool 버튼을 클릭하여 미디어 풀을 감추세요.

Media Pool 화면이 사라지면 뷰어와 타임라인이 훨씬 크게 보입니다.

4 인터페이스 오른쪽 상단에 있는 상자 모양의 싱글 뷰어 모드 버튼을 선택하면 소스 뷰어가 
사라지며 타임라인 뷰어가 화면 중심으로 이동합니다. 

가로 분할선으로 타임라인 공간을 줄이면 뷰어 크기를 늘릴 수 있습니다.

타임라인에 있는 가로 분할선은 뷰어와 툴바를 분리합니다. 분할선을 아래로 드래그하면 뷰어가 
확대되고 타임라인 트랙의 크기는 줄어듭니다. 타임라인에서 수직 간격은 많이 필요하지 
않으므로 트리밍 작업 시 뷰어를 확대하여 작업하기 좋습니다.

5 툴바와 트랜스포트 컨트롤 사이에 마우스 포인터를 놓으세요.
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6 마우스 포인터가 크기 조절 커서로 변하면 타임라인 속 비디오 트랙 위에 약간의 공간은 남겨둔 
채 가로 분할선을 아래로 드래그합니다.

이 레이아웃을 Big Trim 레이아웃으로 저장한 다음 모든 프로젝트에 걸쳐 사용할 수 있습니다.

7 Workspace > Layout Presets > Save Layout as Preset 순으로 선택하세요.

8 나타나는 창에 레이아웃 이름을 Big Trim으로 저장하고 OK를 클릭합니다.

작업에 최적화된 Big Trim 레이아웃이 선택되었으므로 프로그램 타임라인을 트리밍하고 조정해 
보겠습니다.

플레이헤드로 트리밍하기
클립의 시작 프레임과 끝 프레임을 제거할 수 있는 가장 빠른 방법은 탑/테일 트리밍이라고 하는 
편집 방식입니다. 이러한 트리밍 방식은 뉴스 같은 방송 프로그램에 많이 사용되는 방식이지만, 모든 
종류의 프로그램에 사용하기도 좋은 편집 방식입니다. 실제로 원하는 것보다 조금 더 많은 클립을 
추가하여 대략적으로 클립을 추가합니다. 그런 다음, 새롭게 원하는 시작 및 끝 지점에 플레이헤드를 
배치하여 클립의 프레임 일부를 제거하는 편집 방식입니다. 타임라인 시작점을 기준으로 트리밍 
작업을 시작해 보겠습니다. 전체 타임라인을 재생할 필요 없이 첫 번째 클립만 확인하여 어떻게 
편집할지 구상해볼 수 있습니다.

1 Viewer > Zoom > Zoom to Fit 순서로 선택하거나, [Shift+Z] 키를 함께 누르면 타임라인을 전체 
화면 크기로 볼 수 있습니다.

2 타임라인 시작 부분에 플레이헤드를 놓고 두 개의 클립을 재생해 확인합니다.

첫 번째 클립은 아무 문제가 없지만, 시작 부분과 끝 부분을 조금 작업하여 이를 향상 시킬 수 
있습니다. 클립 시작점에 적막감이 흐르는 부분을 다듬어 보겠습니다.

3 플레이헤드를 타임라인 시작점에 놓습니다.

4 툴바에 있는 줌 슬라이더를 오른쪽으로 드래그하여 첫 번째 클립이 타임라인 화면의 반 정도를 
차지하도록 확대합니다.

5 대사 속 ‘so’와 ‘in this film’ 사이에 플레이헤드를 놓으세요. 오디오 파형을 참고하여 두 단어 
사이에 플레이헤드를 놓으세요.
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플레이헤드가 위치한 지점을 클립 시작점으로 새롭게 지정할 수 있습니다. 두 가지 도구를 
사용하여 이를 수행합니다. 먼저 이미 사용 중인 셀렉션 모드(Selection Mode) 도구를 적용해 
보겠습니다.

6 Trim > Trim Start 순으로 선택하거나 [shift] + [[] 키를 누르세요.

플레이헤드가 위치한 곳이 클립 시작점으로 지정됩니다. 변경되었는지 확인해 보겠습니다.

7 타임라인 시작점에 플레이헤드를 두고 스페이스 바를 눌러 클립을 재생하세요.

클립의 시작점은 변경되었어도 타임라인 시작점이 아니므로 타임라인과 첫 번째 클립 시작 
지점에 빈 공간이 생기게 됩니다. 지금 사용한 트리밍 작업을 취소하고 다른 도구를 사용해야 
하는데요.

8 Edit > Undo 순으로 선택하거나 [command + Z] 키(macOS) 또는 [controll + Z] 키(Windows)를 
눌러 이전 트리밍 작업을 취소하세요.
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9 툴바에서 트리밍 편집 모드 도구를 선택하거나 [T] 키를 누르세요.

트리밍 편집 모드 도구는 타임라인 길이를 줄이거나 늘릴 때 사용할 수 있는 아주 유연한 기능의 
도구입니다. 트림 에딧 모드 도구와 셀렉션 모드 도구의 가장 큰 차이점은 트리밍 편집 도구는 
빈 공간 없이 타임라인에도 영향을 미친다는 점입니다. 그럼 한 번 사용해 보겠습니다.

10 대사 속 ‘so’와 ‘in this film’ 사이에 플레이헤드를 다시 놓으세요. 

11 Trim > Trim Start 순으로 선택하거나 [shift] + [[] 키를 누르세요.

같은 방식으로 클립의 시작 프레임이 트리밍되지만, 이번에는 클립이 타임라인 시작점에서 
시작되며 변경 사항이 타임라인 전체에 걸쳐 적용되므로 클립의 전체 길이가 줄어듭니다. 클립 
끝부분을 살펴보겠습니다.

12 타임라인 시작 부분에 플레이헤드를 놓고 첫 번째 클립을 재생하세요.

‘Shoot the real world’라고 말하는 부분에서 클립이 끝난다면 더욱 강력하게 의미가 전달될 
것입니다.

13 ‘Shoot the real world’ 끝에 플레이헤드를 놓고 그다음에 오는 문장은 포함되지 않도록 주의하세요.
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정보 좌/우 화살표 키를 누르면 플레이헤드가 한 프레임씩 앞/뒤로 움직여 더욱 
정확한 위치를 찾을 수 있습니다.

시작점을 트리밍하는 대신, 클립 끝부분의 프레임을 제거하는 기능을 사용해 보겠습니다.

트리밍 편집 모드 도구가 선택되어 있으므로 플레이헤드가 위치한 곳에서 클립 마지막 부분까지 
프레임을 모두 제거하면 4과에서 사용한 리플 제거 기능과 마찬가지로 타임라인도 짧아집니다. 
4과에서 오디오 트랙의 자동 선택 기능을 해제하여 오디오 부분이 삭제되지 않도록 했듯이 
여기에서도 음악 끝부분이 트리밍되지 않도록 자동 선택 기능을 해제합니다.

14 자동 선택 버튼을 클릭하여 Audio 2의 해당 기능을 해제하세요.

15 Trim > Trim End 순으로 선택하거나 [shift] + []] 키를 누르세요.
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Video 1과 Audio 1 클립의 마지막 지점 위치한 플레이헤드가 있는 곳까지 프레임이 트리밍되지만 
오디오 트랙은 그대로 유지됩니다. 타임라인의 나머지 클립은 방금 제거된 프레임 수 만큼 
왼쪽으로 이동합니다.

16 툴바에서 셀렉션 모드 도구를 선택하거나 [A] 키를 누르세요.

17 타임라인 시작점에 플레이헤드를 놓고 재생하여 트리밍된 클립의 맨 첫 부분과 마지막 부분을 
확인하세요.

이 편집 방식을 통해 두 가지를 배울 수 있습니다. 첫째로 전체 타임라인에 걸쳐 앞부분과 뒷부분을 
빠르게 트리밍하여 편집 영상을 간추릴 수 있으며, 두 번째로는 트림 에딧 모드 도구는 타임라인까지 
제거하지만, 셀렉션 모드 도구는 빈 공간을 그대로 남겨둔다는 기본적인 사항을 배울 수 있습니다. 

리플 트리밍 
트림 에딧 모드 도구는 다양하게 사용할 수 있어 더욱 신속하고 정확하며 유연한 작업이 가능합니다. 
이제 다른 클립을 사용하여 트리밍 작업을 향상시킬 수 있는 방법을 알아보겠습니다.

1 방금 트리밍한 인터뷰 클립 맨 끝에 플레이헤드를 놓으세요.

2 타임라인에서 인터뷰 클립 다음에 이어지는 세 개 클립을 인터뷰 대상자의 모습이 다시 나타날 
때까지 재생하세요. 

몰디브 장면이 너무 늦게 나타나는 것을 확인하실 수 있습니다. 클립 시작과 동시에 수상 
비행기가 이미 화면 위쪽에 나타나는데요, 몰디브 장면 시작점에 프레임을 추가하여 비행기 
모습이 조금 나중에 나타나도록 합니다. 장면을 확대하여 클립을 타임라인 창 중심에 배치하세요.

3 10_MALDIVES 클립 시작점에 플레이헤드를 놓으세요.

4 타임라인 아래 있는 스크롤 바를 오른쪽으로 드래그하여 플레이헤드를 중간 지점에 놓습니다.
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5 툴바에 있는 줌 슬라이더를 오른쪽으로 드래그하여 타임라인에 있는 10 MALDIVES 클립의 
크기를 확대합니다.

이제 두 가지의 작업 방식에서 선택할 수 있습니다. 셀렉트 모드 도구를 사용하여 몰디브 클립 
시작 부분에 프레임을 추가함으로써 그 앞에 위치한 A380 클립 마지막에 있는 일부 프레임을 
덮어쓰기 할 수 있습니다. 다른 방식으로 타임라인이 리플되는 트림 에딧 모드 도구를 사용하면 
A380 클립에는 영향을 주지 않습니다.

A380 클립은 변경할 것이 없기 때문에 리플 트리밍 방식을 선택하겠습니다.

6 툴바에서 트림 에딧 모드 버튼을 클릭하거나 [T] 키를 누르세요.

트림 에딧 모드를 선택하면 커서를 사용해 타임라인 속 클립을 선택 및 이동할 수 없습니다. 
커서의 주요 사용 목적은 컷 포인트와 트리밍하려는 지점을 선택하는 것입니다.

7 트림 에딧 모드의 커서를 02_A380_TAKEOFF 클립 끝에 놓으세요.

커서가 리플 트림 커서로 변하면 클립 길이를 늘리거나 줄일 수 있습니다. 커서를 컷 포인트 
왼쪽에 두면 클립 끝부분이 트리밍됩니다.

8 트림 에딧 모드 커서를 10 MALDIVES 클립 시작점에 놓으세요.

커서를 컷 포인트 오른쪽에 두면 클립 앞부분이 트리밍됩니다. 여기서는 이 앞부분을 트리밍할 
예정입니다.

9 클립 앞부분을 왼쪽 방향으로 살짝 드래그하고 잠깐 유지합니다.
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타임라인을 드래그하면 뷰어가 두 개로 나뉘어 왼쪽 뷰어에는 현재 재생되고 있는 클립의 
마지막 프레임이 나타나고 오른쪽 뷰어에는 앞으로 재생될 클립의 첫 프레임이 나타납니다. 
두 개의 프레임이 나란히 나타나는 디스플레이 방식은 클립 속 두 프레임 사이의 액션과 
프레이밍이 서로 일치하는지 확인할 수 있도록 제작되었습니다.

10 10 MALDIVES 클립 속 비행기가 화면에서 사라질 때까지 왼쪽으로 드래그하세요.

정보 드래그하여 트리밍을 작업하면 컷 포인트가 플레이헤드가 있는 곳으로 
스내핑되어 정확한 작업이 어려울 수 있습니다. 이러한 일이 발생할 경우 [N] 
키를 눌러 스내핑 기능을 해제하세요.

프레임 제거 시 리플 트리밍을 사용하면 트리밍 포인트 뒤에 있는 모든 클립을 끌어당겨 공백을 
제거합니다. 이전 과에서 학습한 리플 삭제 기능과 비슷합니다. 리플 커서를 사용하여 프레임을 
추가하면 클립의 길이만 연장되는 것이 아니라 프로그램의 전체 길이가 늘어나게 됩니다.

11 트리밍 포인트를 확인하려면 Playback > Play Around/To > Play Around Current Frame 순으로 
선택하거나 [/] 키를 누르세요.

정보 명령어 실행 뒤 재생되는 초 단위의 재생 시간은 편집 사용자 환경설정의 
프리-롤과 포스트-롤 설정에 따라 달라집니다.

트리밍 도중 프레임을 추가할 경우 타임라인에서 클립의 편집이 이루어졌기 때문에 인/아웃 
포인트에 포함되어 있지 않은 캡처 클립의 추가 프레임을 사용할 수 있어야 합니다. 타임라인에 
있는 아직 사용하지 않은 클립 부분은 핸들이라고 부릅니다.
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클립 전체를 타임라인에 편집할 경우 핸들의 길이를 연장할 수 없기 때문에 트리밍 작업 시 
프레임을 제거하는 옵션만 사용 가능합니다.

숫자로 트리밍하기
컷 포인트를 드래그하지 않고 특정 숫자를 사용해 트리밍할 경우 원하는 프레임 수를 정확하게 
입력하거나 프레임을 앞/뒤로 조금씩 움직여 조절할 수 있습니다.

1 트림 에딧 모드 도구를 사용하여 10_MALDIVES 클립의 시작 부분을 선택하세요.

방금 트리밍한 영상을 확인할 때 비행기가 너무 갑자기 나타나는 것을 확인했습니다. 클립 
시작점에 1초 간격의 프레임을 추가해 보겠습니다. 1초를 정확하게 맞춰 드래그하는 대신에 
키패드에서 프레임 수를 입력할 수 있습니다.

2 [-1.]을 입력하고 [return] 키(MacOS) 또는 [Enter] 키(Windows)를 누르세요. 

10_MALDIVES 클립의 시작점에 1초 간격의 프레임이 추가됩니다. 음수를 입력하여 프레임을 
추가하는 것이 직관적인 방식이 아닐 수도 있지만, 양수/음수의 선택은 타임라인 방향을 기반으로 
이루어집니다. 클립 또는 컷 포인트를 왼쪽으로 이동하려면 음수를, 오른쪽으로 이동하려면 
양수를 입력합니다.

3 편집한 컷을 확인하려면 Playback > Play Around/To > Play Around Current Frame 순으로 
선택하거나, [/] 키를 누르세요.

초 또는 프레임 숫자를 입력하면 몰디브 클립에서 더욱 정확한 시작 포인트를 지정할 수 있습니다. 
[,(콤마)] 또는 [.(마침표)] 키를 누르면 프레임이 하나씩 움직입니다.

4 몰디브 클립 시작점에서 3개의 프레임을 삭제하려면 [.] 키를 세 번 누르세요.

정보 [shift]+[,] 또는 [shift]+[.]를 누르면 5 프레임씩 이동합니다.

5 트리밍 포인트를 확인하려면 Playback > Play Around/To > Play Around Current Frame 순으로 
선택하거나 [/] 키를 누릅니다.

6 몰디브 클립의 시작점 방향으로 한 프레임 옮기려면 [,] 키를 한 번 누르세요.

핸들 

인 포인트 아웃 포인트

핸들

음수(-) 음수(-)양수(+) 양수(+)

인 포인트 아웃 포인트
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정보 Playback > Loop를 선택한 다음 현재 프레임을 재생하면 영상을 확인하면서 [.] 
키와 [,] 키를 사용해 원하는 조절을 할 수 있습니다.

숫자판 사용과 트리밍 포인트 드래그 중에서 원하는 방식을 선택할 수 있습니다. 숫자판을 사용하는 
것은 속도는 빨라도 시각적으로 확인하기 어렵습니다. 트리밍을 드래그하면 움직이는 프레임을 
확인할 수는 있지만, 작업 공간을 많이 차지합니다. 상황에 맞는 작업 방식을 선택하세요.

트리밍할 트랙 선택하기
지금까지 비디오 클립을 트리밍하는 방법을 배워봤는데요, 오디오 트랙이 포함된 클립을 선택한다면 
어떻게 될까요?

1 [shift + z] 키를 눌러 전체 타임라인을 확인한 다음, 06_MILKYWAY와 02_if_it_was_possible 
클립 사이에 플레이헤드를 놓으세요.

2 툴바에 있는 줌 슬라이더를 드래그하여 두 개의 클립을 확대합니다.

정보 macOS에서는 [command]+[+] 또는 [command]+[-] 키를 누르면 특정 
크기만큼 타임라인이 확대 또는 축소됩니다. Windows에서는 [control]+[+] 또는 
[control]+[-]를 누르면 특정 크기만큼 타임라인이 확대 또는 축소됩니다.

3 트림 에딧 모드 버튼을 클릭하거나 [T] 버튼을 눌러 트림 에딧 모드를 선택하세요.
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4 마우스 포인터를 컷 포인트 오른쪽 02_if_it_was_possible 클립 위로 가져가세요.

5 리플 트리밍을 위해 02_if_it_was_possible 클립 시작점을 클릭합니다.

비디오 트랙만 선택하더라도 비디오와 오디오 트랙 모두 선택됩니다. 오디오와 비디오 모두 
같은 인터뷰 클립에서 왔기 때문에 서로 연결되어 있습니다. 이러한 속성은 링크 연결 버튼이 
선택된 타임라인 속에서 클립을 이동할 때와 비슷합니다.

6 타임라인 속 비디오 트랙 위 빈 공간을 클릭하면 선택된 편집 포인트가 사라집니다.

7 링크 연결 버튼을 클릭하여 해당 기능을 해제하세요.

정보 [option] 키(macOS) 또는 [Alt] 키(Windows)를 길게 누르면 링크 연결 버튼 
기능을 해제하지 않고도 일시적으로 비디오 편집 포인트를 설정할 수 있습니다.

8 리플 트리밍을 위해 02_if_it_was_possible 클립의 시작점을 다시 한번 선택하세요.
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링크 선택 기능을 활성화하면 오직 비디오 편집 포인트만 선택됩니다.

9 선택한 편집 컷을 확인하려면 Playback > Play Around/To > Play Around Current Frame 순으로 
선택하거나, [/] 키를 누르세요.

해당 오디오 영상을 위한 오프셋을 설정하여 비디오 또는 오디오가 먼저 나타나도록 하는 
기술은 프로그램의 흐름을 향상시키기 위해 편집에서 사용되는 하나의 편집 기술입니다. 
일반적으로 J-컷과 L-컷으로 알려진 이러한 편집 방식은 다이얼로그 장면에서 가장 많이 사용되는 
편집 기술이지만, 다음 숏으로 자연스럽게 이어질 수 있도록 여기서도 사용할 수 있습니다. 
클립의 연속성을 더욱 높이기 위해 영상이 시작하기 몇 초 전에 음성이 시작되도록 해보겠습니다.

10 편집 컷을 오른쪽으로 1초 정도 드래그하여 “It was really important” 문장과 “Every shot was 
original” 문장 사이에 오도록 합니다. 오디오 트랙의 파형을 지침으로 삼아 두 문장 사이로 
영상 컷을 이동하세요. 

정보 Trim > Dynamic Trim을 선택하여 활성화하면 [J, K, L] 키를 사용하여 
트리밍할 수 있습니다.

이 컷을 확인하기 전에 비디오 트랙 트리밍 시 06_MILKYWAY 클립 아래 있는 오디오 트랙이 
왜 움직였는지 짚어보고 가는 것이 좋습니다. 이는 위에서 언급된 자동 선택 버튼의 상태와 
관련이 있습니다.

자동 선택 기능이 트리밍 작업 동안 타임라인의 동기화를 유지시킵니다. 이 기능을 더욱 자세히 
이해할 수 있도록 이번에는 오디오 트랙의 자동 선택 기능을 해제한 상태에서 트리밍 작업을 
해보겠습니다.

11 Audio 1에서 자동 선택 버튼 기능을 클릭해 기능을 해제하세요.
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12 02_if_it_was_possible 클립의 시작점을 선택하고 오른쪽 방향으로 몇 개의 프레임을 
드래그합니다.

Audio 1 트랙의 자동 선택 버튼 기능을 해제했기 때문에 비디오 트랙에서 프레임을 트리밍해도 
오디오는 조절되지 않습니다. 그 결과 오디오 싱크는 맞지 않고 비디오 트랙의 길이도 짧아졌습니다. 
빨간색 배지는 오디오와 비디오 트랙에서 싱크가 어긋난 프레임 수를 나타냅니다. 이제 자동 
선택 기능을 이해했으므로 해당 작업을 취소하고 5과 학습을 마무리해보겠습니다.

13 Edit > Undo 순으로 선택하거나 [command + Z] 키(macOS) 또는 [control + Z] 키(Windows)를 
눌러 이전 트리밍 작업을 취소하세요.

14 Audio 1에서 자동 선택 버튼 기능을 활성화하세요.

15 연결 선택 버튼을 클릭하여 클립을 연결합니다.

16 툴바에서 셀렉션 모드 도구를 선택하거나 [A] 키를 누르세요.

드디어 지금까지 작업한 트리밍을 확인할 단계입니다.

17 06_MILKYWAY 클립의 시작점에 플레이헤드를 놓고 J-컷을 확인합니다.

편집자들의 관심사는 항상 오디오와 비디오 동기화를 유지하는 것입니다. 연결 선택 기능은 클립별로 
작업할 시 매우 유용한 기능이며, 자동 선택 버튼은 타임라인을 기준으로 작업할 시 유용하게 사용할 
수 있습니다. 일부 상황에서는 두 기능을 모두 해제해야 하지만, 대부분은 활성화시켜 놓는 것이 
좋습니다.



115

롤
 트

리
밍

 사
용

하
기

롤 트리밍 사용하기
리플 트리밍은 컷 포인트의 한쪽 면에 적용되는 반면, 롤 트리밍 기능은 클립의 시작점과 끝 지점 
모두에 적용되는 편집 방식입니다. 이러한 유형의 트리밍 방식은 전체 타임라인 길이를 그대로 
유지하거나, 타임라인 동기화를 그대로 유지하려고 할 시에 사용하기 매우 유용합니다.

1 타임라인에서 플레이헤드를 06_MILKYWAY 클립 맨 끝으로 옮기세요.

2 스페이스 바를 눌러 05_BAY AREA_LIGHTS 클립을 끝까지 재생합니다.

인터뷰 영상은 ‘Everything was real’이라고 말하는 부분에서 끝나기 때문에 이번에는 비디오 
트랙만 트리밍하면 됩니다. 하지만, ‘real’이라는 단어가 나오는 시점에서 바닷가 장면이 화면에 
나타난다면 더욱 자연스럽게 두 개의 숏이 이어지게 됩니다. 이는 짧은 오버랩 장면으로도 
충분합니다.

3 툴바에서 링크 연결 버튼을 클릭하여 해당 기능을 해제하세요.

롤 트리밍은 셀렉션 모드 도구 또는 트림 에딧 모드 도구를 사용하여 수행할 수 있습니다. 롤 
트리밍의 속성은 사용하는 도구와 상관없이 항상 같습니다. 그러므로 셀렉션 모드 도구가 
선택되어 있어도 됩니다.

4 마우스 포인터를 화면 중심에 있는 비디오 컷 포인트 위에 둡니다.

마우스 포인터가 화면 중심에 오면 커서가 롤 트리밍 커서로 변경됩니다.

5 비디오 트랙에서 컷 포인트를 클릭하여 02_if_it_was_possible 인터뷰 클립 끝 지점과 05_BAY 
AREA_LIGHTS 클립 시작점 사이를 선택합니다.
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정보 리플 또는 롤 커서로 컷 포인트를 선택하면 [U] 키로 편집하려는 클립의 한 
면을 토글하여 선택할 수 있습니다.

두 개의 컷 포인트가 선택된 상태에서는 두 개의 컷에 모두 동일한 편집 조정이 적용됩니다. 
인터뷰 클립 끝 지점에서 프레임을 제거하면 바닷가 장면 클립 시작점에는 프레임이 추가됩니다.

6 컷을 왼쪽으로 드래그하여 ‘was real’이라는 단어 바로 앞에 놓으세요. 오디오 트랙에서 오디오 
파형을 지침 삼아 이 단어 사이에 영상 컷을 놓습니다.

트랜지션을 재생하여 영상을 확인해 보겠습니다.

7 편집한 컷을 확인하려면 Playback > Play Around/To > Play Around Current Frame 순으로 
선택하거나, [/] 키를 누르세요.

[,(콤마)] 그리고 [.(마침표)] 키를 누르면 원하는 지점을 찾아 계속해서 조절할 수 있습니다. 

슬립 편집하기 
타임라인 편집 작업에서 항상 클립의 길이만 조절하는 것은 아닙니다. 간혹 현재 타임라인에 있는 
소스 클립의 앞부분 또는 뒷부분이 필요할 수도 있습니다. 타임라인에 이미 위치한 클립의 길이는 
변경하지 않고 클립의 범위만 변경하는 것이죠. 이러한 편집 작업을 슬립 편집이라고 합니다.

1 Viewer > Zoom > Zoom to Fit 순으로 선택하거나, [Shif+Z] 키를 함께 누르면 전체 타임라인으로 
영상을 볼 수 있습니다.

2 01_A380_TAXI 클립에 플레이헤드를 이동합니다.
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3 스페이스 바를 눌러 10_MALDIVES 클립이 나타나면 재생을 멈추세요.

02_A380_TAKEOFF 클립이 약간 느리게 나타나고 비행기가 프레임에서 사라지기도 전에 
클립이 끊기는 것을 볼 수 있습니다. 클립의 처음과 마지막 부분을 수정하여 이를 보정할 수 
있을까요? 물론입니다. 하지만, 슬립 도구를 사용하면 같은 보정 작업도 훨씬 신속하게 수행할 
수 있습니다.

4 02_A380_TAKEOFF 클립 위에 플레이헤드를 놓고 툴바의 줌 슬라이더를 드래그해 타임라인 창 
가운데 A380 클립이 확대되어 나타나고 양쪽 끝에 다른 두 개의 클립이 보이도록 조정하세요.

5 트림 에딧 모드 버튼을 클릭하거나 [T] 키를 누르세요.

리플 트림과 롤 트리밍 편집을 오가며 작업할 때와 마찬가지로 슬립 커서 선택 시 마우스 
포인터의 위치가 중요합니다.

6 02_A380_TAKEOFF 클립의 중간 위쪽으로 마우스 포인터를 이동하세요.

커서가 슬립 커서로 변경됩니다. 슬립 커서의 위치를 맞추면 슬립 편집 사용의 준비가 완료됩니다.

7 뷰어의 오른쪽 상단 화면에서 비행기가 프레임 밖으로 완전히 나갈 때까지 클립을 왼쪽으로 
드래그하여 슬립 편집을 수행합니다.
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이를 드래그하면 마지막 프레임과 재생될 프레임을 모두 비교할 수 있도록 뷰어가 4개의 분할 
화면으로 나타납니다. 상단에 위치한 두 개의 프레임은 슬립 편집하는 클립의 시작 프레임과 
마지막 프레임을 보여줍니다. 왼쪽 하단에 있는 프레임은 이전 클립의 끝 프레임을 보여주고 
오른쪽 하단에 있는 프레임은 다음 영상의 시작 프레임을 보여줍니다. 4분할 화면을 통해 세 
가지 클립의 액션을 비교하고 매칭시키면서 슬립 편집을 수행할 수 있습니다. 

참고 설정창 환경 설정 및 화면 크기에 따라 클립 드래그를 멈추고 마우스 
위치를 재설정한 다음에 다시 드래그해야 할 수도 있습니다.

비행기가 프레임 밖으로 완전히 사라지며 이륙하는 모습이 완성되어 영상이 더욱 자연스러워 
졌습니다.

8 슬립 편집한 클립 앞에 플레이헤드를 놓고 타임라인을 재생하여 영상을 확인하세요.

이전보다는 향상되었지만 비행기가 사라지는 프레임 다음에 몰디브 장면이 바로 나타나는 
것을 수정하면 좋을 것 같습니다. 비행기가 사라진 다음의 프레임 5개를 추가할 필요가 있습니다.

클립에서 슬립 도구를 한번 클릭하면 그 다음부터는 키보드 단축키를 사용해 좌/우로 1프레임 
또는 5프레임씩 슬립 편집할 수 있습니다.

9 [shift] + [,] 키를 눌러 5프레임씩 슬립 편집하세요.

10 슬립 편집한 클립 앞에 플레이헤드를 놓고 타임라인을 재생하여 편집한 영상을 확인하세요.

영상이 마음에 들면 그대로 둡니다. 다음 장면으로 바로 넘어가는 것보다는 어느 정도의 ‘추가 
프레임’이 필요하겠다는 생각이 들면 키보드 단축키를 사용하여 다시 조정하세요.

11 작업을 완료하면 툴바에서 셀렉션 모드 도구를 선택하거나 [A] 키를 누르세요.

슬립 편집 방식은 대부분 방금 작업한 것보다 더욱 미묘한 조절이 가능합니다. 클립을 완벽하게 
맞추기 위해 조금씩 프레임을 움직이는 슬립 편집은 자주 사용하는 편집 기능입니다.



119

셀
렉

션
 도

구
를

 사
용

해
 빈

 공
간

 만
들

기

셀렉션 도구를 사용해 빈 공간 만들기
1과에서처럼 트리밍 작업으로 기본 설정되어 있는 셀렉션 모드 도구를 사용할 수도 있습니다. 클립의 
길이를 줄이면 리플 트리밍되지 않고 빈 공간이 생기며 클립의 길이를 늘리면 다음 클립 위에 
덮어씁니다.

1 Viewer > Zoom > Zoom to Fit 순으로 선택하거나, [Shif+Z] 키를 함께 누르면 전체 타임라인으로 
영상을 볼 수 있습니다.

2 08_SOUTH_POLE 클립 시작점에 플레이헤드를 놓으세요.

3 스페이스 바를 눌러 05_BAY_AREA_LIGHTS 클립이 나타날 때까지 재생하세요.

06_MILKYWAY 클립은 길이가 길어서 짧게 줄이는 것이 좋습니다. 새로운 클립을 06_MILKYWAY 
클립 위에 덮어쓰기 할 수도 있지만, 대부분의 경우 이러한 편집 방식은 부적절합니다. 예를 
들면 해당 클립을 아직 불러오기 하지 않았거나 어떤 클립을 사용할지 아직 결정하지 않았을 
수 있기 때문입니다. 그럼에도 불구하고 클립의 길이를 줄이고 빈 공간을 남겨 표시하고 싶을 
수도 있습니다. 이유가 무엇이든 간에 빈 공간 생성 기능은 셀렉션 모드 도구로 적용할 수 있는 
중요 트리밍 기능입니다.

4 06_MILKYWAY 클립 중간에 플레이헤드를 놓으세요.

5 툴바에 있는 줌 슬라이더를 드래그하여 화면에 나타나는 클립 크기를 증가시키세요.

6 06_MILKYWAY 클립 시작점에 마우스 포인터를 두세요.
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리플 트림 커서와 비슷한 모양의 크기 조절 트림 커서가 나타납니다. 모양은 비슷해도 서로 
다른 기능을 가집니다.

7 도구에 +4:00이 나타날 때까지 06_MILKYWAY 클립의 시작점을 오른쪽으로 드래그하세요.

트림 에딧 도구가 리플 트림 도구와 다른 점은 셀렉션 모드 도구를 사용해 한쪽 면을 트리밍할 
경우 빈 공간이 생기는 것입니다.

빈 공간 표시하기
프로그램에 빈 공간 남겨둘 수는 없으므로 클립 사이마다 생기는 빈 공간을 채워줘야 합니다. B-Roll 
빈에서 이러한 공간을 채울 클립을 찾아보겠습니다.

1 Workspace > Reset UI Layout 순으로 선택하면 미디어 풀과 소스 뷰어가 화면에 나타납니다.

2 B-Roll 빈에서 07_Kenya 클립을 더블 클릭하여 뷰어에 로딩하고 스페이스 바를 눌러 클립을 
재생하세요.
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빈에 사용하지 않은 유일한 클립인 07_KENYA 클립이 빈 공간에 사용하기 가장 적당합니다.

3 소스 뷰어에서 조그바를 드래그하여 수면 위에 비치는 비행기의 모습이 수직으로 되면 멈추세요.

이곳을 인 포인트로 표시하세요.

4 [l] 키를 눌러 소스 클립에 인 포인트를 표시합니다.

타임라인에 있는 빈 공간을 클립으로 채워질 특정 부분이므로 소스 클립에 아웃 포인트를 따로 
설정할 필요는 없습니다. 하지만, 빈 공간의 크기에 따라 타임라인에는 인/아웃 포인트 표시가 
필요합니다.

5 플레이헤드를 해당 빈 공간의 시작점에 드래그하세요.

플레이헤드를 이동해서 인 포인트를 표시하고 다시 플레이헤드를 옮긴 다음, 아웃 포인트를 
표시하는 대신 Mark Clip 명령어를 사용해 클립 속 플레이헤드가 위치한 곳을 표시할 수 
있습니다.

6 Mark > Mark Clip 순으로 선택하거나, [X] 키를 누르세요.
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Mark Clip 명령어는 타임라인에 인/아웃 포인트를 추가했지만, A1의 오디오 트랙을 사용하여 
클립 길이를 표시했습니다. 오디오 트랙은 무시하고 빈 공간으로 남겨 놓아야 하는데요, 이는 
자동 선택의 또 다른 사용 사례입니다. 트리밍 작업 시 트랙을 동기화시키고 클립의 특정 범위를 
제거할 때에도 4과에서 작업한 것과 마찬가지로 트랙을 확인해 줍니다. 여기서 자동 선택 기능은 
인/아웃 포인트를 설정할 때 Mark Clip 명령어가 적용될 트랙을 지정하도록 합니다.

7 타임라인 헤더에서 Audio 1과 Audio 2에 해당하는 오디오 선택 버튼 기능을 해제하고 자동 
선택 버튼은 활성화된 상태로 두세요.

8 Mark > Mark Clip 순으로 선택하거나, [X] 키를 누르세요.

정보 여러 개의 비디오 트랙에 자동 선택 기능이 활성화되어 있는 경우 가장 
낮은 숫자의 비디오 트랙이 대상 트랙이 됩니다.

Video 1에 자동 선택 기능이 활성화되어 있어 Mark Clip 명령어 기능이 빈 공간을 사용해 
인/아웃 포인트를 정확하게 설정합니다. 이제 편집 작업만 하면 됩니다.

9 07_KENYA 클립을 편집하기 위해 도구바에서 덮어쓰기 버튼을 클릭합니다.
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이는 5과에서 가장 먼저 다뤘던 트리밍 기능이 타임라인 시작점과 클립 시작점 사이에 빈공간을 
생성하는 것과 유사하며 반드시 숙지해야 하는 가장 기본적인 속성입니다.

복습하기
1 Trim Start 또는 Trim End 사용 시 트랙에는 해당 기능을 적용하지 않으려면 어떻게 해야 하나요?

2 사용자 지정 레이아웃 프리셋의 저장 기능은 어떤 메뉴에서 찾을 수 있나요?

3 트랜지션 트리밍 작업에서 타임라인 뷰어에 2-Up 화면 분할 모드 사용 시 주요 기능은 무엇인가요?

4 롤 트리밍과 리플 트림 기능의 차이점은 무엇인가요?

5 타임라인 속 클립을 더블 클릭하면 인/아웃 포인트 조절 시 타임라인에도 변경 사항이 적용되나요?
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1 타임라인 헤더에서 해당 트랙의 자동 선택 버튼 기능을 해제합니다.

2 Workspace 메뉴에서 레이아웃 프리셋을 저장할 수 있습니다.

3 2-Up의 왼쪽 화면에는 이전 영상의 끝 프레임이 나타나고, 오른쪽 화면에는 다음 영상의 시작 
프레임이 나타납니다.

4 롤 트리밍은 트림 포인트를 가진 두 개의 클립 길이를 조절하고, 리플 트림은 트리밍을 위해 
선택한 한쪽 면의 클립 길이만 조절됩니다.

5 네. 이를 소스 트리밍이라고 합니다.
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트랜지션 및 효과 
적용하기 

한 장면을 위한 기본적인 토대가 완성되면 
다양한 그래픽과 효과를 추가하여 지금까지와는 
차원이 다른 수준의 창의성을 발휘할 수 있습니다. 
제작 중인 프로그램 종류에 관계 없이 간단한 
크로스 페이드에서 놀라운 모핑 트랜지션에 
이르는 다양한 효과를 추가할 수 있습니다. 
수많은 효과들이 굉장히 미묘하고 때로는 눈에 
띄지 않기도 하지만 어떤 효과는 주의를 
사로잡습니다. 이번 과에서는 DaVinci Resolve 
15의 도구를 샘플로 사용하여 Edit 페이지에서 
시각적으로 흥미로운 요소를 생성해 보겠습니다. 
하지만 트랜지션 및 효과를 추가하는 개념을 
이해하면서 스스로 자신감 있게 배워나가는 
것이 더욱 중요합니다.

예상 소요 시간

이 과를 학습하는 데는 약 50분 
정도의 시간이 소요됩니다.

학습 목표

클립 페이드 인/페이드 아웃하기 126

크로스 디졸브 추가하기 127

트랜지션 사용자 지정하기 130

커스텀 프리셋 저장하기 131

이펙츠 라이브러리에서 트랜지션 및 
필터 적용하기 133

숏 리프레이밍하기 137

렌더링 및 백그라운드 캐싱 142

일정 속도로 재생 속도 변경하기 144

복습하기 149
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클립 페이드 인/페이드 아웃하기
대부분의 프로그램들이 페이드 트랜지션(페이드 인) 기법을 사용하여 시작한 다음 페이드 아웃 
기법으로 마무리됩니다. 페이드 기법에는 두 가지 요소가 함께 사용됩니다. 한 요소는 비디오 클립이고 
다른 하나는 완전히 검은 프레임인데, DaVinci Resolve에서는 검은 프레임 대신 타임라인의 빈 
공간을 사용합니다.

1 먼저 Age of Airplanes 프로젝트를 실행하세요.

2 Rough Cuts 빈에서 Transitions and FX 러프 컷을 더블 클릭하세요.

이번 과에서는 비디오 트랙을 변경해볼 예정이기 때문에 레이아웃을 필요에 맞게 조정할 수 
있습니다.

3 Workspace > Layout Presets > Big Trim > Load Preset을 선택하여 이전에 생성한 레이아웃을 
사용할 수 있습니다. 

타임라인 보기를 사용자 지정해 오디오 트랙은 작게 보이고 비디오 트랙은 크게 보이도록 
합니다.

4 Timeline View Options 메뉴를 클릭하세요.

5 Track Height의 Audio 슬라이더를 맨 왼쪽으로 드래그하세요.

6 Track Height의 Video 슬라이더를 중간쯤에 두고 Timeline View Options 버튼을 다시 누르면 
해당 옵션이 감춰집니다.

7 플레이헤드를 타임라인의 시작 부분으로 가져가세요.

8 이 트레일러를 재생하려면 아주 짧은 페이드 인 효과를 추가해야 합니다.
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9 타임라인에 있는 01_shoot the real world 클립 위로 포인터를 가져가세요.

오디오 클립과 마찬가지로 클립의 좌측 상단 또는 우측 상단에 두 개의 비디오 페이드 핸들이 
나타납니다.

10 클립 시작 지점에서 시작해 도구 끝 부분에 +00:10이 나타날 때까지 핸들을 클립 중간 지점으로 
드래그하세요. 

이제 시작 부분에 10 프레임의 페이드 인 효과가 추가되었습니다.

11 타임라인 시작 부분을 재생하여 적용된 페이드 효과를 감상할 수 있습니다.

정보 클립 시작 부분에서부터 페이드 인 효과를 끝내고자 하는 지점까지 
플레이헤드를 드래그할 수 있습니다. 그런 다음 Trim 메뉴에서 Fade In to Playhead
를 선택하세요.

페이드 핸들을 조절하면 페이드 인/페이드 아웃 효과를 쉽고 빠르게 삽입 및 조정할 수 있습니다.

크로스 디졸브 추가하기
트랜지션이란 한 숏의 끝부분에서 다른 숏의 시작 부분으로 서서히 옮겨가는 효과를 말합니다. 
영상을 꼼꼼히 보지 않았더라도 수많은 TV 프로그램 및 영화를 통해 자주 봐왔을 것입니다. 가장 
흔한 영상 트랜지션이 바로 크로스 디졸브라는 기법으로, 한 클립의 마지막 부분이 다음 클립의 
시작 부분과 겹쳐집니다. 크로스 디졸브를 가장 신속하게 추가할 수 있는 방법은 바로 타임라인에서 
이를 직접 생성하는 것입니다.

1 타임라인에서 첫 번째 빨간 마커를 찾으세요.
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2 먼저 08_SOUTH_POLE_DC3 클립을 재생하고 그 다음 07_KENYA를 재생하세요.

이 두 개의 클립을 매끄럽게 섞어볼 겁니다. 기본 설정인 크로스 트랜지션을 추가합니다.

3 줌 슬라이더를 드래그해 작업하게 될 클립에 줌 인 기능을 적용하세요.

정보 가운데 마우스 버튼으로 타임라인에서 팬 기능을 사용할 수 있습니다.

4 롤링 트리밍을 실행하려면 마우스 포인터를 08_SOUTH_POLE_DC3와 07_KENYA 클립이 
만나는 지점으로 직접 가져가세요.

5 포인터가 롤링 트림 커서로 변할 때 마우스를 클릭해 선택하세요.

녹색의 롤링 트리밍 핸들이 편집 포인트 양쪽에 나타납니다.

6 Timeline > Add Transition을 선택하거나 [Cmd] + [T] 키(macOS) 또는 [Ctrl] + [T] 키(Windows)를 
누르세요.

1초간 지속되는 디졸브 효과가 편집 포인트에 추가됩니다.

정보 User Preferences 창의 편집 카테고리에서 기본 설정된 트랜지션 길이를 
변경할 수 있습니다.
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트랜지션을 생성하면 두 개의 클립 프레임이 겹쳐집니다. 즉, 트랜지션 프레임 절반은 이전 
클립의 사용되지 않는 클립의 프레임 부분이고, 나머지 절반은 다음 영상 클립의 절반으로 
이루어집니다. 5과에서 트리밍 작업에 사용한 두 개의 비디오 핸들로 이제 클립을 늘려 트랜지션을 
완성할 수 있습니다.

7 두 개의 클립을 재생해 디졸브 트랜지션 효과를 확인하세요.

정보 트랜지션을 제거하려면 줌인하고 셀렉션 도구로 해당 트랜지션을 선택한 
다음 [Delete] 키를 누르세요.

트랜지션 축소 및 확장
1초로 기본 설정된 디졸브 트랜지션의 길이가 모든 장면에 완벽하게 맞아 떨어지면 좋겠지만  
실상은 그렇지 않습니다. 일부 움직임이 잘려 나가거나 클립을 너무 연장해 이전에는 나타나지 
않았던 카메라의 흔들림이 보일 수도 있습니다. 이유가 어쨌든 간에 어떤 상황에서는 디졸브 
트랜지션의 지속 시간을 바꿔야 할 수도 있습니다. 가장 쉽고 빠른 방법은 타임라인에서 드래그하는 
것입니다.

1 마우스 포인터를 08_SOUTH_POLE_DC3와 07_KENYA 클립의 디졸브 트랜지션 우측 
가장자리로 가져가세요.

2 도구 끝부분에 -00:06이라는 숫자가 나타날 때까지 우측 가장자리 부분을 편집 포인트 쪽으로 
드래그하세요.

가장자리를 드래그하면 트랜지션 양쪽에서 각각 6 프레임씩 줄어들어 총 12 프레임이 감소됩니다. 
디졸브 트랜지션은 두 클립이 만나는 중앙 지점에 조절되기 때문에 트랜지션을 얼마나 짧게 
줄이는지에 관계없이 양쪽 끝에서 동일한 개수의 프레임이 삭제됩니다. 그럼 트랜지션은 얼마나 
길게 만들 수 있을까요? 이는 빈에 있는 두 개의 소스 클립 길이에 따라 달라집니다.

트랜지션에 사용된 프레임

이전 클립 이전 클립 핸들편집 포인트

다음 클립다음 클립 핸들
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3 선택한 편집 영상이 더 이상 연장되지 않을 때까지 우측 가장자리 부분을 오른쪽으로 드래그하세요.

트랜지션이 거기까지만 연장되는 이유는 트랜지션을 더 길게 생성할 수 있는 미디어가 없어 클립의 
핸들 중 하나가 결국 끝나버리기 때문입니다.

트랜지션 사용자 지정하기
각 트랜지션은 파라미터를 통해 사용자가 원하는 대로 모양을 조정할 수 있습니다. 크로스 디졸브처럼 
간단한 트랜지션은 와이프 트랜지션과 같이 특별한 트랜지션에 비해 조절 가능한 파라미터가 많지 
않습니다. 사용자 지정 컨트롤은 항상 인스펙터에 나타납니다.

1 Cross Dissolve 트랜지션을 더블 클릭하면 인스펙터 창에 해당 트랜지션이 나타납니다.

정보 트랜지션을 선택하기 어려울 경우엔 줌 슬라이더로 타임라인을 확대하면 
어렵게 컷 포인트를 선택할 필요 없이 트랜지션 아이콘을 선택할 수 있습니다.

인스펙터 창에 트랜지션을 위한 파라미터가 나타납니다. 윗부분에는 모든 트랜지션에서 자주 
사용되는 파라미터가 나타납니다. 길이(Duration), 정렬(Alignment), 트랜지션 종류(Transition 
Style) 옵션이 포함되어 있습니다. 아랫부분에는 현재 선택한 트랜지션을 위한 파라미터만 
나타납니다. 

2 정렬(Alignment) 옵션은 Start On Edit을 선택하세요.
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이전에는 디졸브 트랜지션이 편집 포인트 앞쪽에서 시작했지만 이제는 편집 포인트에서 
시작됩니다. 

3 Cross Dissolve의 Style 옵션은 Film을 선택하세요. 

Style 메뉴에서 다양한 Cross Dissolve 스타일을 고를 수 있습니다. Film 디졸브 트랜지션에서는 
필름을 위해 광학적으로 생성된 디졸브의 미묘한 밝기와 가속 반응이 연출됩니다. Ease In & 
Ease Out 가속화 기능을 선택해 가속 커브를 더 높일 수도 있습니다.

4 Ease 메뉴에서 In & Out을 선택하면 부드러운 트랜지션이 생성됩니다.

5 수정된 필름 디졸브 효과를 재생해 변경 사항을 확인하세요. 

이제 트랜지션을 사용자 지정했으니 이를 저장해 반복적으로 사용하는 방법에 대해 알아보겠습니다. 

커스텀 프리셋 저장하기
트랜지션을 사용자 지정한 후에 해당 트랜지션과 변경 사항을 Effects Library에 저장하면 향후 
새로운 프로젝트에도 사용할 수 있습니다.

6 타임라인에서 사용자 지정된 Cross Dissolve 트랜지션을 우클릭하세요.

7 팝업 메뉴에서 Create Transition Preset을 선택하세요.
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8 Transition Preset 창에서 Cinema Dissolve라는 이름을 입력한 다음 OK를 클릭하세요.

저장된 프리셋은 Effects Library에 보관됩니다.

9 인터페이스 툴바의 좌측 상단에 있는 Effects Library 버튼을 클릭하세요.

Effects Library에는 모든 트랜지션과 타이틀, 필터 효과 정보가 담겨 있습니다. 좌측에 있는 
카테고리를 통해 원하는 효과 유형을 쉽게 찾을 수 있습니다.

10 사이드 바에서 Video Transitions 카테고리를 선택하세요.

모든 커스텀 프리셋은 User 섹션에 있는 Effects Library 하단에 있습니다. 아이콘에 노란색 
하이라이트가 표시되어 쉽게 식별할 수 있습니다. 

11 Effects Library를 아래쪽으로 스크롤해 저장된 프리셋을 검색하세요.

저장된 프리셋을 프로그램의 대표 트랜지션으로 사용하고자 할 경우 이를 표준 트랜지션으로 
지정할 수 있습니다. 표준 트랜지션은 Timeline > Add Transition 메뉴나 키보드 단축키를 통해 
추가할 수 있어 편리합니다.

12 Effects Library에서 저장된 프리셋을 우클릭한 다음 Set As Standard Transition을 선택하세요.

새로운 표준 트랜지션 이름 좌측에 빨간색 태그가 나타나 해당 트랜지션이 표준 트랜지션임을 
알려줍니다. 이제 해당 트랜지션은 이 시스템에서 생성되는 모든 프로젝트의 표준 트랜지션으로 
설정되었습니다.
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이펙츠 라이브러리에서 트랜지션 및 
필터 적용하기
DaVinci Resolve는 시각적으로 굉장히 독특한 유형의 다양한 트랜지션을 지원합니다. 다른 
트랜지션들이 디졸브 트랜지션만큼 이야기를 만들어 가는 데 유용하지는 않을 수 있지만, 특정 
상황에서는 굉장히 유용합니다. 다른 종류의 트랜지션은 자주 사용되지 않기 때문에 키보드 단축키를 
사용하는 대신 Effects Library에서 직접 추가하게 됩니다.

1 플레이헤드를 두 번째 인터뷰 클립의 점프컷에 놓으세요. 

2 [/] 키를 누르면 편집 포인트 주변부가 재생됩니다.

이는 인터뷰 영상에서 기존에 의도치 않게 생성된 점프컷입니다. 이제 Smooth Cut이라 불리는 
독특한 트랜지션을 사용해 이 문제를 해결해 보겠습니다.

3 Effects Library 상단에 있는 검색 버튼을 클릭하세요.

긴 트랜지션 또는 필터 목록을 검색하는 대신 원하는 효과의 이름을 직접 검색할 수 있습니다.

4 검색 필드에서 Smooth를 입력한 다음 [return] 키를 누르면 Smooth Cut 트랜지션이 나타납니다.

5 Effects Library의 Smooth Cut 트랜지션을 타임라인에 있는 점프컷 위로 드래그하세요.

6 트랜지션 커서가 영상이 만나는 지점 한가운데 왔을 때 마우스 버튼에서 손을 떼세요.

Smooth Cut은 두 영상이 만나는 지점을 매끄럽게 연결하는 정교한 트랜지션입니다. 점프컷이 
정교할 경우 Smooth Cut을 사용해 마치 하나의 이어진 숏처럼 보이게 만들 수도 있습니다. 
대략 3~4개 프레임 정도의 아주 짧은 길이에서 최상의 결과물을 얻을 수 있습니다. 
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7 Smooth Cut이라는 이름이 선명하게 보일 때까지 타임라인을 확대하세요.

8 마우스 포인터를 하이라이트된 Smooth Cut 박스 우측 가장자리로 가져가세요.

9 끝부분에 -00:09와 00:04 사이의 숫자가 나타날 때까지 드래그하세요.

10 타임라인을 재생해 수정된 점프컷을 확인할 수 있습니다.

혹시 편집한 인터뷰 영상을 하나의 연속적인 장면으로 만들 경우 윤리적인 문제가 발생하지는 
않을까요? 이 항공 관련 영상을 통해서 도덕적인 딜레마에 빠질 가능성은 없지만 작업하는 각 
프로젝트를 잘 파악해야 합니다.

필터 효과 적용하기
Effects Library에는 독특한 시각 효과를 생성하는 필터 효과도 포함되어 있어 자주 발생하는 시각 
관련 문제를 해결할 수 있습니다.

1 [shift]키와 [Z]키를 함께 누르면 전체 타임라인이 나타납니다.

2 05_BAY_AREA_LIGHTS 클립 맨 마지막에 있는 빨간색 마커에 이를 때까지 [shift]키와 아래 
화살표 키를 함께 누르세요.

위 클립은 채도가 약간 낮아 틸트 쉬프트 렌즈로 촬영했다면 훨씬 보기 좋았을 것입니다. 
다행히도 DaVinci Resolve에는 Tilt-Shift Blur 필터가 내장되어 있어 렌즈를 사용한 것 같은 
효과가 연출됩니다.

3 Effects Library에서 검색 필드 우측에 있는 클리어 버튼을 눌러 검색 내용을 지우세요.
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4 사이드 바 카테고리 목록에서 OpenFX를 선택한 다음 검색 필드에서 Tilt를 입력하세요.

5 Tilt-Shift Blur 필터를 타임라인에 있는 05_BAY AREA LIGHTS 클립 위로 드래그하세요.

그러면 Tilt-Shift Blur 필터가 추가됩니다. 하지만 무료 버전의 DaVinci Resolve를 사용 중일 
경우 Studio 버전에서만 사용 가능한 효과라는 표시가 대화 상자에 나타납니다.

편집 결과물에 워터마크가 나타날 수는 있지만 업그레이드하지 않고 작업을 계속 이어갈 수 
있습니다. 

6 계속하려면 Not Yet을 클릭하세요. Inspector에는 사용자가 원하는 영상룩으로 설정하기 위한 
다양한 파라미터가 있습니다.

7 타임라인에서 05 BAY AREA LIGHTS 클립을 선택한 다음 인터페이스 우측 상단에 있는 
인스펙터 버튼을 누르세요.

클립에 필터 효과를 추가하면 인스펙터 창의 표준 Video 탭 옆에 OpenFX 탭이 나타납니다.
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8 인스펙터 상단에 있는 OpenFX 탭을 클릭하세요.

정보 파라미터 하나 또는 전체 효과를 재설정하려면 인스펙터 오른쪽에 있는 
원형 모양의 Reset 버튼을 클릭하세요.

인스펙터에 있는 해당 효과를 비활성화하면 필터가 적용된 숏을 원본과 신속하게 비교할 수 
있습니다.

9 인스펙터 상단의 필터명 왼쪽에 있는 빨간색 버튼을 클릭해 해당 효과를 비활성화하세요.  
이 버튼을 다시 한 번 누르면 효과가 활성화됩니다. 

 

무료 버전의 DaVinci Resolve를 사용 중인 경우에는 타임라인에서 해당 효과를 제거할 수 
있습니다.

10 인스펙터 상단에 있는 휴지통 아이콘을 클릭하세요.

효과의 사용이 항상 좋은 결과를 만들어내는 것은 아닙니다. 이야기를 효과적으로 전달하기 위해 
효과를 최대한 많이 또는 최대한 적게 사용할 수 있습니다. 결국 결과물에 영향을 미치기 때문에 
적용하려는 효과가 이야기의 분위기와 잘 어울리는지 항상 확인하는 것이 좋습니다. 시청자의 
주의를 올바른 방향으로 이끄는지 말이죠. 그렇다고 생각되면 해당 효과를 적용하세요. 결국 작업을 
진행하는 사람의 미적 감각이 결정하는 부분입니다.

서드파티 효과 플러그인 사용하기 

크로스 플랫폼을 지원하는 OpenFX는 DaVinci Resolve 및 Fusion뿐 아니라 다른 
여러 응용 프로그램에서도 사용되는 표준 효과 플러그인입니다. Boris FX Continuum과 
Red Giant Universe, Re:vision Effects’ ReelSmart Motion Blur 등의 인기 플러그인 
패키지를 DaVinci Resolve에 추가할 경우 DaVinci Resolve의 표준 도구로는 구현하기 
힘든 다양한 스타일을 연출할 수 있습니다. 이러한 플러그인은 Effects Library에서 다른 
항목을 적용하는 것과 동일한 방식으로 적용됩니다. 

플러그인의 설치 및 라이센스 관리는 각 제조업체의 설치 프로그램으로 운영됩니다. 
설치가 끝나고 나면 OpenFX 플러그인이 Effects Library와 OpenFX 카테고리에 
나타납니다.
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숏 리프레이밍하기
대부분의 경우 16×9 종횡비를 사용하는 HD 또는 UHD 프로젝트 영상을 편집하게 됩니다. 하지만 
때때로 다른 종횡비를 사용해 프로그램을 편집 및 확인해야 할 수도 있습니다. 이 경우 Output 
Blanking 메뉴를 사용하면 됩니다.

1 Timeline > Output Blanking > 2.39를 선택하세요.

극장 와이드 스크린 35mm에 사용되는 2.39:1 종횡비가 뷰어에 적용됩니다.

정보 Output Blanking 메뉴에서 마스크를 생성하는데 사용하는 컨트롤은 컬러 
페이지의 Sizing 팔레트 중 Output Sizing 모드에서 찾을 수 있습니다.

Output Blanking 기능은 클립에서 감춰진 부분을 제거하는 게 아니라 가리는 방법을 사용하기 
때문에 클립을 새로운 종횡비에 더욱 잘 들어맞게 리프레이밍 할 수 있습니다.

2 플레이헤드를 첫 번째 인터뷰 숏 위로 옮긴 다음 타임라인에서 해당 클립을 선택하세요.

그러면 인스펙터에 선택한 클립을 위한 비디오 탭 컨트롤이 나타납니다. 해당 컨트롤에는 
일반적인 Zoom, Position, Rotation Angle, Crop 파라미터가 포함되어 있습니다.

뷰어에서 피사체를 아래쪽으로 이동하면 헤드룸을 더욱 확보할 수 있어 좀 더 만족스러운 합성 
결과를 얻을 수 있습니다.

3 마우스 포인터를 Position Y 숫자 필드 위로 가져가세요.

모든 숫자 입력란은 설정값을 드래깅하여 조절할 수 있는 가상 슬라이더를 지원합니다..

4 Y Position 숫자 입력란에서 설정값이 -70.00이 될 때까지 왼쪽으로 드래그하세요.
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이는 피사체에 더 적합한 위치 설정값입니다. 해당 설정을 나머지 인터뷰 숏에도 복사해 적용해야 
합니다.

5 Edit > Copy로 이동하거나 [Cmd] + [C] 키(macOS) 또는 [Ctrl] + [C] 키(Windows)를 누르세요.

6 타임라인에서 오른쪽에 있는 다음 인터뷰 클립을 선택하세요. 그런 다음, [Cmd] 키(macOS) 또는 
[Ctrl] 키(Windows)를 누른 상태에서 남아 있는 두 개의 인터뷰 클립을 클릭하여 선택합니다.

7 Edit > Paste Attributes 순으로 선택하거나, [Option] + [V] 키(macOS) 또는 [Alt] + [V] 키(Windows)를 
누르면 Paste Attributes 창이 나타납니다. 

8 Video Attributes 카테고리에서 Position 확인란을 선택한 다음 Apply를 클릭하세요.

첫 번째 인터뷰 클립에 적용된 위치 조정값이 선택한 인터뷰 클립에도 동일하게 적용되었습니다.

온스크린 컨트롤 사용하기
인스펙터에 있는 가상 슬라이더를 드래그하는 것이 아니라 뷰어에 있는 온스크린 컨트롤을 사용해 
위치, 크기, 회전 등의 자주 사용하는 변형 효과를 적용할 수 있습니다. 뷰어에서 숏을 리프레이밍 
해보겠습니다.

1 05_BAY_AREA_LIGHTS 클립 맨 마지막에 있는 빨간색 마커에 이를 때까지 [shift] 키와 아래 
화살표 키를 함께 누르세요.

이 클립은 크레딧이 나오기 전 영상이 끝나가고 있음을 암시하는 마지막 클립이기 때문에 풀 
백 및 풀 어웨이 카메라 기법을 사용해보겠습니다. 먼저 온스크린 컨트롤을 사용해 클립 크기를 
조금 크게 조정하겠습니다.
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2 타임라인에서 05 BAY AREA LIGHTS 클립의 앞쪽 절반 부분을 선택한 다음 플레이헤드를 그 
위로 가져가 뷰어에서 클립을 확인하세요.

3 뷰어 좌측 하단에서 타임라인 뷰어 팝업 메뉴를 클릭한 다음 Transform을 선택하세요.

뷰어에 프레임 크기와 위치를 보여주는 사각형의 경계선이 나타납니다.

4 클립 크기를 변경하려면 사각형 경계선 끝에 있는 핸들 중 하나를 클릭한 다음 줌 설정값이 
1.200으로 나타날 때까지 안에서 바깥 방향으로 드래그하세요.

Zoom X 및 Zoom Y는 서로 연결되도록 기본 설정되어 있기 때문에 사이즈를 조정하면 클립의  
X와 Y값이 동일하게 조정되어 종횡비가 그대로 유지됩니다.

정보 뷰어 좌측 상단의 배율 메뉴를 통해 뷰어에 나타나는 프레임 크기를 
변경할 수 있습니다.

5 뷰어 좌측 하단에서 크기 변형을 위한 사각형 아이콘을 클릭하면 온스크린 컨트롤이 사라집니다.
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크기 조절 애니메이션
두 개의 키프레임을 설정하면 인스펙터에 있는 거의 모든 파라미터에 애니메이션 기능을 적용할 
수 있습니다. 크기를 조정한 현재 프레임을 시작 키프레임으로 사용하고 새로운 키프레임은 클립 
끝부분에 설정하세요.

1 플레이헤드를 05 BAY AREA LIGHTS 클립이 시작하는 지점으로 가져가세요.

2 클립을 선택하면 인스펙터에 컨트롤이 나타닙니다.

이미지의 파라미터에 애니메이션 효과를 주려면 키프레임을 설정해야 합니다. 키프레임을 통해 
각기 다른 파라미터 설정값을 특정 프레임에 지정할 수 있습니다. 그러면 DaVinci Resolve에서 
두 설정값을 보간해 부드러운 애니메이션 효과를 생성합니다.

이미 클립 크기를 키웠으므로 이제 크기를 줄이고자 하는 부분으로 플레이헤드를 가져가세요.

3 플레이헤드를 05 Bay Area Lights 클립 1/3 지점으로 가져가세요.

이곳이 바로 프레임의 크기를 줄여야 하는 지점으로 여기에 키프레임을 추가해야 합니다.

4 인스펙터에서 Zoom X 및 Zoom Y 숫자 입력란 오른쪽에 있는 줌 키프레임 버튼을 클릭하세요.

파라미터에 애니메이션 효과를 적용하려면 각각의 프레임에 최소 두 가지의 설정값을 설정해야 
합니다. 이제 애니메이션의 시작 부분에 나타날 첫 번째 키프레임이 설정되었습니다. 그런 다음 
이미지의 크기 변화가 멈추는 지점을 위한 두 번째 설정값을 설정해야 합니다.

5 타임라인에서 05 Bay Area Lights 클립 2/3 지점으로 플레이헤드를 가져가세요.

DaVinci Resolve에서는 자동 키프레임 모델을 사용합니다. 파라미터의 첫 번째 키프레임이 
이미 설정된 경우 플레이헤드의 위치를 변경한 다음 파라미터를 조정하면 두 번째 키프레임이 
자동 추가됩니다.

6 커서를 Zoom X 숫자 입력란으로 가져간 다음 설정값이 1.0으로 재설정될 때까지 오른쪽으로 
드래그하세요.

7 [/] 키를 누르면 현재 선택된 클립 주변부가 재생됩니다.

타임라인에서 키프레임과 커브 에디터를 사용해 키프레임의 위치와 효과의 부드러움 정도를 
세부 조정할 수 있습니다.

8 타임라인을 확대하면 05 BAY AREA LIGHTS 클립을 좀 더 선명하게 볼 수 있습니다.
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9 클립을 선택한 상태에서 타임라인 세그먼트 우측 하단에 있는 다이아몬드 모양의 키프레임 
버튼을 클릭하세요.

키프레임 트랙에는 각 키프레임을 나타내는 작은 흰색 점들이 포함되어 있습니다. 이 흰색 점을 
드래그하면 해당 키프레임의 위치가 변경됩니다.

10 키프레임 버튼 왼쪽에 있는 커브 에디터 버튼을 클릭하세요.

클립 하단에 커브 에디터가 나타납니다.

커브 에디터에 있는 흰색 점은 키프레임을 나타냅니다. 커브 에디터 상단에 있는 버튼을 통해 
선택한 키프레임의 보간 방식을 변경할 수 있습니다.

11 커브 에디터 왼쪽 측면에 있는 첫 번째 키프레임을 클릭하세요. 

12 왼쪽에 있는 첫 번째 보간 버튼을 누르면 Ease Out 보간 방식이 적용됩니다.

13 커브 에디터 오른쪽 측면에 있는 마지막 키프레임을 클릭하세요.

14 오른쪽 끝에서 두 번째 보간 버튼을 누르면 Ease In 보간 방식이 적용됩니다.
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15 키프레임 버튼과 커브 에디터 버튼을 클릭하면 두 개의 키프레임 디스플레이가 모두 종료됩니다. 

16 [/] 키를 누르면 현재 선택된 클립 주변부가 재생됩니다.

렌더링 및 백그라운드 캐싱
영상에 적용한 모든 효과는 컴퓨터와 디스크 드라이브의 속도뿐 아니라 사용 중인 파일 형태에 
따라 부드럽게 재생되지 않을 수도 있습니다. 타임라인 뷰어 위에 있는 초당 프레임(fps) 표시 장치는 
사용 중인 컴퓨터에서 실제로 실행되고 있는 프레임 재생 속도를 보여줍니다. 시스템에서 실제 
프로젝트 프레임 속도보다 느리게 재생될 경우 숫자 옆에 빨간 점이 나타납니다.

DaVinci Resolve에서는 복잡한 효과의 재생 성능을 최적화시키기 위해 해당 효과를 디스크 드라이브에 
자동으로 렌더링 및 캐싱합니다. DaVinci Resolve에서는 파일 렌더링 작업을 위해 세 개의 차별화된 
캐싱 시스템을 사용하지만 이번 과에서는 Edit 페이지를 위한 스마트 캐싱 기능을 중점적으로 배워볼 
것입니다.

먼저 캐싱 기능이 켜져 있는지 확인해야 합니다.

1 Playback > Render Cache> Smart를 선택하세요.

스마트 캐싱은 트랜지션, 불투명도 조절, 합성 모드 겹치기 등의 타임라인 작업용 효과를 
처리합니다. 캐싱 작업이 필요한 타임라인 구역 위에는 빨간색 바가 나타나는 반면 이미 캐싱된 
구역엔 파란색 바가 나타납니다.

이 모든 작업은 굉장히 간단하지만 캐싱 작업을 사용자 지정하려면 추가 설정 과정을 거쳐야 
합니다.

2 File > Project Settings > Master Settings로 이동하세요.
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Master Settings에는 캐싱과 관련된 몇 개의 Optimized Media 설정이 포함되어 있습니다. 
DaVinci Resolve에서 렌더링한 파일을 저장하는 데 사용하는 압축 포맷은 Cache frames in 
메뉴에서 설정할 수 있습니다. macOS 및 Windows에서는 보통 비압축 10비트 및 8비트 포맷과 
Avid의 DNxHR 포맷이 자주 사용됩니다. macOS 버전의 DaVinci Resolve에서는 Apple의 ProRes 
압축 포맷까지 지원합니다.

기본 설정 환경에서는 보기 좋은 고화질의 10비트 파일이 최종 출력 영상으로 생성됩니다. 
속도가 느린 디스크가 탑재된 휴대용 PC 또는 노트북 컴퓨터를 사용해 일시적으로 작업할 
경우엔 Avid DNxHR HQ나 ProRes 422 같은 화질이 조금 떨어지는 8비트 포맷을 선택해 처리 
속도를 높일 수 있습니다. 여기서는 이 기본 설정을 그대로 두고 배경 처리 과정으로 넘어가겠습니다.

3 Enable background caching 항목이 선택되어 있는지 확인하세요.

백그라운드 캐싱 기능을 활성화하면 미리 입력해둔 컴퓨터 미사용 시간이 지난 후에 효과 
렌더링 작업이 시작됩니다. 

4 Enable background caching 입력란에 숫자 3을 입력하세요.

이제 컴퓨터를 3초간 사용하지 않으면 백그라운드 캐싱 작업이 활성화되어 효과를 렌더링하기 
시작합니다.

정보 현재 프로젝트의 모든 렌더링된 캐시 파일을 삭제하려면 Playback > 
Delete Render Cache > All을 선택하세요.

이제 스마트 캐싱이 활성화되었으므로, DaVinci Resolve에서 효과 재생을 최적화하는 데 필요한 
모든 것들을 자동으로 렌더링합니다. 프로젝트를 다시 열어도 캐싱된 클립은 그대로 저장되어 
있습니다. 하지만 캐싱 효과를 변경할 경우엔 이를 다시 캐싱해야 합니다. 
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일정 속도로 재생 속도 변경하기
클립 재생 속도는 다양한 이유로 변경하게 됩니다. 때론 극적인 장면을 강조하거나 클립 타이밍이 
장면과 맞아 떨어지도록 만들 때 사용합니다. 대부분의 프로덕션 장르에서는 클립 속도를 높이거나 
낮추고 심지어 몇 초간 프레임 정지시키기도 합니다.

가장 많이 사용하는 속도 변경 방법은 재생 속도 변경입니다. 타임라인에 있는 클립 재생 속도를 
균일하게 변경해 단일 프레임 레이트의 슬로우 모션 또는 패스트 모션 효과를 얻을 수 있습니다.

1 플레이헤드를 타임라인에 있는 06_MILKYWAY 클립의 시작 부분으로 가져가세요.

2 클립을 재생합니다.(속도를 변경하기 전에 항상 확인해 보는 것이 좋습니다.)

이 클립의 경우 저녁 하늘이 나오는 장면의 재생 속도가 조금 빠른 편입니다. 타임라인에서 
클립 길이는 그대로 두고 재생 속도만 느리게 조정할 수 있습니다.

3 06_MILKYWAY를 선택하세요. 마우스로 클립을 우클릭하면 나타나는 팝업 메뉴에서 Change 
Clip Speed를 선택하세요. 

클립 재생에 필요한 수많은 컨트롤이 탑재된 Change Clip Speed 창이 나타납니다. 

4 Speed값 입력란에 50을 입력한 다음, Change 버튼을 누르면 창이 사라집니다.
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해당 설정값을 50%로 설정하면 타임라인 프레임 레이트의 절반 속도로 재생됩니다. 여기서는 
초당 12프레임으로 재생됩니다. 타임라인의 클립명 옆에 있는 작은 속도 변경 아이콘을 통해 
클립 재생 속도가 변경되었음을 확인할 수 있습니다.

5 클립을 재생해 변경된 재생 속도를 확인하세요.

슬로우 모션 클립 생성 시 Change Clip Speed 창에 있는 기본 설정은 전체 클립 또는 타임라인 
길이에 영향을 끼치지 않습니다. 하지만 DaVinci Resolve에는 클립 길이를 변경해 속도를 
조정하는 도구가 따로 없습니다.

셀렉션 도구 및 트림 도구를 사용한 리타이밍
Change Clip Speed 창에서 일정 속도로 재생 속도를 변경하고 클립 길이를 유지하는 동안 리타임 
컨트롤에서 재생 속도를 낮추거나 높여 클립 길이를 늘이고 줄일 수 있습니다.

1 06_MILKYWAY 클립을 우클릭한 다음 팝업 메뉴에서 Retime Controls를 선택하거나 [Cmd] + 
[R] 키(macOS) 또는 [Ctrl] + [R] 키(Windows)를 누르세요.

클립 상단에 Speed Change 바가 나타납니다. 클립의 현재 재생 속도가 클립 아래 나타납니다. 
타임라인에 있는 Speed Change 바를 조정하면 클립 재생 속도가 변경됩니다.

2 툴바에서 트림 도구를 선택하거나 [T] 키를 누르세요.

3 포인터를 Speed Change 바 오른쪽 끝으로 움직이세요.
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포인터가 이중 화살표 모양 커서로 바뀝니다.

4 클립 하단의 속도 디스플레이 숫자가 40%로 변할 때까지 Speed Change 바 끝부분을 오른쪽으로 
드래그해 클립 길이를 늘리세요.

Speed Change 바를 왼쪽으로 드래그하면 재생 속도가 빨라지면서 클립의 길이가 줄어듭니다. 
트림 도구를 선택하면 Speed Change 바가 타임라인 속 다른 클립에까지 영향을 미칩니다. 
하지만 최근 작업을 취소하면 툴바에서 선택한 도구에 따라 트리밍 작업이 어떻게 달라지는지 
확인할 수 있습니다.

5 [Cmd] + [Z] 키(macOS) 또는 [Ctrl] + [Z] 키(Windows)를 누르면 방금 작업한 속도 변경 작업이 
취소됩니다.

6 툴바에서 셀렉션 모드(Selection Mode) 도구를 클릭하거나 [A] 키를 누르세요.

7 포인터를 Speed Change 바 오른쪽 끝으로 옮기고 다음에 이어지는 인터뷰 클립을 완전히 
덮어쓸 때까지 오른쪽으로 드래그하세요.

8 시간이 재설정된 클립을 재생해 결과물을 확인하세요.

정보 클립을 원래 속도로 되돌리려면, 클립 하단에 있는 클립 속도 팝업 메뉴를 
클릭한 다음 Reset to 100%를 선택하세요.

트림 도구를 선택하면 타임라인도 그 영향을 받아 나머지 클립이 오른쪽으로 이동됩니다. 클립 
길이와 전반적인 타임라인의 길이가 연장됩니다.
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역방향으로 클립 재생하기
리타임 컨트롤이 나타나면 Speed Change 바를 사용해 트리밍하는 대신 클립 하단에 있는 팝업 
메뉴를 사용해 속도를 변경할 수 있습니다.

1 06_MILKYWAY 클립 하단에 있는 리타임 팝업 메뉴를 클릭하세요.

이 메뉴에는 속도를 높이고 줄이는 일반적인 옵션 외에도 다양한 리타이밍 조건에 맞게 속도를 
설정하는 기능이 포함되어 있습니다. 물론 다른 옵션을 통해 재생 조건을 재설정하거나 역방향으로 
재생할 수 있습니다.

2 메뉴에서 Reverse Segment를 선택하세요.

3 속도가 재설정된 클립을 재생해 결과물을 확인하세요.

이제 클립이 동일한 속도로 역방향 재생됩니다.

리타임 처리 시간 변경하기
속도가 재설정된 클립의 처리 방식을 변경하면 영상의 표현 방식도 달라집니다. 인스펙터에 있는 
다양한 리타임 처리 설정 항목을 통해 속도와 화질을 조정할 수 있습니다. 숏 안에서의 움직임과 
허용할 처리 시간에 따라 선택할 항목이 달라집니다.

4 시간이 재설정된 06_MILKYWAY 클립을 선택하세요.

5 인스펙터를 실행하세요.

6 인스펙터 아래쪽으로 스크롤하세요.

7 Retime Process 메뉴를 클릭해 메뉴를 여세요.
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클립 리타이밍 처리 옵션은 Nearest, Frame Blend, Optical Flow의 세 가지 항목으로 구성되어 
있습니다.

 � Nearest가 가장 빠른 처리 옵션이지만 화질은 가장 낮습니다. 간단한 이 설정을 적용할 경우 
프레임이 복제되어 슬로 모션 효과를 생성하는데, 움직임이 크지 않은 클립에서도 움직임이 
더딘 아티팩트 현상이 발생할 수 있습니다. Nearest는 프로젝트 설정의 마스터 설정에서 
지정된 기본 옵션입니다. 

 � Frame Blend는 좀 더 집약적인 처리 방식으로 더욱 향상된 영상룩을 얻을 수 있습니다. 
이 옵션 역시 프레임을 복제해 슬로 모션 효과를 생성하지만 블랜딩 작업을 통해 좀 더 
부드러운 움직임 또한 생성합니다. 신뢰도가 가장 높은 옵션이며 대체적으로 양호한 
결과물을 얻을 수 있습니다. 

 � Optical Flow는 가장 집중적인 처리 능력이 요구되는 옵션으로 가장 뛰어난 화질을 얻을 수 
있습니다. 이 옵션은 모션 예측 기술 및 와핑 기술을 사용하여 원본 소스 프레임으로부터 
새로운 프레임을 생성합니다. 클립에 나오는 동작이 아무런 방해를 받지 않는 경우엔 아주 
부드러운 결과물을 얻을 수 있습니다. 하지만 걸어가는 사람의 다리처럼 여러 개의 움직이는 
요소가 서로 다른 방향에서 교차하며 등장하는 경우나 카메라 움직임이 불규칙한 경우에 
Optical Flow 처리 과정을 적용하면 늘어지거나 끊어지는 아티팩트 현상이 발생할 수 
있습니다.

정보 Project Settings의 Frame Interpolation에 있는 부가적인 Motion 
estimation 컨트롤을 통해 조금씩 끊어지거나 늘어나는 아티팩트 현상을 개선할 
수 있습니다.

8 메뉴에서 Optical Flow를 선택하세요.

Optical Flow 옵션을 선택하면 빨간색 바가 클립 위에 나타나 처리 과정에 캐싱 작업이 필요하다는 
사실을 알려줍니다. 스마트 캐싱이 활성화되면 렌더링이 알아서 처리되어 몇 초 후면 결과를 
확인할 수 있습니다.

9 클립이 캐싱되면 광학 흐름 결과를 재생하여 더욱 부드러워진 움직임을 확인하세요.

먼저 Optical Flow 처리 과정을 적용해 만족스러운 결과가 나오는지 확인한 다음 필요에 따라 Frame 
Blend 옵션으로 돌아갈 수 있습니다. Optical Flow의 경우 다른 리타임 처리 과정과는 달리 결과물을 
캐싱 처리해야 합니다.
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1 Edit 페이지 타임라인에서 트랜지션을 드래그해 길이를 연장할 수 없는 이유는 무엇인가요?

2 커스텀 트랜지션 프리셋을 저장하는 방법은 무엇인가요?

3 인스펙터에서 백그라운드 캐싱을 설정 및 실행할 수 있습니다. T(진실) 또는 F(거짓)로 답하세요. 

4 위치 설정 파라미터의 애니메이션 효과에 필요한 최소 키프레임 수는 무엇인가요?

5 클립 속도 변경 시 Change Clip Speed와 Retime Controls의 차이점은 무엇인가요?
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1 트랜지션 양쪽의 미디어 핸들을 모두 사용할 수 없는 경우 트랜지션을 드래그해 길이를 연장할 

수 없습니다.

2 커스텀 트랜지션 프리셋을 저장하려면 타임라인에 있는 트랜지션을 우클릭한 다음 Create 
Transition Preset을 선택하세요.

3 F. 백그라운드 캐싱은 Project Settings에서 설정 및 활성화할 수 있습니다.

4 애니메이션 효과를 생성하려면 클립 속 서로 다른 곳에 두 개의 키프레임이 필요하며, 각기 
다른 설정값을 입력해야 합니다. 

5 Change Clip Speed를 선택하면 해당 창이 열려 특정 속도값을 입력할 수 있습니다. 속도를 
설정하고 나면 타임라인의 클립 길이는 동일하게 유지되지만 재생 속도는 달라집니다. 리타임 
컨트롤(Retime Controls)을 사용하면 타임라인에 있는 클립 위에 속도 바가 나타나며, 속도 바를 
드래그하면 클립 길이가 변하면서 재생 속도가 빨라지거나 느려집니다.
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오디오 후반 제작과 
사운드 디자인 소개

 ‘백문이 불여일견’ 혹은 ‘천 마디 말보다 한 번 보는 게 더 낫다’라는 속담을 한 번은 꼭 들어봤을 
겁니다. 하지만 모션 픽쳐에 있어 시각 자료와 사운드 트랙은 똑같이 중요합니다. 사실 훌륭한 사운드 
트랙은 화면에 환상을 일으키고 감정을 불러일으키며, 관객들을 화면 속 세계로 이끌어 그들의 
상상력을 사로잡습니다. 반면 사운드 트랙이 엉망일 경우에는 관객의 이야기 몰입도가 떨어지고 
그러면서 제작 방식과 연기, 구성상의 허점이 있지는 않은지 주목하게 됩니다. 

오디오 후반 제작 작업은 대부분 오디오 볼륨 조절과 오디오 트랙 믹싱 작업으로 구성되어 있습니다. 
프로덕션 사운드를 강력한 사운드 트랙으로 전환하려면 시간과 기술적인 능력, 창의적 비전, 수행 
능력뿐만 아니라 전문가용 오디오 도구가 완비되어 있어야 합니다. DaVinci Resolve 15은 바로 
이러한 모든 도구를 갖춘 프로그램으로 전문적인 사운드 트랙을 제작할 수 있습니다. 다음 오디오 
챕터로 넘어가기 전에 오디오 후반 제작 과정과 워크플로 개념을 이해하는 것이 좋습니다.

오디오 워크플로에 영향을 미치는 요소에는 프로젝트의 종류 및 제작 예산, 포맷, 파일 길이, 상품, 
배포 방식 등이 있으며 주로 이러한 요소들이 오디오 후반 제작팀의 규모 및 작업 시간, 작업에 
필요한 도구를 결정하게 됩니다. 내러티브 형식과 다큐멘터리 형식의 프로젝트에 모두 필수적인 
기본 오디오 후반 제작 과정을 먼저 살펴보도록 하겠습니다. 이 과에서는 오디오 후반 제작 과정의 
다양한 작업 방식과 단계를 설명하고 있지만, DaVinci Resolve에 Fairlight 페이지가 따로 내장되어 
있어 추가 인원이나 예산 없이 같은 방식으로 프로젝트를 작업할 수 있습니다.
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먼저 기본 용어를 알아보도록 하겠습니다. 오디오 후반 제작이란 움직이는 화면을 위한 사운드 
트랙을 제작하는 작업 과정을 말합니다. ‘움직이는 화면’은 규모의 크고 작음에 상관없이 영화 극장 
프로젝트부터 스트리밍 영상에 이르는 모든 종류에 사용됩니다. 사운드 트랙은 완성된 프로젝트에 
수반되는 오디오를 말합니다.

고객이 완성된 프로젝트를 확인할 때 커다란 영향을 주는 것이 바로 사운드 트랙입니다. 잘 만들어진 
사운드 트랙은 관객이 쇼에 완전히 몰입하게 만들어 사운드 트랙의 존재를 알아차리지 못할 수도 
있습니다. 반면 비전문적이거나 허술한 사운드 트랙은 단 몇 초 만에 관객의 집중을 흐트러트릴 
뿐만 아니라 관객이 극장을 떠나거나 시청자들이 채널을 돌리게 할 수도 있습니다. 

바닷가 및 놀이 공원 같은 공공장소에서 촬영한 홈 비디오를 직접 녹화하거나 본 적이 있다면 자연 
음향을 녹음하고 들어보는 것이 본질적으로 얼마나 어려운지 직접 경험한 것이나 다름없습니다. 
주변 소음과 방해 요소가 넘쳐나기 때문에 오디오 후반 제작 과정을 통해 정제되지 않은 사운드를 
깨끗한 대사와 현실감 넘치는 효과, 어쿠스틱한 음악적 파노라마를 모두 갖춰 강력한 감정을 전달하는 
사운드 트랙으로 만들어 냅니다. 

오디오 후반 제작 워크플로란?
영화 속 사운드 싱크의 출현과 함께 생긴 오디오 후반 제작의 첫 번째 규칙은 바로 ‘영상 작업이 
완전히 끝나기 전에는 절대로 오디오 작업을 시작하지 말아라’입니다. 여기서 작업이 끝났다는 것은 
영상 편집에 더 이상 어떠한 추가 변경도 이루어지지 않는 단계를 말합니다.

하지만 실제로 변경 사항은 항시 일어나기 마련이지요. 이 점이 왜 중요할까요? 그 이유는 바로 
사운드 트랙에 프레임이 정확하게 유지되어야 영상과 완벽한 동기화를 이루기 때문입니다. 만약  
1 프레임 또는 2 프레임만 어긋나도 영상과 사운드가 맞지 않는 것이 금방 눈에 띄어 영상에 집중할 
수 없게 되며 비전문적인 작업으로 관객이 시청을 중지할 수도 있습니다.

일반적으로 후반 제작 워크플로에서 오디오 후반 작업에 완성된 편집 영상을 변경하면 그 피해는 
눈덩이 효과처럼 불어나게 됩니다. 하지만 유일하게 디지털 오디오 워크스테이션을 갖춘 전문 편집 
소프트웨어 DaVinci Resolve에서 작업하면 어떤 편집 변경 사항을 적용하더라도 효과적으로 
프로젝트를 즉각 업데이트할 수 있습니다. 이로 인해 편집 화면과 오디오 작업, 색보정을 필요에 
따라 옮기며 작업할 수 있어 혼자서 작업할 경우 엄청난 창의적인 유연성을 발휘하게 됩니다.

같은 프로그램 안에서 한 프로젝트의 편집과 오디오 후반 제작 작업을 모두 할 수 있어 규모가 큰 
프로덕션에서 이루어지는 업데이트 및 다른 시스템으로의 파일 변환, 편집/오디오 후반 작업 간의 
프로젝트 컨폼 작업 시 발생하는 문제점이 해결됩니다. 무엇보다도 편집에 사용하는 타임라인에서 
오디오 후반 제작을 작업할 수 있어 단 한 프레임도 놓치지 않고 완벽한 싱크를 유지할 수 있습니다. 
오디오 작업을 시작하면 편집자는 복사한 타임라인에 추가로 변경 작업을 이어갈 수 있습니다. 
그러면 오디오 편집자가 DaVinci Resolve의 강력한 타임라인 비교 도구를 사용하여 타임라인 간 
서로 다른 사항을 손쉽게 합치기할 수 있습니다.

DaVinci Resolve는 최고 품질의 오디오 후반 제작에 필요한 오디오 도구를 갖추고 있으며, 작은 
프로젝트뿐만 아니라 대규모 할리우드 스튜디오와 방송국에서도 사용할 수 있는 강력한 도구입니다. 
혼자서 작업하는 단일 사용자 또는 대규모 후반 제작 팀에 소속되어 있는 사용자 모두 프로젝트를 
쉽게 이동할 수 있어 경험이 풍부한 오디오 사운드 디자이너 및 오디오 엔지니어에게 사운드트랙을 
믹싱 또는 마스터링하도록 의뢰할 수 있습니다.
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프로젝트를 작업하는 단일 사용자 또는 오디오 전문팀의 필요에 따라 다음 설명된 모든 작업 단계를 
수행할 수 있습니다.

사운드트랙 스포팅
스포팅 세션에서는 오디오를 감독하는 음향 편집가 또는 사운드 디자이너가 감독 및 편집자, 작곡가와 
함께 한자리에 둘러 앉아 추가/수정/재녹음 해야 하는 사운드트랙 요소를 가려냅니다. 
사운드트랙 스포팅 과정에서 남긴 노트는 스포팅 목록에 통합되며, 여기에는 뮤직 큐, 주요 음향 
효과, 다이얼로그 수정, 추가 오디오 노트 내용이 있습니다.

DaVinci Resolve는 편집 페이지와 Fairlight 페이지에서 모두 사용할 수 있는 타임라인 마커 기능으로 
이러한 스포팅 과정을 간소화시켰습니다. Fairlight 페이지의 마커 인덱스는 상호 작용하는 스포팅 
목록 기능을 하여 각 마커에 해당하는 정보 및 썸네일을 포함하고 있을 뿐만 아니라 타임라인 속에 
선택된 마커 위치로 플레이헤드를 이동합니다.

프로덕션 다이얼로그 편집
다이얼로그 편집은 다이얼로그를 여러 개의 트랙으로 나누고, 원치 않는 사운드를 삭제하고, 한 
단어 또는 문장이 더욱 분명하게 들리도록 오디오를 교체하고, 일관성을 유지하기 위해 서로 다른 
클립 오디오 레벨의 균형을 맞추는 매우 지루한 후반 작업 중 하나입니다. 왜 이런 수고를 감내해야 
할까요? 사운드 트랙에서 음성 언어는 히트곡의 리드 보컬 목소리만큼이나 중요하기 때문이죠. 
다이얼로그 편집자는 다이얼로그, 내레이션, 보이스오버를 포함한 모든 음성 언어를 책임집니다.

프로덕션 다이얼로그 편집 작업에서는 먼저 각각의 캐릭터에 해당하는 트랙을 따로 생성한 다음, 
전체 다이얼로그 클립을 특정 트랙으로 이동하는 작업을 합니다. 이는 아주 중요한 작업 단계로 
프로덕션마다 캐릭터 음성이 각기 다르기 때문에 각 음성마다 볼륨 평준화, 이퀄라이제이션, 효과음 
처리 과정을 거쳐야 합니다.

다음으로, 다이얼로그 편집자가 오디오 트랙을 정리하고 혀를 차는 소리나 쩝쩝 거리는 소리 등 
원치 않는 소음을 제거합니다. 귀에 거슬리는 소리는 바로 이 단계에서 제거하면 됩니다. 플러그인과 
효과를 사용하면 딸깍거리거나 펑 하는 등의 원치 않는 소음을 자동으로 제거할 수 있지만, 클립에 
추가하는 모든 오디오 처리가 음성에 영향을 끼칠 수 있다는 점을 기억하세요.

다이얼로그 정리가 끝나면 볼륨 레벨의 균형이 맞춰져 다이얼로그 트랙마다 일관성이 유지됩니다. 
다이얼로그가 손상되거나 소음 또는 불확실한 음성이 많아 이를 사용하지 못할 경우 다른 트랙이나 
사전 녹음된 오디오로 교체해야 합니다. 프로덕션 다이얼로그를 다시 녹음하는 과정을 후시녹음
(ADR) 또는 루핑이라고 합니다.

다이얼로그 편집은 시간과 노력이 많이 요구되는 작업입니다. DaVinci Resolve는 이러한 작업 과정을 
간소화하고 속도를 높일 수 있는 간편한 이동 및 정확한 편집 도구, 단축키 기능을 제공합니다.
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다이얼로그 편집이 끝나면 창의적인 작업 과정이 시작됩니다. 사운드 트랙에서 발휘되는 음향 
디자이너의 창의성은 사진 작가가 사진을 통해 나타내는 것과 비슷합니다. 음향 디자이너는 관객을 
위한 전반적인 청각적 경험을 책임지는 사람입니다. 물론 다양한 종류의 사운드 트랙 및 사운드 
트랙을 구성하는 음악을 감독하기도 합니다. 이러한 오디오 트랙에는 다이얼로그, 앰비언스, 강력한 
음향 효과, 효과음이 있습니다.

음향 디자이너는 이러한 청각적 환상 및 사운드 트랙의 전체적인 분위기를 결정할 뿐만 아니라 
이들의 상상 속에만 존재하는 음향 요소를 생성, 녹음, 향상 시키는 일을 합니다. 결국 많은 
프로젝트에서는 실제로 존재하지 않는 음향 효과를 필요로 합니다. 용이나, 외계인, 좀비를 위한 
음향은 어디에서도 얻을 수 없으니까요. 이러한 음향은 실제 사운드와 모방한 사운드, 많은 처리 
작업 및 사운드 효과를 거쳐 완전히 새롭게 제작해야 합니다.

사운드 디자이너는 음향 효과의 깊이와 디테일을 결정하고 음향 편집자는 각각의 음향 효과를 해당 
사운드 트랙에 편집합니다. 음향 효과는 네 종류 카테고리로 분류됩니다.

자연의 소리 또는 프로덕션 사운드는 다이얼로그를 제외한 야외 촬영 현장에서 마이크를 통해 
녹음된 오디오를 말합니다.

앰비언스 사운드 또는 앰비언트 사운드는 리듬감 있게 부서지는 파도 소리나 외딴 바닷가의 
새소리처럼 로케이션 촬영 시에 발생하는 주변 음향을 말합니다. 

강력한 음향 효과는 말 그대로 영상과 음향을 물리적으로 동기화시키는 음향 요소로 장면 또는 
이야기에 필수적인 부분입니다.

폴리 사운드는 등장인물이 화면 속 환경과 교류하며 발생하는 음향 효과로 구성되어 있습니다. 폴리 
사운드는 유니버셜 스튜디오의 전설적인 음향 편집가였던 잭 폴리(Jack Foley)의 이름에서 따온 
용어이며, 그는 처음으로 무대를 재현해 녹음하는 기술을 개발한 인물입니다. 폴리 사운드는 오리지널 
프로덕션 오디오를 위한 주먹다짐부터 발자국 소리와 옷깃이 흩날리는 소리 등 모든 음향을 
대체합니다.

DaVinci Resolve의 Fairlight 페이지에 있는 오디오 편집 도구는 음향 효과 편집 작업에 요구되는 
정확한 편집과 배치를 위해 특별히 제작되었습니다. DaVinci Resolve의 클립 속도 변경 기능은 첨단 
사운드 디자인 및 피치 효과에 완벽한 기능입니다.

음악 편집 
음악 편집이란 다양한 음악적 요소를 사운드 트랙에 배치하여 분위기와 이야기 전개를 향상 시키는 
작업을 말합니다. 모든 사운드 트랙의 음악은 두 가지 카테고리로 나뉘게 되며 여기에는 등장 인물이 
영상 속에서 듣게 되는 음악 즉, 소스 사운드 또는 다이제틱 사운드와 후반 제작 과정에서 관객의 
편의를 위해 배경 음악으로 추가되는 논다이제틱 사운드가 있습니다.

다이제틱 사운드는 특히 볼륨 레벨과 위치, 효과, 현장감이 해당 장면 내용과 어울리도록 주의를 
기울여야 합니다.

감정적인 효과 및 충격을 위해 후반 제작에서 추가되는 논다이제틱 사운드로는 스코어, 스팅어, 
스탭이 있습니다. 스팅어(Stinger)는 긴장감을 일으키는 단음이나 화음을 말합니다. 스탭(Stab)은 
마치 느낌표의 사용처럼 이야기 또는 내레이션에서 청중의 주의를 끌기 위한 짧고 강력한 음악을 
말합니다.
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다이얼로그 트랙 편집이 완성되고 음향 효과와 음악이 추가되면 각 오디오 트랙의 사운드를 더욱 
섬세하게 조절하는 작업을 통해 다른 오디오 트랙과 같은 맥락을 유지합니다. 오디오 트랙의 사운드를 
향상 시키는데 사용하는 도구는 컬러리스트가 숏을 개선하는데 사용하는 도구와 많이 흡사합니다. 
DaVinci Resolve의 사용을 배울 때 색보정 작업은 후반 제작 과정에서 필수적인 과정이므로 오디오와 
컬러 작업의 유사성을 알아두는 것이 유용합니다.

이러한 모든 작업 과정의 목적은 정확한 오디오를 제작해내기 위함입니다. 볼륨 레벨, 다이나믹스, 
이퀄라이제이션, 패닝을 포함한 네 가지의 기본적인 오디오 요소 조절을 통해 오디오 트랙을 향상 
시키면 최종 믹싱 작업에서 의도한 대로 오디오 요소가 작동됩니다. DaVinci Resolve에서는 각 
트랙마다 이러한 네 가지를 요소를 조절할 수 있으며 플러그인 또는 패칭이 따로 필요하지 않습니다.

볼륨 컨트롤은 오디오 트랙의 소리 세기를 데시벨 단위로 조절하는데 사용하며 엄격한 방송 표준이 
있어 루미넌스 레벨 조절과 비슷하고 일반적으로 장면에서 관객이 제일 먼저 알아차리는 요소이기도 
합니다. 개별 클립과 장면, 출력에서 루미넌스를 조절하듯이 각각의 클립과 트랙, 메인 출력마다 
오디오 볼륨 레벨을 조절할 수 있습니다. DaVinci Resolve의 타임라인 또는 인스펙터에서 클립의 
볼륨 레벨을 조절할 수 있습니다. 트랙 볼륨은 오디오 믹서에 있는 페이더로 조절 가능합니다. 자동 
기능을 통해 시간이 지나면서 볼륨 레벨이 바뀌도록 할 수도 있습니다.

다이나믹스 컨트롤은 오디오 트랙에서 최고 음역대와 최저 음역대 간의 차이를 나타내는 다이나믹 
레인지를 조절합니다. 오디오 트랙의 다이나믹 레인지는 숏의 콘트라스트와 매우 비슷합니다. 높은 
다이나믹 레인지를 가진 오디오 트랙은 한 장면에서 등장 인물이 속삭이다가 소리를 지르는 것처럼 
트랙 속에 매우 시끄러운 요소와 조용한 요소가 함께 있는 것을 말합니다. 낮은 다이나믹 레인지는 
광고 속 보이스오버처럼 시작부터 마지막까지 등장 인물의 볼륨 레벨이 일정하여 음역대가 평평합니다. 
컬러 페이지의 파형 또는 퍼레이드 스코프로 작업한 경험이 있는 경우, 오디오 트랙의 다이나믹스를 
클립의 화이트/블랙 레벨 조절 방식과 매우 비슷하게 사용할 수 있습니다. 가장 높은 오디오 레벨은 
화이트 레벨, 가장 낮은 오디오 레벨은 블랙 레벨이라고 생각하면 됩니다.

Fairlight 페이지의 오디오 믹서에는 편리한 사용을 위해 한 패널에 가장 많이 사용하는 네 가지 
종류의 다이나믹 컨트롤이 구성되어 있습니다. 오디오 컴프레서는 가장 높은 오디오 피크를 가장 
낮은 피크에 가깝도록 낮추는 방식으로 다이나믹 레인지를 좁히는데 사용됩니다. 반대로 익스팬더는 
가장 높은 오디오 피크와 낮은 피크의 간격을 넓혀 다이나믹 레인지를 확장합니다. 리미터와 게이트는 
모두 음향 브릭월 역할을 하여 표적 레벨을 초과하는 사운드를 제한하고 설정된 최댓값보다 사운드가 
낮아지는 것을 방지합니다.

팬 컨트롤은 오디오 트랙의 사운드를 파노라믹 스테레오 필드 안에 배치합니다. 이러한 컨트롤 
기능을 사용하여 마치 촬영 기사가 숏을 시각적으로 구성하듯이 음향 경험을 구성합니다. 오디오 
트랙을 좌/우로 이동하여 원하는 곳에 정확하게 옮길 수 있으며, 마치 실생활에서 듣거나 화면을 
통해 듣는 것 같은 경험을 선사합니다. DaVinci Resolve의 편집 페이지와 Fairlight 페이지에서는 
첨단 팬 컨트롤 기능과 함께 서라운드 사운드 시스템을 위한 2D(스테레오) 및 3D 사운드 배치 기능을 
지원합니다.



156 이퀄라이제이션(EQ) 컨트롤은 특정 주파수를 조작하여 전체 사운드를 향상 시키며 색보정 작업의 
컬러, 채도, 색조처럼 조절됩니다. 예를 들어 사람의 목소리는 수백만 명이 공유하는 기본 주파수를 
기본으로 하며, 추가 주파수는 음색을 추가해 사람의 목소리에 색을 입혀 더욱 독특하고 구분 가능한 
목소리로 만들어 줍니다. 이퀄라이제이션의 주요 기능은 음성의 품질을 떨어뜨리는 주파수는 낮추고 
좋은 주파수는 높여 전체 사운드를 향상 시키는 것입니다. Fairlight 페이지의 오디오 믹서에는 오디오 
트랙을 향상 시키고 스위트닝 처리하는데 완벽한 6밴드 파라메트릭 이퀄라이저가 각 트랙마다 
포함되어 있습니다.

믹싱 및 마스터링
오디오 후반 제작의 마지막 단계는 오디오 트랙을 믹싱하고 마스터링 출력하는 것입니다. 오디오 
믹싱 작업을 제외한 모든 작업을 완성했을 경우 오디오 믹싱 작업은 꽤 간단해집니다. 오디오 믹싱과 
마스터링 작업의 목표는 각 오디오 트랙 레벨의 균형을 맞춰 전체 음향의 질을 높이는 것입니다. 이 
작업은 오디오 트랙 레벨을 미묘하게 조절하거나, 비슷한 트랙을 서브 믹스로 통합해 페이더 한 개로 
쉽게 조절하여 해낼 수 있습니다. 최종 마스터링 파일은 뛰어난 음향을 포함하고 딜리버리 규격에 
맞는 라우드니스를 충족해야 합니다. 다행히도 Fairlight 페이지에는 오디오 트랙과 라우드니스 
미터를 믹싱하여 모든 오디오 레벨이 정확한지 확인하는데 필요한 모든 기능이 포함되어 있습니다.

지금까지 오디오 후반 제작 워크플로에 필수적인 기술적 작업 단계와 창의적인 도구 사용에 대해 
알아보았으므로 다음 과에서는 직접 프로젝트를 생성하여 이러한 기술 및 도구를 직접 사용해 보실 
수 있습니다.
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편집 페이지에서 
오디오 작업하기 

작업하는 프로젝트 크기에 따라 기본 오디오 
트랙 또는 전체 사운드 디자인 작업을 맡게 되는 
경우가 있습니다. 오디오 편집자에게 작업을 
넘길지라도 최종 오디오 믹싱 작업에서 어떤 
사운드를 원하는지 기본적인 방향은 제시해줘야 
합니다.

DaVinci Resolve 15의 편집 페이지에는 사운드 
트랙 믹싱을 위한 오디오 편집 도구와 믹싱 
도구가 포함되어 있습니다. DaVinci Resolve의 
Fairlight 페이지에는 모든 기능을 갖춘 디지털 
오디오 워크스테이션(DAW) 또한 포함되어 
있습니다. 이번 과에서는 편집 페이지에서 
사운드 효과를 위한 추가 오디오 트랙을 생성한 
다음 오디오 레벨을 설정하여 균형 잡힌 오디오 
믹싱을 생성해 보겠습니다.

예상 소요 시간

이 과를 학습하는 데는 약 45분 
정도의 시간이 소요됩니다.

학습 목표
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프레임 범위 마킹하기 161

클립에 주석 달기 162

오디오 작업에 맞게 
인터페이스 사용자 지정하기  169

트랙 추가 및 패칭 171

트랙에 컬러 표시하기 173

Edit Index에서 마커 찾기 174

빈에서 마커 확인하기 176

클립 연결하기 178

오디오 모니터링/솔로/음소거 179

미터 읽기 및 타겟 설정하기 180

클립 속 오디오 레벨 변경하기 184

오디오 페이드 추가하기 186

복습하기 187
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마커로 작업하기
현재 사용하는 것과 비슷한 버전의 타임라인을 사용하여 오디오 믹싱을 생성하세요. 타임라인에 
내러티브와 음악이 이미 배치되어 있으므로 음향 효과를 사용하기 적절한 타임라인 영역을 먼저 
찾으세요. 마커를 사용하여 소스 클립에 주석을 달고, 또는 타임라인 속 특정 시간을 검색하거나, 
시간 범위에 라벨을 붙일 수 있습니다. 이러한 마커 기능은 주로 나중에 해야 할 일을 기억하기 위해 
사용됩니다. 음향 효과가 추가로 필요한 네 곳을 찾을 수 있도록 현재 타임라인에 마커를 추가합니다.

1 Age of Airplanes 프로젝트를 열고 Workspace > Reset UI Layout 순으로 선택하세요.

2 Rough Cuts 빈에서 04 Audio Rough Cut 타임라인을 더블 클릭하면 타임라인 뷰어에 로딩됩니다.

3 타임라인에서 플레이헤드를 02_A380_TAKEOFF 클립 중간 부분으로 옮기세요.

이 클립에 비행기 이륙 시 나는 커다란 소음을 추가할 수 있는데요, 여기에 마커를 사용하려면 
먼저 해당 클립을 선택해야 합니다.

4 셀렉션 모드 도구를 사용하여 타임라인에서 클립을 클릭하세요.

툴바에 있는 마커 버튼을 사용하여 마커를 추가합니다.

5 마커 버튼을 클릭하세요.

정보 Option 메뉴를 사용하여 뷰어에 마커가 나타나거나 사라지도록 On/Off 할 
수 있습니다.

타임라인 속 선택된 클립에서 플레이헤드가 있는 곳에 파란색 마커가 추가되었습니다.

6 클립에서 파란색 마커를 더블 클릭하거나 해당 마커를 선택하고 [Shift + M] 키를 누르면 마커 
창이 나타납니다.
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마커 색상을 변경하면 작업을 세분화할 수 있습니다. 예를 들어 그래픽을 추가하는 곳에는 
초록색을 그리고 효과가 필요한 곳에는 보라색을 사용할 수 있습니다. 마커에 노트를 추가하여 
변경에 관한 설명을 입력할 수도 있습니다.

7 빨간 색상의 스와치를 선택하고 이름 입력란에 SFX를 입력하세요. 노트 입력란에는 Add Roaring 
Take Off를 입력한 다음 Done을 클릭하세요.

한 개의 클립이 완성되어 이제 타임라인에 마커와 노트가 필요한 곳은 두 군데입니다.

8 플레이헤드를 타임라인에 있는 10_MALDIVES 클립 중간 부분으로 이동하고 이를 선택하세요.

이 클립에서는 더욱 빠르게 작업할 수 있는 키보드 단축키를 사용해 보겠습니다.

9 [M] 키를 두 번 누르세요.

[M] 키를 한 번 누르면 마커가 추가되고, 한 번 더 누르면 마커창이 나타납니다.
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10 이름 입력란에 SFX를 입력하고, 노트 입력란에는 Add Overhead Sea Plane이라고 입력한 

다음, 빨간색을 선택하세요. 그런 다음 Done을 클릭하세요.

정보 마커를 삭제하려면 Marker 창을 열고 Remove Marker를 클릭하거나, 해당 
마커를 선택하고 [delete] 또는 [backspace] 키를 누르세요.

11 타임라인 플레이헤드를 08 South_Pole_DC3 클립 중간 지점에 놓고 클립 위의 회색 부분을 
클릭하여 타임라인 속 모든 선택을 해제합니다.

이 클립에서는 키보드 단축키를 사용하여 신속하게 작업해 보겠습니다.

12 [M] 키를 누르세요.

플레이헤드 아래에 있는 타임라인 눈금자에 마커가 추가됩니다. 클립에 적용되는 다른 마커와는 
달리 드래그하거나 자르기/붙여넣기하여 South Pole 클립을 타임라인 속 새로운 곳에 옮길 
경우 마커는 같이 이동하지 않습니다. 이를 제외하고는 일반 클립 마커 기능과 모두 동일하게 
작용합니다.

13 [M] 키를 다시 누르면 마커창이 나타납니다. 입력란에 SFX를 입력하세요. 노트 입력란에는  
Add Loud Prop Plane이라고 입력한 뒤, 빨간색을 선택하고 Done을 클릭합니다.

정보 타임라인 속 클립을 리플 트리밍하면 타임라인 눈금자에 있는 마커도 
함께 이동합니다.

모든 빨간색 마커가 프로그램에 추가되었습니다.



161

프
레

임
 범

위
 마

킹
하

기

프레임 범위 마킹하기
마커의 기능은 클립의 특정 프레임을 찾거나, 타임라인 눈금을 찾는 것에만 제한되지 않습니다. 
프레임 범위를 표시하는 데에도 사용할 수 있습니다. 시각적으로 교정이 필요한 클립의 범위에 
노트를 추가해 보겠습니다. 오디오 변경은 더 이상 표시하지 않으므로 새로운 컬러의 마커를 
사용하겠습니다.

1 도구바에서 줌 슬라이더를 방금 빨간색 마커를 추가한 08_SOUTH_POLE_DC3 클립으로 
드래그하세요.

타임라인에 어떤 클립도 선택되지 않았는지 확인하세요.

2 08_SOUTH_POLE 클립 시작점에 플레이헤드를 놓으세요.

시각 효과 노트를 노란색으로 설정하겠습니다.

3 도구바에 있는 마커 메뉴에서 노란색을 선택합니다.

타임라인 눈금에 노란색 마커가 추가되었습니다.

4 [Option] 키(MacOS) 또는 [Alt] 키(Windows)를 누르고 마커를 드래그하여 다른 클립 끝으로 
옮기세요.

마커 기능은 다른 클립까지 확장됩니다. 이제 노트를 추가하고 프레임을 이동할 수도 있습니다.

5 [Shift+M] 키를 눌러 마커창을 여세요.
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6 이름 입력란에 VFX를 입력하고 노트 입력란에는 Move the plane down이라고 입력합니다. 

Done을 클릭하면 마커창이 닫힙니다.

대부분의 경우 간단한 노트만으로 변경에 필요한 정보를 충분히 남길 수 있으며 간혹 사진 한 장이 
장문의 글을 대체하기도 합니다.

클립에 주석 달기
마커에 내장된 그리기 도구를 사용하면 더욱 자세한 정보를 남길 수 있습니다. 단순히 비행기를 
옮기라고 적는 것이 아니라 프레임에 화살표를 그려 어느 방향으로 비행기를 옮길지 직접 그릴 수 
있습니다.

1 타임라인 뷰어 왼쪽 아래에 있는 타임라인 팝업 메뉴에서 주석(Annotations)을 선택하세요.

정보 타임라인 뷰어의 팝업 메뉴에서 Annotations를 선택하면 현재 선택한 
위치에 아무것도 없을 경우 자동으로 마커가 추가됩니다.

주석 기능을 위한 온스크린 컨트롤을 활성화하면 뷰어 왼쪽 상단에 그리기 도구, 화살표 도구,  
컬러 도구 등의 세 가지 옵션과 함께 주석 도구바가 추가됩니다.
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2 화살표 아이콘을 클릭한 다음 비행기 조종석에서 바퀴쪽으로 화살표를 드래그하세요. 

3 컬러 팝업 메뉴에서 노란색을 선택하세요. 

정보 라인 또는 화살표를 선택하고 [delete] 또는 [backspace] 키를 누르면 
주석이 사라집니다.

4 타임라인 뷰어의 팝업 메뉴에서 주석 도구를 클릭하면 주석 툴바가 사라집니다.

오디오 작업을 이어가면서 빨간색 마커가 사용자의 주의를 끌게 될 것입니다. 마커 노트에 
해당하는 음향 효과의 위치를 지정해야 합니다.
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소스 뷰어에 마커 추가하기
소스 클립에 마커를 적용할 시 매우 유용하다는 사실을 알게 될 것입니다. 소스 클립에 사용한 
마커에는 타임라인처럼 노트를 추가할 수 있습니다. 사용하려는 타임라인의 클립 여러 군데를 
손쉽게 찾기 위해 마커를 사용할 수도 있습니다. 이 방식을 사용하면 마커를 여러 인/아웃 포인트를 
위한 자리 표시 장치로 사용할 수 있습니다.

1 오디오 빈에서 Sound FX 클립을 더블 클릭하면 소스 뷰어에 클립이 나타납니다.

이는 여러 사운드를 포함하고 있는 전형적인 음향 효과입니다. 타임라인에 사용할 수도 있는 
음향 효과를 한번 들어보겠습니다.

참고 본 책에 있는 이미지를 보면 특정 환경 설정에 빈이 나타나지만, 이를 
똑같이 설정해야만 하는 것은 아닙니다. 사용하는 환경 설정에 따라 빈이 
아이콘 또는 목록 보기 방식으로 나타날 수 있습니다.

2 5초 길이의 Sound FX 클립을 재생하세요.



165

클
립

에
 주

석
 달

기

다행히도 이 클립의 첫 번째 음향 효과는 프로펠러기가 돌아가는 소리입니다. 같은 단축키 
기능을 사용하여 소스 뷰어 클립에 마커를 추가하실 수 있습니다.

3 음향 효과 최고점(가장 높은 파형점)에 소스 뷰어의 조그바를 옮기세요.

4 [M] 키를 누르세요. 

소스 뷰어 조그바 아래 있는 소스 클립에 마커가 추가되었습니다. 소스 클립 마커에 노트를 
추가할 수도 있습니다.

5 [M] 키를 다시 눌러 마커창을 열고 이름 입력란에 Plane Overhead라고 입력하고 Done을 
클릭하세요. 

첫 번째 음향 효과를 위한 마크 표시가 완료되었습니다. 이러한 마커 기능은 나중에 편집을 
시작할 때 효과 위치를 정하는데 도움을 줍니다.
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소스 뷰어에서 클립 범위에 마킹하기
소스 뷰어에서 클립 범위를 마킹하는 것은 타임라인에서 마킹하는 것보다 좀 더 복잡합니다. 소스 
뷰어의 조그바를 확대할 수 없기 때문에 마커 범위를 드래그하는 것이 어려울 수 있습니다. 소스 
뷰어에 마커 범위를 지정하여 클립의 입/출력 포인트 여러 개를 모의로 적용해 보기에 좋습니다. 
여러 개의 효과음이 포함된 긴 음향 효과 클립에 이 기능을 사용할 수 있습니다. 소스 뷰어에 이미 
추가한 이전 마커를 고려해 프로그램에 사운드 두 개의 위치를 설정해야 합니다. 먼저, South Pole 
샷을 위한 프로펠러 비행기의 시끄러운 사운드를 설정해 보겠습니다.

1 소스 뷰어에서 Sound FX 클립을 약 30초간 재생하세요.

30초 즈음에 프로펠러기가 이륙을 준비하는 시끄러운 사운드가 좋은 음질로 들립니다. 이 음향 
효과 사용을 결정하기 전에 마커를 사용하여 South Pole 클립에 원하는 범위를 결정합니다. 
그런 다음, 소스 클립에서 사용 가능한 범위를 계속해서 찾습니다.

소스 뷰어에서 프로펠러기 사운드 효과가 시작되는 지점으로 조그바를 옮기세요.

프로펠러기 엔진 소리가 시작되는 곳은 South Pole 비행기의 모습과는 어울리지 않습니다.  
음향 효과를 조금 더 재생하고 엔진 소리가 제대로 들리기 시작하는 지점에 마커를 표시합니다.

2 클립을 재생하여 엔진 소리가 크게 올라가는 지점을 찾으세요.

3 [M] 키를 눌러 소스 뷰어에 마커를 추가하세요.

4 [M] 키를 다시 누르면 마커창이 나타납니다. Name 입력란에 Loud Prop Plan이라고 입력하세요.
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5 마커 표시 범위를 넓히려면 Duration 입력란 맨 끝에 있는 숫자 세 자리를 삭제하세요.

6 다음으로 300을 입력하여 클립 길이를 3초로 설정하고 [Enter] 키를 누른 다음, Done을 
클릭하세요.

정보 마커 범위를 입력하는 대신에 [Option] 키(MacOS) 또는 [Alt] 키(Windows)를  
누르고 마커를 드래그하여 범위를 설정할 수도 있습니다.

이번에는 원하는 지점 주변에 인/아웃 포인트를 추가한 다음, 이를 마커로 변환해 보겠습니다.

A380 Takeoff 클립에는 커다란 소음을 내며 이륙하는 제트기가 나옵니다.

7 클립 중간 지점 즈음에 제트기 이륙 소음이 날 때까지 조그바를 천천히 드래그합니다.  
(힌트: 오디오 파형에 보이는 중간 크기의 피크 지점이 제트기 소음이 시작하는 곳입니다.)

제트기 소음 위치를 지정하면 인/아웃 포인트를 사용하여 범위를 지정하세요.

8 소스 뷰어에서 제트기 이륙 소음이 시작하는 곳으로 조그바를 옮기세요.
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9 인 포인트를 표시한 다음, 소음이 끝나는 지점에 아웃 포인트를 표시하세요.

10 인/아웃 포인트 사이를 마우스 우클릭하면 나타나는 메뉴에서 Convert In and Out to Duration 
Marker를 선택하세요.

정보 같은 메뉴를 사용하여 마커 범위를 인/아웃 포인트로 변환할 수도 
있습니다.

인/아웃 포인트와 같은 위치의 프레임을 찾을 수 있도록 Duration 마커가 추가됩니다. 같은 팝업 
메뉴를 사용해 설정창을 열 수 있습니다.

11 마커 범위를 마우스 우클릭하면 나타나는 메뉴에서 Modify Marker를 선택하세요.

마커를 변경할 수 있는 창이 나타납니다.

12 Name 입력란에 Roaring Jet Take Off를 입력하고 Done을 클릭하세요.

타임라인 속 마커의 필요를 충족시키는 음향 효과를 찾아냈으므로 이제 이 음향 효과를 트레일러에 
편집하여 시네마틱한 효과를 주도록 하겠습니다.
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오디오 작업에 맞게 
인터페이스 사용자 지정하기 
이번 과에서는 오디오 트랙 작업이 많으므로 오디오 파형 디스플레이를 더욱 자세히 볼 수 있도록 
오디오 트랙의 크기를 키워 타임라인 보기 방식을 사용자 지정해 보겠습니다. 이는 특정 사운드의 
위치를 더욱 정확하게 설정하고 오디오를 더욱 효과적으로 평가하도록 도와줍니다. 게다가 이러한 
오디오 파형의 사용은 오디오 볼륨을 결정하는데 시각적으로 매우 용이합니다.

타임라인 속 오디오 트랙을 위한 여유 공간을 더욱 확보하기 위해 트랙을 위로 옮기고 비디오 트랙 
위에 있는 공간을 삭제합니다.

1 마우스 포인터를 타임라인 속 비디오 트랙과 오디오 트랙 사이에 놓으세요.

마우스 포인터가 크기 조절 커서로 변하면 이를 위/아래로 드래그하여 오디오 또는 비디오 
트랙의 공간을 넓히거나 줄일 수 있습니다.

2 수평 분할선을 위로 드래그하여 비디오 트랙이 타임라인 맨 위에 가도록 하세요.

6과에서 했던 방식처럼 Timeline View Options 메뉴에서 오디오 트랙의 보기 방식을 변경할 
수 있습니다.

3 도구바에서 Timeline View Options 버튼을 클릭하면 팝업 메뉴가 나타납니다.

여기서 작업에 맞게 비디오 트랙과 오디오 트랙의 높이를 변경하세요.
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4 Clip View Options에서 세 번째 트랙 보기 방식 버튼을 클릭하면 오디오 트랙과 비디오 트랙이 

접힙니다.

5 Timeline View Options에서 세 번째 버튼을 클릭하면 오디오 파형이 활성화됩니다.

6 Track Height에서 비디오 트랙 높이 슬라이더를 오른쪽 끝까지 드래그하여 트랙 크기를 높이세요.

7 Track Height에서 오디오 트랙 높이 슬라이더를 오른쪽으로 반쯤 드래그하여 트랙 크기를 
높이세요.

8 Timeline View Options에서 오디오 파형 버튼을 클릭하면 타임라인 트랙의 오디오 파형이 
나타납니다.

9 Timeline View Options 버튼을 클릭하면 팝업 메뉴가 사라집니다.

이제 타임라인이 오디오 편집 및 오디오 믹싱 작업에 맞게 설정되었습니다. 나중에 다른 인터페이스 
조절 컨트롤을 추가하고, 오디오를 모니터링하겠지만, 지금은 효율적인 음향 효과 편집을 위해 
타임라인 속 파형을 크게 보이도록 하겠습니다.
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트랙 추가 및 패칭
오디오 파일의 크기가 작은 것 치고는 타임라인이 상당히 잘 정리되어 있습니다. Audio 1은 인터뷰 
전용 트랙이며 Audio 2는 음악 전용 트랙입니다. 정돈된 오디오 트랙을 유지하기 위해 빈 오디오 
트랙을 추가하여 새로운 음향 효과를 위한 공간을 제공하세요.

1 타임라인 헤더에서 Audio 2를 마우스 우클릭하면 팝업 메뉴가 나타납니다.

팝업 메뉴에는 트랙을 추가, 이동, 삭제할 수 있는 옵션이 있습니다. 사용하려는 스테레오 음향 
효과는 새로운 스테레오 오디오 트랙에 편집해야 합니다.

2 팝업 메뉴에서 Add Track > Stereo 순으로 선택하세요.

정보 여러 개의 채널을 가진 오디오 클립이 타임라인 속 한 개의 트랙에 싱글 
오디오 클립으로 나타납니다. 새로운 오디오 트랙을 처음 생성할 시 모노, 
스테레오, 5.1 서라운드, 멀티 채널 같은 오디오 포맷을 선택하세요. 이 포맷은 
나중에 변경할 수 있습니다.

Audio 3 트랙이 타임라인에 추가됩니다. 이제 소스 클립에 있는 오디오 콘텐츠를 새로운 Audio 3  
트랙에 편집할 수 있도록 오디오 트랙을 패칭합니다. 

3 A1 데스티네이션 컨트롤을 Audio 3으로 드래그하여 소스 뷰어에 있는 A1 트랙을 타임라인에 
있는 Audio 3 트랙에 맞춰 조정합니다.

이제 오디오 트랙이 패칭되었으므로 첫 번째 음향 편집을 타임라인에 편집할 수 있습니다.  
첫 번째 음향 편집의 위치를 지정해 보겠습니다.

4 소스 뷰어에서 Playback > Previous Marker를 세 번 선택하거나 또는 [Shift + 위 화살표] 키를 
눌러 클립의 첫 번째 마커로 이동합니다.
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소스 뷰어에 첫 번째 마커가 표시된 장면이 나타납니다. 뷰어 위에 나타나는 마커 오버레이를 
통해 하늘 위로 날아가는 프로펠러 비행기 장면임을 알 수 있습니다. 프레임 맨 위쪽으로 
비행기가 날아가는 몰디브 장면에 사용하기 최적인 기능입니다.

5 타임라인 뷰어를 클릭하거나 [Q] 키를 눌러 타임라인 뷰어를 활성화하세요.

6 Playback > Previous Marker 순으로 선택하거나, [Shift + 위 화살표] 키를 클릭하여 몰디브 클립 
위로 마커를 이동하세요.

음향 효과를 편집하는 가장 좋은 방법은 이전에 사용한 리플레이스 편집 기능을 사용하는 
것입니다. 보통 음향 효과를 추가할 때 프레임 속 움직임과 음향 효과의 정확한 동기화 포인트를 
맞추려고 시도합니다. 대부분 이러한 동기화 포인트는 클립의 처음 또는 마지막 부분이 아닌 
경우가 많기 때문에 다른 방법을 사용하여 클립을 정렬해야 합니다. 리플레이스 편집 기능을 
사용하여 조그 바를 음향 효과의 동기화 포인트로 옮긴 다음, 원하는 음향 효과 동기화 포인트가 
위치한 비디오 프레임에 타임라인 플레이헤드를 놓으세요. 소스 클립은 이미 날아가는 비행기의 
소음이 가장 크게 들리는 부분에 배치되어 있습니다. 이 포인트는 프레임 위로 진입하는 수상 
비행기와 일치시켜야 합니다. 

7 비행기 앞부분이 프레임 속으로 들어오는 지점으로 플레이헤드를 옮기세요.
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정보 플레이헤드를 정확하게 이동하기 어려운 경우 [N]키를 누르거나 툴바에서 
스내핑 버튼을 눌러 스내핑 기능을 해제하세요. 플레이헤드가 더 이상 마커에 
스내핑되지 않습니다.

빈 트랙에 클립을 교체할 경우에는 리플레이스 편집 기능을 사용하여 같은 트랙에 있는 클립을 
교체하는 것이 아니라 Audio 3 트랙에서처럼 반드시 인/아웃 포인트를 설정해야 합니다.

8 Mark > Mark Clip을 선택하거나, [X] 키를 눌러 몰디브 클립에 인/아웃 포인트를 표시하세요.

9 툴바에서 리플레이스 편집 버튼 또는 [F11] 키를 누르세요.

10 음향 효과를 재생하여 영상과 동기화되는지 확인하세요.

음성이 Audio 1에, 음악이 Audio 2에, 그리고 음향 효과가 Audio 3에 배치되어 트랙 레이아웃이 잘 
정돈되었습니다. 편집 작업에 걸쳐 정돈된 미디어를 유지하는 것은 매우 중요하지만, 오디오 편집에서는 
수십 개의 트랙을 관리해야 하기 때문에 미디어 관리의 중요성이 더욱 커집니다.

트랙에 컬러 표시하기
컬러 표시 레이어를 추가하면 트랙을 더욱 체계적으로 정돈할 수 있습니다. 비디오 클립에 이미 컬러 
표시를 해두었지만, 타임라인 속 트랙에도 컬러 표시가 가능합니다. 타임라인을 더욱 쉽게 분석할 
수 있도록 음악 트랙은 주황색으로, 음향 효과 트랙은 초록색으로 표시해 보겠습니다.

1 Audio 2 타임라인 헤더를 우클릭하세요.

2 팝업 메뉴가 나타나면 Track Color > Orange를 선택하세요.
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Audio 2의 음악 클립이 주황색으로 바뀝니다.

3 Audio 3 타임라인 헤더를 우클릭하세요.

4 팝업 메뉴가 나타나면 Track Color > Olive를 선택하세요.

음향 효과 클립이 올리브색으로 바뀝니다. 이 트랙에 새로 편집하는 모든 클립 색상이 올리브 
색상으로 나타납니다. 빈에 있는 클립에 컬러를 지정하면 해당 컬러가 타임라인 트랙에도 적용됩니다.

Edit Index에서 마커 찾기
지금 작업하는 것처럼 짧은 타임라인에서 마커로 이동하는 작업은 그다지 어렵지 않습니다. 하지만 
복잡한 타임라인에서는 수십 개의 마커 중 특정 마커의 위치를 빠르게 찾아내야 합니다. Edit Index는 
현재 타임라인에서 클립과 마커 같은 모든 편집 작업을 볼 수 있는 목록입니다.

1 DaVinci Resolve 창 맨 위에 있는 Edit Index 버튼을 클릭하세요.

미디어 풀 아래 Edit Index가 나타나며 모든 편집 작업과 메타데이터가 세로줄에 표시됩니다. 
짧은 타임라인임에도 불구하고 나타나는 정보가 너무 많습니다.

2 Edit Index 오른쪽 상단에 있는 메뉴 옵션을 클릭하세요.
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3 Show Markers > Red를 선택하세요.

Edit Index에 타임라인 속 빨간색 마커만 나타나도록 변경되어 훨씬 쉽게 목록을 확인할 수 
있습니다. 이것보다 더욱 간단하게 할 수도 있는데요. 빈 목록 보기에서 세로줄 정보를 숨기거나 
나타나게 할 수 있습니다.

4 칼럼 제목줄을 우클릭하면 해당 메뉴가 나타납니다.

5 메뉴에서 Number, Color, Notes를 제외한 모든 옵션 선택을 해제하세요.

이제 설정 컬러와 입력한 노트를 기준으로 각각의 마커를 확인할 수 있습니다.

6 Add Roaring Take Off 노트가 포함된 빨간색 마커를 클릭하세요.
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02_A380_Takeoff 클립에서 해당 마커가 있는 곳으로 타임라인이 건너 뛰기 합니다. 이곳에 
다음 음향 효과를 추가해보겠습니다. 소스 뷰어에 있는 마커를 찾는 대신에 DaVinci Resolve
에서 더욱 쉽게 작업할 수 있는 방법을 사용해 보겠습니다.

빈에서 마커 확인하기
소스 클립에 추가된 마커는 빈 목록 보기에서 확인할 수 있습니다. 클립 길이가 설정된 마커의 경우 
여러 개의 인/아웃 포인트를 사용하여 이를 타임라인에 직접 편집할 수 있습니다.

1 미디어 풀 위에 있는 목록 보기 버튼을 클릭하세요.

음향 효과 클립명 왼쪽에 펼치기 화살표가 있습니다. 이 화살표를 클릭하면 클립에 추가된 
마커가 나타납니다.

2 Sound FX 클립 옆에 있는 펼치기 화살표를 클릭하세요.

소스 클립에 있는 각각의 마커가 클립 파일명 아래 나타납니다. 클립 길이가 설정된 마커의 
경우 타임라인에 이를 드래그하면 클립의 길이가 인/아웃 포인트로 사용됩니다.

3 오디오 빈에서 Roaring Jet Take off 마커를 Audio 3 트랙에 드래그하여 02_A380_TAKEOFF 
클립 시작점과 같은 곳에 놓습니다.

한 개의 음향 효과를 더 추가하겠습니다.
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정보 빈 목록 보기에 있는 마커를 더블 클릭하면 소스 뷰어에 클립이 나타나고 
마커가 있는 곳에 조그바가 배치됩니다.

4 Edit Index에서 SFX - Add Loud Prop Plane 앞부분을 클릭하여 타임라인 속 플레이헤드를 
마커 위치에 재배치하세요.

5 오디오 빈에서 Loud Prop Plane 마커를 Audio 3 트랙에 드래그하여 08_SOUTH_POLE_DC3 
클립 시작점과 같은 곳에 놓습니다.

6 타임라인 시작점으로 플레이헤드를 이동한 뒤, 새로 추가한 음향 효과를 재생하세요.

모든 오디오 트랙과 음악, 내레이션, 음향 효과의 위치 지정이 완료되었습니다.
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클립 연결하기
오디오와 비디오를 같이 캡처한 클립은 DaVinci Resolve에서 자동으로 연결됩니다. 이러한 속성으로 
오디오와 비디오를 함께 훨씬 쉽게 이동하고 트리밍할 수 있으며 동기화가 유지됩니다. 하지만, 새로 
추가한 음향 효과는 이야기가 다릅니다. 음향 효과는 연결된 영상이 없기 때문이죠. 하지만 영상과 
동기화를 연결하여 영상 클립을 옮길 시에 음향 효과가 밑에 같이 움직이도록 할 수는 있습니다.

1 타임라인에서 02_A380_TAKEOFF 클립을 선택하세요.

2 [command] 키(macOS) 또는 [Ctrl] 키(Windows)를 누른 상태에서 02_A380_TAKEOFF 클립 
바로 밑에 있는 Audio 3의 음향 효과를 클릭하세요.

나중에 A380 클립을 움직이거나, 이를 삭제할 시에 두 개의 클립이 함께 움직여야 합니다. 
이렇게 하기 위해선 클립과 음향 효과를 연결해야 합니다.

3 SOUND FX 클립을 우클릭하면 나타나는 팝업 메뉴에서 Link Clips를 선택하세요.

타임라인 클립명 앞에 작은 연결 아이콘이 나타납니다. 이 아이콘은 오디오 클립이 다른 클립과 
연결되어 있음을 의미합니다. 타임라인에서 하나를 선택하면 마치 함께 녹화한 것처럼 연결된 
다른 하나도 선택됩니다.

4 타임라인을 훑어보고 남은 세 개의 음향 효과를 해당 비디오 클립과 연결합니다.

타임라인 툴바에 있는 링크 선택 버튼은 함께 녹화해서 연결된 클립처럼 클립을 서로 연결합니다.
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오디오 모니터링/솔로/음소거
오디오 편집을 시작할 때 가장 먼저 해야 하는 일은 바로 오디오를 들어보는 일입니다. 오디오 트랙을 
재생하여 영상 내용과 함께 확인합니다.

1 [Home] 키를 누른 다음, 스페이스바를 눌러 타임라인을 끝까지 재생합니다.

각각의 오디오 트랙 내용을 이해하기 위해서 솔로 모드로 개별 트랙을 각각 들어볼 수 있습니다.

2 [Home] 키를 눌러 플레이헤드를 타임라인 시작 부분으로 이동하세요.

3 Audio 1에서 솔로 버튼을 누르면 일시적으로 다른 오디오 트랙은 음소거 됩니다.

4 스페이스 바를 누르면 타임라인이 재생됩니다.

인터뷰 오디오만 들리고 다른 두 개의 트랙은 재생되지 않습니다.

5 타임라인이 재생되는 동안 Audio 3에 있는 솔로 버튼을 클릭해 음향 효과를 확인하세요.

여러 개의 트랙을 솔로 처리하여 선택한 트랙의 오디오만 들을 수 있도록 할 수 있습니다.

오디오 미터를 사용하여 오디오 레벨을 정확하게 모니터링합니다.

6 DaVinci Resolve 인터페이스 오른쪽 상단에 있는 믹서 버튼을 누르면 오디오 믹서가 나타납니다.

믹서 패널을 사용하여 오디오 미터와 함께 각 트랙의 오디오 레벨을 모니터링하세요. 오디오 
미터는 오디오 볼륨 및 프로세싱 조절을 위한 시각적 지표 역할을 합니다. DaVinci Resolve의 
오디오 미터는 중간 지점인 평균 레벨을 계속해서 생성하며 오디오 미터의 얇은 원픽셀 라인은 
오디오 피크를 나타냅니다. 하지만 편집 페이지에서는 같은 트랙에 있는 클립 오디오의 일관성을 
유지하는 것이 목표이므로 모든 내러티브가 같은 오디오 레벨로 맞춰지며 비슷한 음향 효과 
또한 모두 일정한 레벨을 유지합니다.

7 타임라인을 재생하여 솔로 처리된 트랙을 오디오 미터와 함께 확인하세요.

미터에 각 오디오 트랙이 나타나는 것을 확인하여 트랙에 맞게 적절한 레벨로 맞추세요.

정보일부 Mac용 키보드에서는 [home] 키와 [end] 키가 지원되지 않습니다. 타임라인 
시작점으로 이동할 시에는 [fn] 키와 왼쪽 화살표 키를, 끝으로 이동할 시에서는  
[fn] 키와 오른쪽 화살표 키를 함께 누르세요.
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미터 읽기 및 타겟 설정하기
클립의 볼륨을 조절하기 전에 오디오 믹서에서 사용하는 것과 같은 RMS(평균제곱근값) 피크 미터를 
읽는 방법을 배우는 것이 중요합니다. 오디오 믹서에서 사용하는 미터는 데시벨(dB) 눈금을 사용하여 
오디오 클립의 볼륨을 측정합니다. 이 미터 범위는 최대 0 dB에서 -50 dB에 이릅니다. 0 dB을 
넘어서는 모든 오디오 레벨은 왜곡 현상이 발생하기 때문에 반드시 0 dB 밑으로 항상 유지해야 
합니다. 어떠한 상황에서도 변치 않는 원칙은 아니지만, 다이얼로그, 음향 효과, 음악 트랙에는 
일반적으로 시작 포인트로 좋은 dB 표적 레벨이 있습니다.

일반적인 음성 대화의 오디오 레벨은 평균 -12 dB 정도입니다. 

음향 효과는 매우 다양하기 때문에 표적 범위가 훨씬 넓지만, 일반적으로 -10과 -30dB 사이에 오도록 
합니다.

음악 트랙은 넓은 다이나믹 레인지를 필요로 하지만, -20과 -30 dB 사이에 오는 것이 좋습니다.

이러한 오디오 레벨 기준 값은 시작 포인트로 사용하기에는 좋지만, 결국 직접 오디오를 듣고 최종 
결정을 내리게 됩니다.

오디오 믹싱 첫 단계는 각 클립에 포함된 오디오 형식에 맞게 레벨을 조절하는 것입니다. 결국 모든 
다이얼로그 클립은 한 개의 다이얼로그 트랙에 놓고 대략 같은 오디오 레벨로 재생해야 합니다. 
싱글 트랙과 표적 dB-레벨 전략은 모든 음향 효과 및 음악에 적용됩니다. 하지만, 지금 단계에서는 
클립 레벨로 오디오를 믹싱할 것이기 때문에 다이얼로그 레벨과 음악 또는 음향 효과 레벨을 비교할 
필요는 없습니다. 나중에 Fairlight 페이지에서 작업할 때 트랙 레벨 믹싱을 다루게 됩니다.

오디오 트랙 1에 있는 다이얼로그를 먼저 작업해 보겠습니다.

오디오 정규화
모든 비디오와 오디오를 타임라인에 편집하고 나면 작업 중인 프로젝트에 맞게 오디오 레벨을 
설정할 준비가 완료됩니다. 먼저, 주요 오디오를 가진 오디오 트랙을 분석합니다. 여기서는 Audio1의  
인터뷰 클립이 주요 오디오이므로 이 클립을 최대 볼륨 레벨로 설정합니다.

1 플레이헤드를 타임라인 시작점에 놓습니다.

2 Audio 1 트랙에만 솔로 처리가 되어있는지 확인하세요.

클리핑 레벨

다이얼로그 타겟

음향 효과 타겟

음악 타겟
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3 [Shift + z] 키를 눌러 Audio 1에 있는 모든 클립을 확인하세요.

4 Audio 1에 있는 클립에 선택 상자를 드래그하거나, [Cmd] 키(macOS) 또는 [Ctrl] 키(Windows)를  
누른 상태에서 여러 클립을 선택하세요. 

오디오 정규화 기능을 사용하면 선택한 클립을 최대 볼륨으로 빠르게 설정할 수 있습니다.

5 선택한 오디오 클립을 우클릭하고 Normalize Audio Levels를 선택하세요.

그러면 특정 dBFS 레벨에 도달하기 위한 오디오 피크를 표적으로 하여 오디오를 증폭시킬 수 
있는 설정창이 나타납니다. 대부분의 다이얼로그 및 보이스오버에서 사용하기 좋은 시작점은 
-12 dBFS 정도입니다. 오디오 피크는 약간 높게 설정해도 됩니다.

6 Reference Level 입력란에는 -5를 입력하세요.

설정창 아래에 있는 두 개의 옵션은 모든 클립의 가장 높은 피크를 사용하여 표적 레퍼런스 
레벨을 설정할 것인지 또는 선택한 클립의 피크를 표적 레퍼런스 레벨에 도달하도록 증폭시킬 
것인지 결정합니다. Audio 1 트랙에는 다양한 레벨의 오디오가 많기 때문에 오디오 클립의 
피크를 각각 최대치로 조절해 보겠습니다.

7 Independent 옵션을 선택하세요.
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8 Normalize를 클릭하고 트랙 1의 오디오를 재생하여 어떤 오디오를 일정하게 유지할 것인지 

결정합니다.

오디오를 재생하면서 믹서 레벨을 확인하세요. 평균 오디오 레벨은 약 -10과 -15 dBFS 사이를 
오갑니다. 오디오 트랙의 가장 높은 피크값은 목표값인 -5 dBFS을 절대 넘기지 않습니다.

Inspector에서 오디오 레벨 설정하기
오디오 트랙을 재생해보면 끝에서 두 번째 클립의 사운드가 다른 것에 비해 현저하게 낮은 것을 
확인하실 수 있습니다. 모든 클립은 서로 다르기 때문에 자동 정규화 기능에 더해서 일부 클립의 
조절이 필요합니다.

1 스무스 컷 트랜지션이 있는 두 개의 오디오 클립 사이로 플레이헤드를 옮기세요.

2 끝에서 두 번째 오디오 클립을 선택하고 Inspector 버튼을 클릭하면 Inspector가 나타납니다.

타임라인에서 오디오 클립을 선택하면 Inspector에 오디오 레벨 피치, EQ 파라미터가 나타납니다.

3 Volume 슬라이더를 오른쪽으로 드래그하여 10으로 설정하세요.

정보 선택한 클립의 볼륨을 증가 또는 낮추려면 MacOS에서는 [Cmd+Option+
플러스] 키 또는 [Cmd+Option+마이너스] 키를 누르고 Windows에서는 [Ctrl+Alt+
플러스] 또는 [Ctrl+Alt+마이너스] 키를 누르세요.
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4 클립을 재생하고 미터를 확인하여 -10과 -15 dB 사이에 오는지 확인하세요. 오디오 미터가 -10 dB을  
계속해서 넘어서는 경우 Volume 슬라이더를 왼쪽으로 드래그하여 클립 레벨을 약간 낮추세요.

-12 dB 정도로 오디오 레벨을 최적화시키는 것이 중요합니다. 그렇지 않으면 주요 클립의 사운드가 
너무 낮아 디지털 오디오 녹음 작업에서 풀 다이나믹 레인지가 가진 장점을 살릴 수 없게 됩니다.

타임라인에서 레벨 설정하기
오디오 레벨을 신속하게 조절해야 할 경우 타임라인 속 볼륨 커브를 사용해 그래픽으로 클립의 
오디오 레벨을 변경할 수 있습니다.

1 Audio 3의 트랙 헤더에서 솔로(S) 버튼을 클릭하면 해당 음향 효과만 재생됩니다.

2 Audio 3 타임라인에서 음향 효과 시작 부분에 플레이헤드를 놓으세요.

3 필요한 경우 스크롤 바를 타임라인 아래로 드래그하면 타임라인 창에서 세 개의 음향 효과를 
모두 확인할 수 있습니다.

4 이 세 개의 음향 효과를 재생하고 미터를 통해 A3의 오디오를 모니터링하세요.

세 종류의 음향 효과 모두 볼륨이 너무 높습니다. 오디오 레벨이 모두 일렬로 일치해서도 
안됩니다.

어림잡아 -10에서 -30 dB 범위로 음향 효과 레벨을 설정하여 사용할 수 있습니다.

5 Audio 3의 음향 효과 오디오 클립에서 중간에 가로지르는 흰색 선에 마우스 포인터를 두세요.

이 흰색 라인은 볼륨 커브로 해당 클립의 볼륨 레벨을 나타냅니다. 볼륨 커브를 아래로 드래그하여 
내리면 Inspector에서 볼륨 슬라이더를 왼쪽으로 움직였을 때처럼 볼륨이 낮아집니다.

6 마우스 포인터가 위/아래 화살표로 바뀌면 약 -10 dB이 될 때까지 볼륨 커브를 아래로 
드래그하세요.

이제 오디오 볼륨이 10 dB으로 낮춰졌습니다.

정보 설정값 표시에는 현재 값에 오프셋이 적용된 값이 나타납니다. 오디오가 
미터에 도달하는 정확한 dB 레벨은 나타나지 않습니다. dBFS(dB Full Scale)라는  
용어는 정확인 미터 측정값을 나타내지만 간단한 dB값은 오프셋 레벨을 
나타냅니다.



184
제

7과
 

편
집

 페
이

지
에

서
 오

디
오

 작
업

하
기

 
모든 음향 효과는 처음 재생하면 크게 들릴 수가 있습니다. 이 전에 배운 복사/붙이기 방식을 
이용하여 오디오 클립의 낮은 레벨을 다른 클립에 쉽게 복사할 수 있습니다.

7 A3의 첫 번째 음향 효과 클립을 선택하세요.

8 Edit > Copy를 선택하거나, [Cmd + C](macOS) 키 또는 [Ctrl+C](Windows) 키를 누르세요.

9 A3에서 두 번째 음향 효과 클립을 선택하고, [Cmd](macOS)키 또는 [Ctrl](Windows) 키를 누른 
상태에서 세 번째와 마지막 음향 효과 클립을 모두 클릭하세요.

10 Edit > Paste Attributes를 선택하거나, [Option+V](macOS) 또는 [Alt+V](Windows) 키를 누르세요.

Audio Attributes 창에는 한 클립에서 다른 클립으로 복사/붙여넣기 할 수 있는 클립 속성이 
포함되어 있습니다.

11 Audio Attributes Volume 확인란을 선택하고 Apply를 클릭하세요.

첫 번째 인터뷰 클립의 볼륨 속성이 선택된 클립에 붙이기 되었습니다.

12 타임라인을 재생하세요. Volume 슬라이더를 드래그하여 더욱 미세하게 볼륨을 조정하세요.

클립에 같은 오디오 레벨 속성을 복사/붙여넣기 하면 복잡한 타임라인에서 많은 시간을 절약할 수 
있지만, 클립을 재생하여 오디오 레벨이 적절한지 확인해야 합니다.

클립 속 오디오 레벨 변경하기
음악 트랙은 오디오 믹싱에 통합시킬 마지막 트랙입니다. 한 개의 음악 클립 안에 있는 두 개의 
오디오 레벨을 서로 다르게 설정해야 하므로 다른 트랙보다 레벨 설정이 약간 복잡합니다. 타임라인에서 
음악은 인터뷰 오디오 밑에 깔리기 때문에 조용한 레벨로 재생되다가 인터뷰가 끝나면 볼륨이 다시 
점점 올라갑니다. 편집 페이지에서는 키프레임을 사용해 다양한 방식으로 한 클립에 여러 개의 
레벨을 설정할 수 있습니다.

1 트랙 헤더에서 A1과 A2의 솔로 버튼을 해제하세요.

이제 세 가지의 모든 오디오 트랙을 함께 들을 수 있습니다.

먼저 인터뷰가 시작되는 곳의 음악 볼륨 레벨을 낮게 설정하겠습니다. 인터뷰 대사와 음악 
소리가 충돌하지는 않으면서 해당 장면의 배경 음악으로 사용할 수 있을 정도로 낮게 설정합니다. 
타임라인에서 볼륨 라인을 드래그하면 바로 레벨을 설정할 수 있습니다. 여기서도 마찬가지로, 
어림잡아 -20에서 -30 dBFS 사이에 오도록 하면 됩니다.

2 음악 클립에서는 약 -20 dB이 될 때까지 볼륨 라인을 아래로 드래그하세요.
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3 오디오가 믹싱된 타임라인을 재생하세요.

전체 레벨 커브를 드래그하여 클립의 전체 오디오 레벨을 설정하세요. 전체 오디오 레벨은 
타임라인 속 인터뷰 부분에는 적당할 수 있지만 비행기 장면에서는 너무 낮아 소리가 전혀 
들리지 않습니다. 볼륨 라인 조절을 위한 키프레임을 추가하여 시간이 갈수록 클립의 볼륨이 
변하도록 설정할 수 있습니다.

4 첫 번째 인터뷰 클립 맨 끝에 플레이헤드를 놓으세요.

이곳의 오디오 볼륨을 높여야 하므로 음악 클립에 키프레임을 추가합니다.

5 음악 클립에서 [option] 키(macOS) 또는 [Alt] 키(Windows)를 클릭한 상태에서 플레이헤드 아래 
있는 볼륨 라인을 클릭하여 키프레임을 추가합니다.

하얀색 점으로 나타나는 키프레임이 커브에 추가되었습니다. 이 키프레임은 음악 볼륨이 
올라가는 지점을 표시합니다. 이제 설정한 지점 앞에 다른 키프레임을 설정하여 음악이 최고조에 
달하는 지점을 지정하세요.

6 타임라인 빈 곳을 클릭하여 클립 선택을 해제합니다.

7 -12를 입력하고 [Enter/Return] 키를 눌러 플레이헤드를 0.5초 앞으로 이동합니다.

8 [option] 키(macOS) 또는 [Alt] 키(Windows)와 함께 플레이헤드 아래에 위치한 레벨 커브를 
클릭하여 키프레임을 추가하세요.
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볼륨이 서서히 변하거나, 갑자기 올라가도록 설정이 변경되었습니다. 두 번째 키프레임의 수직 
위치를 변경하면 볼륨이 급격하게 증가합니다.

9 음악 클립의 두 번째 키프레임에 마우스 포인터를 놓으세요.

마우스 포인터가 바뀌면서 키프레임 위에 위치했음을 나타냅니다.

10 약 -10.00 db이 될 때까지 키프레임을 위로 드래그합니다.

11 타임라인 첫 부분을 재생하여 볼륨이 새로 설정된 오디오 믹스를 확인하세요.

첫 번째 인터뷰 영상의 오디오 볼륨 레벨만 설정한 상태이기 때문에 타임라인 속 나머지 오디오 
볼륨이 너무 낮게 느껴집니다. 키프레임을 계속 추가하여 전체 타임라인의 오디오 레벨을 조절할 
수 있지만, 이번 과에서는 여기까지 하고 다음 과에서 Fairlight 페이지를 사용하여 작업을 마무리 
지어보겠습니다.

오디오 페이드 추가하기
대부분의 오디오 페이드는 송수신 오디오 클립을 부드럽게 하는 하나의 수정 처리 작업 역할을 
합니다. 특히 P와 B 같은 파열음으로 시작하는 내레이션 및 다이얼로그에서 음성이 너무 강해 
변경이 필요할 경우에는 섬세한 페이드 조절이 주로 적용됩니다. 음악에 페이드 인과 페이드 아웃 
기법 또한 사용하게 될 것입니다.

1 타임라인 시작 부분을 재생하여 음악이 시작되는 부분에서 멈추세요.

음악의 오디오 레벨이 아무리 낮게 설정되어 있어도 음악이 갑자기 시작되는 느낌을 줍니다. 
인터뷰 영상 중간 즈음에 음악이 시작되어 비행기가 나타나는 부분에서 음악이 최고조에 
오르도록 설정해야 합니다. 적당히 긴 페이드 인 효과를 사용하여 천천히 구축되도록 할 수 
있습니다.

2 [Shift + Z] 키를 누르면 전체 타임라인을 볼 수 있습니다. 

3 타임라인에서 마우스 포인터를 음악 클립 위에 가져가세요.

오디오 페이드 핸들은 클립 오른쪽과 왼쪽 상단에 나타납니다.
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4 왼쪽 핸들을 클립 중간 방향으로 드래그하여 설정값이 +2.00이 되도록 합니다.

정보 페이드 핸들을 드래그하는 대신 페이드 인이 정지되는 곳에 플레이헤드를 
놓고 Trim > Fade In to Playhead를 선택하세요.

클립 시작점에 2초짜리 페이드 인 효과를 추가하였습니다.

5 타임라인 시작점을 재생하여 새로운 페이드 인 오디오를 확인하세요.

모든 조합의 페이드 핸들과 레벨 커브, Inspector 설정 변경을 자유자재로 사용하여 오디오 트랙을 
개선할 수는 있지만, 이러한 모든 도구 및 기술의 사용은 단지 시작에 불과합니다. 다음 과에서는 
진정한 멀티 트랙의 영화용 사운드 트랙 작업을 위해 DaVinci Resolve의 Fairlight 페이지를 사용해 
보도록 하겠습니다.

복습하기
1 타임라인 눈금자에 마커를 표시할 때 반드시 확인해야 하는 것은 무엇인가요?

2 타임라인의 모든 마커 목록은 어디서 확인하나요?

3 타임라인 오디오 클립의 볼륨 라인에 키프레임은 추가하는 방법은 무엇인가요?

4 Normalize Audio 창에서 실행할 수 있는 기능은 무엇인가요?

5 편집 페이지에서 RMS/Peak 미터를 확인할 시 -5 dbFS 정도의 오디오는 너무 조용합니다.  
T(진실) 또는 F(거짓)로 답하세요.
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정답
1 타임라인 눈금자에 마커를 추가하려면 선택된 클립이 없는지 확인해야 합니다.

2 Edit Index에서 일부 또는 전체 타임라인 마커 목록을 확인할 수 있습니다.

3 [option] 키(macOS) 또는 [Alt] 키(Windows)와 함께 볼륨 라인을 클릭하세요.

4 Normalize Audio 창에서 dbFS 값을 입력할 수 있으므로 선택한 한 개 또는 그 이상의 클립을 
위한 가장 높은 피크값을 설정할 수 있습니다.

5 F. 편집 페이지에서 RMS/Peak 미터를 확인할 시에 0이 가장 높은 값이므로 -5 dbFS은 매우 
높은 것에 속합니다.
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Fairlight 사운드 믹싱: 
인터페이스 둘러보기

영화 제작이 시각 예술 분야에만 국한되어 있다면 
왜 전문 제작 업체들이 수많은 시간과 노력, 그리고 
비용을 들여 완벽한 사운드트랙을 만들려고 하는 
걸까요? 이는 시각적인 이야기 전개에 있어 고품질의 
오디오가 빠질 수 없기 때문입니다. 보통 아마추어와 
전문 제작자의 실력 차이가 여기서 나타나게 됩니다. 

DaVinci Resolve 15의 Fairlight 페이지는 필름 및 
영상 프로덕션에서 시네마 수준의 음향을 구현할 
수 있도록 특별 제작된 작업 공간입니다. 무엇보다도 
편집 응용 프로그램에 모든 기능이 통합되어 있어 
최종 딜리버리 미디어를 마스터하는 순간까지 편집/
시각 효과/색상/사운드 믹싱 작업을 언제든 조정할 
수 있습니다. Fairlight 페이지와 DaVinci Resolve의 
조합으로 프로젝트를 처음부터 끝까지 작업할 수 
있는 영화 제작 업계의 판도를 뒤바꿀만한 통합형 
프로그램입니다.

이번 과에서는 Fairlight 페이지를 살펴보며 음향 
효과 및 내레이션 편집, 보이스오버 녹음, FairlightFX를 
사용해 백그라운드 험 노이즈 제거하기 등의 방법을 

배워볼 수 있습니다.

예상 소요 시간

이 과를 학습하는 데는 약 45분 
정도의 시간이 소요됩니다.

학습 목표

인터페이스 둘러보기 190

트랙 이름 변경 및 색상 표시하기 195

스포팅 목록 보기 196

트랙 포맷 변경하기 198

Fairlight에서 클립 트리밍하기 199

음향 효과 정렬하기 201

타임라인에서 오디오 녹음하기 204

클립 속성 변경하기 207

Fairlight FX 사용하기 210

서브믹스로 트랙 정돈하기 215

트랙 레벨 설정하기 219

복습하기 221
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인터페이스 둘러보기
이제 워크플로에 관한 이야기를 나누어보겠습니다. 현재 작업 중인 프로젝트의 편집 작업 대부분이 
끝났기 때문에 이제 거의 마무리 단계에 있다고 볼 수 있습니다. 일정 단계가 지나면 오디오 피니싱 
작업으로 넘어가야 합니다. 보통 모든 오디오 후반 제작 과정은 개별 오디오 소프트웨어를 사용해 
따로 마무리합니다. 그 결과 오디오 후반 제작 프로그램과 함께 편집된 타임라인을 공유하는 과정에서 
미디어를 여러 번 변환 및 복제하게 됩니다. 이제 DaVinci Resolve 15를 사용해 이런 복잡한 워크플로를 
간소화시켜 보겠습니다.

1 DaVinci Resolve를 열고 프로젝트 매니저(Project Manager)에서 Age of Airplanes 프로젝트를 
여세요.

2 러프 컷(Rough Cuts) 빈에서 05 Fairlight Rough Cut을 더블 클릭하면 해당 클립이 타임라인에 
나타납니다. 

이 타임라인은 이전 과에서 사용했던 것과는 약간의 차이가 있습니다. 지금까지의 모든 볼륨 
변경 내용과 음악 트랙의 키프레이밍 및 페이드 업이 포함되어 있을 뿐 아니라 다양한 음향 
효과까지 지원합니다.

3 DaVinci Resolve 인터페이스 아래 쪽에 있는 Fairlight 버튼을 클릭하세요. 

이 버튼 하나만 클릭하면 편집 작업에서 오디오 후반 작업으로 넘어갈 수 있습니다.

인터페이스에 커다란 타임라인 하나만 있는 것처럼 보일 수 있지만, 사실 Fairlight 페이지는 4 
구역으로 구성되어 있습니다.

재생, 검색, 녹음을 위한 
타임라인 트랜스포트 

컨트롤

개별 채널이 포함된 각 
오디오 트랙이 표시되는 

타임라인 

자주 사용하는 도구와 
명령어를 위한 툴바

패널 표시하기/감추기용 
인터페이스 툴바
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편집 페이지에서 볼 수 있는 것과 동일한 색상으로 표시된 트랙과 마커, 오디오 레벨이 포함된 
현재 사용 중인 타임라인을 이제 Fairlight 페이지에서도 사용 가능합니다. Fairlight는 멀티 채널 
오디오 녹음과 편집, 믹싱, 스위트닝에 최적화되어 있기 때문에 구성이 약간 다릅니다. 보시다시피 
기본 레이아웃에 오디오 타임라인만 나타나도록 설정되어 있습니다. 하지만 필요에 따라 
인터페이스 툴바에서 다른 패널을 열어 사용할 수 있습니다. 미디어 풀과 뷰어, 미터, 믹서는 
나타나지 않도록 기본 설정되어 있습니다.

4 인터페이스 툴바의 우측 상단에 있는 Meters 버튼을 클릭하면 모니터링(Monitoring) 패널이 
나타납니다.

이름에서 알 수 있듯이 모니터링 패널에는 현재 타임라인의 모든 오디오 및 비디오 콘텐츠가 
표시됩니다. 트랙 레벨의 균형을 맞추는데 사용하는 확장형 오디오 믹서 또한 탑재되어 있습니다.

5 인터페이스 툴바에서 Mixer 버튼을 클릭하면 믹서가 나타납니다.

6 Mixer의 좌측 끝부분을 왼쪽으로 드래그하면 믹서가 확장되어 5개의 모든 트랙을 위한 채널 
스트립이 나타납니다.
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Fairlight Mixer에 있는 여러 컨트롤을 한눈에 알아차릴 수 있는데, 특히 믹서 상단에서 Effects 
슬롯과 EQ, Dynamics, Pan 컨트롤을 확인할 수 있습니다. 믹서 사용법은 이 과의 뒷부분에서 
더 자세히 배울 수 있습니다. 그럼 이제 프로젝트를 재생해보겠습니다. Edit 페이지에서 배운 
여러 재생 기술은 여기서도 사용할 수 있습니다. 

7 플레이헤드를 타임라인 시작점으로 드래그하거나 [Home] 키를 누르세요.

8 스페이스 바를 누르면 프로젝트 재생이 시작됩니다.

9 [K] 키를 누르면 재생이 일시 정지되고 [L] 키를 두 번 누르면 빨리 감기 모드로 재생됩니다.

10 [J] 키를 누르면 역방향으로 재생됩니다. 

11 타임라인 위에 있는 트랜스포트 컨트롤에서 정지 버튼을 클릭하거나 스페이스 바를 다시 누르면 
재생이 정지됩니다.

12 필요할 경우 [Shift + Z] 키를 눌러 타임라인에 있는 모든 클립을 수평 방향으로 정렬할 수 있습니다. 

Edit 페이지와는 달리 각 트랙에 포함된 채널 번호가 나타나는 것을 확인할 수 있습니다. Audio 
1 트랙의 두 채널을 좀 더 명확하게 볼 수 있도록 오디오 트랙을 수직으로 확장해보겠습니다.

13 [Shift] 키를 길게 누른 채 마우스의 가운데 휠을 스크롤하면 타임라인 창의 오디오 트랙이 
수직으로 정렬됩니다.
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정보 Fairlight의 타임라인을 줌인할 때 가로 방향으로 확대하면 플레이헤드를 
중심으로, 세로 방향으로 확대하면 선택한 트랙을 중심으로 줌인 기능이 
적용됩니다.

또한 트랜스포트 컨트롤 스트립에는 재생, 되감기, 빨리 감기와 같은 기타 표준 트랜스포트 
컨트롤과 반복 재생 및 녹음 등의 오디오 전용 트랜스포트 컨트롤이 포함되어 있습니다.

비디오 미리보기
일반적인 오디오 후반 제작 워크플로에서는 오디오 편집자가 사운드트랙을 생성할 때 별도의 
레퍼런스 비디오를 가이드로 사용합니다. 하지만 Resolve의 경우 Fairlight 페이지에 타임라인의 
비디오를 보여주는 뷰어가 탑재되어 있어 레퍼런스 비디오가 따로 필요 없습니다. 모니터링 패널에서 
뷰어를 다른 미터와 함께 두거나 개별 창으로 따로 확장할 수 있습니다. 지금까지 모니터링 패널과 
믹서를 확장해 살펴봤습니다. 이제 인터페이스를 간소화시켜 타임라인과 뷰어를 집중적으로 
살펴보겠습니다.

1 인터페이스 툴바 우측 상단에 있는 Mixer 버튼을 클릭하면 믹서가 나타납니다.

2 스페이스 바를 누르고 재생이 진행되는 동안 미터와 뷰어를 살펴봅니다.

3 미터에는 모든 트랙 및 출력 레벨이 나타납니다. 해당 프로젝트에는 오디오 트랙이 몇 개밖에 
없으므로 뷰어를 개별 창으로 확장하고 미터가 나타나지 않도록 하겠습니다.

4 뷰어에서 확장 버튼을 클릭하면 뷰어가 개별 팝업 창으로 전환됩니다.

5 Meters 버튼을 클릭하면 모니터링 패널이 사라집니다.

6 팝업 뷰어 창을 화면 좌측 하단으로 옮기세요.
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오디오 트랙 위에서 비디오 타임라인 영상을 확인할 수도 있습니다.

7 툴바에서 타임라인 보기 옵션(Timeline View Options) 버튼을 클릭하세요.

8 Timeline View Options 팝업 메뉴 상단에 있는 비디오 트랙(Video Tracks) 버튼을 클릭하세요.

Fairlight 타임라인에 있는 오디오 트랙 위에 비디오 트랙과 모든 편집 영상이 나타납니다. Blackmagic 
DeckLink 카드 또는 UltraStudio를 사용 중일 경우 비디오를 두 번째 영상 디스플레이에서 볼 수 
있습니다.
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트랙 이름 변경 및 색상 표시하기
오디오 트랙 개수가 늘어나고 이를 신속하게 검색해야 하는 상황에서는 트랙 관리 능력이 아주 
중요합니다. 각기 다른 유형의 트랙에 사용한 트랙 번호를 기억하는 대신 트랙명을 콘텐츠에 대한 
설명으로 바꿀 수 있습니다. 이 프로젝트에서는 알파벳 대문자만 사용해 개별 트랙명을 설정하도록 
하겠습니다. 오디오 후반 제작 과정에서는 흔히 트랙명에 알파벳 대문자를 사용하는데, 이는 트랙 
헤더와 오디오 믹서에서 읽기 쉽기 때문입니다.

1 Audio 1 트랙 헤더를 클릭하면 해당 트랙이 선택됩니다.

몇 개의 트랙은 손쉽게 다룰 수 있지만 프로젝트에 5개 이상의 트랙이 있는 경우도 있습니다. 
이런 경우엔 트랙 번호보다 좀 더 명확한 방법이 필요합니다. 다행히 DaVinci Resolve의 경우 
오디오 트랙명을 헤더에서 입력할 수 있습니다.

2 A1 트랙 헤더에서 Audio 1을 더블 클릭하세요. SYNC라고 입력한 다음 [Return] 키를 누르세요.

이 트랙에는 동기화된 인터뷰 음성이 포함되어 있습니다. 다음 두 트랙에는 음향 효과가 포함되어 
있으며, 마지막 두 트랙은 음악을 위한 트랙입니다.

3 Audio 2와 Audio 3 이름을 각각 SFX 01과 SFX 02로 입력하세요.

4 Audio 4 트랙을 클릭하고 트랙명을 DRUM HITS로 입력하세요.

5 Audio 5 트랙을 클릭하고 트랙명을 MUSIC으로 입력하세요.

Fairlight 페이지에서는 Edit 페이지와 마찬가지로 새로운 트랙에 색상을 표시해 관리할 수 
있습니다. 

6 SFX 01 트랙 헤더를 우클릭한 다음 Change Track Color > Lime을 선택하세요.



196
제

8
과

 
F

ai
rl

ig
h

t 
사

운
드

 믹
싱

: 
인

터
페

이
스

 둘
러

보
기

7 SFX 02에서도 같은 과정을 반복합니다.

8 DRUM HITS 트랙에서 헤더를 우클릭한 다음 Change Track Color > Yellow를 선택하세요.

9 MUSIC에서도 같은 과정을 반복합니다.

이제 비슷한 음향 요소의 트랙에 같은 색상이 표시되어 있기 때문에 규모가 큰 타임라인도 쉽게 
분석할 수 있습니다. 정리하자면 트랙 몇 개만 작업하는 경우엔 굳이 트랙의 이름을 설정하고 색상을 
지정할 필요는 없지만, 여러 개의 트랙을 작업하는 경우엔 체계적인 방식으로 작업하는 것이 좋습니다.

스포팅 목록 보기
후반 제작 작업엔 여러 사람이 함께 참여하기 때문에 원활한 의사소통이 필수입니다. 따라서 
프로젝트에 필요한 오디오 업무 목록을 작성하는 것이 중요합니다. 대부분의 프로젝트에는 기억해야 
할 수많은 세부 사항이 포함되어 있기 때문에 혼자서 모든 편집 및 오디오 믹싱 작업을 수행할 
경우에도 반드시 목록을 작성해야 합니다.

목록에는 음악과 음향 효과, 부가적인 보이스오버를 어디에 배치할 것인지와 같은 기본적인 결정 
사항을 반드시 포함시켜야 합니다. 이런 결정 사항들은 스포팅 목록에 문서화되어 있는데, 보통 
감독과 음향 편집자, 그리고 작곡가가 함께 프로그램을 시청하며 음향 효과와 음악이 필요한 부분을 
확인 또는 발견할 수 있습니다.

모든 작업을 혼자서 진행하더라도 추가하려는 모든 오디오 요소에 관한 스포팅 목록이 필요합니다. 
Index 패널은 Edit 페이지 및 Fairlight 페이지에 추가한 새로운 마커를 활용하여 스포팅 목록을 
작성하는 데 큰 도움이 됩니다.

1 인터페이스 툴바의 좌측 상단에 있는 Index 버튼을 클릭하세요.
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Index는 두 가지 탭으로 구성되어 있습니다. 첫 번째 탭에서는 현재 타임라인에 있는 모든 
트랙을 확인할 수 있습니다. 두 번째 탭에는 타임라인에 추가된 마커가 나타납니다. 

2 Index의 Markers 탭을 클릭하세요.

Markers 색인을 통해 각 타임라인 마커의 썸네일 및 타임코드 위치를 확인할 수 있습니다. 
Name과 Notes 입력란에 입력한 모든 텍스트 또한 목록 보기 형태로 나타납니다.

3 Index 창 상단에 있는 목록 보기 버튼을 클릭하면 인덱스 목록이 나타납니다.

목록 보기에서 칼럼의 마커 정보를 사용하면 칼럼에 필요한 정보만 나타나게 할 수 있어 스포팅 
목록을 생성하는 데 도움이 됩니다. 

4 칼럼 제목 중 하나를 마우스로 우클릭한 다음 Start TC, End TC, Duration 선택을 해제하면 
Index에 해당 칼럼이 더 이상 표시되지 않습니다.

5 Frame 칼럼 헤더를 클릭하면 타임라인에 나타나는 순서대로 마커가 정렬됩니다.

이제 마커 스포팅 목록 설정이 완료되었으므로 다음 사운드트랙 작업에서 이를 가이드로 활용할 
수 있습니다. 
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정보 선택한 칼럼 헤더에 따라 마커를 오름차순 또는 내림차순으로 정렬할 수 
있습니다. 이를 위해 Frames 칼럼으로 정렬하면 마커가 타임라인에 나타나는 
순서대로 유지됩니다.

6 목록의 첫 번째 마커를 더블 클릭하세요.

정보 Fairlight 페이지에서 [Shift + 위/아래 화살표] 버튼을 누르면 Edit 페이지와 
마찬가지로 플레이헤드가 한 마커에서 다른 마커로 이동됩니다.

플레이헤드가 곧바로 타임라인에 있는 마커 위치로 이동됩니다. 마커에는 Sync 내레이션이 왜 
스테레오로 되어 있는지 묻는 내용이 담겨 있습니다. 스테레오로 다이얼로그를 편집하는 편집자가 
없는 건 아니지만, 음성 트랙은 보통 모노로 녹음 및 편집합니다.

트랙 포맷 변경하기
다이얼로그 또는 인터뷰, 보이스오버 형식의 음성이 담긴 프로젝트는 해당 음성이 타임라인 속 주요 
오디오일 가능성이 높습니다. 따라서 잘 다듬어진 사운드트랙을 생성하려면 해당 클립에 시간을 
따로 들여 세부 작업을 거쳐야 합니다.

음성 편집의 첫 번째 단계는 바로 녹음 파일을 평가하는 것입니다. Fairlight 타임라인에 있는 오디오 
클립을 보면서 트랙 녹음 방법에 대한 많은 정보를 얻을 수 있습니다.

1 A1 SYNC 트랙을 살펴보겠습니다. 이 클립은 2채널 스테레오 트랙으로 구성되어 있기 때문에 
두 개의 파형이 존재합니다.

2 A1 SYNC 트랙에서 솔로 버튼을 클릭한 다음 두 채널을 재생하세요. 좌/우 채널이 동일하게 
들립니다.

내레이션이나 다이얼로그는 보통 모노 클립으로 녹음합니다. 현재 나타나는 파형의 모습이 
동일하고 좌/우 채널에 차이가 없기 때문에 두 채널이 같은 모노 녹음이라고 볼 수 있습니다. 
이를 모노 클립으로 전환할 수 있는 가장 빠른 방법은 전체 트랙을 모노로 변환하는 것입니다.

3 A1 SYNC 트랙 헤더를 우클릭한 다음 Change Track Type To > Mono를 선택하세요.
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트랙 유형을 변환하고 나면 다음 세 개의 주요 표시 장치를 통해 트랙이 변경되었음을 확인할 
수 있습니다. 트랙명 우측에 있는 라벨에 1.0이라는 표시가 나타나 모노 트랙임을 알 수 있습니다. 
트랙 헤더 오른쪽에 있는 오디오 미터에는 두 개 대신 하나의 볼륨 미터만 나타납니다. 마지막으로 
오디오 트랙 클립에는 한 개의 채널만 나타납니다.

클립 자체는 변경되지 않지만, 이들 클립 중 하나를 스테레오 트랙으로 편집 또는 복사할 경우 두 
채널 모두 다시 나타나게 됩니다. 모노 트랙엔 하나의 오디오 채널만 넣을 수 있기 때문에 스테레오 
클립을 모노 트랙으로 편집하면 좌측 채널(타임라인의 위쪽 채널)을 사용하도록 기본 설정되어 
있습니다. 이들 클립의 양쪽 채널 모두 동일하므로 트랙을 변환하는 것이 모든 클립을 모노로 변경할 
수 있는 가장 빠른 방법입니다.

Fairlight에서 클립 트리밍하기
음성이 녹음된 트랙을 정리하는 다음 단계는 보통 Edit 페이지에서 사용한 것과 비슷한 트리밍 
방법을 사용해 조절하는 것입니다. 하지만 Fairlight 페이지의 트리밍 방식은 Edit 페이지의 트리밍 
도구가 아닌 선택 도구로 트리밍하는 것과 더욱 비슷합니다. Fairlight에서는 리플 트리밍 방식으로 
클립을 다듬지 않기 때문에 트랙 동기화를 그대로 유지한 채 클립을 확장 또는 축소할 수 있습니다.

1 Index에서 두 번째 마커를 더블 클릭하세요.

플레이헤드가 곧바로 SYNC 트랙의 첫 번째 타임라인 클립 마지막 부분으로 이동됩니다. Index
에 있는 마커 노트에는 내레이션이 너무 빨리 끝났다는 내용이 적혀있습니다. 

2 툴바에서 수평 슬라이더를 드래그하여 타임라인 창에 가득 찰 때까지 내레이션 클립을 
확대합니다.
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우선 클립을 재생해 내레이션을 들어보겠습니다.

3 툴바에서 Range Selection Tool을 클릭하거나 [R] 키를 누른 다음 A1, SYNC 트랙에 있는 클립을 
클릭하세요.

범위 선택 도구로 클립을 선택하면 해당 클립 주변에 인/아웃 포인트가 표시되어 클립을 재생하고 
다른 채널과의 차이점을 검토하는 작업이 훨씬 수월해집니다. 

4 [Option + /(슬래시)] 키(macOS ) 또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 
사이의 오디오가 재생됩니다. 

이 클립의 마지막 부분에 나오는 단어가 약간 빨리 끝나는데요, 클립을 연장해 마지막 단어가 
좀 더 명확하게 들리도록 조정할 수 있습니다.

5 [Option + X] 키(macOS) 또는 [Alt + X] 키(Windows)를 눌러 인/아웃 포인트를 삭제합니다.

6 마우스 포인터를 싱크 내레이션 클립 끝부분으로 가져간 다음 마우스 포인터가 트림 커서로 
변할 때까지 기다리세요.

7 마지막 단어가 클립에 완전히 포함될 때까지 클립 끝부분을 오른쪽으로 드래그하세요. 트랙 
파형을 가이드로 사용해 트리밍 작업을 마칠 수 있습니다.

마지막 부분만 수정했기 때문에 전체 클립을 듣는 대신 마지막 부분만 들어보도록 하겠습니다.

정보 Timeline > Razor를 선택해 툴바에 있는 가위 모양 아이콘을 사용하거나 
[Cmd + B] 버튼(macOS) 또는 [Ctrl + B] 버튼(Windows)을 눌러 클립을 분할할 수 
있습니다.
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8 범위 선택 커서를 클립 하단의 오른쪽 부분에 두고

9 왼쪽 대각선 방향으로 타임라인 헤더까지 드래그하여 선택 범위를 설정하세요.

선택 범위를 드래그하면 해당 범위를 포괄하는 인/아웃 포인트가 표시됩니다. 

10 [Option + /(슬래시)] 키(macOS ) 또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 
사이의 오디오가 재생되어 새롭게 조절된 마지막 부분을 들어볼 수 있습니다.

11 [A] 키를 누르면 선택 도구로 되돌아가며 [Option + X] 키(macOS) 또는 [Alt + X] 키(Windows)를 
누르면 인/아웃 표시가 삭제됩니다.

12 A1 SYNC의 솔로 모드를 해제하세요.

Fairlight 페이지에서의 트리밍 작업은 비디오 프레임에 얽매여 있지 않기 때문에 아주 세밀한 
서브프레임 오디오 트리밍 작업이 가능합니다.

음향 효과 정렬하기
내레이션 또는 음성 트랙을 편집하고 나면 음향 효과 및 음악 편집 작업에 집중할 수 있습니다. 
때로는 전체 프로젝트를 위해 완벽히 믹싱된 음악을 사용하기도 하고 어떤 경우엔 개별적으로 
분할된 음악을 사용하기도 합니다. 하지만 여전히 트랜션트나 짧은 음향 효과를 추가해 소리로 감탄 
부호를 표현하는 등의 음악 믹싱 작업을 하기도 합니다.

1 Index에 있는 세 번째 마커인 Copy drum hit를 더블 클릭하세요.

플레이헤드가 곧바로 DRUM HITS 트랙의 중간 부분으로 이동됩니다.

2 [shift + Z] 키를 함께 누르면 전체 타임라인이 나타납니다.

3 A4, DRUM HITS 트랙에 솔로 모드를 적용하세요.
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4 툴바에서 Range Selection Tool을 클릭하거나 [R] 키를 누른 다음 A4, DRUM HITS 트랙에 있는 
클립을 클릭하세요.

이 트랙의 사운드를 검토해 작업할 내용을 알아보겠습니다.

5 [Option + /(슬래시)] 키(macOS ) 또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 
사이의 오디오가 재생됩니다.

이 음향은 비록 음량이 크고 소리가 울리는 단일 드럼 사운드지만 사운드트랙에 사용하면 
소리로 훌륭한 감탄 부호를 표현할 수 있습니다. 마커에 남겨진 노트 내용을 기반으로 트랙에서 
클립의 시작 부분을 복사한 다음 마지막 음악이 나오는 곳에 붙여넣기 합니다. Fairlight 페이지의 
복사/붙여넣기 기능은 플레이헤드의 위치를 기반으로 클립을 정확히 배치하도록 설계되었다는 
점을 기억하세요. 따라서 음향 효과를 이동할 경우 선택한 부분과 플레이헤드 위치에 주의를 
기울이세요.

6 [A] 키를 누르면 선택 도구로 되돌아가며 [Option + X] 키(macOS) 또는 [Alt + X] 키(Windows)를 
누르면 인/아웃 포인트가 삭제됩니다.

7 타임라인에서 빈 공간 아무 곳이나 클릭하면 모든 트랙 선택이 해제됩니다. 

8 3과에서 했던 것과 마찬가지로 [J/K/L] 키를 사용해 플레이헤드를 드럼 사운드 파형이 시작하는 
지점 위로 직접 가져가세요.

9 A4 DRUM HITS의 솔로 모드를 해제하세요.

10 A4, DRUM HITS 트랙에서 클립을 선택한 다음 [Cmd + C] 키(macOS) 또는 [Ctrl + C] 키(Windows)
를 누르세요.

11 플레이헤드를 타임라인 끝부분으로 드래그하세요.



203

음
향

 효
과

 정
렬

하
기

플레이헤드를 움직이면 반투명의 클립 정보가 플레이헤드를 따라 나타나는 것을 볼 수 있습니다. 
플레이헤드를 움직이더라도 드럼 소리 파형의 시작 부분에 그대로 머물러 있습니다. 덕분에 
드럼 소리를 원하는 곳에 쉽고 정확하게 배치할 수 있습니다.

12 타임라인에 있는 마지막 클립의 시작 부분에 플레이헤드를 두었을 때 엔딩 크레딧의 첫 번째 
프레임이 뷰어에 나타나면 [Cmd + V] 키(macOS) 또는 [Ctrl + V] 키(Windows)를 눌러 클립을 
해당 위치에 붙여넣으세요.

새롭게 추가된 드럼 소리 위치를 확인해보겠습니다.

13 툴바에서 Range Selection Tool을 클릭하거나 [R] 키를 누른 다음 A4 DRUM HITS 트랙의 
마지막 클립을 클릭하세요.

14 [Option + /(슬래시)] 키(macOS ) 또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 
사이의 오디오가 재생됩니다.

15 [A] 키를 누르면 선택 도구로 되돌아가며 [Option + X] 키(macOS) 또는 [Alt + X] 키(Windows)를 
누르면 인/아웃 포인트가 삭제됩니다.

Edit 페이지와 마찬가지로 영상 정렬 상태가 완벽하지 않을 경우 [,] 키(쉼표)나 [.] 키(마침표)를 
눌러 프레임을 앞/뒤로 조금씩 움직이세요.
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타임라인에서 오디오 녹음하기
DaVinci Resolve의 Fairlight 페이지 타임라인에서 자신만의 보이스오버를 녹음할 수 있습니다. 
마이크를 셋업해 마이크 입력을 트랙에 연결하고 트랙을 정렬한 다음 녹음을 시작하면 됩니다.

여기서는 트레일러 영상을 위한 엔딩 보이스오버 태그를 임시로 녹음해보겠습니다. 보통 보이스오버 
연기자들은 음향 편집 작업이 시작되기 전까지는 녹음을 시작할 수 없습니다. 따라서 편집하면서 
사용할 임시 보이스오버 클립을 직접 쉽게 녹음할 수 있습니다. 실제 보이스오버 연기자들이 도착하면 
동일한 녹음 방법으로 최종 보이스오버를 타임라인에 직접 추가할 수 있습니다.

참고 별도의 마이크가 없는 경우 컴퓨터에 내장된 마이크를 사용해 다음 과정을 
따라 해 볼 수 있습니다. 마이크가 부족한 경우 셋업 및 녹음 부분을 정독한 다음 
녹음이 끝나면 해당 내용에 따라 작업을 진행하세요.

1 개별 USB 마이크를 사용할 경우 DaVinci Resolve를 종료하고 마이크를 컴퓨터에 연결하세요.

2 컴퓨터의 사운드 시스템 또는 환경 설정에서 마이크 또는 내장 마이크를 오디오 입력 장비로 
설정합니다.

3 DaVinci Resolve에서 Age of Airplanes 프로젝트를 여세요.

4 File > Project Settings를 선택합니다.

5 Capture and Playback 설정을 클릭하세요.

6 Save clips to 입력란에 있는 브라우저 버튼을 클릭한 다음 새로 녹음한 오디오 파일의 저장 
위치를 선택하세요.

7 Save to close the Project Settings 창을 클릭하세요.

8 Monitoring 패널(미터)을 감추고 Mixer가 나타나게 하세요.
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마이크를 연결하고 캡처 경로를 설정했으니, 이제 녹음용 트랙을 생성하고 타임라인을 설정하기만 
하면 됩니다.

녹음용 트랙 생성 및 패칭하기
오디오를 트랙에 녹음할 때 스테레오로 녹음할 것인지, 아니면 모노로 녹음할 것인지를 결정하는 
것이 중요합니다. 이제는 다이얼로그 및 보이스오버에는 주로 모노 포맷을 사용한다는 사실을 
짐작할 수 있으실 텐데요,

여기서는 녹음을 위한 새로운 모노 트랙을 생성한 다음 Mixer의 입력 설정을 사용해 마이크를 새로운 
트랙으로 패칭해보도록 하겠습니다.

1 아무 트랙 헤더를 마우스로 우클릭한 다음 Add Tracks를 선택하세요.

2 Add Tracks 창이 나타나면 Number of tracks를 1로 설정한 다음 Insert Position을 Below SYNC
로 설정하세요. Audio Track Type을 Mono로 변경합니다. 그런 다음 Add Tracks를 클릭하세요.

새로운 모노 트랙이 A1 아래 쪽에 나타납니다. 이제 트랙을 위한 입력을 설정할 차례입니다. 
Mixer의 입력 설정을 사용해 트랙 입력을 패칭할 수 있습니다.

3 트랙 헤더에서 Audio 2 이름을 더블 클릭한 다음 VO라고 입력합니다. 이 트랙은 보이스오버를 
위한 트랙으로 사용됩니다.

4 창의 오른쪽 상단에 있는 Mixer 버튼을 클릭하면 믹서 메뉴가 열립니다.

입력 설정은 각 채널 스트립 상단, 트랙 번호 바로 밑에 나타납니다. 입력이 따로 지정되지 않은 
트랙에는 No Input이라는 문구가 나타납니다.

5 A2 채널 스트립 상단의 Input 팝업 메뉴에서 Input을 선택하세요.
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그러면 Patch Input/Output 창이 나타나고 왼쪽에서는 소스(Source) 입력 정보를, 오른쪽에서는 
목적지 (Destination) 트랙 정보를 확인할 수 있습니다.

6 마이크를 위한 첫 번째 채널을 소스로 선택한 다음 VO 트랙을 목적지로 선택하세요.

7 창 아래 쪽에 있는 Patch 버튼을 클릭해 입력 패치를 설정한 다음 해당 창을 닫으세요. 

트랙 생성 및 패칭이 완료되었습니다. 이제 녹음을 위해 트랙을 아밍(Arming)할 차례입니다.

녹음용 트랙 아밍하기
각 트랙 헤더에는 R이라고 표시된 아밍 버튼이 있습니다. 이 버튼을 누르면 녹음용 트랙이 활성화됩니다. 
이를 위해 먼저 Audio 2 트랙에서와 마찬가지로 입력과 트랙을 패칭해야 합니다. 아밍 버튼(R 버튼)
은 Mixer에 있는 트랙 헤더와 트랙의 채널 스트립에서 사용할 수 있습니다.

1 A2 트랙 헤더에서 아밍 버튼을 클릭하세요.

트랙명과 아밍 버튼이 빨간색으로 변해 녹음용 트랙이 아밍되었음을 알 수 있습니다.

참고 녹음을 시작하기 전에 대사를 미리 알아두는 것이 좋습니다. 트레일러 
영상의 마지막 대사는 다음과 같습니다. “In the age of airplanes, we’ve 
become explorers once again.”
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2 녹음하기 전에 대사를 한두 번 연습해보는 게 좋습니다.

녹음 시 다른 트랙의 소리가 들리면 그 소리까지 함께 녹음됩니다.

3 A2 VO 트랙에 솔로 모드를 적용하세요.

4 트랜스포트 컨트롤에 있는 녹음 버튼을 누르세요. 플레이헤드가 움직이면서 타임라인에 빨간 
영역이 그려지기 시작하면 현재 녹음이 진행되고 있다는 뜻입니다. 최대한 영화 트레일러 느낌이 
나는 목소리로 대사를 읽어보세요. 대사를 다 읽고 나면 스페이스 바를 눌러 녹음을 종료합니다.

5 A2 VO 트랙의 솔로 모드를 해제하면 보이스오버를 음악 및 음향 효과와 함께 검토할 수 있습니다.

6 녹음 파일을 재생합니다.

7 재생이 끝나면 트랙 헤더에서 아밍 버튼을 클릭해 트랙 아밍을 해제하세요.

비록 이번 프로젝트에서는 보이스오버를 임시로 녹음하는 정도의 기능만 사용하겠지만, DaVinci 
Resolve의 Fairlight 오디오 페이지에는 후시 녹음(ADR)과 멀티 트랙 음악 녹음, 효과음 등의 첨단 
녹음 도구까지 포함되어 있습니다. 보이스오버를 녹음할 수 없는 경우엔 다음에 소개될 내용을 통해 
사전 녹음된 전문 보이스오버 클립으로 작업하는 방법을 배울 수 있습니다.

클립 속성 변경하기
꽤 괜찮은 수준의 임시 보이스오버를 녹음했더라도 전문 성우와 함께 실제 보이스오버를 녹음할 
경우엔 보이스오버를 검토한 다음 이를 타임라인에 추가해야 합니다. Fairlight에 있는 미디어 풀의 
모든 오디오 클립에 접속해 해당 클립을 검토할 수 있습니다.

1 DaVinci Resolve 윈도우의 좌측 상단에 있는 Index 버튼을 클릭해 Index 메뉴를 닫은 다음 
미디어 풀을 클릭하면 이 프로젝트에 있는 빈과 클립이 나타납니다.

2 빈 목록에서 Audio 빈에 있는 VO 빈을 선택하세요.

모든 오디오 클립이 빈에 나타납니다. 클립을 검토해 필요한 클립을 검색한 다음 프로젝트에서 
편집할 수 있습니다.

3 HF VO 클립을 클릭하면 패널 상단에 있는 Media Pool 미리보기 플레이어에 해당 클립이 
로딩됩니다.
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굳이 클립을 재생하지 않아도 두 개의 파형을 통해 스테레오 클립임을 알 수 있습니다. 위쪽 
채널(채널 1)의 파형 피크가 낮은데요, 이는 다른 채널보다 조용하다는 것을 의미합니다. 그럼 
오디오를 듣고 차이점을 확인해 보겠습니다.

정보 채널 간의 차이점은 헤드폰을 사용해 쉽게 구별할 수 있는데, 이는 
스테레오 클립의 개별 채널이 양쪽 귀에 따로따로 들리기 때문입니다.

채널 1(좌측 채널)은 채널 2(우측 채널)만큼 깨끗하게 들리지 않습니다. 인터뷰나 대사 녹음 
시에는 종종 마이크를 두 개 사용합니다. 가장 선명하게 녹음되는 붐 마이크를 주요 마이크로 
사용하며 백업용으로는 소형 마이크 또는 라펠 마이크를 주로 사용합니다. 전문 보이스오버 
클립을 모노 트랙에 편집할 때 채널 2를 사용하고 있는지 확인해야 합니다.

4 빈에서 HF VO 클립을 우클릭한 다음 Clip Attributes를 선택하세요.

클립 속성에 오디오 포맷과 채널 매핑 정보가 나타납니다. 기본 설정에 따라 좌측 채널은 항상 
채널 1로 설정되며 스테레오 클립을 모노 트랙으로 변환할 때는 채널 1이 사용됩니다. 클립 속성 
창에서 기본 설정 사항을 변경할 수 있습니다.

5 클립 속성 Format 팝업 메뉴에서 Mono를 선택하세요.

6 Source Channel을 Embedded Channel 2로 변경하세요.
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7 OK를 클릭하면 클립 속성 창이 종료됩니다.

이제 채널 2를 오디오 소스로 사용하는 보이스오버용 모노 클립이 생성되었습니다. 이 클립을 
모노 트랙으로 편집하면 음질이 좋은 붐 마이크 녹음을 사용할 수 있습니다.

8 타임라인에서 녹음해둔 임시 보이스오버 파일을 선택한 다음 [delete] 또는 [backspace] 키를 
눌러 해당 파일을 삭제하세요.

9 플레이헤드를 마지막 분홍색 마커가 있는 곳으로 옮기세요. 이 마커는 보이스오버의 시작 
지점을 나타냅니다.

10 Media Pool의 HF VO 클립을 드래그해 클립의 시작 지점이 타임라인의 플레이헤드 위치와 
일치하도록 배치하세요.
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11 플레이헤드를 새로운 보이스오버 클립 앞으로 옮긴 다음 타임라인을 재생해 모든 트랙 믹스를 
들어보세요.

지금까지 셋업, 리맵핑, 다이얼로그 트랙 편집 방법을 살펴봤습니다. 이제 프로젝트의 음향 품질을 
다룰 준비가 완료되었습니다.

Fairlight FX 사용하기
Fairlight에는 세 종류의 모든 OS에서 작동하는 다양한 종류의 네이티브 오디오 플러그인이 탑재되어 
있습니다. macOS를 사용할 경우 서드파티 VST 및 Audio Unit 플러그인까지 지원됩니다. Windows 
사용자들은 VST 플러그인까지 사용할 수 있습니다. 이러한 플러그인을 단일 클립 또는 전체 트랙에 
적용하여 흔히 발생하는 문제를 해결하거나 프로젝트 분위기에 맞는 음향을 설계할 수 있습니다.

1 보이스오버 트랙에 솔로 모드를 적용하면 다른 사운드트랙에 방해받지 않고 해당 트랙만 들을 
수 있습니다.

2 툴바에서 범위 선택 도구를 클릭하거나 [R] 버튼을 누른 다음 타임라인에서 보이스오버 클립을 
클릭하세요.

3 [Option + /(슬래시)] 키(macOS ) 또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 
사이의 오디오가 재생됩니다.

보이스오버에서 피치가 낮은 음역의 잡음이 들릴 수 있습니다. 이는 전기 신호가 오디오 케이블로 
침투되는 흔히 발생하는 문제입니다. 보통 접지나 오디오 케이블 차폐가 잘못된 경우에 발생됩니다. 

이런 문제를 최소화할 수 있는 노치 필터를 사용하여 녹음 시 아주 좁은 오디오 주파수 대역을 
간편하게 차단할 수 있습니다. 오디오 클립에서 자주 발생하는 험 노이즈 주파수는 녹음하는 
지역에 따라 60 Hz 또는 50 Hz 달라집니다. 이는 미국과 아시아, 유럽에서 사용하는 A/C 표준이 
나라마다 다르기 때문입니다. Fairlight에 탑재된 De-Hummer Fairlight FX 특수 플러그인을 
사용해 각기 다른 유형의 웅웅거리는 잡음을 해결할 수 있습니다. 

4 Resolve 윈도우 좌측 상단의 Media Pool에서 Effects Library 버튼을 클릭하면 Audio FX 
플러그인이 나타납니다.
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5 FairlightFX 카테고리에서 De-Hummer 플러그인을 타임라인의 보이스오버 클립으로 드래그하세요.

플러그인 적용 시 컨트롤과 함께 나타나는 De-Hummer 창을 통해 험 노이즈 유형을 선택할 수 
있습니다.

정보 Inspector가 열려 있는 경우 De-Hummer를 위한 컨트롤도 함께 
나타납니다. 그곳에 있는 휴지통 아이콘을 클릭하면 해당 효과가 삭제됩니다.



212
제

8
과

 
F

ai
rl

ig
h

t 
사

운
드

 믹
싱

: 
인

터
페

이
스

 둘
러

보
기

6 Frequency 영역에서 60 Hz 버튼을 클릭하여 De-Hummer가 60 Hz 주파수를 제거하도록 
설정할 수 있습니다.

De-Hummer 창의 그래프 하단에 주파수가 나타납니다. 왼쪽에서 낮은 주파수를, 오른쪽에서 
높은 주파수를 확인할 수 있습니다. 그래프에 나타나는 딥은 클립에서 삭제 또는 축소된 좁은 
주파수 대역을 의미합니다.

7 타임라인 위쪽의 트랜스포트 컨트롤에서 루프 버튼을 클릭한 다음 [Option + /(슬래시)] 키(macOS ) 
또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 사이의 오디오가 반복 재생됩니다.

8 클립이 재생되는 동안 Amount 다이얼을 드래그해 삭제되는 험 노이즈 양을 조절할 수 있습니다.

Amount 다이얼을 시계 방향으로 드래그하면 보이스오버 클립의 해당 주파수(이 경우 60 Hz) 
볼륨이 줄어듭니다. 따라서 음성 녹음의 품질도 변하게 됩니다. 험 노이즈는 섬세하게 균형을 
맞추면서 제거할 양을 결정해야 합니다. 그렇지 않으면 음성 품질이 크게 떨어질 수 있습니다.

그래프만 봤을 때는 60 Hz를 선택해 해당 주파수만 제거하면 될 것처럼 보일 수 있지만, 단순히 
주파수 하나를 제거한다고 해서 문제가 해결되지는 않습니다. Slope 컨트롤을 조절해 원치 
않는 험 노이즈를 생성하는 다른 주파수를 추가로 제거할 수 있습니다.

9 보이스오버에서 험 노이즈가 거의 들리지 않을 때까지 Slope 컨트롤을 드래그하세요.
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10 조절을 마치고 나면 스페이스 바를 눌러 재생을 멈추고 De-Hummer 창을 닫으세요. 그런 다음 
툴바에서 선택 도구를 클릭하거나 [A] 버튼을 누르세요. 마지막으로 A2 VO 트랙의 솔로 모드를 
해제합니다.

De-Hummer는 가장 많이 사용되는 플러그인 중 하나입니다. 최소한의 노력으로 자주 발생하는 
문제를 해결할 수 있어 영상 편집자들도 많이 사용합니다.

전체 트랙에 Reverb 적용하기
이전 단계에서는 보정용 플러그인을 개별 클립에 적용해봤습니다. 믹서 위쪽에 효과를 삽입하거나 
Effects Library의 효과를 타임라인 트랙 헤더로 드래그하는 방식으로 전체 트랙에 플러그인을 
적용할 수 있습니다. 이번엔 Resolve의 강력한 Reverb 플러그인을 A1 SYNC 트랙 전체에 적용하고, 
일부 프리셋을 사용하여 트랙 사운드에 깊이와 공간감을 더해보겠습니다.

조절 가능한 그래픽 3D 큐브를 사용하는 공간적 시뮬레이션 플러그인은 공간의 크기와 모양을 
바탕으로 음향 반사 및 잔향을 제어합니다. 이뿐만 아니라 다양한 컨트롤을 사용할 경우 무미 건조한 
음향을 석조 성당 건물이나 타일을 깐 욕실 등의 공간에서 나는 소리처럼 만들 수 있습니다.

SYNC 트랙의 첫 번째 클립 주변이 재생되도록 설정한 다음 전체 트랙에 Reverb 플러그인을 
적용해보겠습니다.

1 SYNC 트랙에 솔로 모드를 적용하세요.

2 Range 선택 도구를 위해 [R] 버튼을 누르거나 타임라인에서 A1 SYNC 트랙의 첫 번째 클립을 
클릭하면 해당 클립에 재생 범위가 표시됩니다.

3 [A] 버튼을 눌러 셀렉션 도구를 선택하세요.

4 Effects Library에서 Reverb 플러그인을 A1 SYNC 트랙 헤더 위로 드래그하세요.

사용법이 명백한 Reverb 제어창은 3D 공간 속 크기를 기반으로 본래 신호음(Direct)과 초기 
반사음(ER), 후기 잔향음(Reverb)이 어우러져 원하는 효과를 생성합니다. 
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좌측 상단의 청록색 3D 사각형은 공간의 크기를 나타냅니다. 오른쪽 그래프에는 오디오 신호에 
적용된 리버브 효과가 왼쪽에서 오른쪽 방향으로 나타나 대략적인 정보를 시각적으로 확인할 
수 있습니다. 아래 쪽에 있는 컨트롤을 통해 초기 반사톤(Early Reflection Tone)과 리버브 톤
(Reverb Tone), 리버브(Reverb) 타이밍을 세밀하게 조정할 수 있습니다. 우측 하단에 있는 
컨트롤을 통해 그래프에서 파란색으로 나타나는 본래 신호음(흰색 수직 라인)과 초기 반사음, 
리버브 레벨을 조절할 수 있습니다.

5 [Option + /(슬래시)] 키(macOS ) 또는 [Alt + /(슬래시)] 키(Windows)를 누르면 인/아웃 포인트 
사이의 오디오가 반복 재생됩니다.

들어보면 기본 리버브 프리셋 설정이 이미 적용된 것을 알 수 있습니다. 이제 처음 두 개의 
프리셋을 들어볼텐데요, 이를 통해 좁은 공간과 넓은 공간에서 느껴지는 엄청난 차이를 확인할 
수 있습니다.

6 Reverb 창 왼쪽 상단에서 프리셋 팝업 메뉴를 클릭한 다음 Bathroom을 선택하세요.

왼쪽에는 좁은 3D 공간이 나타나고 오른쪽에는 짧은 리버브 꼬리가 나타나는데, 이를 통해 
공간이 좁다는 사실과 이런 좁은 공간에 맞는 리버브 효과가 적용되었다는 사실을 알 수 
있습니다. 

7 프리셋 팝업 메뉴에서 Cathedral을 선택하세요.

리버브 효과를 많이 적용할수록 그 차이가 확연하게 느껴집니다.

8 해당 창 좌측 상단에 있는 빨간색 바이패스 스위치를 누르면 플러그인이 종료됩니다. 바이패스 
스위치를 한 번 더 클릭하면 플러그인이 다시 적용됩니다.
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드래그해 크기 및 음향을 변경할 수 있습니다.

10 작업이 끝나면 재생을 정지하고 Reverb 창을 닫습니다.

11 Inspector가 열린 상태에서 SYNC 트랙 헤더를 선택하세요.

12 인스펙터에서 Reverb 효과 옆에 있는 휴지통 아이콘을 클릭하면 트랙에서 해당 효과가 삭제됩니다.

Reverb는 DaVinci Reslove 15에서 제공하는 놀라운 Fairlight FX 플러그인 중 하나입니다. 지금까지 
플러그인과 프리셋을 손쉽게 적용하는 방법에 대해 알아봤습니다. 이제 여러분들의 프로젝트에 
해당 기능을 직접 적용해보세요.

서브믹스로 트랙 정돈하기
타임라인에 있는 모든 트랙의 오디오 신호는 트랙에서 메인 출력으로 흘러갑니다. 메인 출력을 
모니터링하는 경우엔 통합 또는 믹싱된 모든 트랙이 한꺼번에 들립니다. 그래서 오디오 믹싱이라고 
부릅니다. 클립과 해당 트랙 조정을 마치고 나면, 서브믹스를 사용해 믹싱 처리 과정을 간소화할 수 
있습니다. 서브믹스를 사용하면 여러 트랙의 신호 및 효과가 믹서에 있는 단일 채널 스트립으로 
통합됩니다. 후반 작업 과정에서는 종종 다이얼로그 및 특수 효과를 위해 서브믹스를 생성하곤 
합니다.

이번 과정을 통해 내레이션 트랙과 음향 효과, 그리고 음악을 각각의 개별 서브 믹스로 통합해 
보겠습니다. 이런 방식으로 모든 특수 효과 음향을 조금씩 낮추거나 모든 내레이션 클립의 음량을 
높여 믹스를 조절할 수 있습니다. Fairlight 페이지는 트랙을 생성해 버스(서브믹스)에 지정할 수 있는 
아주 간단하지만 강력한 방법을 제공합니다. 이제 각 클립의 상대적인 레벨을 설정했기 때문에 모든 
내레이션과 특수 효과를 서브믹스로 옮길 수 있습니다.

1 Fairlight > Bus Format을 선택하면 Bus Format 창이 열립니다.
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Bus Format 창에서는 네 가지 중 한 버스 유형에 트랙을 지정할 수 있습니다. 서브믹스는 이러한 
버스 유형 중 하나입니다. 현재 해당 창에는 M1라고 불리는 기본 설정 메인 버스가 포함되어 
있으며, 이 버스는 현재 작업 중인 프로젝트를 위한 스테레오 오디오 출력입니다.

2 Sub 버튼을 클릭하면 Submix 버스가 버스 목록에 추가됩니다.

새로운 서브믹스는 모노 SYNC 및 보이스오버 트랙을 위해 사용될 예정입니다. 따라서 가장 
먼저 해야 할 일은 모노 설정 여부와 관련 설명 내용이 포함되어 있는지 확인하는 일입니다.

3 Format 팝업 메뉴에서 Sub1이 Mono로 설정되어 있는지 확인하세요.
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4 User Name 칼럼에서 Sub 1 이름을 더블 클릭한 다음 VO SUB이라고 입력하세요.

서브믹스에 색상을 지정할 수도 있습니다.

5 보이스 오버 서브믹스의 Color 팝업 메뉴에서 Navy를 선택하세요.

보이스오버 설정을 마치고 나면 음향 효과 트랙을 위한 다른 항목도 설정할 수 있습니다.

6 Sub 버튼을 두 번 클릭하면 두 개의 추가 서브믹스가 목록에 추가됩니다.

7 두 개의 서브믹스를 위해 Format 팝업 메뉴에서 Stereo를 선택하세요. 이는 음향 효과와 음악 
모두 스테레오로 녹음되었기 때문입니다.

8 User Name 칼럼에서 Sub 2 이름을 더블 클릭한 다음 SFX SUB이라고 입력하세요. 그런 다음 
Sub 3를 더블 클릭한 뒤 MUSIC SUB이라고 입력하세요.

9 SFX 서브믹스의 Color 팝업 메뉴에서 SFX 서브믹스 색상을 Lime으로, MUSIC 서브믹스 색상을 
Yellow로 지정합니다.

10 OK를 클릭하면 Bus Format 창이 사라집니다.

이제 모든 서브믹스 설정이 끝났습니다. 이제 다음 단계로 넘어가 트랙을 해당 서브믹스에 
지정해야 합니다.

트랙 지정하기
Bus Assign 창에서 서브믹스에 들어갈 트랙을 설정해야 합니다.

1 Fairlight > Bus Assign을 선택하면 Bus Assign 창이 열립니다.
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Bus Assign 창 위쪽에는 현재의 Main 및 Bus 정보가 나타납니다. 아래쪽 버튼에는 상단 버스에 
지정 가능한 트랙과 서브믹스, AUX 버스가 나타납니다.

2 창 위쪽의 버스 중에서 S1:VO SUB 버튼을 클릭하세요.

S1 VO SUB 버튼을 선택한 상태에서는 아래쪽 목록에서 Narration Sub 버스에 추가하고자 하는 
트랙을 선택할 수 있습니다.

3 아래쪽 트랙 목록에서 SYNC와 VO 버튼을 누르세요.

SYNC와 VO 트랙을 선택하면 S1 라벨이 버튼 아래쪽에 나타나 해당 버스에 속해 있음을 알 수 
있습니다. 개별 트랙을 서브믹스에 지정하고 나면 이를 메인 카테고리에서 삭제해도 상관없습니다.

4 버스 상단에 있는 M1:Main을 선택하세요.

5 Available Tracks 우측에 있는 Un-Assign All 버튼을 클릭하면 Main에 있는 모든 개별 트랙이 
삭제됩니다.

오직 S1만이 SYNC 및 VO 트랙에 남아 두 개의 트랙이 서브믹스에 있다는 사실을 알려줍니다. 
다른 모든 트랙은 비어있기 때문에 나머지 트랙을 적합한 서브믹스에 추가할 수 있습니다.

6 창 위쪽의 버스 중에서 S2 SFX SUB 버튼을 클릭하세요.

7 아래쪽 트랙 목록에서 SFX 01과 SFX 02 트랙을 클릭하세요.

8 창 위쪽의 버스 중에서 S3 MUSIC SUB 버튼을 클릭하세요.

9 아래쪽 트랙 목록에서 DRUM HITS와 MUSIC 트랙을 클릭하세요.

이제 모든 개별 트랙이 서브믹스로 이동되었으므로, 세 개의 서브믹스를 M1:Main에 추가하도록 
하겠습니다.

10 창 위쪽의 버스 중에서 M1: Main 1 버튼을 클릭하세요.
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11 아래쪽 트랙 목록에 생성된 세 개의 VO SUB, SFX SUB, MUSIC SUB 서브믹스를 클릭하면 
M1:Main 1 출력에 추가됩니다.

12 Save 버튼을 누르면 Bus Assign 창이 종료되며 트랙 지정 사항이 저장됩니다.

Edit 페이지에서 클립 레벨 조정 및 버스 지정 작업을 마치고 나면, Fairlight 페이지의 미터를 사용해 
각 서브 믹스 레벨을 설정하는 작업으로 돌아갈 수 있습니다.

트랙 레벨 설정하기
음향 믹싱 처리 과정의 핵심은 오디오 밸런스입니다. 작업을 성공적으로 마치면 균형 있는 오디오 
믹싱 결과물을 얻을 수 있습니다. 이전 과에서는 클립 단위의 볼륨을 조정했지만, 이번엔 전체적인 
균형을 위해 전체 트랙과 서브믹스를 상대적으로 조정해 보겠습니다.

1 인터페이스 툴바 좌측 상단에 있는 Effects Library 버튼을 클릭하면 Effects Library가 닫히며 
타임라인에 더 많은 공간이 생겨납니다.

2 Mixer가 열려 있는지 확인한 다음 왼쪽 끝부분을 드래그하면 각 채널의 스트립을 볼 수 있습니다. 
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Mixer 패널에는 각 타임라인 트랙을 위한 채널 스트립과 서브믹스, 마스터 오디오 스트립이 
포함되어 있습니다. 각 채널 스트립은 지정해둔 트랙 및 서브믹스 색상으로 표시됩니다. 믹서 
페이드는 단일 클립의 볼륨을 조정하는 Inspector와는 달리 서브믹스 페이더를 사용해 변경 
사항을 전체 트랙 및 트랙 그룹에 일괄 적용합니다.

3 [shift + Z] 키를 함께 누르면 전체 타임라인이 나타납니다. 타임라인 시작점에 플레이헤드를 
두고 스페이스 바를 눌러 전체 프로그램을 재생합니다. 

동기화된 인터뷰 음성이 전반적으로 너무 낮은 편이지만 걱정할 필요는 없습니다. Mixer에 있는 
해당 SYNC 페이더를 사용해 전체 볼륨 레벨을 조절할 수 있습니다.

4 타임라인을 다시 재생한 다음 인터뷰 음성이 좀 더 명확하게 들릴 때까지 SYNC 페이더를 
드래그하세요. 

5 타임라인을 다시 재생하고 트랙을 조정하세요. 그런 다음 타임라인을 다시 재생하고 서브믹스를 
조정하면 모든 음향 요소 간의 적절한 균형을 맞출 수 있습니다.

정보 타임라인을 재생 시 자동 제어 기능을 사용하면 트랙 레벨 조정 사항까지 
함께 녹음할 수 있습니다. Fairlight에 대한 자세한 내용은 DaVinci Resolve 사용 
설명서와 Audio Mixing Guide to DaVinci Resolve 15 교육 교재를 참고하세요.

전반적인 트랙 레벨을 조정할 때 미터 레벨을 주시하고 정확한 시스템에서 품질 좋은 스피커을 
사용해 오디오 결과물을 모니터링하는 것이 중요합니다. 정확한 디스플레이를 사용해 비디오 
콘텐츠를 검토하는 것과 마찬가지로 사운드트랙 콘텐츠를 오디오가 정확하게 조정된 환경에서 
들어봐야 합니다. 따라서 헤드폰으로만 음질을 확인하고 오디오 후반 작업을 마치는 것이 아니라 
정확하게 전문 조정된 스피커를 사용해 최종 믹싱을 준비하세요.
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영상 기술에서 음향이 절반을 차지한다는 말을 한 번쯤 들어보셨을 텐데요, 하지만 종종 독립 영화 
제작자들은 음향 제작에 최소한의 관심만을 기울이곤 합니다. 조지 루카스(George Lucas)는 이런 
말을 했습니다. “영화 제자작자들은 완벽한 사운드트랙을 만들기 위해 최선을 다해야 합니다. 
왜냐하면 투자의 관점에서 볼 때 음향이 가장 큰 수익률을 가져다주기 때문입니다.”

복습하기
1 Fairlight 페이지에서 비디오를 위한 뷰어가 나타나는 패널은 어디인가요?

2 Fairlight 페이지의 타임라인에서 녹화하고자 하는 트랙은 어떻게 알아볼 수 있나요?

3 빈 안에서 스테레오 클립을 모노 클립으로 변경하는 방법은 무엇인가요?

4 De-Hummer를 사용하면 스테레오 클립의 50 Hz 및 60 Hz 소음만 제거됩니다. T(진실) 또는 
F(거짓)로 답하세요. 

5 단일 페이더를 사용해 Fairlight 믹서의 여러 페이더를 제어할 수 있는 방법은 무엇인가요?
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정답
1 타임라인의 비디오를 위한 뷰어는 Fairlight 페이지의 사용자 툴바에 있는Meters 패널에 

나타납니다. 

2 Fairlight 페이지의 타임라인 트랙 헤더에 있는 아밍 녹화 버튼(R 버튼)을 클릭해 녹화하려는 
트랙을 선택하세요.

3 빈에서 클립을 우클릭한 다음 Clip Attributes를 선택해 스테레오 클립을 모노 클립으로 변경할 
수 있습니다.

4 F. De-Hummer를 사용해 다양한 주파수 범위를 삭제할 수 있습니다.

5 Bus Format 및 Bus Assign 창에서 서브믹스를 생성하면 단일 페이더로 Fairlight 믹서에 있는 
여러 개의 페이더를 제어할 수 있습니다.



돌연변이 생명체의 습격이나 외계인의 우주선 착륙 장면을 현실감 있게 만들기 위해 영화 제작자는 
시각 효과 아티스트에게 작업을 의뢰합니다. 실제 촬영을 통해 만들 수 없는 영상을 제작하기 
위해서는 시각 효과를 사용하게 됩니다. 카메라로 촬영하기 너무 어렵거나, 위험하거나, 또는 비용이 
많이 드는 경우에 시각 효과 합성 기능을 사용할 수 있습니다.

DaVinci Resolve 15에는 Fusion의 모든 시각 효과 및 모션 그래픽 도구들이 탑재되어 있기 때문에 
이 프로그램 하나로 장편 영화 품질에 버금가는 영상을 만들 수 있습니다.

편집(Edit) 페이지에서는 간단한 시각 효과를 생성할 수 있는 반면, Fusion 페이지에서는 정교하고 
사실적인 효과를 만들기 위한 고급 도구들을 사용할 수 있습니다. Davinci Resolve는 노드 트리라고도 
불리는 플로우 그래프(flow graph) 형식의 인터페이스를 사용하며 이는 시각 효과와 모션 그래픽 
작업을 위해 특별히 고안되었습니다.

이 과에서는 Fusion이 제공하는 완벽한 3D 작업 공간과 250개 이상의 합성 도구 및 시각 효과 
도구를 이용하여 여러 가지 작업을 수행하는 방법을 배울 수 있습니다. 무엇보다도 이 기능들이 
이제 DaVinci Resolve에 통합됨으로써 편집, 색보정, 오디오 후반 작업에서 시각 효과 및 모션 그래픽 
작업에 이르기까지 클릭 한 번으로 원하는 메뉴에 접근할 수 있습니다!

시각 효과 합성 
알아보기
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시각 효과 합성이란 무엇인가?
합성은 두 개 혹은 그 이상의 이미지를 합쳐서 하나의 새로운 이미지로 만드는 과정입니다. 합성은 
여러 이미지를 합치는 이상의 의미를 가집니다. 비디오 클립, 애니메이션, 텍스트, 매트, 파티클, 
그래픽 등 서로 다른 요소들을 합성할 수 있습니다. 간혹 이런 요소들을 레이어라고 지칭하는데 
하나의 요소 위에 다른 요소를 얹는 방식을 사용해 새로운 이미지를 만들어내기 때문입니다.

시각 효과는 다양한 작업에 사용됩니다. 색상 및 오디오 후반 작업이 그렇듯이 시각 효과 또한 
창의적인 영화 제작에서 중요하고 흥미로운 작업 과정 중 하나입니다. 작업의 종류에 따라 다르지만, 
시각 효과를 영상에 적용하기 위해서는 여기 나오는 일부 또는 모든 기능을 익혀야 할 것입니다. 
제작 규모가 작은 경우에는 시작부터 끝까지 한 사람이 숏을 완성해야겠지만 규모가 큰 스튜디오에서는 
로토스코핑, 3D, 파티클, 조명 등 각 분야를 맡은 전문가가 있는 경우가 많습니다.

여러분이 편집자 혹은 컬러리스트로 고용된 경우에도 간단한 시각 효과를 입혀 달라는 요청을 자주 
받을 것입니다. 후반 제작의 다른 작업도 마찬가지겠지만, 도구 사용법과 기술을 배우려면 연습이 
필요합니다. 도구에 숨겨진 기술을 이해하면 문제 해결 능력과 능률을 높일 수 있습니다.

업계에서는 점점 작품의 마감 시간이 짧아지는 추세이기 때문에 영상 작업을 더 빠르고 효율적으로 
해낼 수 있는 편집자와 컬러리스트에 대한 수요가 높습니다. 색보정과 오디오 후반 제작뿐 아니라 
DaVinci Resolve 내의 Fusion 시각 효과에 대한 기본을 배운다면 당신은 가치가 높은 아티스트가 
될 것이며 더 많은 작업을 맡게 될 것입니다.

시각 효과 시작하기
예전에는 시각 효과가 일부 예산이 큰 장편 영화의 제작에서나 쓰이는 고급 기능이었습니다. 이제 
Fusion이 DaVinci Resolve로 통합되면서 엄청난 규모의 예산이 아니더라도 누구나 DaVinci Resolve를  
사용하여 장편 영화 품질에 버금가는 시각 효과를 사용할 수 있습니다.

시각 효과가 단지 외계인, 우주선, 폭발 장면을 만드는 데만 필요하다고 생각한다면 그것은 프로젝트의 
품질을 올려주는 수많은 작은 효과들의 중요성을 간과하는 것입니다. 사실 시각 효과 작업의 대부분은 
보정 작업, 제거 작업, 또는 하늘이나 창문 바꾸기처럼 크게 드러나지 않는 숨은 효과 주기 같은 
것입니다. 이러한 시각 효과를 사용하면 짧은 시간 내에 프레임이 엉망인 B롤 영상부터 흐린 회색 
하늘에 이르는 모든 장면을 개선할 수 있습니다.

요소 추가하기
날씨는 예측이 불가능하므로 스토리 전개를 위해 눈 내리는 장면이 필요하면 눈을 내리게 해야 
합니다. 그래서 눈, 비, 안개, 혹은 번개까지도 만들어 내는 기술이 시각 효과 아티스트들에게는 
필수적입니다. Fusion의 파티클 시스템을 사용하면 움직이거나, 떨어지거나, 떠내려가는 등의 날씨와 
관련된 요소들을 진짜같이 만들어낼 수 있습니다.

간혹 실제 촬영장에서 특정 장면들을 연출하는 것은 매우 위험할 수 있습니다. 예를 들어 연기, 
날아다니는 파편, 불같은 것은 연기자와 스태프에게 항상 위험한 요소입니다. 대부분의 경우 이러한 
위험 요소들은 별도로 촬영한 다음, 나중에 합성하면 현실감 있는 영상을 안전하게 만들어낼 수 
있습니다.
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동물과 아이들
동물이나 어린이와 함께 촬영하면 이들의 예측하기 힘든 행동 때문에 촬영이 지연될 수 있습니다. 
이런 경우에는 숏을 나누어 동물 장면을 주요 액션에서 떼어 내어 별도로 촬영하면 스케줄을 
지연시키지 않고 숏을 완성할 수 있습니다. 분리된 숏을 매끄럽게 연결하여 합성함으로써 한 번에 
촬영한 것 같은 자연스러운 합성 영상을 만들어 낼 수 있습니다.

하늘 바꾸기
완벽해 보이는 일몰 혹은 뭉게구름 가득한 청명한 하늘은 모든 장면에 어울리는 멋진 배경이 
되겠지만, 날씨를 우리가 마음대로 하지는 못합니다. 모든 제작진이 준비 완료된 상태이고 장비는 
이미 대여했으며 시간은 하염없이 흘러가는데 날씨가 협조해주지 않을 때가 있습니다. 하지만 우리는 
이럴 때도 촬영을 해야만 합니다. 이런 경우 대부분은 하늘을 바꾸는 시각 효과 작업을 하게 됩니다. 
Fusion의 키어, 로토스코핑 도구, 트래킹, 3D 합성 기능을 이용해서 칙칙한 회색 하늘을 제거하거나 
과노출된 하늘을 복구해 낼 수 있습니다. Fast Noise 또는 볼륨메트릭 효과를 주면 촬영 당시에는 
없었던 선명한 파란색 하늘과 아름답고 드라마틱한 구름이 나타나게 됩니다.
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Fusion의 3D 컨트롤을 사용하여 빛의 방향과 아지랑이, 시차에 의한 카메라 모션 등 모든 요소를 
시뮬레이션할 수 있습니다. 이런 요소들을 사용함으로써 저렴하고 인위적인 가짜 영상과는 비교도 
안 되는 그럴듯한 하늘 바꾸기 작업이 가능해집니다.

연기/코스메틱 보정하기
연기자의 연기력이 조금 부족하다면 보정 혹은 보완 작업을 통해 재촬영에 들어가는 큰 비용을 
아낄 수 있습니다. 이 합성 작업은 매우 흔하게 이루어지지만, 관객이 거의 알아차리지 못하고 보정의 
정도에 따라 다르지만 비교적 작업이 간단합니다. 예를 들어 연기자가 죽은 척을 해야 하는데 실수로 
눈을 움직일 경우가 있습니다. 이런 작은 움직임은 촬영하는 동안에는 눈에 띄지 않다가 그 후 
영상실에서 작업하다 보면 너무나 명백하게 드러납니다. 이때의 심정은 정말 고통스러울 정도죠. 
이럴 때 전체 숏 중 한 프레임을 작업하여 눈을 감은 모습을 합성한다면 전체 숏을 살려낼 뿐 아니라 
비슷한 경우에 재사용할 수 있는 보정 화면을 얻게 됩니다. 흉터, 문신, 모양이 고르지 않은 선탠 
라인을 제거하는 작업에도 비슷한 기술이 사용되며 이는 Fusion의 플래너 트래커, 페인트 도구, 
로토스코핑을 사용하면 됩니다.

장소 바꾸기 

제작비는 한정되어 있어 촬영 장소와 촬영 시기에 항상 제약이 생기기 마련입니다. 하지만 촬영 
환경을 조금만 개선하면 이러한 제약 요소들을 안 보이게 숨기고 영상의 전반적인 느낌에 변화를 
줄 수 있습니다. 예를 들어 움직이는 차 안에서 바라보는 Time Square 장면을 찍어야 하는데 실제 
그 장소에서 촬영할 수 없다면 차의 창문을 바꾸는 작업을 할 수 있습니다. 또는 펜트하우스 장면을 
찍어야 하는데 한정된 예산 때문에 1층에서 촬영을 해야 할 경우에도 마찬가지입니다. 이런 시각 
효과들은 시각 효과 전문가들에게는 일상적인 작업이며 편집자와 컬러리스트에게도 간단한 작업이 
될 수 있습니다.

와이어 제거하기
시각 효과를 사용함으로써 위험한 스턴트 장면에 현실감을 더할 수 있습니다. 폭발 장면 또는 
초자연적인 현상으로 인해 연기자가 스크린을 가로질러 날아가는 장면을 촬영할 때는 안전띠나 
와이어를 장착하게 됩니다. 이런 장면을 촬영 후 Fusion의 클론(Clone) 또는 트래킹(Tracking) 도구를 
사용하여 간단하게 와이어나 연결 고리를 숨길 수 있습니다. 이런 작업은 시각 효과 전문가가 다른 
중요한 합성 작업을 하고 있을 때 편집자나 컬러리스트가 대신할 수도 있습니다. 또한 Fusion에서 
사용하는 와이어 제거 기법은 조명 스탠드, 전화선, 보기 흉한 안테나 같은 것을 제거할 때도 똑같이 
적용할 수 있습니다.
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가상 세트의 확장
배경 장면을 향상시키는 것에서 더 나아가 가상 세트 전체를 확장함으로써 영상을 보는 관객을 
순식간에 특정 장소로 이동시킬 수 있습니다. 물론 사운드 스테이지 안에서 안전하게 작업하면서 
말이죠. 연기자와 제작진 전체를 히말라야 산기슭으로 실어나르는 대신 숏의 배경을 사원, 산, 눈으로 
대체할 수 있습니다. 시대극이나 SF 영화 제작에서 대규모의 세트장을 만들 필요 없이 시각 효과를 
사용함으로써 엄청난 양의 시간과 돈을 절약할 수 있습니다. 연기자 주변에 필요한 사물들을 배치하고 
배경에 그린 스크린을 두기만 하면 됩니다. 후반 작업 시 Fusion 페이지를 사용하면 카메라의 
움직임을 추적하고 그린 스크린 배경을 3D 확장 세트로 대체할 수 있습니다.

모션 그래픽

모션 그래픽 또는 모션 디자인은 그래픽 요소에 애니메이션 효과를 주는 작업입니다. 이는 스크린 
위에 정보를 표시하기 위한 것으로 시각 효과, 애니메이션, 그래픽 디자인을 결합한 것입니다. 어떤 
형태의 정보는 그 자체가 목적이 되므로 대부분의 모션 디자인 프로젝트에서는 텍스트가 제일 
중요한 역할을 하게 됩니다. Fusion 페이지에서는 2D와 3D 타이포그라피(typography) 도구뿐 아니라 
창의적인 페인팅 도구 및 베지어(Bézier) 곡선 그리기 도구, 놀라울 정도로 심도 있는 스플라인(Spline) 
애니메이션 컨트롤을 제공합니다. 이 기능들을 사용하면 커뮤니케이션, 교육, 재미를 위해 시선을 
끄는 애니메이션 디자인을 생성할 수 있습니다.

세상을 보는 눈 키우기
고품질의 시각 효과를 만들어내고 싶다면 세상을 관찰하는 눈을 길러야 합니다. 시각 효과로 만든 
영상이 관중에게 진짜처럼 보이거나 느껴지지 않으면 관중은 믿지 않을 테니까요. 우리 주변의 
세계를 철저하고 자세히 관찰하는 기술은 시각 효과의 기술이나 예술적인 측면을 터득하는 것만큼이나 
중요합니다.

숙련된 시각 효과 아티스트가 되기 위해서는 빛, 원근, 깊이가 실제 세계에서 어떻게 표현되는지 
인지해야 하고, 관찰을 통해 얻은 안목을 합성 작업에 적용할 줄 알아야 합니다. 만약 합성 장면을 
구성하는 모든 요소가 같은 장소에서 촬영된 것처럼 보여야 한다면 이러한 합성 요소에 비추는 
빛이 같은 방향에서 비치도록 작업해야 합니다. 시각 효과 장면을 실제처럼 보이게 하려면 반드시 
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실제 세계의 디테일과 똑같이 상대적인 크기, 시차 모션, 깊이를 시뮬레이션해야 합니다.

시각 효과를 처음 사용한다면 작은 것부터 시작하세요. Fusion 페이지는 매우 광범위하고 강력한 
기능을 제공합니다. Fusion이 DaVinci Resolve에 통합됨으로써 이제 한 번의 클릭으로 시각 효과 
작업 페이지로 이동할 수 있습니다. 기능이 제대로 작동하는지 확인하려면 간단하게 테스트 해보세요. 
그런 다음 숙련된 정도나 작업 시간을 고려하여 본인이 작업을 마무리해도 되고 시각 효과 전문가에게 
넘겨도 됩니다.

시각 효과 합성은 한 가지 필터 효과를 입히는 것처럼 간단한 작업이 아니라, 여러 도구를 조합해서 
사용하는 작업입니다. 이 작업을 잘 해내려면 시간, 인내, 경험이 필요하지만 아주 재미있는 작업이어서 
실험과 연습을 통해 배워 나갈 수 있습니다. 결국은 여러분이 상상할 수 있는 최고의 멋진 영화 
장면을 만들어낼 것입니다.

월트 디즈니는 이렇게 말했습니다. “불가능해 보이는 일을 해내는 것은 일종의 재미죠.”
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Fusion에서 그래픽 
및 효과 생성하기

시각 효과를 사용하여 공상적이거나 불가능해 보이는 
장면을 실제와 같이 완벽하게 바꿀 수 있습니다. 극장 
안에서 최신의 블록버스터를 관람할 때, 아이폰 혹은 
집에서 큰 TV 화면으로 프로그램을 시청할 때 시각 효과를 
쉽게 접할 수 있습니다. DaVinci Resolve 15을 사용하면 
자신만의 시각 효과를 만들어서 관객들이 작품 속으로 
완전히 몰입하여 화면 속 장면을 실제처럼 믿도록 만들 
수 있습니다.

시각 효과 제작은 일종의 공예라고 볼 수 있으며 기술을 
습득하기까지 시간과 연습이 필요합니다. 그러나 기술을 
습득하기만 하면 상상 속에서나 가능한 일, 말 그대로 
어떤 이야기라도 실제처럼 만들어낼 수 있습니다.

DaVinci Resolve의 Fusion 페이지에는 레이어 방식 대신 
노드 방식에 기반하여 시각 효과와 애니메이션 모션 
그래픽 생성을 위한 모든 도구가 포함되어 있습니다. 
장난감 블록을 합치듯이 도구들을 서로 연결하여 이미지 
처리 플로차트에 연결함으로써 작업이 이루어집니다.

이 과에서는 자주 사용되는 효과들을 만들어 보겠습니다. 
실습을 통해 시각 효과와 모션 그래픽 작업을 살펴봄으로써 
Fusion의 강력한 텍스트 레이아웃 및 키프레임 애니메이션 
도구를 사용하여 장면 합성, 그린 스크린 키 생성, 
애니메이션 타이틀 제작의 방법을 배워볼 것입니다.  
이를 통해 기본적인 기술을 습득한 후에는 스스로 Fusion 
페이지를 더 탐구해보고 부가적인 도구를 사용해 보면서 
자신만의 효과를 만들어낼 수 있습니다.

예상 소요 시간 

이 과를 학습하는 데는 약 90분의 
시간이 소요됩니다.

학습 목표

인터페이스 둘러보기 230

미디어 풀에 있는 클립 추가하기 236

합치기 노드 이해하기 238

효과 삽입 및 조정하기 240

클립에 페인팅 작업하기 245

편집 페이지에서 레이어 사용하기 251

그린 스크린 키잉하기 253

모션 트래킹 257

새로운 숏으로 넘어가기 261

Text+ 노드 사용하기 262

비디오에 타이틀 배치하기 265

키프레임 애니메이션 266

복습하기 273
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인터페이스 둘러보기
시각 효과와 모션 그래픽 작업 시에는 한 번에 한 개의 숏만 작업해야 할 경우가 종종 발생합니다. 
DaVinci Resolve는 다른 영상 제작 소프트웨어와 달리 프레임을 다른 애플리케이션으로 엑스포트할 
필요가 전혀 없습니다. 작업을 마쳤으면 렌더링한 후 다시 임포트하면 됩니다. 메타데이터를 분실할 
염려가 없고 애플리케이션을 빠져나갈 필요도 없으며 영상의 어디쯤 작업하고 있는지 항상 알 수 
있을 뿐 아니라 그 외 프로젝트 및 미디어에 언제든 접속할 수 있습니다. DaVinci Resolve 15은 시각 
효과뿐 아니라 음향 믹싱, 컬러 그레이딩의 후반 제작 과정 전체를 간소화시킵니다. 이는 새로운 
작업 방식이기 때문에 그에 맞는 콘텐츠를 사용하여 시각 효과 합성을 익히게 될 것입니다.

1 DaVinci Resolve를 열고 Project Manager를 우클릭한 후 Import를 선택하세요.

R15 lessons 폴더 아래의 Lesson 09 폴더에 있는 Hyperlight.drp 파일을 여세요.

2 이 프로젝트에는 한 개의 타임라인과 세 개의 숏이 있으며 이를 가지고 모션 그래픽과 시각 
효과 작업을 해 볼 것입니다.

3 타임라인에서 플레이헤드를 첫 번째 빨간색 마커까지 가져가면 여배우의 클로즈업 장면에 
도달합니다.

4 Fusion 페이지 버튼 또는 [Shift+5] 키를 누르세요.

Fusion 페이지로 전환하면 플레이헤드는 Edit 페이지에 있을 때와 같은 위치에 있으며 여기서 
해당 클립에 시각 효과를 적용할 수 있습니다.

그러나 시각 효과를 생성하기 전에 먼저 Fusion 페이지를 한번 둘러보겠습니다.

Fusion 페이지는 크게 네 개의 구역으로 나뉩니다. 상단에 보이는 두 개의 뷰어에는 합성에 
사용 중인 이미지가 나타납니다. 뷰어 아래의 툴바에는 가장 자주 사용되는 효과들이 표시됩니다. 
노드 에디터라고 불리는 하단의 작업 영역은 효과를 구성하는 공간이기 때문에 Fusion 페이지의 
심장이라 볼 수 있습니다. 마지막으로, 인스펙터(Inspector)가 오른쪽에 보입니다.
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작업 영역에는 노드 에디터가 보이도록 기본 설정되어 있습니다. Fusion은 편집 페이지처럼 
레이어 방식의 타임라인을 사용하지 않습니다. 대신 노드 트리를 사용하여 각 이미지나 효과를 
노드 에디터에 표시합니다. 노드들이 플로 차트 형식으로 연결되어 전체 합성 구조를 더욱더 
쉽게 볼 수 있고 원하는 변경 작업을 신속하게 수행할 수 있습니다. Fusion에서의 노드 작업은 
레이어 방식의 인터페이스에서 겹겹이 쌓여 있는 합성 레이어와 필터 사이를 헤집고 다니는 
것보다 훨씬 속도가 빠릅니다. 노드 트리에서는 노드 하나를 사용하여 이미지에 효과를 적용 
후 이를 다른 노드에 넘겨 추가작업을 수행하는 방식 즉, 노드에서 노드로 이어지는 흐름을 
따릅니다.

5 마우스 포인터를 노드 에디터의 회색 빈 곳에 놓고 마우스 가운데 버튼을 누른 후 노드 트리가 
패널의 가운데에 오도록 드래그하세요.

Fusion 페이지로 가져온 클립이나 이미지 파일은 노드 에디터에서 MediaIn 노드로 표시됩니다. 
현재 MediaIn 노드는 편집 페이지에 있는 클립을 나타냅니다. MediaOut 노드는 편집 페이지의 
타임라인으로 다시 전송될 이미지를 나타냅니다.

6 노드 에디터에서 MediaIn1 노드를 선택한 후 [1] 키를 누르면 왼쪽의 뷰어 1에 이미지가 나타납니다.

인스펙터에서는 노드 에디터에서 
선택된 노드 또는 도구의 

파라미터들을 확인하고 수정할  
수 있습니다.

작업 영역에는 모든 조합의 
노드 에디터, 키프레임 에디터, 
스플라인 에디터가 나타납니다.

왼쪽 뷰어와 오른쪽 뷰어는 여러 
개 이미지 혹은 여러 개 효과를 

보여줄 수 있습니다.

툴바는 자주 사용되는 효과를 
노드 에디터에 바로 추가할 수 
있도록 버튼들을 제공합니다.
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정보 이미지 처리 작업을 지칭하는 데에는 노드와 도구라는 용어가 교차적으로 
사용됩니다.

해당 노드의 기능이나 이미지를 설명하는 내용으로 노드 이름을 변경할 수 있습니다.

7 MediaIn1 노드가 선택된 상태에서 [F2] 키를 누른 후 노드 이름을 ACTRESS로 바꾸세요.

8 MediaOut1 노드가 선택된 상태에서 [F2] 키를 누른 후 노드 이름을 OUTPUT으로 바꾸세요.

뷰어 아래에 있는 타임라인 눈금은 현재 작업 중인 효과의 지속 시간을 표시합니다. 타임라인 
눈금에 있는 빨간색 플레이헤드를 드래그하여 프레임 사이를 이동할 수 있습니다. 편집 
페이지에서 소스 뷰어나 타임라인 뷰어에서 조그바를 움직이는 것과 마찬가지입니다.

정보 Fusion 페이지의 타임라인 눈금 및 모든 시간 관련 필드에는 프레임 수가 
나타나도록 기본 설정되어 있습니다. 타임코드를 표시하려면 Fusion > Fusion 
Settings로 들어가 Defaults 패널에서 설정을 변경하세요.

타임라인 눈금은 전체 소스 클립의 길이를 보여주지만 노란색 선들은 렌더링 범위, 즉 해당 
클립이 최종 렌더링 시 타임라인 상에서 실제 차지하는 부분을 표시합니다.

뷰어 1 뷰어 2
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9 플레이헤드를 왼쪽 첫 번째 노란색 선이 있는 곳에서 두 번째 노란색 선이 있는 곳으로 렌더링 
범위를 드래그하세요.

렌더링 범위를 따라 플레이헤드를 드래그하면서 오른쪽 타임라인 눈금에 표시되는 현재 프레임 
번호를 확인하세요. 타임라인 눈금 왼쪽에는 렌더링 시작 프레임과 끝 프레임이 표시됩니다.

타임라인 눈금 아래에는 양쪽 핸들로 드래그하여 렌더링 범위를 확대할 수 있는 스크롤 바가 
있습니다. 이 장치는 타임라인에서 긴 소스 클립 중 극히 일부만을 사용하고 싶을 때 유용합니다.

정보 macOS의 경우 [Cmd+왼쪽 화살표] 또는 [Cmd+오른쪽 화살표] 키를, 
Windows의 경우 [Ctrl+왼쪽 화살표] 또는 [Ctrl+오른쪽 화살표] 키를 눌러 
플레이헤드를 렌더 범위의 시작 또는 끝으로 이동할 수 있습니다.

10 핸들이 양쪽에 달린 스크롤바에서 왼쪽 끝을 잡고 타임라인 눈금의 가운데 방향으로 드래그하여 
노란 선이 타임라인의 시작점 근처에 오도록 하세요.

11 이제 손잡이의 오른쪽 끝을 잡고 타임라인 눈금의 가운데 방향으로 드래그하여 노란 선이 
타임라인의 끝점 근처에 오도록 하세요.

정보 렌더 범위를 초기화하려면 타임라인 눈금을 우클릭하여 Auto Range 
Render를 선택하세요.

플레이헤드가 움직임에 따라 녹색 선이 타임라인 눈금 위에 나타나는데 이는 영상의 매끄러운 
재생을 위해 해당 프레임이 램(RAM)으로 캐싱됨을 뜻합니다. 사용하는 시스템의 램 용량이 클수록 
램 재생을 위해 캐싱되는 영역이 더 길어집니다.
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첫 번째 효과 추가하기
레이어 방식 대신 노드 방식을 사용하는 작업 방식을 이해하기 위해 이 클립에 간단한 효과 하나를 
추가해 보겠습니다.

1 Fusion 페이지의 좌측 상단에 있는 Effects Library 버튼을 클릭하세요.

Fusion에 있는 이펙트 라이브러리에는 250개 이상의 도구가 포함되어 있습니다.

이 라이브러리는 도구들을 카테고리별로 나누어 놓았습니다. 그리기와 파티클부터 마스킹, 
이미지 필터, 트래킹에 이르기까지 많은 카테고리가 존재합니다.

MediaIn 노드와 MediaOut 노드 사이에 도구를 연결함으로써 효과를 만들 수 있습니다. 이번 
예제에서는 워프 카테고리에서 그리드 워프 도구를 추가해 보겠습니다. 

2 Effects Library에서 Tool > Warp를 선택하면 워핑 도구 목록이 보입니다.

이 숏의 프레이밍을 수정하기 위해서는 그리드 워프 효과를 사용합니다.

3 이펙트 라이브러리에서 Grip Warp 도구를 드래그하여 ACTRESS와 OUTPUT 노드 사이의 
연결선 위로 드래그하세요. 연결선이 반쯤 파란색으로 변했을 때 마우스 버튼을 떼면 그리드 
워프 도구가 추가됩니다.
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4 인터페이스 툴바의 좌측 상단에 있는 이펙트 라이브러리 버튼을 다시 클릭하면 해당 패널이 
닫힙니다.

5 노드 에디터에서 그리드 워프 노드를 선택한 다음 [2] 키를 누르세요.

그리드 워프가 적용된 영상이 뷰어 2에 나타납니다. 효과 적용 전의 원래 영상은 뷰어 1에 
그대로 남아 있습니다.

그리드 워프 노드는 ACTRESS 노드의 출력을 전송받고 자신의 출력을 OUTPUT 노드로 보내면, 
OUTPUT 노드의 출력이 편집 페이지의 타임라인으로 전송이 되는 개념입니다.

노드 에디터에서 노드 한 개를 선택하면 해당 노드를 조정하기 위한 파라미터들이 인스펙터 
창에 나타나고 뷰어에는 온스크린 컨트롤이 나타납니다.

6 그리드 워프 효과가 클립에 어떤 효과를 주는지 관찰하기 위해 오른편의 뷰어 2에서 프레임 
가운데에 있는 그리드 점을 드래그하여 이리저리 움직여 보세요.

컨트롤 포인트를 드래그하는 거리만큼 이미지가 밀려나는 것을 확인할 수 있습니다. 효과를 준 
이미지가 뷰어 2에 나타나는 동안 뷰어 1은 여전히 원본 이미지인 ACTRESS를 보여줍니다. 
효과를 주기 전과 후의 화면을 이렇게 두 개의 뷰어 화면을 통해 볼 수 있기 때문에 더욱 
정확하게 비교하면서 조정값을 수정할 수 있습니다.

Fusion 페이지에서 생성한 효과는 편집 페이지의 타임라인에서 즉시 보이게 되어 있습니다.

7 프로그램 창 아래에서 Edit 페이지 버튼을 클릭하거나 [Shift+4] 키를 누르면 편집 페이지로 
돌아갑니다.

편집 페이지의 스마트 캐시는 편집 작업이 수행되는 동안 Fusion에서 작업된 효과를 
백그라운드에서 렌더링합니다.

이제 첫 번째 효과를 생성했으니 Fusion 페이지로 돌아갑시다.

8 프로그램 창의 아래에서 Fusion 페이지 버튼을 클릭하거나 [Shift+5] 키를 누르면 Fusion 
페이지로 돌아갑니다.
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노드 트리가 어떻게 플로차트처럼 작동하는지는 쉽게 알 수 있습니다. 왼쪽에서 이미지가 
들어와서 효과가 적용된 후 오른쪽에 있는 편집 페이지로 다시 보내집니다.

9 노드 에디터에서 그리드 워프 노드를 클릭한 후 [Delete] 또는 [Backspace] 키를 누르면 그리드 
워프 효과가 삭제됩니다.

이번 실습은 노드 트리의 인터페이스와 기본적인 개념에 익숙해지기 위한 간단한 연습이었다고 
보시면 됩니다. 이 과의 나머지 부분에서는 세 개의 클립에 좀 더 전문적이고 실제 작업에서 사용되는 
시각 효과를 적용해 보겠습니다.

미디어 풀에 있는 클립 추가하기
초보자 수준의 시각 효과는 두 개 혹은 그 이상의 이미지를 합쳐서 새로운 이미지를 만들어내는 
것입니다. 지금 Edit 페이지의 타임라인에는 클립이 한 개밖에 없지만, 미디어 풀을 통해 해당 프로젝트 
내의 클립을 불러올 수 있습니다. 공상 과학 영화 같은 이 장면에서는 컴퓨터 그래픽으로 이미 
만들어 놓은 헤드업 디스플레이(HUD)를 등장인물이 있는 우주 캡슐에 추가하겠습니다.

1 프로그램 화면의 왼쪽 위에 있는 미디어 풀 버튼을 클릭하세요.

Fusion 페이지의 미디어 풀은 Edit 페이지에 있는 미디어 풀과 같은 것이며 여러 개의 빈과 
클립을 포함합니다.

2 마스터 빈에서 헤드업 디스플레이 클립을 드래그하여 노드 에디터의 빈 곳에 가져다 놓으세요.

이 클립을 표시하기 위해 새로운 MediaIn1 노드가 생성됩니다. 이 클립은 합성 화면에 아직 
연결되지 않았습니다. 단지 노드 에디터에만 추가된 것입니다. 해당 클립을 합성 화면에 연결하지 
않고 뷰어에 표시되도록만 해도 많은 것을 배울 수 있습니다.

3 MediaIn1 노드를 선택 후 [F2] 키를 눌러 이 노드의 이름을 HUD로 변경합니다. 그러고 나서 [1]
키를 누르면 뷰어 1에 해당 이미지가 나타납니다.
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HUD 노드의 왼쪽 아래에 있는 흰색 작은 점은 뷰어 지정 버튼으로 이 버튼에 불이 들어오면 
뷰어 1에 해당 노드가 나타나고 있음을 알려줍니다.

OUTPUT 노드를 살펴보면 오른쪽에 있는 두 번째 뷰어 지정 버튼에 불이 들어와 있으므로 이 
노드가 뷰어 2에 나타나고 있음을 알려줍니다. 뷰어 2에 나타나는 OUTPUT 노드의 이미지는 
편집 페이지의 타임라인에 나타나는 최종 합성 결과물입니다.

정보 노드 위에 있는 뷰어 지정 버튼을 클릭하여 해당 노드의 출력을 어느 
뷰어로 보낼 것인지 선택할 수도 있습니다.

뷰어 1에는 바둑판 배경과 함께 HUD 그래픽이 나타나며 이 컴퓨터 그래픽은 알파 채널이 
포함되어 있기 때문에 투명도가 이미 적용되었음을 알 수 있습니다.

정보 알파 채널은 이미지 내의 빨강, 초록, 파랑 채널과 더불어 네 번째 채널에 
해당합니다. 알파 채널은 이미지의 어느 부분이 불투명하고 어느 부분이 
투명한지를 결정합니다.

4 뷰어 1 위쪽에 있는 Color 컨트롤 버튼을 클릭하거나 뷰어 안을 클릭한 다음 [A] 키를 누르면 
뷰어 내에 알파 채널이 나타납니다.

컬러 컨트롤 버튼은 뷰어가 현재 클립의 알파 채널을 표시하도록 전환합니다.

5 컬러 컨트롤 버튼을 클릭 후 [C] 키를 누르면 원래의 전체 컬러로 되돌아옵니다.

6 Media Pool 버튼을 클릭하여 미디어 풀을 닫으면 노드 에디터와 뷰어를 위해 더 큰 공간을 
확보할 수 있습니다.

노드 에디터에 이번 효과 적용을 위한 모든 요소가 준비되어 있으니 이제 합성 장면을 만들어보겠습니다.
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합치기 노드 이해하기
합치기 노드는 Fusion 페이지에서 가장 중요하고 자주 쓰이는 도구 중 하나입니다. 이 노드는 두 
개의 이미지를 합성 및 블렌딩합니다. 효과를 추가할 때처럼 합치기 노드를 추가할 수 있습니다. 
툴바에서 Merge 노드를 드래그하여 노드 에디터의 ACTRESS와 OUTPUT 노드 사이로 추가하세요.

1 툴바에서 첫 번째 도구 위로 마우스 버튼을 움직이세요.

마우스를 도구 위에 갖다 대면 해당 도구의 명칭이 표시됩니다.

6개의 툴바 카테고리가 옅은 분할선에 의해 구분됩니다. 왼쪽에서 오른쪽 방향으로 제너레이터
(Generator), 컬러(Color), 합성/변환(Compositing/Transform), 마스크(masks), 파티클(Particles), 
3D 카테고리입니다.

2 툴바의 두 번째 분할선 바로 다음에 있는 Merge 노드를 드래그하여 노드 에디터의 ACTRESS 
노드와 OUTPUT 노드 사이의 연결선 위로 가져와 움직여 보세요.

3 연결선의 절반이 파란색으로 변했을 때 마우스 버튼을 떼면 ACTRESS와 OUTPUT 노드 사이로 
합치기 노드가 추가됩니다.

정보 [Shift] 키를 누른 채 노드를 드래그하면 해당 노드가 노드 트리에서 떨어져 
나옵니다. 이때 새로운 위치로 다시 연결할 수 있습니다. 또는 노드를 선택 후 
[Delete] 또는 [Backspace] 키를 누르면 노드 에디터에서 해당 노드가 삭제됩니다.

이제 합치기 노드가 노드 트리에 연결되었고 이 노드를 사용하여 여배우가 나오는 장면 위에 
HUD 그래픽을 합성할 수 있습니다. 두 개의 이미지를 합치기 전에 합치기 노드에 대해 자세히 
알아볼 필요가 있는데요, 합치기 노드에는 배경 이미지(노란색 세모) 입력, 전경 이미지(녹색 
세모) 입력, 마스킹을 위한 입력(파란색 세모)인 세 개의 입력이 있습니다. 다른 노드와 마찬가지로 
합치기 노드에도 출력(흰색 네모)이 포함되어 있습니다.

제너레이터 컬러 합성/변환 마스크 3D파티클
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합치기 노드를 삽입하면 이 노드로 들어오는 연결선이 자동으로 배경 입력에 연결됩니다. 전경 
이미지를 연결하고 싶다면 수동으로 작업하면 됩니다. 노드 트리에서 여배우가 나오는 장면이 
합치기 노드의 노란색 배경 입력으로 연결됩니다.

4 HUD 그래픽을 합치기 노드의 전경 입력으로 연결하려면 HUD 노드에서 네모로 표시된 출력을 
드래그하여 합치기 노드의 초록색 전경 입력으로 가져가세요.

HUD 그래픽을 전경 입력으로 추가하면 여배우 이미지 위에 해당 그래픽이 놓이며 이 그래픽은 
내장 알파 채널이 적용되어 투명하게 보입니다.

정보 Blackmagic Design Ultra Studio나 DeckLink 카드를 통해 연결된 대형 
방송용 화면 같은 세 번째 디스플레이를 사용할 때는 키보드에서 [3] 키를 눌러 
해당 노드가 세 번째 모니터에 출력되도록 할당할 수 있습니다.

5 노드 에디터에서 HUD 노드를 드래그하여 합치기 노드 아래에 놓으세요.

노드의 구조

뷰어 할당 버튼 효과 마스크 입력

출력

전경 입력

배경 입력
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여기서 기억할 점은 노드의 위치를 바꾸는 것은 단지 시각적으로 보기 쉽게 하기 위함이지 합성 
결과에는 전혀 영향을 주지 않습니다. 노드 간 연결을 바꾸어야만 겹쳐지는 순서나 이미지가 바뀝니다.

합치기 노드는 Fusion에서 만들어 볼 대부분 합성 작업의 기초가 되는 주춧돌입니다. 합치기 노드는 
두 개의 이미지만 연결할 수 있지만, 그 두 개의 입력에 대해 이해하는 것은 매우 중요합니다. 그래야 
나중에 여러 개의 합치기 노드를 엮어서 훨씬 복잡한 시각 효과를 만드는 방법을 익힐 수 있습니다.

효과 삽입 및 조정하기
노드 배치는 노드 기반의 합성 시스템을 이해하는 데 있어 가장 중요한 개념입니다. 노드 트리에서 
어디에 노드를 추가하고 어떻게 연결하는지에 따라 합성의 결과가 달라집니다.

HUD 그래픽의 프레임은 배경보다 약간 더 크기 때문에 그 일부가 잘려나갈 수 있습니다. 배경의 
크기를 변경하지 않고 그래픽 크기만 변경하기 위해서는 적당한 위치에 변환 노드를 추가해야 
합니다.

1 툴바의 세 번째 분할선 앞에 위치한 변환 도구를 드래그하여 노드 에디터의 빈 곳에 놓으세요.

이 변환 도구가 HUD 그래픽에만 적용되도록 해야 합니다. 만약 이 도구를 합치기 노드 이후에 
놓으면 전체 숏의 크기가 변경될 것입니다.

2 [Shift] 키를 누른 채로 변환 도구를 HUD 노드와 합치기 노드 사이로 드래그하세요. 마우스 
포인터가 연결선 위에 접근하면 연결선이 파란색으로 변하고, 이때 마우스 버튼을 떼면 변환 
노드가 추가됩니다.
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아직 변경 사항이 적용되지 않았지만, 뷰어1에는 원본 그래픽이 나타납니다. OUTPUT 노드의 
출력을 나타내는 뷰어 2에는 변환 작업이 적용된 영상이 나타납니다.

정보 화면 왼쪽 하단 코너의 상태 표시 바는 현재 선택된 노드의 기본적인 
메타데이터 값을 표시합니다.

노드 에디터에서 노드 한 개를 선택하면 해당 노드를 조정하기 위한 파라미터들이 인스펙터 
창에 나타나고 뷰어에는 온스크린 컨트롤이 나타납니다.

3 인스펙터에서 Transform Size 슬라이더를 왼쪽으로 드래그하여 이미지 위 왼쪽에 있는 로고가 
잘리지 않고 나타날 때까지 크기를 줄이세요.

해당 숏에 다른 효과를 추가하려면 툴바에서 원하는 도구를 클릭하기만 하면 됩니다.

4 툴바의 두 번째 분할선 직전에 있는 Blur 도구를 드래그하여 변환 도구 바로 다음에 추가하세요.
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노드 에디터에서 노드 하나를 선택 후 툴바에서 원하는 버튼을 클릭하면 해당 도구가 선택된 
노드로 바로 추가됩니다. 블러 도구가 변환 노드 다음에 추가되었습니다.

컴퓨터 그래픽을 부드럽게 조정해 놓아야 실제 영상에 합성했을 때 더 현실감 있게 보입니다. 
여기서는 배경이 되는 실제 영상에 그래픽이 더 매끄럽게 겹쳐지도록 약간의 블러 효과를 
주겠습니다.

5 인스펙터에서 Blur Size 슬라이더를 드래그하여 값을 1.5 정도에 맞추면 그래픽이 조금 
부드러워집니다.

정보 노드 트리에서 노드를 선택 후 [Cmd + P] 키(macOS) 또는 [Ctrl + P] 키
(Windows)를 누르면 해당 노드를 일시적으로 비활성화할 수 있습니다.

이제 합성 장면을 미리 보기 해 봅시다.

6 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요. 스페이스 바를 누르면 합성 클립이 재생됩니다.

OUTPUT 노드의 결과 화면이 뷰어 2에 나타납니다.
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마스크 효과 
툴바에 있는 효과에는 노드를 연결하기 위한 입력과 출력이 존재합니다. 효과의 입력은 노란색 
세모로 표시되고 출력은 흰색 네모로 표시됩니다. 모든 노드에는 마스킹에 사용하기 위해 별도의 
마스크 효과 입력이 달려 있으며 파란색 세모로 표시됩니다. 이 입력을 사용하여 필터나 이미지 
처리 작업에 영향을 받는 영역을 제한할 수 있습니다. 옅은 비네트 블러 효과를 만들기 위해 배경에 
블러 노드를 하나 더 추가해 봅시다.

1 노드 에디터에서 ACTRESS 노드를 선택하세요.

노드가 선택된 상태에서 두 번째 블러 효과를 추가하면 효과가 이 클립에만 적용됩니다.

2 노드 트리에서 ACTRESS 노드 다음에 블러 효과를 추가하기 위해 툴바에서 Blur 도구를 
클릭하세요.

현재 뷰어에 나타나는 노드를 변경하여 블러 효과가 적용된 최종 영상을 확인하세요.

3 Blur2 노드를 선택 후 [1] 키를 누르면 뷰어 1에 해당 노드가 나타납니다.

4 인스펙터 창에서 Blur Size 슬라이더를 드래그하여 10으로 설정하세요.

이제 상당한 양의 블러 효과가 전체 이미지에 적용되었습니다. 매트 도구를 추가하여 블러 
효과가 적용되는 영역을 제한할 수 있습니다.

5 Blur2 노드를 선택 후 세 번째 분할선 바로 다음에 있는 마스크 카테고리에서 Ellipse 마스크 
도구를 클릭하세요.

블러 노드가 선택되었기 때문에 Ellipse 도구는 자동으로 블러 노드에 연결됩니다. Ellipse는 
마스크 도구이기 때문에 파란색 마스크 효과 입력으로 자동 연결됩니다.

뷰어 2에서 블러 효과가 타원 모양의 안쪽에 적용되었습니다. Ellipse 마스크 도구를 이용하여 
비네트 블러 효과를 적용해 봅시다. 먼저 블러 효과가 타원 모양의 바깥쪽에 적용되도록 
반전시켜야 합니다.

6 인스펙터에서 Invert 확인란을 선택하면 Ellipse 매트가 반전됩니다.
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비네트 블러 효과를 더 멋지게 만들기 위해 추가적인 조정 작업을 할 수 있습니다.

7 인스펙터에서 Level 슬라이더 값을 낮추면 블러 효과가 원본 이미지에 섞이면서 Ellipse 매트가 
조정됩니다. 그럼 다음, Soft Edge 슬라이더를 드래그하면 중앙에서 블러 효과가 적용된 
가장자리로 천천히 변화합니다.

정보 각 파라미터 슬라이더 끝에 있는 작은 회색 점은 해당 슬라이더의 기본 
설정값을 표시합니다. 이 회색 점을 클릭하면 슬라이더의 위치가 기본 
설정값으로 초기화됩니다.

해당 프레임의 16:9 종횡비보다 더 넓은 영역에 적용하기 위해서 온스크린 컨트롤을 사용하여 
타원 모양에 변화를 줄 수 있습니다.

8 뷰어 2에서 타원의 오른쪽 가장자리를 드래그하여 폭을 늘리면 효과가 적용되는 영역이 
넓어집니다.
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9 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮긴 후, 스페이스바를 누르면 합성 장면이 재생됩니다.

합성 장면이 처음으로 재생될 때 DaVinci Resolve가 램에 해당 효과를 로딩합니다. 타임라인 눈금 
아래 나타나는 녹색 줄이 램으로 캐싱되는 영역을 표시해 줍니다.

전체 합성 영역, 즉 렌더 범위 내 처음부터 끝까지의 전체 영역이 램에 캐싱될 경우에는 합성 장면이 
실시간으로 재생됩니다.

정보 Preferences > System Configuration에서 Fusion Memory Cache Setting을 
조정하면 Fusion 페이지에 램을 더 많이 할당할 수 있습니다.

클립에 페인팅 작업하기
Fusion 페이지에는 벡터 기반의 페인팅 도구가 있어 물체를 복제하거나, 모션 그래픽을 위해 스트로크 
애니메이션을 만들거나, 창조적인 방법으로 숏 안에 요소들을 그려 넣을 수 있습니다. 합성 장면에 
더욱 현실감을 더하기 위해 페인팅 도구를 사용하여 불빛을 추가하면 관객이 바라보는 헤드업디스플레이 
유리판의 모습을 더욱 향상시킬 수 있습니다.

1 툴바의 첫 번째 그룹에서 Paint 도구를 노드 에디터의 빈 곳에 드래그한 다음, [1] 키를 눌러 해당 
노드의 출력이 뷰어 1에 나타나도록 하세요.
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페인팅 도구는 해상도를 정의하기 위한 가상의 캔버스가 필요합니다. 배경 도구를 사용하여 
페인팅 도구를 위한 캔버스를 생성할 수 있습니다.

2 툴바의 첫 번째 그룹에서 Background 도구를 페인팅 도구의 위쪽 빈 공간으로 드래그하세요.

3 배경 도구의 출력을 드래그하여 페인팅 도구의 노란색 입력으로 연결하세요.

이제 페인팅 도구를 ACTRESS와 HUD 그래픽에 합성할 수 있습니다. 합치기 도구를 사용하여 
두 개의 이미지를 합성하는 방법은 앞에서 배웠는데요. 합성 장면에 다른 요소를 추가하려면 
합치기 노드의 출력을 다른 노드의 배경으로 사용하는 방식으로 여러 개의 합치기 도구를 
연결하면 됩니다.

4 툴바에서 Merge 노드를 노드 에디터로 드래그하여 Merge1 노드와 OUTPUT 노드 사이 연결선 
위로 가져오면 연결선 절반이 파란색으로 변합니다.

5 이때 마우스 버튼을 떼면 새로운 합치기 노드가 추가됩니다.

6 페인팅 노드의 출력을 Merge2 노드의 초록색 전경 입력으로 연결하세요.
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현재 배경 노드의 알파 채널이 투명하게 설정되어 있지 않아 지금까지 OUTPUT 노드의 최종 
출력 영상이 나타나던 뷰어 2에는 검은색 화면이 나타납니다. Merge2 노드에 페인트 작업을 
하려면 검은색 배경 노드를 투명하게 만들어야 합니다. 

7 노드 에디터에서 배경 노드를 선택 후 인스펙터에서 Alpha 슬라이더를 0으로 내리세요.

알파 값을 0으로 설정하면 배경 노드의 검은 색이 투명하게 되면서 여배우와 HUD 합성 장면이 
나타납니다. 이제 페인팅 작업을 시작하겠습니다.

8 노드 에디터에서 Paint 노드를 선택하세요.

페인팅 노드가 선택되면 페인팅 도구 툴바가 뷰어 위쪽에 나타납니다. 스트로크는 뷰어 툴바의 
도구 중 가장 유연하게 작업할 수 있는 도구이므로 제일 자주 사용하게 될 겁니다.

9 뷰어 툴바에서 Stroke 페인팅 도구를 선택하세요.
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10 마우스 포인터를 뷰어 안쪽으로 옮긴 후 [Cmd] 키(macOS), 혹은 [Ctrl] 키(Windows)를 누른 
상태에서 드래그하면 붓의 크기가 커집니다. 

지금은 일단 흰색으로 칠하고, 스트로크를 생성한 후에 색을 바꾸어 보겠습니다.

11 굵은 붓을 사용해서 붓을 떼지 않고 한 번에 화면 왼쪽 배우의 뺨 근처에 원 모양으로 그리기 
하세요.

12 같은 방법으로 화면 오른쪽 위에 약간 더 큰 원 모양을 그리세요.
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인스펙터의 Modifiers 탭에서 페인트 작업 후 언제든지 붓을 변경할 수 있습니다.

13 인스펙터 위쪽에 있는 Modifier 탭을 클릭하세요.

모디파이어 탭에는 지금까지 생성된 각 스트로크의 헤더가 표시됩니다. 또한 다음에 생성할 
스트로크 작업을 준비할 수도 있습니다. 각 헤딩 아래에 있는 파라미터를 수정하면 각 스트로크의 
모양을 변경할 수 있습니다.

14 모디파이어 패널에서 stroke1을 더블클릭하세요.

각 스트로크에는 인스펙터에서 사용하는 페인트 도구와 동일한 컨트롤이 포함되어 있습니다.

15 Brush Control의 펼치기 화살표를 클릭 후 Softness 슬라이더를 1.8로 드래그하면 스트로크 
작업 시 가장자리가 조금 부드러워집니다.

16 태양 빛을 비추는 것을 표현하기 위해 컬러 스와치를 사용하여 붓의 색을 흰색에서 연한 
노란색으로 바꾸어 줍니다.
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첫 번째 페인팅 스트로크의 색상 변화가 뷰어에 나타납니다.

17 모디파이어 패널에서 Stroke 2의 헤더를 더블클릭하여 붓의 소프트니스와 색을 똑같이 
조정하세요.

합치기 노드에 있는 블렌딩 기능을 사용하여 스트로크가 이미지에 더 잘 합쳐지도록 만들 수 
있습니다. 

18 노드 에디터에서 Merge2 노드를 선택 후 인스펙터에서 Blend 슬라이더를 0.5로 드래그하면 
스트로크 두 개의 불투명도를 낮출 수 있습니다.

Apply Mode 메뉴에는 합치기 노드의 더욱 복잡한 블렌딩 기능이 있습니다. 이 설정은 간단한 
수학적 방식으로 전경 및 배경의 색과 루미넌스에 기초하여 이미지를 블렌딩합니다.

Apply Mode 메뉴에는 여러 종류가 있지만 합성 장면에 전반적으로 사용하는 효과의 종류에 
따라 다음과 같은 카테고리로 Apply Mode를 나눌 수 있습니다.

 � 색을 어둡게 하기: Darken, Multiply

 � 색을 연하게 하기: Add, Lighten, Screen

 � 색 대비 높이기: Hard light, Overlay, Soft light

유리에 비친 빛을 나타내기 위해 오버레이 모드를 사용하여 노란색 스트로크가 적용된 영역의 
색 대비를 높여 봅시다.

19 Apply Mode 메뉴에서 Overlay를 선택하세요.
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20 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요. 스페이스 바를 누르면 합성 클립이 재생됩니다.

HUD 합성 장면에 마지막으로 작업한 부분은 유리 위에 희미하게 비추는 햇빛이었습니다. 이제 편집 
페이지로 돌아가서 전체 장면의 흐름 속에서 이 효과를 관찰합시다.

편집 페이지에서 레이어 사용하기
Fusion의 전체 기능이 이제 DaVinci Resolve에 구현되었기 때문에 편집 페이지에서 레이어 작업 
및 변형 작업을 한 결과가 Fusion 페이지에도 그대로 적용됩니다. 편집 페이지의 타임라인에 있는 
두 개의 레이어를 어떻게 Fusion 페이지로 옮길 수 있을지 살펴봅시다.

1 Edit 버튼을 클릭하거나 [Shift + 4] 키를 누르면 Edit 페이지로 전환됩니다.

2 타임라인에서 플레이헤드를 두 번째 빨간색 마커 위로 움직이세요.
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3 타임라인에서 Video 2에 있는 클립을 선택하세요. [D] 키를 누르면 해당 클립이 비활성화되고 
Video 1 트랙이 보입니다.

이 트랙의 클립은 컴퓨터 그래픽으로 만든 행성의 모습입니다. Video 2는 그린 스크린용 
클립입니다.

4 다시 [D] 키를 눌러 Video 2의 그린 스크린 클립을 활성화합니다.

편집 페이지의 타임라인에서 합성 요소를 레이어/트리밍/정렬한 다음, 여러 개의 클립을 Fusion 
페이지로 옮겨올 수 있습니다. 편집 페이지에 있는 클립 여러 개를 Fusion 페이지로 가져오려면 
반드시 Fusion 클립을 생성해야 합니다.

5 타임라인에서 두 개의 클립을 모두 선택하여 우클릭 후 New Fusion Clip을 선택하세요.

새 Fusion 클립이 타임라인에 생성되고 선택된 빈에 이 클립이 추가됩니다. 두 개의 레이어가 
한 개로 합쳐지지만 Fusion 페이지에서 각각의 레이어에 접근 가능합니다.
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정보 Fusion 클립을 우클릭 후 Open In Timeline을 선택하면 편집 페이지의 
모든 Fusion 클립 레이어가 나타납니다.

6 플레이헤드를 이 클립 위에 오게 한 다음, Fusion 페이지 버튼을 누르거나 [Shift+5] 키를 누르세요.

Fusion 페이지의 노드 에디터에서 Video 1의 클립은 Median1 노드로, Video 2의 클립은 MediaIn2 
노드로 표시됩니다. 두 개의 클립이 합치기 노드에서 합쳐지며 MediaIn1의 출력이 배경으로, 
MediaIn2의 출력은 전경으로 사용됩니다. 어느 노드가 어느 클립에 해당하는지 쉽게 알아볼 
수 있도록 노드의 이름을 다시 붙여 봅시다.

7 Fusion 페이지에서 MediaIn1 노드를 선택 후 [1] 키를 누르세요.

8 MediaIn1 노드를 우클릭한 다음 Rename을 선택하거나 [F2]를 누르세요. 이 노드의 이름을 
PLANET_BKGD라고 입력합니다.

9 Fusion 페이지에서 MediaIn2 노드를 선택 후 [1] 키를 누르세요.

10 MediaIn2 노드를 우클릭한 다음 Rename을 선택하거나 [F2]를 누른 후 GREENSCREEN_FRGD라고  
적어 넣습니다.

합치기 노드는 두 클립이 타임라인에서 겹쳐지도록 할 수는 있지만, 키잉 능력은 없습니다. 그린 
스크린 숏을 키잉하기 위해서는 키어 도구를 추가해야 합니다.

그린 스크린 키잉하기
두 개의 숏을 합치기 위해서는 매트가 필요한데 이는 전경 요소는 투명하게 그리고 배경 요소는 
불투명하게 정의하는 흑백 출력 이미지입니다. 이전에 사용했던 컴퓨터에서 생성된 알파 채널과는 
달리, 전경에 있는 라이브 액션 숏은 매트를 포함하고 있지 않습니다. 따라서 키잉 처리를 통해 
매트를 생성할 것인지는 사용자의 선택에 달려있습니다.

정보 이번 실습에서는 그린 스크린을 이용하지만, 작업 방법은 숏에서 블루 
스크린을 제거할 때와 같습니다.
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1 노드 에디터에서 GREENSCREEN_FRGD를 선택 후 화면의 왼쪽 위에 있는 Effects Library 
버튼을 클릭하세요.

편집 페이지에서와 마찬가지로 OpenFX 카테고리 내에 모든 ResolveFX가 들어 있습니다. 
그러나 Fusion 페이지에서는 합성 도구가 모두 Tools 카테고리 아래에 있습니다. 키어는 Tools 
> Matte 카테고리 아래에 있습니다.

정보 매트와 마스크라는 용어는 종종 혼용됩니다. 이 책에서 매트는 투명 
픽셀과 불투명 픽셀을 정의하는 흑백 출력 이미지를 지칭합니다. 마스크는 
매트를 적용한 결과물입니다. 매트를 사용하여 이미지 속 한 부분을 마스크로 
분리시킵니다.

2 Tools의 펼치기 화살표를 클릭한 후 Matte 카테고리를 선택하세요. Delta Keyer를 한 번 
클릭하세요.

노드 에디터에서 GREENSCREEN_FRGD노드가 선택되어 있었기 때문에 DeltaKeyer1이
GREENSCREEN_FRGD의 출력으로 연결됩니다.

델타 키어는 Fusion 페이지에서 가장 첨단의 색차 키어이면서 사용은 아주 간편합니다.

3 델타 키어 노드를 선택 후 [1] 키를 눌러 뷰어 1에 해당 노드의 출력이 나타나도록 하세요.

작업의 첫 단계는 투명하게 만들려는 전경 이미지에서 녹색을 선택하는 것입니다.

4 인스펙터에서 Background Color 스포이드 아이콘을 드래그하여 뷰어 1의 녹색 화면 위로 
가져가세요.
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5 녹색 화면이 없어지고 뷰어 2에서 행성의 모습이 선명히 보이면 그때 마우스 버튼에서 손을 
떼세요.

방금 한 작업이 바로 녹색을 선택함으로써 전경 숏을 위한 매트를 생성한 것입니다. 뷰어를 
통해 보았을 때 작업 결과가 만족스러운 경우라도 품질 검증을 위해 항상 매트를 점검해야 
합니다.

6 뷰어 1 위쪽에서 Color 컨트롤 버튼을 클릭하세요.

현재 작업 중인 라이브 액션 숏의 매트나 알파 채널이 표시됩니다. 이번 경우처럼 그린 스크린 
키가 매우 선명하다 하더라도 매트 조절을 통해 불투명한 영역은 완전한 흰색, 투명한 영역은 
완전한 검은색인지 확인해야 합니다.

7 숏을 따라 플레이헤드를 드래그하면서 흰색 불투명 영역이 회색으로 나타나는 곳이 있는지 
찾아보세요. 이와 동시에 검은색 투명 영역이 회색으로 나타나는 지점이 있는지도 찾아보세요.
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제대로된 매트의 경우 투명한 영역은 완전한 검은색으로, 불투명한 영역은 완전한 흰색으로 
나타납니다. 회색으로 보이는 영역은 반만 투명하다는 뜻이며 만약 해당 숏에 머리카락, 유리 
등의 반투명 물질이 포함되어 있다면 전혀 문제가 되지 않습니다. 이번 실습에서 사용한 전경은 
그런 요소가 전혀 없으므로 완벽히 검은색 또는 흰색으로 표시되어야 합니다. 그러나 클립을 
점검하다 보면 매트 내에 회색 영역이 발견될 겁니다. Deltakeyer 매트 탭에서 이를 수정하여 
매트의 밀도를 증가시킬 수 있습니다.

8 인스펙터에서 Matte 탭을 클릭하세요

매트 탭에는 매트의 밀도와 가장자리를 수정하는 파라미터가 포함되어 있습니다. 매트의 품질은 
키의 품질에 의해 좌우되기 때문에 이 탭이 델타 키어에서 가장 중요한 탭이라 볼 수 있습니다. 
매트 탭의 제일 위쪽에 있는 것이 Threshold 슬라이더입니다. 이것을 조절하여 흑백의 컷오프 
기준점을 설정할 수 있습니다. Low Threshold의 설정값보다 낮으면 완전한 검은색, High 
Threshold 설정값보다 높으면 완전한 흰색으로 간주됩니다.

9 회색 영역이 완전한 검은색으로 변할 때까지 Treshhold의 Low 슬라이더를 우측으로 드래그해 
임계값을 높이세요.

10 회색 영역이 완전한 흰색으로 변할 때까지 Treshhold의 High 슬라이더를 좌측으로 드래그해 
임계값을 낮추세요.
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11 뷰어 1 위쪽의 Color 컨트롤을 클릭하면 델타 키어의 출력 색상으로 되돌아옵니다.

12 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮긴 후, 스페이스바를 누르면 합성 장면이 재생됩니다.

숏의 조명 상태와 전경에 있는 합성 대상이 무엇인지에 따라 차이가 있겠지만, 키잉 작업에는 많은 
조정 작업 및 로토스코핑 작업이 필요하며, 숏 내 여러 부분을 수정하기 위해 여러 개의 델타 키어를 
사용해야 하는 경우도 발생합니다. 그러나 이번 실습에서 배운 기본적인 설정 작업은 Fusion 내 
모든 키잉 작업에서 사용되는 공통 원리입니다.

모션 트래킹
트래킹이란 숏에서 사물의 움직임을 분석하고 그 분석 데이터를 이용해서 모션의 경로를 만드는 
과정입니다. 모션 트래킹 작업을 완료한 후에 다른 클립이나 요소를 여기에 추가하여 똑같은 모션 
경로를 따르도록 만들 수 있습니다. 키잉 합성의 마지막 작업은 바로 행성이 나오는 배경 숏을 전경 
숏에 자연스럽게 통합시키기 위해 행성이 전경 숏을 촬영한 핸드헬드 카메라의 움직임을 따라 
움직이도록 만드는 것입니다. 먼저 전경 숏의 카메라 움직임을 분석하기 위해 트래킹을 적용해야 
합니다.

1 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위의 시작점으로 옮겨 프레임 0에 맞추세요.

분석을 해야 하는 모션이 GREENSCREEN_FRGD 노드에 있으므로 트래커를 이 노드의 출력에 
추가해야 합니다.

2 노드 에디터에서 GREENSCREEN_FRGD를 선택하세요.

트래커는 이펙트 라이브러리에 있습니다. GREENSCREEN_FRGD 노드를 선택한 다음 이펙트 
라이브러리에서 트래커를 클릭하기만 하면 트래커가 추가되면서 해당 노드에 자동으로 
연결됩니다.

3 화면의 좌측 상단에 있는 Effects Library 버튼을 클릭하여 라이브러리 패널을 다시 여세요.

4 Tools > Tracking 카테고리에서 Tracker를 선택하면 GREENSCREEN_FRGD 노드 이후에 
트래커가 추가됩니다.
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트래커는 Fusion 페이지의 트래킹 도구 중 가장 간단한 도구입니다. 트래커는 카메라 모션이 
포함되어 명암 대비가 뚜렷한 패턴의 움직임을 분석합니다.

5 [1] 키를 누르면 뷰어 1에 트래커의 출력이 나타납니다.

트래커 설정의 첫 번째 단계는 해당 프레임 내에 뚜렷한 명암 대비의 패턴을 주고 그 위에 
트래커를 놓는 것입니다.

뷰어에서 트래커는 두 개의 상자로 나타납니다. 안쪽 상자는 트래커가 따라가야 할 명암 대비 
패턴을 표시합니다. 상자의 왼쪽 상단 모서리를 잡고 드래그하면 상자의 위치를 옮길 수 있습니다. 
이 상자를 정확한 위치에 놓아야만 트래킹이 제대로 이루어집니다. 핸드헬드 카메라로 인해 
생긴 모션 이외에는 모션이 전혀 없는 부분을 숏 내에서 찾아야 합니다. 따라서 팔과 머리를 
움직이고 있는 남자 배우는 이 조건에 맞지 않습니다. 창문 가장자리를 따라 선명하게 보이는 
지점을 선택해 보겠습니다.

6 뷰어 1에서 패턴 상자의 왼쪽 상단 핸들을 드래그하여 창문 가장자리 오른쪽 아래 모서리의 
밝은 부분 위에 트래커를 놓으세요.

패턴 상자가 확장되면서 해당 영역을 확대해 보여줌으로써 선택된 영역을 정확하게 작업하도록 
돕습니다.

7 창문 가장자리의 선택된 영역이 상자의 중심부에 왔을 때 마우스 버튼에서 손을 떼세요.
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트래커의 바깥쪽 상자는 검색을 위한 상자입니다. 트래커는 클립의 프레임 사이를 움직이면서 
패턴 상자가 인식한 패턴을 찾아냅니다. 검색 영역이 클수록 트래킹 분석의 속도는 느려집니다. 
느리게 움직이는 사물의 경우에는 한 프레임에서 다음 프레임으로 넘어갈 때 패턴이 크게 
움직이지 않을 가능성이 크기 때문에 이 경우에는 검색 상자를 비교적 작게 설정해도 됩니다. 
빠르게 움직이는 사물의 경우에는 검색 상자를 크게 설정해야 할 수도 있습니다.

지금 이 숏에서는 카메라의 움직임이 많이 빠르지는 않기 때문에 프레임이 바뀌는 동안 선택한 
패턴이 조금씩만 움직일 것입니다. 직사각형의 검색 상자는 현재 크기 그대로 두겠습니다.

인스펙터 상단에 보이는 트래킹 분석 버튼들을 사용하여 앞으로 또는 뒤로 트래킹할 수 있습니다.

8 오른쪽에 있는 Track From First Frame 버튼을 눌러 트래킹을 시작하세요.

뷰어 1은 분석이 완료되기까지의 트래킹 진척 상황을 보여줍니다. 또한 트래킹하고 있는 프레임 
수와 소요 시간에 대한 정보를 표시하는 창도 나타납니다.

9 OK 버튼을 클릭하면 합성 작업을 계속할 수 있습니다.

트래킹이 완료되면 배경 이미지를 트래커에 추가함으로써 카메라의 움직임과 똑같은 모션 
경로를 따르도록 해야 합니다.

트래커에 요소 추가하기
Fusion에 있는 클립에는 원래 위치, 회전, 스케일링 파라미터가 내장되어 있지 않습니다. 클립을 
옮기거나 위치를 바꾸려면 변환 노드를 추가해야 합니다. PLANET_BKGD 노드에 변환 노드를 
추가해야 트래커를 사용하여 새로운 위치에서 움직이게 할 수 있습니다.

1 PLANET_BKGD 노드를 선택 후, 툴바의 세 번째 분할선 앞에 있는 Transform 도구를 클릭하세요.

변환 노드가 PLANET_BKGRD 노드 직후에 추가됩니다. 변환 노드의 온스크린 컨트롤을 사용하여 
행성의 위치를 재조정하고 회전시킬 수 있습니다. 온스크린 컨트롤을 사용하여 트래커를 추가할 
수도 있습니다.

2 뷰어 2에서 변환 노드의 온스크린 컨트롤을 우클릭한 후 Transform1: Center > Connect To > 
Tracker 1 > Unsteady Position을 선택하세요.
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3 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮긴 후, 스페이스바를 누르면 합성 장면이 재생됩니다.

트래커의 경로에 기반하여 배경의 위치가 재설정됨에 따라 그 아래에 투명한 바둑판 패턴이 
드러납니다. 이를 수정하기 위해서는 배경 이미지의 상대적인 위치값을 사용하여 이를 숏 전반에 
적용해야 합니다. 배경의 크기를 증가시키기 위해 변환 노드의 Size 컨트롤을 사용할 수 있습니다.

4 인스펙터에서 변환 노드의 Size 컨트롤을 1.2 정도로 드래그한 다음, 바둑판 모양의 배경이 더는 
안 보이는 것을 확인하기 위해 전체 합성 장면을 미리보기 합니다.

이제 배경 숏에 있는 행성이 전경 숏의 카메라 움직임을 따라 움직입니다. 이 실습은 모션 트래킹 
사용의 한 가지 예에 불과합니다. 모션 트래킹은 용도가 매우 다양하기 때문에 나중에 컬러 페이지에서 
색보정 작업을 시작할 때도 다시 한번 적용할 기회가 있을 겁니다.
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새로운 숏으로 넘어가기
그린 스크린 숏 작업을 끝냈기 때문에 이제 Edit 페이지로 돌아가서 플레이헤드를 새로 만든 클립 
쪽으로 움직여 보세요. DaVinci Resolve의 캐싱 기능이 배경 화면에 입혀진 시각 효과를 렌더링하게 
됩니다. 그러나 계속해서 시각 효과와 모션 그래픽을 다른 숏에 적용하고 싶다면 편집 페이지로 
돌아갈 필요가 없습니다. Fusion 페이지에서도 손쉽게 새로운 클립으로 변경할 수 있습니다.

1 DaVinci Resolve 창의 왼쪽 상단 모서리에서 Effects Library를 클릭하여 라이브러리 패널을 
닫은 후 Clips 버튼을 클릭하세요.

편집 페이지의 타임라인에 있는 모든 클립이 노드 에디터의 하단에 썸네일 형태로 나타납니다.

2 클립 디스플레이에 나타나는 첫 번째 썸네일을 클릭하세요.

썸네일로 전환하면 해당 클립을 위한 MediaIn1, MediaOut1 노드가 담긴 새 노드 에디터가 
나타납니다. 그린 스크린 합성을 위한 노드 트리가 이 클립에 저장되어 있으므로 이 썸네일을 
선택하면 노드 트리가 다시 로딩됩니다. 그러나 편집 페이지나 Fusion 페이지에서 새로운 숏으로 
전환하면 사실상 새 클립을 위한 새 Fusion 문서를 열게 됩니다.

3 플레이헤드를 드래그하여 클립을 미리보기 하세요.

정보 램 재생을 위해 Fusion에 할당된 램 메모리 크기는 Fusion 페이지의 
오른쪽 아래에 표시됩니다. 이 숫자를 마우스 우클릭하면 캐시를 완전히  
비워서(Purge Cache) 램 메모리를 초기 상태로 돌릴 수 있습니다. 캐시를 
일부러 비우지 않아도 DaVinci Resolve가 새로운 프레임을 렌더링할 때 
자동으로 램을 초기화합니다.

이 클립이 Fusion에서 사용하게 될 다음 숏입니다. 클립 썸네일을 숨기면 노드 에디터의 공간을 
더 넓게 확보할 수 있습니다.

4 DaVinci Resolve 프로그램 창의 왼쪽 상단 모서리에 있는 Clips 버튼을 다시 한번 클릭하면 
썸네일이 숨겨집니다.

이 새로운 클립 위에 Hyperlight라는 공상 과학 영화의 타이틀 애니메이션을 생성해볼 겁니다.
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Text+ 노드 사용하기
좋은 그래픽이란 메인 타이틀, 스틸 이미지, 혹은 프로그램 내 자막 등의 종류와 상관없이 중요한 
정보를 전달하는 동시에 프로그램이 가진 본래 영상룩은 그대로 유지할 수 있어야 합니다. 시청자의 
주의를 끌 수도 있어야겠죠. 이번 실습에서는 공상 과학 영화의 첫 번째 숏 오프닝 타이틀을 위한 
애니메이션 효과를 생성해 볼 겁니다.

1 노드 에디터 빈 곳에서 마우스 가운데 버튼을 누른 후 노드 트리가 패널의 가운데에 오도록 
드래그하세요.

2 툴바의 첫 번째 카테고리에 있는 Text+ 도구를 드래그하여 노드 에디터로 가져온 후 연결선 
위쪽의 빈 곳에 놓으세요.

Fusion은 2D와 3D 텍스트 옵션을 제공합니다. 이번 작업은 처음으로 해 보는 타이틀 작업이므로 
Text+라는 2D 텍스트 도구를 사용하여 간단한 타이틀 애니메이션을 만들어 보겠습니다.

3 [1] 키를 누르면 뷰어 1에 타이틀이 나타납니다.

타이틀 노드를 노드 트리에 연결하기 전에 타이틀 디자인 작업을 시작할 수 있습니다.

4 인스펙터 창의 Styled Text 입력란에 HYPERLIGHT를 입력하세요.

5 Styled Text 입력란 아래의 Font 메뉴에서 Open Sans(macOS) 또는 SegoeUI(Windows)를 
선택하세요.

6 그 아래 메뉴에서는 Light를 선택하세요.
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이제 글자 크기를 조금 증가시켜 볼 겁니다.

7 인스펙터에서 Size 슬라이더를 드래그하여 0.1 정도로 글자 크기를 늘리세요.

Text+ 도구에는 Shading Elements라고 불리는 매우 유연한 방식의 스타일링 옵션들이 있습니다. 
이 옵션들을 사용하여 텍스트의 필, 아웃라인, 보더, 섀도우 스타일을 조정할 수 있습니다.

8 Shading 탭을 클릭하세요.

Shading 탭에서는 글자색, 테두리, 그림자, 불빛을 적용할 수 있습니다. 평범한 흰색 글자를 
사용하기보다는 그라디언트 효과를 사용하여 글자를 채워봅시다.

9 인스펙터의 Properties 섹션에서 Type을 Gradient로 설정합니다.

두 개의 컬러점이 달린 Gradient 바가 나타납니다. 왼쪽 끝에 있는 컬러점은 그라디언트의 
윗부분 색을 설정하는 용도이고 오른쪽 컬러점은 아랫부분의 색을 설정하는 용도입니다.

10 왼쪽 컬러점을 선택 후 연한 노랑으로 변경하세요. 오른쪽 컬러점을 선택 후 진한 황금빛 
노랑으로 변경하세요.

텍스트의 Fill Color는 8가지 셰이딩 요소 중 하나입니다. 나머지 요소들은 인스펙터의 Shading 
Elments 팝업 메뉴에서 설정할 수 있습니다. 이 요소들 모두 원하는대로 변경할 수 있지만 첫 
번째 White Fill 요소만 기본 설정으로 활성화되어 있습니다. 그 외 다른 요소들은 개별적으로 
활성화해야 합니다.
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11 Select Elements 메뉴에서 2번을 선택 후 오른쪽에 있는 Enabled 버튼을 클릭하세요.

Shading Elements의 두 번째 요소는 Red Outline으로 기본 설정되어 있습니다. 이것을 Soft 
Drop Shadow로 바꾸어 보겠습니다.

12 Appearance에서 Text Fill 버튼을 클릭하면 셰이딩 요소가 Outline에서 Second Text Fill로 
변경됩니다.

13 컬러 스와치에서 색을 검은색으로 바꾸세요.

14 인스펙터에서 아래로 스크롤하여 Softness 섹션을 연 후, X와 Y 슬라이더 값을 5 정도에 맞추면 
연하고 부드럽게 떨어지는 그림자가 만들어집니다.

이제 텍스트에 깊이감을 더하기 위해 그림자의 오프셋을 설정해 봅시다.

15 Position 섹션을 열어서 Offset X와 Offset Y 파라미터의 값을 각각 조정하면 부드럽게 떨어지는 
그림자의 위치가 텍스트 아래쪽 왼편에 약간 치우치도록 할 수 있습니다.

앞서 언급했듯 8개의 셰이딩 요소를 추가하여 필, 섀도우, 아웃라인, 보더, 글로우를 적용할 수 
있습니다. 또한 각 셰이딩 요소의 Position, Shear, Rotation 값을 원하는 대로 제어할 수 있기 
때문에 타이틀 제작을 위한 옵션은 무궁무진합니다.

영화 타이틀을 생성했으니 이제 실제 비디오 클립 위에 적용하면 어떻게 보일지 살펴보겠습니다.



265

비
디

오
에

 타
이

틀
 배

치
하

기

비디오에 타이틀 배치하기
헤드업 디스플레이 숏과 그린 스크린 숏을 합성했을 때와 마찬가지로 비디오에 타이틀을 추가하는 
작업에도 합치기 도구를 사용합니다.

1 툴바에서 Merge 노드를 드래그하여 연결선 위로 가져오세요.

2 노드 연결선이 반쯤 파란색으로 변했을 때 마우스 버튼을 떼면 MediaIn1과 MediaOut1 노드 
사이로 합치기 노드가 추가됩니다.

현재 행성 장면인 MediaIn1 노드가 합치기 노드의 배경으로 연결되어 있습니다. 타이틀은 
전경으로 연결해야 합니다.

3 텍스트를 합치기 노드의 전경 입력으로 연결하려면 Text1 노드의 네모 표시된 출력을 합치기 
노드의 초록색 전경 입력으로 드래그하세요.

뷰어 2에서 MediaOut1 노드의 출력을 모니터링하므로 뷰어 2에 텍스트가 나타납니다.

Apply Mode에서 숏에 페인트 스트로크를 블렌딩했던 것과 마찬가지로 Apply Mode에서 모션 
그래픽을 더욱 효과적으로 합성할 수 있습니다. 다시 말해, Apply Mode에서 오버레이를 사용하여 
텍스트를 배경에 블렌딩할 수 있습니다.
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4 합치기 노드를 선택 후 Apply Mode 팝업 메뉴에서 Overlay를 선택하세요.

적용 모드를 사용하면 요소를 전경 입력으로 바로 연결하는 방식에 비해 블렌딩이 더 부드럽고 
자연스러워집니다.

키프레임 애니메이션
시간의 흐름에 따라 화면 속 요소가 변하는 기술은 시각 효과 및 모션 그래픽 작업에 있어 핵심적인 
기능입니다. Fusion 페이지가 제공하는 기본적인 키프레임 애니메이션 기능은 기존의 편집 페이지와 
같은 방식이지만, Fusion 페이지에서는 모든 기능이 탑재된 키프레임 에디터 및 스플라인 에디터를 
통해 훨씬 더 세부적인 작업을 수행할 수 있습니다. 텍스트에 페이드 인, 페이드 아웃 기법을 사용하여 
애니메이션을 수행해 봅시다.

1 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요.

Edit 페이지에서 한 것처럼 인스펙터를 사용하여 키프레임을 추가할 겁니다. 이번 경우에는 
텍스트를 페이드 인, 페이드 아웃 하기 위해 합치기 노드를 사용할 겁니다.

2 합치기 노드가 선택된 상태에서 Blend 슬라이더의 오른쪽에 있는 Keyframe 아이콘을 클릭하면 
키프레임이 추가됩니다. Blend 슬라이더는 0으로 드래그하세요.

어떤 파라미터든 키프레임 버튼을 활성화하면 현재 플레이헤드의 위치에 키프레임이 하나 
추가되고 자동 키프레이밍이 설정됩니다. 즉 파라미터를 조정할 때마다 키프레임이 추가됩니다. 
1초짜리 페이드 인, 페이드 아웃을 생성해 봅시다.

3 타임라인 눈금 오른쪽 아래에 있는 현재 시각 필드를 더블 클릭하세요.

4 24를 입력하면 플레이헤드가 효과의 첫 1초 지점으로 당겨집니다.
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5 인스펙터에서 Blend 슬라이더를 오른쪽으로 드래그하여 텍스트가 완전히 드러나도록 하세요.

이제 플레이헤드를 움직여서 페이드 아웃을 위해 키프레임을 두 개 더 설정할 겁니다.

6 타임라인 눈금에서 플레이헤드를 렌더 범위 끝까지 드래그하거나 [Cmd+왼쪽 화살표] 키(macOS)

또는 [Ctrl+왼쪽 화살표] 키(Windows)를 누르세요.

7 Blend 슬라이더를 0으로 드래그하세요.

8 현재 시각 필드를 더블클릭 후 176을 입력하면 타임라인 끝에서부터 24프레임 떨어진 곳으로 
플레이헤드가 옮겨갑니다.

9 Blend 슬라이더를 1로 드래그하세요.

10 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요.

영화 제목이 시선을 더 잘 끌 수 있도록 클립이 재생되는 동안 글자들이 천천히 퍼져나가는 
방식의 애니메이션을 제작해 보겠습니다.

11 Text1 노드를 선택 후 인스펙터에서 Text 탭을 클릭하세요.

12 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요.

13 Tracking 슬라이더의 오른쪽에 있는 Keyframe 아이콘을 클릭하면 해당 트래킹 파라미터에 
키프레임이 추가됩니다.

기본 설정된 위치에서 트래킹을 시작해서 클립의 마지막 부분에 도달했을 때 최대한으로 넓게 
퍼지도록 하겠습니다.
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14 타임라인 눈금에서 플레이헤드를 렌더 범위 끝까지 드래그하거나 [Cmd+왼쪽 화살표] 키(macOS)

또는 [Ctrl+왼쪽 화살표] 키(Windows)를 누르세요.

15 인스펙터에서 Tracking 슬라이더를 오른쪽으로 드래그하여 1.5에 맞추세요.

Tracking 슬라이더를 드래그하는 즉시 플레이헤드의 현재 위치에 새 키프레임이 추가됩니다.

16 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요.

17 스페이스바를 눌러 변경된 애니메이션 효과를 확인해보세요.

지금까지 본 것처럼 Fusion 페이지의 인스펙터 창에서 키프레임을 설정하는 방법은 편집 
페이지에서와 같습니다. 즉 Fusion 페이지에서 아주 간단하게 애니메이션 효과를 줄 수 있습니다. 
효과가 적용된 모습을 확인하고 키프레임을 수정하는 작업은 편집 페이지에서와 아주 다른데요, 
이 작업을 통해 Fusion 페이지의 애니메이션 처리 기능이 편집 페이지보다 훨씬 강력하다는 
것을 알 수 있습니다.

키프레임 확인 및 수정
노드 에디터는 합성 작업을 위한 이미지 처리 작업을 설정하고 구성하는 역할을 하지만, 키프레임에 
관련된 정보를 보여주지는 않습니다. 그러나 Fusion 페이지는 키프레임을 확인하고 수정하는 아주 
강력한 도구인 키프레임 에디터와 스플라인 에디터를 제공합니다.

1 DaVinci Resolve 창의 오른쪽 상단 코너에 있는 Spline 버튼과 Keyframes 버튼을 누르면 두 
개의 패널이 나타납니다.
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스플라인 에디터와 키프레임 에디터에는 둘 다 키프레임을 확인하고 수정하는 도구가 포함되어 
있습니다. 지금은 키프레임을 수정하는 것만 배워볼 것이기 때문에 노드 에디터는 필요하지 
않습니다. 노드 에디터를 잠시 숨기면 키프레임 에디터를 위한 공간을 더 넉넉하게 사용할 수 
있습니다.

2 DaVinci Resolve 프로그램 창의 왼쪽 위에 있는 Nodes 버튼을 클릭하면 노드 에디터를 숨길 
수 있습니다.

키프레임 에디터에서 보면 각 노드가 익숙한 타임라인 형식으로 쌓여 있는 것이 보입니다.

키프레임 트랙이 층층이 쌓여 있지만, 그 순서는 합성 순서와 아무런 관련이 없습니다. 키프레임 
트랙은 클립이 시작할 때, 끝날 때, 그리고 여기에 포함된 키프레임들에만 영향을 미칩니다.

3 키프레임 에디터에서 Text1 노드와 Merge1 노드 옆에 있는 펼치기 화살표를 클릭하면 두 트랙의 
시작 프레임과 끝 프레임이 나타납니다.

트랙 아래의 흰색 줄은 Blend 및 Tracking 애니메이션을 위한 키프레임을 의미합니다. 타이틀의 
페이드 인 속도를 높이기 위해 이 블렌딩 키프레임을 움직여 봅시다.

4 키프레임 에디터의 빈 공간을 클릭 후 [Cmd+F] 키(macOS) 또는 [Ctrl+F] 키(Windows)를 누르면 
트랙들의 위치가 에디터 창에 맞게 조정됩니다.

창이 꽉 차도록 트랙을 확장하면 각 키프레임을 더 선명하게 볼 수 있습니다.

5 Blend 트랙에서 두 번째 키프레임을 왼쪽으로 드래그하여 왼쪽 하단 코너에 있는 시간을 
나타내는 숫자가 ‘Time: 12.0’이 되도록 하세요.
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키프레임이 12 프레임 앞으로 이동하였으므로 페이드 인 애니메이션의 지속 시간이 1초가 아닌 
0.5초로 변경되었습니다.

6 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러 플레이헤드를 렌더 
범위 시작점까지 이동하세요. 그리고 스페이스바를 눌러 새 설정값이 어떻게 적용되었는지 
확인하세요.

키프레임 에디터에서는 각 요소와 키프레임의 타이밍을 직접 조정할 수 있습니다. 그러나 
키프레임 간의 속도를 조정하기 위한 가시적인 도구는 제공하지 않습니다. 스플라인 에디터가 
이와 관련된 기본적인 도구를 제공합니다. 키프레임을 선형 가속화 방식에서 자연스러운 Ease-
in/Ease-out 방식으로 바꾸어 글자 간격 효과가 적용된 애니메이션이 좀 더 자연스러워 보이도록 
만들어 봅시다.

7 Spline 에디터에서 Text1 아래의 Character Spacing 확인란을 선택하세요.

8 마우스 포인터를 스플라인 에디터 위로 옮긴 후 [Cmd+F] 키(macOS) 또는 [Ctrl+F] 키(Windows)를  
누르면 그래프 영역이 허용하는 한도 내에서 스플라인 크기가 최대화됩니다.
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Character Spacing 애니메이션 스플라인이 스플라인 에디터에 나타납니다. 시작 키프레임은 
왼쪽 아래에, 마지막 키프레임은 오른쪽 위에 있습니다. 두 개의 키프레임 사이에 있는 직선은 
선형 애니메이션, 즉 움직임이 일정한 비율로 진행된다는 뜻입니다. 좀 더 자연스러운 애니메이션 
효과를 만들고 싶다면 두 키프레임 간의 움직임을 부드럽게 만들면 됩니다.

정보 Fusion 페이지의 모든 패널에서 패닝 및 줌인이 가능합니다. 마우스 중간 
버튼을 누른 채 드래그하면 패닝이 되고 [Cmd] 키(macOS) 혹은 [Ctrl] 키
(Windows)를 누른 채 마우스 가운데 버튼으로 스크롤하면 줌 인 또는 줌 
아웃됩니다.

9 스플라인 에디터에서 두 개의 키프레임을 선택하기 위해 직사각형으로 드래그하세요.

10 스플라인 에디터의 왼쪽 하단 코너에서 Smooth 버튼 혹은 [Shift+S] 키를 누르세요.
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Smooth 버튼은 키프레임을 S 곡선으로 만들고 각 키프레임에 스플라인 손잡이를 추가합니다.

두 개의 키프레임에 모두 이 버튼을 사용하면 애니메이션 시작과 끝이 자연스러워집니다.

11 [Cmd+왼쪽 화살표] 키(macOS) 또는 [Ctrl+왼쪽 화살표] 키(Windows)를 눌러서 플레이헤드를 
렌더 범위 시작점으로 옮기세요. 스페이스바를 눌러 새로 변경된 설정값이 어떻게 적용되었는지 
확인하세요.

Fusion 페이지는 수년간의 개발 과정을 거친 결과 풍부하고 강력한 합성 기능을 제공하게 되었습니다. 
이번 과에서 배운 것만으로 이 기능들을 전부 습득할 수는 없지만, 이전에 다른 시각 효과 및 모션 
그래픽 프로그램을 사용했던 경험이 있다면 다른 사람보다 한발 앞서 출발할 수는 있습니다. 그러나 
합성 작업에 능숙한 사람이라도 처음에는 자신의 콘텐츠에 간단한 효과를 적용해 보면서 천천히 
다른 것들을 시도해 나가기를 추천합니다. 하나씩 습득해 나가다 보면 자신의 Fusion 합성 기술 
실력이 놀라울 정도로 빠르게 성장하는 것을 경험하실 겁니다.
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복습하기
1 Fusion 페이지에서 뷰어1을 통해 노드의 결과물을 확인하는 방법은 무엇인가요?

2 Fusion 페이지를 빠져나가지 않고 다음 숏으로 전환하는 방법은 무엇인가요?

3 두 장면을 블렌딩하려면 어떤 노드를 사용해야 하나요?

4 합치기 노드에서 노란색으로 표시되는 입력은 무엇인가요?

5 Fusion 페이지에서 작업 중 MediaOut 노드가 필요 없을 경우 연결을 해제할 수 있습니다.  
T(진실) 또는 F(거짓)로 답하세요. 
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정답
1 Fusion 페이지에서 뷰어 1을 통해 노드의 출력을 확인하려면 해당 노드를 선택 후 [1] 키를 

누르면 됩니다.

2 Fusion 페이지에서 숏을 전환하기 위해서는 상단 툴바의 Clips 버튼을 클릭 후 작업하고자 하는 
숏의 썸네일을 클릭하면 됩니다.

3 두 장면의 합성을 위해서는 합치기 노드가 사용됩니다.

4 합치기 노드의 노란색 입력은 배경 입력을 뜻합니다.

5 F. MediaOut 노드는 제일 마지막에 위치하며, 노드 에디터의 결과 영상을 Edit 페이지의 
타임라인으로 다시 렌더링합니다.



색보정 기술과 DaVinci Resolve 15의 강력한 색보정 도구 사용법을 배우기에 앞서 색보정 및 
크리에이티브 매체에 대해 알아보는 시간을 갖는 것이 중요합니다.

색보정 작업은 컬러커렉터를 다룰 줄 안다고 해서 할 수 있는 일이 아니며 단순히 스코프를 사용한다고 
해서 결과물이 좋아지는 것도 아닙니다. 그보다는 오히려 고도의 창의력이 필요한 작업입니다. 
실력이 뛰어난 편집자가 프로그램의 이야기를 전개하고 극적인 흐름을 만들어 내는 것과 마찬가지로 
컬러리스트가 영상 이미지를 시각적으로 조정해 시청자들의 감정을 불러일으킵니다. 다른 모든 
크리에이티브 관련 기술과 마찬가지로 컬러리스트로서 뛰어난 실력을 갖추려면 시간이 오래 걸리기는 
하지만 전혀 지루하게 느껴지지 않습니다. 왜냐하면 항상 배워야 할 무언가가 있고 새롭고 창의적인 
스타일이 무궁무진하기 때문입니다.

DaVinci Resolve를 사용하면 30년 이상의 색보정 노하우를 경험하실 수 있습니다. DaVinci는 그동안 
필름, 비디오, 디지털 영상의 시각적인 예술성을 향상시키는 전문 색보정 하드웨어 및 소프트웨어를 
개발하기 위해 끊임없이 노력해왔습니다. 그 결과 DaVinci Resolve는 수준 높고 정교하며 효율적인 
도구 모음을 지원할 수 있게 되었습니다. 이를 통해 프로그램의 클립 영상룩을 조정하고 이러한 
조정 사항을 타임라인 전반에 걸쳐 관리할 수 있습니다.

DaVinci Resolve는 영화 및 방송 업계의 모든 분야에서 근무 중인 전 세계 전문 컬러리스트의 수많은 
피드백을 기반으로 꾸준히 업그레이드되고 있습니다. 덕분에 DaVinci Resolve의 Color 페이지를 
컬러리스트가 생각하는 대로 작업할 수 있도록 개발할 수 있었습니다. 모든 기술적인 정교한 처리 
솜씨는 DaVinci Resolve를 사용하는 아티스트가 프로그램의 무한한 잠재력을 충분히 이해할 때 
얻을 수 있습니다. DaVinci Resolve는 그저 도구에 불과하다는 사실을 기억해야 합니다. 이것이 
바로 DaVinci Resolve의 매력이기도 하죠.

색보정 알아보기



276 다음에 이어질 과에서는 영화, TV 드라마, 웹 시리즈, 단편 영화, 광고, 홍보 영상, 기업 영상 등의 
프로젝트에서 Color 페이지의 뛰어난 성능을 사용하는데 필요한 기본적인 내용을 배워볼 수 있습니다. 
이러한 포맷은 작업의 종류에 관계없이 기본적인 그레이딩 기술과 동일한 도구를 사용하기 때문에 
전문 색보정 분야에서의 작업 경험이 없더라도 걱정할 필요가 전혀 없습니다. 모든 유명한 컬러리스트들 
역시 이러한 단계를 거쳤기 때문이죠. 앞으로 여기서 배운 기본적인 내용을 바탕으로 작업을 진행하게 
될 것입니다.

이제 누구나 고품질의 색보정 작업을 수행할 수 있는 시대가 열렸습니다. Blackmagic Design은 
적당한 성능의 워크스테이션이나 노트북을 가진 편집자라면 누구나 DaVinci Resolve의 강력한 
컬러 도구를 사용할 수 있도록 했습니다. Color 페이지에서 클릭 한 번으로 세계적인 수준의 결과물을 
얻을 수 있습니다.

하지만 색보정 작업에 대해 자세히 알아보기 전에 한걸음 물러나 각 도구가 실제로 어떻게 사용되는지를 
살펴보는 것이 중요합니다.

색보정 작업의 필요성
수많은 프로듀서와 감독들이 묻는 질문 중 하나가 바로 이것입니다. “촬영한 그대로의 영상룩도 
좋아 보이는데 굳이 색보정 작업에 시간을 들일 필요가 있나요?” 시간이 곧 생명인 영상 업계에서 
충분히 나올 법한 질문입니다. Edit 페이지에서 편집한 영상이 괜찮아 보인다면 굳이 따로 색보정 
작업을 할 필요가 있는지 생각해보게 되는 거죠.

하지만 결론은 색보정 작업을 거친 영상과 그렇지 않은 영상의 차이가 분명하다는 사실입니다. 

프로그램에 사용하는 클립의 콘트라스트와 색상을 조정하는 과정을 색보정, 컬러 그레이딩 또는 
그레이딩이라고 합니다. 용어 간의 큰 차이가 있지는 않지만 대부분의 경력 있는 컬러리스트들은 
그레이딩이라는 용어를 주로 사용합니다. 이는 ‘보정’이라는 단어가 무언가 잘못된 부분을 바로 
잡는다는 느낌을 주는 반면에 ‘그레이딩’이라는 단어는 프로그램에 사용하는 각 클립의 예술적 
감각을 더 높은 수준으로 끌어올린다는 느낌을 주기 때문입니다. 그래서 컬러리스트들은 “이 클립이 
괜찮아 보이나요?”라고 묻지 않고 “이 클립을 좀 더 매력적으로 만들 수 있을까요?”라고 질문합니다.

영상톤 설정하기
색상이 주는 정서적인 효과를 통해 관객 분위기를 형성할 수 있다는 사실에는 많은 사람들이 
동의하지만 차가운 파란 조명을 사용한 장면과 따뜻한 주황색 조명을 사용한 장면이 크게 다를 
것이라고 생각하지는 않습니다. 초록빛이 감도는 형광등 장치와 연어 빛깔의 길거리 수은등 조명이 
적절히 적용된 각 장면은 서로 다른 분위기를 자아내며 내러티브와 이를 받아들이는 관객들에게 
새로운 느낌을 전달합니다.



277

물론 이렇게 다양한 광원이 의미하는 바는 작업한 시각적인 팔레트에 따라 달라질 수 있습니다. 
따뜻한 느낌의 조명이 한 영상에서는 로맨틱해 보일 수 있지만 다른 영상에서는 펄펄 끓는 사막의 
불쾌한 느낌으로 전달될 수 있습니다. 이런 효과는 색보정을 통해 영상 이미지와 이야기가 어떤 
조화를 이루는지에 따라 달라집니다. 이 영상이 오후에 찍은 것처럼 보이도록 해야 할까? 색상을 
좀 더 부드럽게 처리해야 하나? 이 장면에 하늘이 꼭 등장해야 하나? 색보정 작업을 통해 영상을 
섬세하게 제어하면 관객들의 인식 역시 달라집니다.

기억해야 할 점은 Color 페이지의 도구를 사용하면 시각 효과를 강화, 약화 또는 완전히 상쇄하는 
방식으로 조화롭고 모든 장면에 꼭 맞는 톤을 생성할 수 있다는 사실입니다.

주관적인 묘사 기법
서사 촬영 기법을 사용할 경우에는 촬영 장소에서 아주 정확한 조명을 사용해 완벽하게 맞아떨어지는 
중립적인 색채 및 색조를 연출하는 일은 거의 없습니다. 그 대신 수많은 조명 도구와 세심한 시각 
기법을 사용해 촬영 장소의 조명 및 색상을 조정하면 어두침침한 분위기, 신비한 느낌, 무서운 느낌, 
후텁지근한 날씨 등을 연출할 수 있습니다. 이런 노력은 색보정 작업실에도 이어지는데 현실을 있는 
그대로 묘사하는 것이 아니라 촬영 감독과 감독이 관객들에게 보여주고자 하는 모습을 연출합니다.

차가운 느낌 따뜻한 느낌

카메라 원본 이미지(좌) / 관객들에게 보여주고자 하는 이미지(우)



278 다큐멘터리 촬영 기법에서는 여전히 렌더링 작업을 거치긴 하지만 현실의 모습을 있는 그대로 
전달하기 위해 노력합니다. 하지만 이렇게 있는 그대로의 모습을 보여주는 것 같은 영상도 사실은 
보정 작업을 거친 결과물입니다. 뮤직비디오와 마찬가지로 피사체가 더 잘 보이도록 만들고 자연의 
모습이 돋보이게 하며 아카이브 영상을 깨끗하게 처리하거나 프레임 주변이 배경으로 아름답게 
사라지게 하는 등의 모든 조정 작업을 사전에 치밀하게 준비할 수 있습니다.

요점은 공포 영화, 건축 다큐멘터리, 홍보 영상, 자동차 광고 등의 작업에서 색보정 도구 및 기술을 
사용하여 주관적인 관점이 투영된 이미지를 연출한다는 사실입니다. 이런 작업에서 제어할 수 있는 
요소가 많아질수록 훨씬 폭넓은 감정 반응을 그려나갈 수 있습니다.

더욱 다양해진 첨단 작업 기능
색보정 작업을 배우면서 경쟁력을 키우고자 할 경우, 그중에서도 특별히 자신의 작업이 아니라 
고객이 의뢰한 프로젝트를 작업할 경우에는 최신 스타일과 트랜드를 파악해야 합니다. 좋은 글을 
쓰기 위해서는 글을 많이 읽어야 한다는 말이 있는데요, 색보정 작업 역시 예외는 아닙니다. 영화, 
TV, 뮤직 비디오, 웹 단편 영상들을 참고하면 좋습니다. TV의 경우 광고 영상이 도움이 됩니다. 
DaVinci Resolve에서 제공하는 색보정 컨트롤 사용법을 배운 다음엔 현재 작업 중인 프로젝트에서 
여러 가지 조정 작업을 통해 영상룩이 어떻게 달라지는지 알아볼 수 있습니다.

마지막으로 우리 주변에 있는 다른 시각 정보를 참고하세요. 패션 매거진을 찾아보거나 아트 갤러리를 
방문하고 산속을 거닐면서 잘 관찰해보세요. 다양한 이미지를 마음에 담고 영감을 얻을 만한 내용이 
있는지 살펴봅니다. 다른 시각적인 분야에 대한 이해가 늘어갈수록 더 많은 아이디어를 떠올릴 수 
있습니다.

마지막으로 고려해야 할 부분은 편리해진 색보정 작업이 TV 업계에 미친 영향입니다. 요즘 대부분의 
TV 드라마에는 장편 영화 수준의 시각 기법이 사용됩니다. 화질이 급격히 향상되면서 TV 프로그램의 
영상 품질이 이전보다 훨씬 좋아졌습니다.

이런 변화가 불러온 의도치 않은 혜택은 유명 영화 배우들이 누리고 있습니다. 이제 더 이상 TV가 
영화보다 뒤떨어지는 매체가 아니기 때문에 TV에 프로그램에 출연했다가도 다시 영화로 자유롭게 
복귀할 수 있습니다. 또한 수준 높은 영화 제작진들과 시설을 갖출 경우 품격은 그대로 유지한 채 
다양한 종류의 TV 프로그램 및 장편 영화를 촬영할 수 있습니다. 고화질 작업을 위해 스트리밍 
서비스와 같은 플랫폼을 추가로 늘리는 일은 정말 즐거운 일입니다. 업계 규모가 그 어느 때보다 
빠르게 성장하고 있기 때문에 재능 있는 편집자 및 컬러리스트에 대한 수요가 급증하고 있습니다.



279색보정 작업 목표
색보정 작업은 RAW 이미지 데이터의 특정 부분을 드러내 시청자들이 보기 좋은 이미지를 연출하는 
것으로 볼 수 있습니다.

이미지 현상
최신 디지털 카메라는 대부분 RAW 색공간 이미지 데이터로 촬영 가능하며, 최소한 노출이  
로그화 되어 있는 RGB 이미지 데이터로 녹화할 수 있습니다. 이렇게 하면 색보정 단계에서 조정할 
이미지 데이터를 최대한 보존할 수 있습니다. 이런 작업 방식이 워크플로를 유연하게 운영하고 
고품질의 조정 작업을 수행하는 데 큰 도움이 되는 것은 사실이지만 미디어를 이런 방식으로 얻게 
될 경우, 편집 및 피니싱 과정을 위해 해당 영상을 가시적인 이미지 형태로 변환하는 추가 과정을 
거쳐야 합니다. 이는 음화 필름을 가시적인 이미지로 변환하려면 현상 및 인화 작업을 거쳐야 하는 
것과 같은 맥락입니다.

DaVinci Resolve는 내장된 카메라 RAW 컨트롤과 DaVinci Resolve 컬러 매니지먼트, LUT 지원 
기능을 통해 이런 작업을 간소화시키기 때문에 미디어를 색보정 작업이 가능한 상태로 신속하게 
준비할 수 있습니다.

모든 클립을 시각적으로 최적화하기
촬영 감독의 업무가 예술적인 의도가 담긴 조명 및 노출을 이미지에 담아내는 것이라면 편집자와 
컬러리스트의 임무는 그런 의도를 파악해 각 클립 이미지 색상과 콘트라스트를 조정하는 것입니다. 
그러면 감독과 촬영 감독이 의도한 것과 최대한 비슷한 최종 결과물을 얻을 수 있습니다. 이런 작업 
과정을 통해 노출과 색균형을 일관되게 조절할 수 있습니다. 이뿐만 아니라 촬영 현장에서는 담아낼 
수 없었지만 감독과 촬영 감독이 원했던 따뜻한 분위기와 콘트라스트를 미세하게 조정할 수도 
있습니다.

로그화된 소스 이미지(좌) / 정규화 및 수정 작업을 거친 동일 소스 이미지(우)
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물론 일부 경우 색상과 노출에서 중대한 문제가 발견되어 미디어를 수정해야 할 수도 있습니다. 
이런 경우 이미지에 좀 더 많은 변화를 가져다줄 도구를 사용할 수 있지만, 결과물의 품질은 주로 
소스 미디어의 화질과 ‘관용도’에 의해 결정됩니다. 예를 들어, Blackmagic URSA Mini 카메라는 
엄청난 양의 이미지 데이터를 RAW 또는 압축을 최소화한 미디어 포맷으로 녹화하기 때문에 일반 
소비자용 카메라로는 불가능한 수준의 광범위한 후반 작업을 수행할 수 있습니다. 다행히도 두 가지 
경우 모두 컬러 페이지에서 지원하는 도구를 사용하면 이미지를 다양한 방식으로 처리해 더욱 
뛰어난 영상룩을 얻을 수 있습니다. 

품질 관리
이 모든 작업을 진행할 때 DaVinci Resolve에서 할 수 있는 모든 창의적인 가능성을 염두에 두는 
것도 중요하지만, 고객에게 전달할 딜리버리 영상이 배포 규정에 맞는 적절한 신호 수준을 유지하도록 
하는 것 역시 중요합니다. 특히 영화, 방송, 스트리밍 전용 프로그램은 아주 구체적인 루마, 크로마, 
색영역 범위가 정해져 있어 이를 초과할 경우 화질 관리 규정 위반으로 간주되어 해당 프로그램이 
반송될 위험이 높습니다.

DaVinci Resolve는 이미지 데이터가 어떤 영향을 받게 되는지 주시하고 이미지를 미세하게 조정할 
수 있도록 특별 제작된 도구를 탑재했습니다. 특히 스코프에 표준 파형과 퍼레이드, 벡터스코프, 
히스토그램 그래프가 나타나 이미지 데이터를 객관적으로 분석할 수 있습니다. 이런 스코프를 통해 
사용 가능한 범위를 확인할 수 있으며 사소한 문제점을 쉽게 발견하고 이미지 특성을 서로 비교할 
수 있습니다.

장면 간의 균형 맞추기
보정 작업을 거치지 않은 여러 장면을 매끄럽게 매칭하는 일은 불가능에 가깝습니다. 아무리 
꼼꼼하게 노출 각도를 설정하더라도 서로 조금씩 다를 수밖에 없어 균형을 맞춰야 합니다. 예를 
들어, 촬영 현장의 조명을 그대로 사용하는 런앤드건 촬영 기법의 경우 한 장면에서 다른 장면으로 
넘어갈 때 조명과 색상을 대대적으로 조정해야 하는 상황이 종종 발생합니다.

장면 간의 이런 차이는 그 정도에 관계없이 편집 과정에서 엄청난 부담이 될 뿐 아니라 시청자들의 
몰입도를 떨어뜨리기도 합니다. 이러한 차이를 줄여 균형을 맞추는 일이 컬러리스트가 해야 할 또 
다른 주요 업무 중 하나입니다. 한 장면에 있는 모든 숏이 같은 시간 및 장소에서 촬영된 것처럼 
나타나고 한 장면에서 다른 장면으로 넘어갈 때 색상 및 콘트라스트 조정 작업을 눈치채지 못할 
정도로 장면이 자연스럽게 이어질 때 비로소 작업을 마무리할 수 있습니다.

노출이 부족한 이미지(좌) / 관객을 위해 수정된 이미지(우)



281스타일 및 사용자 지정 영상룩 추가하기
물론 항상 섬세한 보정 작업만 하는 것은 아닙니다. 예를 들어, 뮤직 비디오나 광고 영상을 작업하는 
경우에는 아주 파격적인 시각 기법을 사용해야 합니다. 이를 위해 DaVinci Resolve는 이미지에서 
예상치 못한 측면을 이끌어 낼 수 있는 다양한 기능을 제공합니다. 예를 들어, 커스텀 커브를 사용해 
화학적인 크로스 프로세싱 효과를 생성할 수 있습니다.

할리우드에서 사용하는 도구
지금까지의 설명으로도 남은 내용과 사용 방법을 알아봐야겠다는 확신이 들지 않을 경우엔 할리우드의 
일부 대형 후반 제작 업체를 비롯한 전 세계 영상 업계에서 DaVinci Resolve를 널리 사용하고 있다는 
사실을 기억하세요. 또한 누구나 사용할 수 있는 DaVinci Resolve의 편리한 접근성 덕분에 수많은 
소규모 후반 제작 업체와 개별 아티스트들이 사용하는 핵심 도구로도 자리매김했습니다. DaVinci 
Resolve로 완성한 작품으로는 <인디펜던스 데이: 리써전스>와 <엑스맨: 아포칼립스> 같은 블록버스터 
영화뿐만 아니라 <빅 식>, <고스트 스토리> 등의 독립 영화, 그리고 HBO의 <웨스트월드>와 AMC
의 <워킹 데드>, CW의 <애로우>와 같은 TV 시리즈가 있습니다.

기본기부터 차근차근 배워 협력 아티스트로 후반 제작 업계로 진출할 계획이거나 혹은 자기 계발을 
통해 스스로 창의적인 작품을 완성하고자 하는 경우, 뒤에 이어질 과정을 통해 일반적인 비선형 
편집 프로그램에서는 경험할 수 없는 영상 조정 및 예술적 표현 방식을 알아갈 수 있습니다.

마지막으로 색보정 작업은 정말 즐겁습니다! 트랙볼에 손을 올려놓고 이미지에 감정을 불어 넣는 
작업은 정말 재미나죠. 실시간으로 영상을 조정해 바로 결과를 확인하고 영상을 통해 전해지는 
감정을 느낄 수 있습니다. 색보정은 지적인 작업이라기 보다는 매우 창의적인 작업입니다. 매일이 
놀라움의 연속인 색보정 작업은 우리가 처음 TV 업계에 빠지된 이유를 떠올리게 하는 정서적인 
직업이기도 합니다.

이런 즐거움을 느껴보세요!

원본 이미지(좌) / 커스텀 커브를 사용해 화학적인 크로스 프로세싱 효과를 적용한 이미지(우)





제10과

퀵스타트: 색보정 

색보정 작업은 편집 작업과 마찬가지로 숙달되기까지 
오랜 시간이 걸리는 일종의 예술 작업입니다. 색상을 
통해 영화의 스타일을 정의하고 분위기를 전달할 
수 있기 때문에 굉장히 강력한 크리에이티브 
도구라고 할 수 있습니다. 시간을 들여 색보정하는 
방법을 배우고 꾸준히 연습하면 놀라운 색보정 
기술을 습득해 뛰어난 영상룩의 창의적인 이미지를 
제작할 수 있습니다.

책 초반부에서 편집 방법을 간단히 살펴봤을 때와 
마찬가지로 이번 과에서는 대부분의 주요 색보정 
도구에 대해 간단히 알아보겠습니다. 프라이머리 
커렉터와 세컨더리 조절 기능, 노드, 트래킹, 특수 
효과를 위한 DaVinci Resolve FX 적용 방법 등에 
대해 알아보겠습니다. 색보정 작업에서 가장 중요한 
것이 손끝으로 직접 수많은 요소를 제어하며 경험해 
보는 것입니다. 이번 과에서는 이러한 창의적인 기술 
습득에 필요한 기초 지식을 배울 수 있습니다.

DaVinci Resolve는 본래 장편 영화의 첨단 색보정 
및 피니싱 작업을 위해 개발되었다는 사실을 
기억하세요. 다시 말해, 할리우드에서 최고의 
스타일리스트들이 대형 블록버스터 영화나 TV 
드라마, 광고 등의 색보정 및 피니싱 작업에 사용하는 
것과 동일한 도구를 사용할 수 있습니다. 

예상 소요 시간

이 과를 학습하는 데는 약 60분 
정도의 시간이 소요됩니다.

학습 목표

컬러 페이지 레이아웃 알아보기 284

리프트, 감마, 게인 변경하기 287

다른 프라이머리 커렉터 컨트롤 사용하기 290

노드 이해하기 293

세컨더리 색보정 작업하기 293

DaVinci Resolve FX 적용하기 296

파워 윈도우 트래킹 299

클립 안정화 300

복습하기 301
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컬러 페이지 레이아웃 알아보기
DaVinci Resolve 15의 Color 페이지에서 기술적이고 창의적인 색보정 처리 과정을 작업할 수 
있습니다. 이제 Color 페이지 레이아웃에 대해 알아보겠습니다.

1 DaVinci Resolve의 Project Manager 창을 여세요.

Color 페이지를 탐색하기에 앞서 프로젝트를 전환하겠습니다. 앞으로 사용하게 될 프로젝트는 
DaVinci Resolve에 저장해둔 프로젝트이며 저장된 프로젝트에는 모든 미디어 파일도 함께 
포함되어 있습니다. 아카이브에 저장된 프로젝트를 복원하면 미디어까지 연결된 프로젝트를 
사용할 수 있습니다. 아카이브에 대한 자세한 정보는 뒷부분에 나와 있습니다. 

2 해당 창을 우클릭한 다음 Restore를 선택하세요.

3 R15 lessons > Lesson 10으로 이동해 Citizen Chain Cyclery.dra 폴더를 선택한 다음 Open을 
클릭하세요.

4 Project Manager에서 복원된 Citizen Chain Cyclery 프로젝트를 연 다음 Rough Cuts 빈에서 
Color Grading Quick Tour를 타임라인 창에 띄웁니다.

DaVinci Resolve의 장점 중 하나는 편집 및 색보정 페이지가 하나의 응용 프로그램에 통합되어 
있어 클릭 한 번으로 두 페이지 간을 쉽게 오갈 수 있습니다.

5 DaVinci Resolve 창에서 Color 버튼을 클릭해 Color 페이지로 이동하세요.
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Color 페이지는 7개의 주요 영역으로 구성되어 있습니다.

참고 DaVinci Resolve를 해상도가 1920 x 1080 미만의 컴퓨터 화면에서 사용할 경우 
일부 패널 및 버튼이 통합되어 나타나기 때문에 스크린 숏 이미지와 달라 보일 수 
있습니다.

Color 페이지로 전환하면 편집 타임라인에 로딩된 모든 클립이 Color 페이지 타임라인에 그대로 
나타납니다. Color 페이지에서는 어떤 컷이나 트랜지션도 변경할 수 없습니다. 단지 색보정 
작업을 적절하게 수행할 수 있도록 타임라인 정보를 제공하는 것입니다.

6 마지막 썸네일을 클릭해 선택하세요.

우측 하단에 키 프레임 
에디터와 컬러/루미넌스 스코프, 

히스토그램 디스플레이 등의 
정보가 나타날 수 있습니다. 

갤러리에는 저장된 변경사항이 포함되어 
있어 이를 타임라인에 있는 다른 클립에 

복사해 넣을 수 있습니다.

타임라인에서 플레이헤드가 있는 곳의 프레임이 
뷰어에 표시됩니다.

노드 에디터로 색보정, 이미지 조정, 
효과 등을 연결해 독특한 영상룩을 

제작할 수 있습니다.

타임라인이 썸네일과 미니 
타임라인으로 분할됩니다.

왼쪽 팔레트에는 컬러, 
콘트라스트, RAW 이미지 

처리를 위한 프라이머리 조정 
컨트롤이 담겨 있습니다.

가운데 팔레트에서는 컬러 
커브, 파워 윈도우, 트래킹, 키잉, 
스테레오스코픽 컨트롤을 사용할 

수 있습니다. 
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선택한 썸네일 주변에 주황색 테두리가 나타나고 플레이헤드가 해당 클립의 첫 번째 프레임으로 
이동합니다.

7 썸네일 아래쪽에서 Apple ProRes 4 22 Proxy 이름을 더블 클릭하면 클립명 보기로 전환됩니다.

썸네일 하단의 미니 타임라인에는 각 클립을 나타내는 얇은 바가 나타납니다. 바의 폭은 클립의 
길이에 비례합니다.

8 첫 번째 클립에 이를 때까지 미니 타임라인의 플레이헤드를 왼쪽으로 드래그하세요.

정보 Edit 페이지에서 트랙을 비활성화하면 미니 타임라인에서 트랙이 어둡게 변합니다.

타임라인을 스크러빙하면 플레이헤드 밑에 있는 클립이 주황색으로 하이라이트되어 해당 

클립이 선택되었음을 나타냅니다. 이는 썸네일에 테두리가 나타나는 것과 동일한 방식입니다. 
뷰어 아래쪽에 있는 트랜스포트 컨트롤과 재생 키보드 단축키는 Edit 페이지에서 사용하는 
것과 동일합니다.

이제 Color 페이지의 레이아웃에 대한 기본 정보를 살펴봤으므로 색보정 작업을 시작할 수 
있습니다.
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리프트, 감마, 게인 변경하기
숏의 스타일을 생성하고 균형을 맞추는데 가장 많이 사용하는 도구는 프라이머리 커렉터에서 찾을 
수 있습니다. DaVinci Resolve의 프라이머리 커렉터에는 수많은 컨트롤이 포함되어 있기 때문에 
Color 페이지에서는 프라이머리 커렉터를 사용해 작업하며 대부분의 시간을 보내게 됩니다.

프라이머리 커렉터를 사용하면 이미지를 색조 영역으로 분할할 수 있어 더욱 섬세한 결과물이 
생성됩니다.

리프트(Lift), 감마(Gamma), 게인(Gain) 컨트롤은 대략적으로 이미지의 어두운 영역, 중간 영역, 밝은 
영역에 해당합니다. 각 영역 안에서 색조값과 루마값을 조정해 다양한 스타일을 연출할 수 있습니다. 
예를 들어, 어두운 영역의 색상이나 밝기 조절하려면 리프트 영역을 움직여야 합니다.

그럼 이제 프라이머리 커렉터의 컨트롤이 어떻게 작동하는지 살펴보겠습니다. 여기서는 컬러휠 
컨트롤을 사용해보도록 하겠습니다.

1 타임라인에서 썸네일 11을 클릭해 플레이헤드의 위치를 해당 클립으로 옮기세요.

2 리프트 색균형 컨트롤에서 컬러 밸런스 제어 장치를 파란색 쪽으로 살짝 드래그하면 어두운 
영역에 파란색이 추가됩니다. 

정보 색균형 컨트롤을 사용한 조절은 굉장히 미미합니다. 대부분의 경우 조정 컨트롤이 
크로스 헤어와 아주 근접하거나 거의 맞닿아 있습니다.

컬러 밸런스 컨트롤 아래쪽에 있는 마스터 휠 컨트롤을 사용해 리프트, 감마, 게인 영역의 밝기를 
조절할 수 있습니다. 리프트 휠을 조절해 어두운 영역의 밝기를 증가 또는 감소시킬 수 있습니다.

3 Y 루미넌스 값이 0.05가 될 때까지 리프트 휠을 오른쪽으로 드래그하세요.

리프트 색균형 컨트롤 아래에 있는 마스터휠을 사용해 이미지의 블랙 포인트를 조절할 수 
있습니다. 휠을 오른쪽으로 드래그하면 이미지 속 어두운 부분이 밝아집니다.

이제 게인 컨트롤을 조절해 스펙트럼의 다른 끝부분을 살펴보겠습니다.
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4 리프트 색균형 컨트롤에서 컬러 밸런스 제어 장치를 주황색 쪽으로 살짝 드래그하면 밝은 
영역에 주황색이 추가됩니다. 

게인 색균형 컨트롤을 조절해 이미지 속 밝은 영역에 색상을 추가할 수 있습니다.

게인 색균형 컨트롤 아래에 있는 마스터휠을 사용해 이미지의 화이트 포인트를 조절할 수 
있습니다. 휠을 오른쪽으로 드래그하면 이미지 속 밝은 부분이 더 밝아집니다.

5 Y 루미넌스 값이 1.3이 될 때까지 게인 마스터휠을 오른쪽으로 드래그하세요.

리프트 마스터휠과 게인 마스터휠을 조절해 클립의 콘트라스트를 효과적으로 조절할 수 
있습니다. 단순히 콘트라스트 컨트롤을 사용하는 대신 리프트 마스터휠과 게인 마스터휠을 
조절해 블랙 포인트 및 화이트 포인트를 훨씬 수월하게 제어할 수 있습니다.

이제 감마를 살펴보겠습니다.

6 감마 색균형 컨트롤에서 제어 장치를 심홍색 쪽으로 살짝 드래그하세요.

감마 색균형 컨트롤을 조절해 이미지 속 중간 영역에 색상을 추가할 수 있습니다.

7 Y 루미넌스 값이 –0.03이 될 때까지 감마 마스터휠을 왼쪽으로 드래그하세요.
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감마 컬러휠 컨트롤 아래에 있는 마스터휠을 사용하면 이전에 설정해둔 블랙 포인트와 화이트 
포인트는 그대로 유지한 채 전반적인 밝기를 조절할 수 있습니다. 해당 컨트롤을 왼쪽으로 
드래그하면 이미지가 전반적으로 어두워집니다. 이제 밝기를 조절한 이미지와 원본 이미지를 
비교해보도록 하겠습니다.

8 View > Bypass All Grades로 이동하거나 [Shift + D] 키를 함께 눌러 원본 이미지를 볼 수 
있습니다. 그런 다음 View > Bypass All Grades로 이동하거나 [Shift + D] 키를 다시 누르면 
수정된 이미지를 볼 수 있습니다. 

여기서는 여러 컨트롤을 조절해보면서 어떤 방식으로 작동하는지 살펴본 것이기 때문에 특별히 
수정된 이미지를 따로 저장할 필요가 없습니다. 리셋 버튼을 사용해 각 컨트롤 또는 전체 
프라이머리 커렉터를 초기화할 수 있습니다.

참고 Color 페이지에서는 각 클립이 실행 취소/되돌리기(Undo/Redo) 히스토리를 
지원합니다. 다시 말해, Edit > Undo로 이동하면 현재 클립에서 바로 직전에 변경한 
작업을 취소할 수 있습니다. Edit 페이지 역시 Color 페이지와는 별개로 자체 실행 취소 
히스토리를 지원합니다. Edit 및 Fairlight 페이지의 경우 취소/되돌리기 기능은 개별 
클립 단위가 아닌 전체 타임라인에 적용됩니다.

9 감마 색균형 컨트롤의 우측 상단에 있는 리셋 버튼을 클릭하세요. 

패널 리셋 버튼을 사용해 전체 프라이머리 커렉터를 초기화할 수 있습니다.

10 프라이머리 커렉터 패널의 우측 상단에 있는 리셋 버튼을 클릭하세요.

리프트, 감마, 게인 컨트롤은 어두운 영역, 중간 영역, 밝은 영역만 따로 제어하는 개별적인 제어 
장치가 아닙니다. 각각의 컨트롤이 영향을 미치는 부분이 상당 부분 겹칩니다. 예를 들어, 리프트를 
조절할 경우 대부분의 컨트롤이 어두운 영역에 영향을 미치지만, 중간 영역과 밝은 영역의 일부 
또한 영향을 받게 됩니다.

이와 마찬가지로 게인을 조절할 경우 대부분의 컨트롤이 밝은 영역에 영향을 미치지만, 중간 영역과 
어두운 영역 일부 역시 미미한 영향을 받게 됩니다. 이를 통해 영상룩을 좀 더 자연스럽고 부드러운 
느낌으로 조정할 수 있습니다. 하지만 한 가지 컨트롤이 나머지 영역에도 영향을 미치기 때문에 
최고의 결과물을 얻으려면 세 가지의 색균형 컨트롤을 잘 조절해야 합니다. 
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다른 프라이머리 커렉터 컨트롤 사용하기
앞서 조정 작업에 사용한 프라이머리 커렉터 컨트롤은 주로 이미지의 리프트, 감마, 게인을 조절해 
전반적인 영상룩을 조정하는 목적으로 사용합니다. 다른 영상 및 사진 응용 애플리케이션에서 
친숙하게 사용하던 몇 개의 프라이머리 커렉터를 조절할 수도 있습니다. 공유 조절 장치는 프라이머리 
커렉터 패널 아래쪽에 있습니다. 이러한 컨트롤을 사용할 경우 리프트, 감마, 게인뿐만 아니라 전체 
이미지에도 영향을 끼칩니다.

1 썸네일 03을 선택하세요.

해당 숏의 색상은 콘트라스트가 낮고 채도가 약간 낮게 나타납니다. 물론 DaVinci Resolve에서 
채도와 콘트라스트를 조절할 수 있지만, 프라이머리 커렉터에서도 아주 쉽고 빠르게 조절할 
수 있습니다.

2 조정 컨트롤에서 포인터를 Contrast 설정값 표시란으로 가져가세요.

정보 디스플레이 해상도에 따라 각 조정 컨트롤명이 표시되지 않을 수도 있습니다. 
아이콘을 보고 각 파라미터를 구별할 수 있습니다. 마우스 포인터를 아이콘 위로 
가져가면 해당 도구의 이름이 작게 나타납니다.

Contrast 설정값을 오른쪽으로 드래그하면 콘트라스트가 증가합니다.

정보 설정값 표시란 또는 파라미터 이름 위로 마우스 포인터를 가져간 다음 마우스를 
드래그해 설정값을 조정할 수 있는데, 이는 DaVinci Resolve의 모든 설정값 표시란에서 
동일하게 작동합니다.

3 포인터를 Contrast 설정값 표시란으로 가져간 다음 설정값이 1.2가 될 때까지 오른쪽으로 
드래그하세요.

조정 컨트롤의 두 번째 페이지에 있는 파라미터를 사용해 숏을 전반적으로 향상시킬 수 있습니다.

4 숫자 2를 클릭하면 조정 컨트롤의 두 번째 페이지가 나타납니다.
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중립 색상 및 디테일 강조하기
조정 컨트롤의 두 번째 페이지에서 컬러 부스트(Color Boost)와 미드톤 디테일(Midtone Detail)을 
사용하여 숏에 시각적인 효과를 추가할 수 있습니다. 컬러 부스트를 사용하면 채도가 높은 색상은 
큰 변화 없이 채도가 낮은 색상의 채도를 끌어올릴 수 있습니다. 

1 마우스 포인터를 Color Boost 설정값에 가져간 다음 설정값이 10이 될 때까지 오른쪽으로 
드래그하세요. 

정보 조정 컨트롤에 있는 이름을 더블 클릭하면 해당 설정값이 초기화됩니다.

이제 이미지 속 남성의 피부톤 채도가 높아졌으며 이미 채도가 높았던 파란색 기둥은 큰 변화가 
없는 것을 확인할 수 있습니다. 

마스터휠과 비슷한 방식으로 섀도우와 하이라이트를 조정할 수 있는 제어 장치도 탑재되어 
있습니다.

2 마우스 포인터를 Shadows 설정값으로 가져간 다음 이미지 속 섀도우가 너무 어둡거나 크러싱되지 
않을 때까지 오른쪽으로 드래그하세요. 

이미지에 생동감을 불어 넣을 수 있는 또 다른 조정 항목은 미드톤 디테일 컨트롤입니다.

미드톤 디테일 컨트롤은 영상 노이즈 현상을 증가시키지 않은 채 가장자리를 아주 선명하게 
만드는 최고의 샤프닝 필터입니다. 

3 마우스 포인터를 Midtone Detail 설정값으로 가져간 다음, 이미지 가장자리 주변의 콘트라스트가 
증가할 때까지 오른쪽으로 드래그하세요. 

컬러 부스트와 미드톤 디테일 컨트롤 모두 조금만 조절해도 변화의 폭이 큰 편입니다. 보통 
처음에는 큰 폭으로 수정한 다음에 만족할 만한 결과를 찾을 때까지 천천히 되돌리는 방식으로 
작업합니다. 
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화이트 밸런스 조절하기
색온도와 색조 컨트롤을 사용해 화이트 밸런스를 직관적으로 수정할 수 있습니다. 화이트 밸런스 
수정이 필요한 장면을 찾아보겠습니다.

1 썸네일 02를 클릭하면 금문교 장면이 나타납니다.

이 숏에는 파란색이 지나치게 많이 포함되어 있습니다. 구름 색상이 하얀색이 아닌 것을 통해 
분명히 알 수 있는데요. 색온도 컨트롤을 사용해 노란색의 따뜻한 느낌을 주거나 파란색의 
차가운 느낌을 주는 방법으로 이미지 속 색상을 변경할 수 있습니다.

정보 불규칙한 광원으로 인해 복잡한 컬러 캐스트 현상이 발생할 경우 틴트 제어 
기능을 사용해 이미지가 심홍색 또는 녹색으로부터 벗어나게 할 수 있습니다.

2 Temperature 설정값 표시란의 숫자가 500~600 사이로 될 때까지 드래그하면 따뜻한 느낌이 
추가됩니다.

늘 그렇듯이 엄청나게 많은 부분을 변경할 경우에는 원본 이미지와 비교하며 작업해야 합니다.

3 View > Bypass All Grades로 이동하거나 [Shift + D] 키를 함께 눌러 원본 이미지를 볼 수 있습니다. 
View > Bypass All Grades로 이동하거나 [Shift + D] 키를 다시 누르면 수정된 이미지를 볼 수 
있습니다. 

정보 DaVinci Resolve Micro Panel 또는 DaVinci Resolve Mini Panel을 프라이머리 
커렉터 전용 하드웨어 컨트롤과 함께 운용할 경우 자주 사용하는 도구 대부분을 
신속하게 사용할 수 있습니다.

조정 작업을 거친 결과 이미지의 화이트 밸런스가 훨씬 좋아졌습니다.

대부분의 색보정 작업 환경에서는 조정 작업 시 두 개의 이미지 간을 오가며 작업하게 됩니다. 
일일이 컨트롤을 설정하고 나서 원본과 비교한 후에 다음 단계로 이동하는 일은 거의 없습니다. 
색보정 기술은 반복적인 학습 과정을 통해 습득됩니다. 시간이 걸리기는 하지만 더 많은 옵션을 
사용해볼수록 작업에 작업 시 더욱 적합한 조정 기능을 찾을 수 있습니다.
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노드 이해하기
Color 페이지에서는 Fusion 페이지와 마찬가지로 노드를 사용해 여러 개의 색보정 작업을 수행할 
수 있습니다. 색보정 및 효과를 레이어로 쌓는 대신 노드를 사용해 컬러 커렉터와 필터 효과를 
원하는 만큼 추가할 수 있습니다. 노드를 통해 각각의 개별 클립을 색보정 플로차트처럼 볼 수 
있습니다. 클립 또는 입력 영상은 왼쪽에서 시작되어 각 노드를 통해 오른쪽으로 흘러가며, 수정된 
결과물은 화면 오른쪽에 나타납니다. Color 페이지에 있는 각 노드는 Fusion 페이지의 노드처럼 한 
종류의 이미지 처리만 수행 가능한 개별 효과와 달리 완벽한 DaVinci Resolve 컬러 커렉터 기능을 
지원합니다.

이전 연습 과정에서는 노드 에디터에서 자동으로 제공된 첫 번째 노드를 사용해 조정 작업을 
수행했습니다. 더욱 복잡한 보정 작업을 수행할 경우 이미지의 각기 다른 부분을 위한 노드나 효과를 
추가할 수 있습니다. 

세컨더리 색보정 작업하기
지금까지는 프라이머리 색보정이라 불리는 작업을 통해 전체 이미지를 보정해왔습니다. 세컨더리 
색보정 기능을 사용하면 특정 이미지 영역만을 분리해 아주 구체적인 변경 작업을 수행할 수 
있습니다. 자주 인용되는 극단적인 예로 한 피사체를 제외한 전체 이미지를 흑백으로 전환하는 
작업을 들 수 있습니다. 이제 세컨더리 색보정 기능을 작업 과정에서 자주 사용할 수 있는 훨씬 
일반적인 업무에 적용해보도록 하겠습니다.

1 두 번째 인터뷰 클립인 썸네일 03을 클릭하세요.
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2 스페이스 바를 누르면 클립이 재생됩니다.

3 클립을 몇 번 확인한 다음 스페이스 바를 눌러 재생을 멈추세요.

이 클립은 밝기가 높아 주의를 분산시키는 중앙의 파란색 기둥을 제외하면 거의 완벽합니다. 
기둥을 완전히 제거할 수는 없지만 색상을 어둡게 조정해 화면을 덜 가리도록 할 수 있습니다.

노드와 커브 사용하기
특정 대상에 세컨더리 색보정 작업을 적용하는 첫 번째 단계는 바로 조정 사항을 자체 노드로 따로 
분리하는 것입니다.

DaVinci Resolve 창의 우측 상단 사분면에 있는 노드 에디터를 사용하여 하나 이상의 개별 노드를 
통합하면 좀 더 정교한 보정 작업을 수행할 수 있습니다.

모든 클립에는 노드가 하나씩 포함되어 있어 노드 에디터에서 해당 노드를 확인할 수 있는데, 여기엔 
초반에 작업한 변경 사항이 담겨 있습니다. 현재 프로젝트에 나타나는 노드에는 사전 중립 보정 
작업 시 적용한 모든 변경 사항이 담겨 있습니다. 

하지만 보정 기능을 이미 가지고 있는 노드를 추가로 생성해 이미지를 보정하는 옵션 또한 지원합니다. 
하나의 보정 기능을 가진 노드를 개별적으로 사용하면 더욱 정확하게 순서대로 조정할 수 있으며 
더욱 쉽게 트래킹하여 수정할 수 있습니다.

이제 노드 에디터에 두 번째 노드를 추가하여 사전에 조정한 컬러 부스트 효과로부터 파란색 기둥에 
적용할 색보정 효과를 따로 분리합니다. 

1 Color 메뉴에서 Nodes > Add Serial Node를 선택하거나 [option + S] 키(macOS) 또는 [Alt + S] 
키(Windows)를 누르세요.

노드 에디터에 있는 기존 노드 다음에 두 번째 노드가 추가됩니다. 02라는 새로운 노드 번호와 
함께 빨간 테두리가 나타나 현재 선택한 노드임을 알려줍니다. 노드명을 더욱 자세하게 변경할 
수 있습니다.

2 노드를 마우스로 우클릭한 다음 메뉴에서 Node Label을 선택합니다.
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3 Blue Pole이라고 입력하거나 [Enter] 키를 눌러 노드명을 변경하세요.

새로운 노드가 생기면 커브 컨트롤을 사용해 파란색 기둥 색상을 변경할 수 있습니다. Photoshop이나  
다른 이미지 편집 응용 프로그램에서 사용하는 친숙한 커스텀 커브가 기본 커브 컨트롤로 
설정되어 있습니다. 하지만 DaVinci Resolve에는 다양한 색조와 휘도, 채도 수준을 따로 분리할 
수 있는 여러 개의 커브 컨트롤이 탑재되어 있습니다. 기둥의 파란색을 낮추기 위해 Hue Vs 
Sat 커브를 사용해보겠습니다.

4 팝업 메뉴에서 Hue Vs Sat를 선택하면 색조/채도 커브가 나타납니다.

Hue Vs Sat 커브는 타임라인 아래쪽에 나타납니다. 해당 컨트롤을 사용할 경우 이미지를 클릭해 
영상 속 특정 색조를 분리할 수 있습니다. 

5 뷰어에서 마우스 포인터를 파란 기둥 위로 가져갑니다.

포인터가 스포이드 아이콘으로 변해 분리하고자 하는 이미지 영역을 샘플링할 수 있음을 
알려줍니다.

6 파란 기둥 부분 중 아무 곳을 클릭해 색조값을 샘플링할 수 있습니다.

뷰어를 클릭하면 Hue Vs Sat 팔레트에 세 개의 포인트가 추가됩니다. 가운데 포인트는 선택한 
영역의 실제 색조입니다. 다른 두 포인트는 가운데 포인트를 드래그해 조정하게 될 색조 범위를 
제한합니다.

7 Hue Vs Sat 팔레트에서 가운데 포인트를 아래쪽으로 드래그하면 파란 색조의 채도가 낮아집니다.
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특정 색조에 해당하는 항목만 낮아진 채도의 영향을 받게 됩니다. 이러한 색조, 휘도, 채도 
커브를 통해 복잡한 처리 과정을 단순화시킬 수 있기 때문에 키잉 작업을 완벽하게 처리하거나 
수작업으로 로토스코핑할 필요가 없습니다.

늘 그렇듯이 이미지를 대폭 수정하고 나면 변경된 부분을 원본 이미지와 비교해보는 것이 
좋습니다. 여기서는 기둥 부분만 비교하면 됩니다. 이전 경우에는 원본 이미지와 변경된 사항을 
비교했지만 여기서는 새로운 노드 위에 변경 사항을 적용했기 때문에 해당 노드를 일시적으로 
비활성화시켜 변경된 부분을 비교할 수 있습니다.

8 Color > Nodes > Enable/Disable Current Node를 선택하거나 [Cmd + D] 버튼(macOS) 또는 
[Ctrl + D] 버튼(Windows)을 누르세요.

이제 파란색 기둥의 채도는 그대로 유지한 채 중립 색보정 처리 과정이 진행된 것을 확인할 수 
있습니다.

9 Color > Nodes > Enable/Disable Current Node를 선택하거나 [Cmd + D] 버튼(macOS) 또는 
[Ctrl + D] 버튼(Windows)을 누르세요.

변경된 사항을 검토하기 위해 색보정 전/후 이미지를 반복해서 신속하게 확인할 수 있습니다. 
필요에 따라 채도 수준을 조정할 수도 있습니다.

DaVinci Resolve FX 적용하기
DaVinci Resolve에는 Resolve FX라고 불리는 블러, 글로우, 필름 그레인, 렌즈 플레어 등의 다양한 
고품질 필터 효과가 탑재되어 있습니다. 이러한 효과를 전체 클립에 적용하거나 스플라인 형태와 
결합해 프레임의 한 영역을 분리시킬 수 있습니다.

1 썸네일 07을 클릭하세요.
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2 스페이스 바를 누르면 클립이 재생됩니다.

이 클립은 이미 첫 번째 노드 위에 기본적인 색보정 작업을 적용했기 때문에 새로운 노드를 
사용해 효과를 추가하도록 하겠습니다.

3 Color > Nodes > Add Serial Node를 선택하거나 [option + S] 키(macOS) 또는 [Alt + S] 키
(Windows)를 누르세요.

지금 추가할 효과는 자주 사용하는 블러 효과입니다. 사이클 선수가 입은 셔츠의 상표를 블러 
처리해보겠습니다. 상표권 규정을 준수하기 위해 반드시 처리해야 하는 빈번한 작업 중 
하나입니다. 첫 번째 단계로 블러 처리하려는 영역을 분리합니다.

4 뷰어 아래쪽에 있는 플레이헤드를 클립 시작 지점으로 드래그하세요.

5 툴바 중앙에 있는 윈도우(Window) 버튼을 클릭하세요.

윈도우를 사용해 프레임 일부를 분리할 수 있습니다. 색조를 사용하는 Hue Vs Sat 커브와는 
달리 스플라인 형태를 사용합니다.

6 원형 윈도우를 클릭하면 해당 윈도우가 클립에 추가됩니다. 

7 원형 윈도우의 사각 모서리 포인트 중 하나를 드래그해 안쪽에 있는 원의 크기를 사이클 선수 
팔 쪽에 있는 로고 크기와 비슷하게 맞출 수 있습니다.

8 원형 윈도우 중심을 드래그해 사이클 선수 팔에 있는 로고를 가리세요.
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Resolve FX를 사용해 윈도우를 채워 로고를 숨길 수 있습니다.

9 노드 에디터 위에 있는 OpenFX 버튼을 클릭하세요.

OpenFX 패널에서 필터 효과를 위한 서드파티 플러그인 목록을 찾아 DaVinci Resolve에 추가할 
수 있습니다. 프로그램 자체에 포함되어 있는 DaVinci Resolve FX 목록 또한 나타납니다.

10 OpenFX 라이브러리를 검색해 모자이크 블러(Mosaic Blur) 효과를 찾으세요. 해당 효과를 
윈도우가 담겨 있는 두 번째 노드로 드래그하세요. 

모자이크 블러 효과를 추가하면 윈도우가 채워지면서 로고가 가려집니다. 자동으로 나타나는 
설정 패널에서 모자이크를 조절할 수 있습니다. 

11 OpenFX 설정 패널에서 Pixel Frequency를 100 정도로 올려 윈도우 모자이크에 사용되는 
사각형 수를 늘릴 수 있습니다.
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해당 모자이크는 현재 이 프레임에만 적용됩니다. 하지만 사이클 선수가 숏 안에서 움직이기 때문에 
윈도우를 트래킹해 모든 로고가 가려지도록 설정해야 합니다.

파워 윈도우 트래킹
Color 페이지에는 놀라운 3D Perspective 트래커가 탑재되어 있어 피사체를 추적할 뿐 아니라 
피사체의 회전 및 시점 변경 사항까지 파악할 수 있습니다. 그 결과 가장 난이도가 높은 피사체를 
추적해 Resolve FX 또는 색보정 작업을 적용할 수 있습니다.

1 툴바에서 트래커 버튼을 클릭하세요.

2 Tracker 패널에 있는 플레이헤드가 클립의 시작점에 있는지 확인하세요.

트래커는 클립 내 피사체의 다양한 측면을 추적합니다. 패널 상단의 확인란을 사용해 변형 
유형을 활성화 또는 비활성화할 수 있습니다. 트래킹할 필요가 없는 파라미터를 비활성화하면 
트래킹 작업 성능이 향상됩니다. 예를 들어, 이 클립에서는 로고의 확대 또는 회전은 고려하지 
않고 피사체의 틸팅 및 회전에만 집중합니다.

3 Zoom 및 Rotate 확인란을 눌러 해당 변형 유형을 비활성화하세요. 

4  Track Forward 버튼을 누르면 트래킹이 시작됩니다.
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5 트래킹이 완료되면 클립을 스크러빙 또는 재생해 결과물을 확인하세요.

트래커 기능 덕분에 윈도우가 사이클 선수 팔의 로고를 완벽하게 추적합니다.

클립 안정화
트래킹은 클립 내 움직임을 처리하는 과정이며 움직임 분석을 통해 프레임 내 요소를 추적하게 
됩니다. 처리 과정에서 클립 내 카메라 움직임까지 측정할 수 있습니다. 컬러 페이지의 트래커는 
움직임을 추적하고 클립을 안정화시키는 두 가지 기능을 수행합니다. 

1 썸네일 10을 선택한 다음 해당 클립을 재생하세요.

이 숏의 패닝 효과를 수정한다고 가정해보겠습니다. 다행히 Stabilizer 기능으로 카메라를 
고정하여 모든 움직임을 삭제할 수 있습니다.

2 Tracker 팔레트 우측 상단에 있는 팝업 메뉴에서 Stabilizer를 선택하세요.

이제 Tracker 팔레트가 트래킹에서 안정화 모드로 전환되었습니다.

3 Tracker 팔레트 아래쪽에 있는 Camera Lock을 선택하세요.
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기존의 카메라 움직임을 부드럽게 만드는 것과는 대조적으로 Camera Lock을 선택하면 Stabilizer가  
클립 내 모든 카메라 움직임을 제거합니다. Color 페이지의 Stabilizer는 Fusion 페이지와는 달리 
포인트를 설정하지 않아도 작동하기 때문에 신속한 안정화 작업이 필요한 경우에 도움이 됩니다.

4 Tracker 팔레트 우측 상단에 있는 Stabilizer 버튼을 누르면 움직임 분석 작업이 시작됩니다.

5 분석 작업이 끝나면 스페이스 바를 눌러 안정화된 클립을 볼 수 있습니다. 

안정화된 클립은 프레임에 맞게 크기가 조정됩니다. 숏에 안정화 작업을 적용하면 카메라 
움직임을 상쇄하기 위해 클립이 상하좌우로 움직입니다. 클립이 이런 방식으로 움직이면 클립 
테두리가 뷰어 안팎으로 움직이는 모습이 뚜렷하게 나타납니다. 이런 현상을 막기 위해 테두리가 
보이지 않을 때까지 클립 크기가 자동으로 조절됩니다. 클립 크기가 조절되는 정도는 숏에서 
제거된 카메라 움직임 정도에 따라 달라집니다.

정보 클립에 얼마만큼의 움직임이 적용되었는지 확인하려면, Tracker 팔레트 아래쪽에 
있는 Zoom 확인란을 비활성화시킨 다음에 해당 클립을 재생하세요.

이번 과에서는 Color 페이지의 컨트롤 사용법을 간략하게 살펴봤지만, 다음 과에서는 Color 페이지에 
대해 더욱 자세히 살펴볼 예정입니다. 이를 통해 프라이머리 커렉터 컨트롤과 부가적인 세컨더리 
도구, 창의적인 영상룩 복사 및 저장법에 관한 자세한 정보를 확인할 수 있습니다.

복습하기
1 Lift 컬러휠 아래쪽에 있는 마스터휠로 어떤 항목을 조정할 수 있나요?

2 숏에 따뜻한 또는 차가운 느낌을 주려면 어떤 컨트롤을 사용해야 하나요?

3 클립 안에 있는 특정 대상의 색상 변경 작업에는 프라이머리 휠을 사용할 수 없습니다. T(진실) 
또는 F(거짓)로 답하세요. 

4 윈도우가 움직이는 피사체를 추적하도록 하려면 어떤 도구를 사용해야 하나요?

5 Color 페이지에서 모자이크 효과를 어디서 찾을 수 있나요? 
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정답
1 Lift 컬러휠 아래쪽에 있는 마스터휠로는 블랙 포인트를 조절할 수 있습니다.

2 색온도 조절 컨트롤을 사용해 따뜻한 또는 차가운 느낌을 숏에 추가할 수 있습니다.

3 F. 퀄리파이어 또는 윈도우를 사용해 특정 대상을 분리한 경우 프라이머리 휠을 사용해 클립 
안에 있는 해당 영역의 색상을 변경할 수 있습니다.

4 윈도우가 움직이는 피사체를 추적하도록 설정하려면 Tracker 팔레트를 사용해야 합니다.

5 모든 ResolveFX 및 서드파티 효과는 Color 페이지의 OpenFX 패널에서 찾을 수 있습니다. 
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프라이머리 색보정 
작업하기 

수많은 도구가 손끝에 준비된 DaVinci Resolve  

15으로 무궁무진한 창의성을 발휘할 수 있습니다! 
컬러리스트로서의 직감을 계발하는 것도 중요하지만 
프로그램을 사용하기 위한 기본적인 기술 또한 
배워야 합니다. 영상룩을 설정하고 창의적으로 
작업하는 것과 더불어 영상에 오류가 없도록 하는 
것 또한 컬러리스트가 할 일입니다.

컬리리스트로서 노출과 색에 문제가 있는 숏이 
있다면 수정해야 할 것입니다. 숏을 밸런싱하는 능력 
또한 중요한데, 여러 대의 카메라를 사용하여 하나의 
장면을 촬영한 경우 이 숏들을 서로 일치시켜야 하며 
의도하지 않았던 컬러 캐스트가 있다면 수정해야 
하기 때문입니다. 또한 컬러리스트는 TV 방송, 영화, 
혹은 웹 배급용인지에 따라 영상이 ‘법적으로’ 문제가 
없도록, 그리고 정해진 기술 규격에 맞도록 작업해야 
합니다.

이번 과에서는 기본적인 뉴트럴 그레이딩 작업  
및 숏 밸런싱하는 방법을 살펴보겠습니다. 주로 
프라이머리 커렉터로 작업하게 되며 내장 스코프를  
통해 작업 결과를 확인합니다. 컬러 그레이드를 저장, 
복사하여 신속하게 여러 숏에 적용 및 매칭할 수 

있습니다.

예상 소요 시간

이 과를 학습하는 데는 약 45분의 
시간이 소요됩니다.

학습 목표

DaVinci Resolve 
컬러 매니지먼트 사용하기  304

자동 보정 기능 사용하기 307

컬러휠로 색상 및 밝기 균형 맞추기 309

스코프에서 조정된 사항 확인하기 310

프라이머리 바를 사용해 색균형 잡기 314

메인 프라이머리 컨트롤로 스타일링하기 317

부가적인 프라이머리 컨트롤을 
사용하여 스타일 강조하기 319

프라이머리 색보정 작업에 커브 사용하기 320

유사한 숏에 색보정 작업 복사하기 328

복습하기 333
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DaVinci Resolve 
컬러 매니지먼트 사용하기 
영화 제작은 기술적인 분야이고 종종 복잡한 작업이 될 수 있습니다. 카메라 종류와 파일 포맷이 
다양하고 작업 과정 또한 복잡합니다. 카메라 제조사들은 최고의 영상 이미지를 제공하기 위해 
노력하지만, 카메라로 촬영 직후 HD 모니터로 영상을 확인할 때에는 별로인 것처럼 보일 수도 
있습니다.

대부분의 전문 디지털 카메라가 만들어 내는 영상은 HD TV에서 보여지는 것보다 훨씬 밝고 색감이 
풍부합니다. 결과적으로 카메라에서 바로 꺼낸 영상은 색이 바랜 것처럼 보이거나 채도가 낮을 때가 
많습니다.

하지만 이 영상 파일들은 카메라별로 특성이 다르며, 원래 HD TV에서 볼 용도로 만들어진 것이 
아닙니다. 따라서 색보정 또는 편집 작업 시 제일 먼저 할 일 중 하나는 콘트라스트와 카메라별로 
다른 컬러 팔레트를 HD TV 또는 사용하고자 하는 다른 디스플레이의 특성에 맞게 수정하는 
작업입니다. DaVinci Resolve는 다양한 카메라와 컬러 스페이스를 폭넓게 수용함으로써 뛰어난 
색상 관리 기능을 제공합니다. 프로젝트 설정 시 DaVinci Resolve 색상 관리에 관한 셋업을 미리 
해두면 색보정 작업을 쉽고 빠르게 시작할 수 있으며 편집에 사용될 영상들을 최대한 기본 보정이 
된 상태로 만들어둘 수 있습니다.

1 DaVinci Resolve를 열면 Project Manager 창이 나타납니다.

다음에 이어질 세 개의 과에서는 실제 프로젝트를 사용하여 컬러 그레이딩 워크플로를 
배워보겠습니다. 이 프로젝트의 제목은 Gnarly in Pink로, 한 소녀의 스케이트보딩 클럽에 관한 
다큐멘터리입니다. DaVinci Resolve에서 아카이브된 프로젝트를 다시 불러오면 기존에 편집, 
저장했던 영상을 그대로 불러와서 곧바로 색보정을 시작할 수 있습니다.

2 Project Manager 창에서 우클릭하여 Restore를 선택하세요.

3 R15 lessons > Lesson 11을 찾아 들어가세요. Gnarly in Pink.dra 폴더를 선택 후 Open을 클릭하세요.

4 프로젝트 매니저에서 Gnarly in Pink 프로젝트를 여세요. Master 빈에서 Gnarly in Pink 편집 
파일을 타임라인으로 가져오세요.
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5 DaVinci Resolve 화면 아래에 있는 Color 버튼을 클릭하면 컬러 페이지로 갑니다.

이제 색상 관리 워크플로를 활성화할 준비가 되었습니다.

6 타임라인에서 05번 썸네일을 클릭하세요.

이 숏은 이제부터 해볼 몇 가지 작업의 결과를 살펴보는데 아주 적당한 이미지입니다.

7 File > Project Settings로 가서 Color Management 카테고리를 선택하세요.

8 Color science 팝업 메뉴에서 DaVinci YRGB Color Managed를 선택하세요.

숏에는 아직 아무런 변화가 없지만 Color science 메뉴 아래에 몇 개의 새로운 팝업 메뉴가 
활성화되었을 겁니다.

그중 Input Color Space, Timeline Color Space, Output Color Space가 보일 겁니다. Timeline 
Color Space와 Output Color Space는 기본 설정인 Rec.709 Gamma 2.4 그대로 두겠습니다. 
이 값은 표준 HD 컬러 스페이스로서 이 프로젝트가 TV용 HD 화질로 딜리버리 된다고 생각하면 
됩니다.

그러나 Input Color Space는 임포트된 클립을 촬영했던 장비에 맞게 설정을 변경하는 것이 
좋습니다.

9 이 클립들은 Blackmagic 4.6K 디지털 시네마 카메라로 촬영했기 때문에 Input Color Space 
값을 Blackmagic Design 4.6K Film v3로 설정하세요.
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정보 색보정 작업을 이미 시작했다면, 다른 종류의 디스플레이 장치로 
딜리버리하기 위해 Output Color Space는 변경하더라도 절대 Input 또는 
Timeline Color Space는 변경하면 안 됩니다.

10 Save 버튼을 클릭하면 설정 창이 닫히는데, 이때 타임라인 뷰어를 주의하여 보세요.

정보 여러 대의 카메라로 촬영했을 경우 Input Color Space는 가장 많이 
사용하는 카메라에 맞게 설정하세요. 그런 다음 각 빈에서 각 카메라로 촬영한 
클립을 우클릭한 후 적당한 Input Color Space를 선택하세요.

플레이헤드를 움직여 보려면 시간이 약간 필요할 수도 있지만, 숏의 섀도우 부분이 어두워지고 
하이라이트 부분은 더 밝아진 것을 확인할 수 있습니다. DaVinci Resolve의 효과들은 어떤 때에는 
미묘해서 잘 표가 나지 않지만, 또 어떤 때는 아주 명확하게 보이기도 합니다. 이런 차이는 카메라에 
따라, 그리고 촬영 시 노출의 양에 따라 다르게 나타납니다. 클립의 영상이 보기에 좋아지긴 했지만, 
아직 색보정 작업을 시작하기 전이라는 사실에 유념하세요. 만약 이 클립들이 과노출된 상태로 
촬영되었다면 과노출된 상태로 보일 겁니다. 만약 화이트 밸런스가 맞지 않은 채 촬영되었다면 그것 
또한 그대로 여기에 나타날 것입니다. 지금 한 작업은 HD 디스플레이 장치에 맞도록 감마 레벨을 
맞춰준 것이 전부입니다. 그럼 이제 색보정 작업을 시작해 보겠습니다.
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자동 보정 기능 사용하기
촬영하는 동안 예측지 못한 혹은 불가피한 상황이 발생하여 클립이 부정확한 색조로 녹화되거나, 
하이라이트 부분이 흐릿하거나, 섀도우 부분이 밝게 나올 수도 있습니다. 따라서 색보정 작업은 
항상 숏의 밸런스를 맞추는 것부터 시작합니다. 숏 밸런싱을 통해 자신만의 룩을 만들어 나중에 
다른 숏에 적용할 수도 있습니다. 여러 기법을 사용하여 색을 밸런싱할 수 있지만, 가장 쉬운 방법부터 
시작해 보겠습니다. 어려운 작업은 DaVinci Resolve에서 처리하도록 하고 사용자는 클릭 몇 번만 
하면 되는 그런 방법입니다.

1 컬러 페이지의 타임라인에서 14번 썸네일, 즉 스케이트 공원 한쪽에 앉아 있는 소년들의 영상을 
클릭하세요.

보통 작업의 시작은 숏의 콘트라스트 조정, 즉 가장 어두운 값과 가장 밝은 값을 설정하는 
일입니다. 이 작업은 컬러휠 팔레트에 있는 블랙 포인트 피커와 화이트 포인트 피커를 사용해 
수행할 수 있습니다.

2 Lift 컬러휠의 왼쪽 위 모서리에 있는 Black Point Picker를 클릭하세요.

이 컨트롤을 사용하여 영상 내에서 가장 어두운 지점을 찾아 선택하세요. 이 지점은 화면 내에서 
가장 어두운 부분이라고 여겨지는 곳이어야 합니다.

3 마우스 포인터를 뷰어 위로 가져간 다음, 가장 오른쪽에 있는 나무의 제일 어두운 그늘을 
클릭하세요.
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화면이 약간 어두워지면서 전체 색이 조금 시원한 느낌으로 변합니다. 섀도우 영역을 클릭하면 
그 지점을 완전한 검정으로 인식하여 검정 영역의 색 뭉침을 교정해 주기 때문에 섀도우 영역에서 
한 가지 색 계열만 두드러지게 보이는 것을 방지해 줍니다. 이제 똑같은 방법으로 화이트 
포인트도 설정해 보겠습니다.

4 Gain 컬러휠의 왼쪽 위 모서리에 있는 White Point Picker를 클릭하세요.

뷰어에서 화면의 가장 밝은 지점을 찾아 선택하세요. 이 지점은 화면에서 가장 밝은 부분이라고 
판단되는 곳이어야 합니다.

5 마우스 포인터를 뷰어 위로 가져간 다음, 소년들 뒤로 보이는 작은 흰색 모자를 클릭하세요.

정보 뷰어에서 줌인하기 위해서는 마우스 포인터를 뷰어에 놓고 마우스 
가운데에 있는 휠을 스크롤하세요.

모자를 정확하게 선택했다면 화면이 조금 밝아질 것입니다. 이 숏은 이제 콘트라스트 및 색의 균형이 
잘 맞춰졌습니다.

화면에서 가장 어두운 곳과 가장 밝은 곳을 클릭해야 합니다. 그렇게 하지 않으면 검정 부분이 너무 
어두워지거나 흰 부분이 너무 밝아져 버립니다. 반대로 너무 밝아 이미 색이 바랜 부분을 선택해도 
안됩니다. 그곳은 색이 아예 없는 부분이기 때문입니다. 모든 정보가 이미 분실된 상태입니다. 
자동화된 도구를 사용할 때 흔히 발생하는 문제인데요, 이 도구들은 색이 최적화된 이미지에서는 
완벽하게 작동하지만, 순수한 흰색 또는 순수한 검정이 부족한 화면에서는 효과가 작기 때문입니다. 
이럴 때는 컬러리스트로서의 안목과 기술에 의존하여 최선의 선택을 해야 합니다.
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컬러휠로 색상 및 밝기 균형 맞추기
자동 보정 도구를 사용해도 효과가 별로 없는 장면들이 있습니다. 혹은 숏을 밸런싱하기 위해 
자동화된 기능을 사용하기보다는 손수 작업을 하고 싶을 때도 있습니다. 이런 경우 DaVinci Resolve의  
프라이머리 컬러 컨트롤은 최소한의 노력으로 균형 잡힌 콘트라스트와 색을 인지할 수 있도록 여러 
기능을 제공합니다.

이 단계에서의 일반적인 작업 방법은 루미넌스를 먼저 보정 후 색과 채도를 보정하는 것입니다.

1 08번 썸네일을 클릭하여 선택하세요.

뷰어에서 이 클립을 들여다보면서 평가해 봅시다.

이 클립은 서랍장 부근의 섀도우가 조금 탁하고 회색조인 반면 흰색 벽은 흐릿하게 보이므로 
콘트라스트가 낮은 화면입니다.

콘트라스트를 향상시키기 위해 이전 과에서 사용했던 프라이머리 색보정 도구를 사용할 수 
있습니다.

2 Lift 마스터 휠을 왼쪽으로 드래그하여 Y 루미넌스의 값이 -0.10 근처에 오도록 하세요.

리프트 마스터 휠을 왼쪽으로 드래그할수록 화면의 어두운 영역이 더 어두워집니다.

3 하이라이트값을 증가시키기 위해 Gain 마스터 휠을 드래그하여 Y 루미넌스 값에 1.30이 
표시되도록 하세요.
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콘트라스트를 최대화했으니 이제 원본과의 비교를 위해 조정값을 일시적으로 비활성화하겠습니다.

4 View >Bypass All Grades를 선택하거나 [Shift + D] 키를 누르면 보정 전 이미지를 볼 수 있습니다. 
그다음 View > Bypass All Grades를 다시 한번 선택하면 보정된 화면이 보입니다.

두 개의 값을 조정했을 뿐인데 화면의 섀도우는 풍성해지고 진해졌으며 하이라이트 부분은 더 
밝아져서 훨씬 좋아 보입니다.

스코프에서 조정된 사항 확인하기
색보정 작업 결과를 객관적으로 점검하기 위해 DaVinci Resolve는 4개의 비디오 신호 스코프를 
제공합니다. 파형, 퍼레이드, 벡터스코프, 히스토그램을 사용하여 클립의 루미넌스, 노출, 색, 채도를 
확인할 수 있습니다.

1 툴바의 제일 오른쪽에 있는 Video Scope 버튼을 클릭하세요.

2 펼치기 화살표를 클릭하여 비디오 스코프 팝업 메뉴를 여세요.

정보 Workspace > Videoscopes > On을 선택하면 한 번에 두 개 혹은 네 개의 
스코프를 볼 수 있습니다.
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모니터링하려는 대상에 따라 해당 메뉴의 4가지 스코프 중에서 선택할 수 있습니다.

3 Parade를 선택하세요.

Parade 스코프는 각 색상 계열을 그래프로 표시합니다. 그래프는 아래에서 위로 읽습니다.  
0이 완벽한 검정이고 1023은 완벽한 흰색입니다. 숏을 밸런싱할 때는 트레이스라고 불리는 
파형의 값이 0 이하로 내려가거나 1023이 넘으면 안 됩니다. 파형의 일부가 잘려나가는, 즉 
클리핑 현상이 일어나서 디테일이 손실될 우려가 있습니다.

퍼레이드의 각 색상 계열을 왼쪽에서 오른쪽으로 읽으면 뷰어에 보여지는 이미지의 위치와 
일치합니다. 예를 들어 빨강, 초록, 파랑 트레이스의 왼쪽 파형은 이미지의 왼쪽 부분을 표현합니다. 
이 방식은 스코프를 보면서 정확하게 어느 영역을 감정하고 있는지 파악할 수 있도록 도와줍니다.

정보 키프레임 에디터로 전환하면서 비디오 스코프를 숨기면 그래픽 카드에 
부하가 덜 걸리므로 재생 시 성능이 좋아집니다.

일반적으로 트레이스의 가장 아랫부분이 0과 128 사이에 옵니다. 숏의 일부가 완전히 블랙일 
경우에는 트레이스의 값이 0 근처로 떨어집니다. 이미지의 가장 어두운 부분이 진한 회색 
정도라면 그 값이 128 라인 정도에 옵니다. 이 숏의 경우, 리프트와 게인 마스터휠을 잘 조정한다면 
트레이스가 0과 1023 사이에 분포하도록 만들 수 있습니다.

4 Lift 마스터 휠을 드래그하여 트레이스의 바닥 부분이 0과 128 사이에 오도록 하세요.
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5 Gain 마스터 휠을 오른쪽으로 드래그하여 파형의 트레이스가 896과 1023 사이에 오도록 하세요.

이제 색과 채도를 조정해 보겠습니다. 색을 감정하기 전에 가산색(Additive Color) 이론에 대해 
조금 알아보겠습니다. 가산색을 사용하여 순백색을 만들려면 빨강, 초록, 파랑을 최대한의 
강도로 혼합해야 합니다. 퍼레이드 스코프 상에서 순백의 이미지는 빨강, 초록, 파랑의 트레이스가 
그래프의 제일 꼭대기를 따라 그려질 겁니다. 이런 경우에는 색 밸런싱을 쉽게 하기 위해 숏 
안에 있는 흰색 벽을 사용하면 됩니다.



313

스
코

프
에

서
 조

정
된

 사
항

 확
인

하
기

이 이미지에는 분명 파랑 틴트가 있을 겁니다. 틴트는 눈으로도 쉽게 구분되지만 퍼레이드에서 
보면 더 확연해집니다.

초록 트레이스가 빨강이나 초록보다 위로 올라가 있다면 이것은 하이라이트 영역에 파랑 계열의 
집중 현상이 있다는 표시입니다. 초록 또는 오렌지 계열의 집중 현상이 뚜렷하게 나타나는 것은 
흔히 나타나는 화이트 밸런스 관련 문제입니다. 이전 과에서 화이트 밸런스를 교정하기 위해 
색온도 조절 컨트롤을 사용했었는데, 여기서는 프라이머리 커렉터의 컬러 휠을 사용하여 이 
흔한 문제를 해결할 수 있습니다.

6 Offset 컬러휠의 컬러 포인트를 노랑/오렌지 쪽으로 드래그하여 벽이 흰색으로 보이도록 만드세요. 
퍼레이드에 보이는 빨강, 초록, 파랑 트레이스가 맨 꼭대기를 따라 그려질 것입니다.

정보 완벽하게 흰색인 영상이 아니라면 스코프는 항상 울퉁불퉁하게 
표시됩니다. 스코프에 나타나는 트레이스를 참고하되, 화이트 밸런스를 
수동으로 조정할 때는 항상 눈으로 직접 확인하면서 최종 판단을 내리세요.

방금 프라이머리 커렉터를 이용하여 숏 한 개에 대한 밸런싱 및 뉴트럴 색보정 작업을 마쳤습니다. 
컬러 그레이딩 작업을 시작할 때 타임라인에 있는 모든 숏에 대해 이 작업을 반복하세요. 이렇게 
하면 색의 중간 지점을 잡아줌으로써 앞으로 일관성 있게 작업을 수행할 수 있습니다.

컬러 그레이딩을 위해 뷰어 사용하기
DaVinci Resolve 화면 내의 뷰어는 TV 방송이나 디지털 영화처럼 색 표현이 중요한 영상을 미리 
보기하는 용도가 아닙니다. 그런 용도라면 Blackmagic Design UltraStudio나 DeckLink 카드를  
사용하여 방송용 혹은 디지털 영화용으로 조정된 화면에 연결해야 합니다.
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프라이머리 바를 사용해 색균형 잡기
DaVinci Resolve의 위력은 도구 모음을 통해 한 가지 작업을 다양한 방법으로 수행할 수 있는 
유연성에 있습니다. 프라이머리 커렉터 도구 모음에 관해 더 배워보기 위해 다른 방법을 적용하여 
새로운 숏의 색 균형을 맞춰보겠습니다.

1 타임라인에서 04번 썸네일을 클릭하세요.

이는 오프닝 숏의 일부로, 익스트림 클로즈업 숏입니다. 이전 숏에서는 컬러와 밝기의 균형을 
맞추기 위해 컬러휠을 사용했지만, 이번에는 Primary Bar라고 불리는 프라이머리 커렉터 내의 
다른 도구 모음을 사용해 보겠습니다.

2 프라이머리 커렉터 팔레트의 오른쪽 위 모서리에 있는 팝업 메뉴에서 Primaries Bars를 
선택하세요.

프라이머리 바는 컬러휠과 마찬가지로 색과 루미넌스를 조정하는 도구로서 리프트, 감마, 게인 
영역의 빨강, 초록, 파랑 값을 가시적으로 명시해 줍니다. 이 도구는 숏 내의 서로 다른 영역에 
있는 특정 색 계열을 밸런싱하고 싶을 때 효과적인 방법이 될 수 있습니다. 톤을 조정하기 위해 
바의 아래에 있는 마스터휠을 사용합니다. 컬러휠 아래에 있던 마스터휠과 같은 것입니다.
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3 Lift 마스터 휠을 왼쪽으로 드래그하여 Y 루미넌스의 값이 -0.05 근처에 오도록 하세요.

화면의 어두운 영역이 더 어두워졌습니다. 아쉽게도 이 이미지는 이전 숏에 비해 하이라이트 
조정이 까다롭습니다. 이 이미지에는 흰색이 없기 때문입니다. 그러나 눈으로 직접 보면서 
하이라이트 영역을 더 밝게 만들 수 있습니다.

4 하이라이트 값을 높이려면 Gain 마스터 휠을 오른쪽으로 돌려 이미지 내 하이라이트 부분이 
더 밝아지고 트레이스의 위쪽 부분이 스코프 창 상단의 1/4쯤 되는 부분에 오도록 조정하세요.

화면 내에 흰색이 없으면 화이트 밸런싱 관련 문제를 정확히 해결하기가 힘듭니다. 하지만 
뉴트럴 그레이 톤이 담긴 넓은 도로 부분을 이용하여 작업할 수 있습니다. 뉴트럴 그레이도 
흰색과 마찬가지로 빨강, 초록, 파랑으로 구성되어 있습니다. 스코프만으로는 뉴트럴 그레이를 
구분하기 힘들기 때문에 빨강, 초록, 파랑의 값을 측정할 수 있는 다른 도구를 함께 사용해야 
합니다. 이 경우 스포이드 아이콘을 사용해 프레임 내 픽셀 영역의 RGB 값을 표시할 수 있습니다.

5 마우스 포인터를 뷰어 위에서 움직이다 보면 포인터가 스포이드 아이콘으로 변합니다.

6 뷰어에서 마우스를 우클릭 후 Show picker RGB value를 선택하세요.

8bit RGB 값이 뷰어 내에서 스포이드 아이콘 옆쪽으로 표시됩니다. 이 값을 보면 해당 픽셀에 
빨강이 많은지 혹은 초록이나 파랑이 많은지 알 수 있습니다. 

7 스포이드 아이콘을 숏의 오른쪽 회색 배경 위로 가져가세요.

RGB 값으로 보면 시멘트 부분의 중간톤 회색 영역은 파랑의 비율이 낮고 빨강의 비율이 높습니다. 
만약 시멘트가 뉴트럴 그레이라면 사용자의 눈에 그렇게 보인다면), 이 RGB 값들을 조정해야 
합니다. 
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이런 유형의 색상 계열 조정 작업은 프라이머리 바를 사용하는 것이 가장 간단합니다.

정보 View > Show RGB Picker Values In > 10-bit를 선택하면 RGB 피커가 10bit의  
숫자 형태(0-1023)로 표시됩니다.

8 시멘트 톤이 속한 중간톤에서 파랑 계열을 올려주기 위해 파랑의 감마 바는 위로 조금 올리고 
빨강 감마는 조금 내립니다.

중간톤 영역을 고르게 만들었으니 이제 가장 어두운 섀도우 영역에 색 집중 현상이 있는지 
확인해 봅니다.

9 소녀의 얼굴 오른쪽 옆으로 드리워진 머리카락의 그림자 부분 위로 스포이드 아이콘을 움직여 
보세요.

10 RGB 값이 거의 대등하게 될 때까지 빨강, 초록, 파랑 리프트 바를 사용하여 세밀한 조정 작업을 
계속하세요.

중요한 조정 작업 후에는 항상 작업 전 숏과 비교해 보는 것이 좋습니다.

11 View > Bypass All Grades 또는 [Shift + D] 키를 누르면 작업 전 이미지를 볼 수 있습니다.  
다시 한번 [Shift + D] 키를 누르면 작업이 완료된 클립을 볼 수 있습니다.
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조정 작업을 하고 나니 이미지의 색 균형과 콘트라스트가 훨씬 좋아졌습니다. 정말 빠르게 작업을 
마쳤습니다. 설정을 하나만 바꾸어서 원래 영상과 비교한 후 다음 숏으로 넘어가는 경우는 거의 
없습니다. 색보정은 조정, 비교, 조정, 비교의 반복입니다. 시간이 걸리긴 하지만, 요리나 정원 
가꾸기처럼 더 많이 탐구할수록 더 좋은 방법을 찾아낼 수 있습니다.

메인 프라이머리 컨트롤로 스타일링하기
프라이머리 커렉터는 뉴트럴 그레이딩 말고도 숏을 창조적으로 스타일링할 수 있는 여러 주요 
도구들을 포함합니다. 숏을 밸런싱했으니 이제 스타일을 한번 줘 보겠습니다. 영상룩을 룩을 만들 
때 가장 중요한 일은 목표를 정하는 것입니다. 이 영상룩을 통해 어떤 느낌을 전달하고 싶으신가요? 
지금 다루고 있는 다큐멘터리는 어린 소녀들의 스케이트보딩 클럽에 관한 이야기지만, 오프닝 숏은 
소녀들이 손톱을 반짝반짝하게 다듬고 색칠하는 장면의 익스트림 클로즈업 숏입니다. 생동감 넘치는 
스케이트보딩 장면들과 대조적인 느낌을 내기 위해 이 소녀들의 행동을 좀 더 따듯하고 부드러운 
동시에 마법의 일몰 시각 같은 스타일로 만들어 봅시다. 

1 노드 그래프에서 Node 01을 우클릭하여 Add Node > Add Serial을 선택하세요

다른 노드를 추가해 스타일리쉬한 영상룩으로부터 색 밸런싱 효과를 분리할 수 있습니다. 
이렇게 하면 효과의 차이점을 쉽게 비교할 수 있을 뿐 아니라, 나중에 노드 그래프에 노드가 
많아지더라도 어떤 보정 작업이 적용되었는지 쉽게 찾아낼 수 있습니다. 노드에 이름을 붙여주면 
어떤 보정이 이루어졌는지 쉽게 알아볼 수 있습니다.
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2 Node 01을 우클릭한 후 Node Label을 선택하세요.

3 노드 이름에 balanced라고 입력하세요.

4 노드 02를 우클릭한 후 Node Label을 선택하세요.

5 노드 이름에 원하는 스타일의 명칭을 입력하세요.

이제 노드가 정리되었으니 이 숏에 적용할 마법의 일몰 시각 스타일을 만들어 봅시다.

6 노드 그래프의 Node 02가 스타일 노드로 제대로 설정되었는지 확인하세요.

7 프라이머리 커렉터 패널의 팝업 메뉴에서 Primaries Wheels를 선택하면 컬러휠 화면으로 
돌아갑니다.

프라이머리 바는 특정 컬러 계열을 조정하는데 탁월하지만, 컬러휠은 여러 색을 자유자재로 
혼합하여 원하는 영상룩에 맞는 정확한 색깔을 만들어 내도록 돕습니다. 특히 DaVinci Resolve 
Micro/Mini/Advanced 컨트롤 패널을 사용한다면 양손으로 트랙볼을 사용하여 원하는 색을 
이리저리 조율할 수 있기 때문에 더욱 효과적으로 색을 혼합할 수 있습니다.

8 Gain 컬러휠에서 컬러 포인트를 노랑/오렌지 방향으로 드래그하여 하이라이트 영역의 색을 
따뜻한 느낌이 되게 만들어 보세요. 

프라이머리 커렉터 도구 중 어떤 것을 사용할지에 대해 너무 고민하지 마세요. 편하게 느껴지는 
도구를 그냥 사용하면 됩니다. 도구를 많이 사용하다 보면 자신의 작업 스타일에 가장 맞는 
도구 모음으로 자연스럽게 이끌릴 겁니다.
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부가적인 프라이머리 컨트롤을 
사용하여 스타일 강조하기
마스터 휠의 아래에 있는 프라이머리 부가 도구를 통해 밝기, 색, 선명도에 미묘한 변화를 줄 수 
있습니다. 피부 색을 조금 따뜻한 색으로 바꾸려면 컬러 부스트 도구를 다시 한번 사용해 볼 수 
있습니다.

1 컬러휠 아래의 조절 스트립에서 [2]를 누르면 두 번째 페이지가 나타납니다.

2 Color Boost 값을 오른쪽으로 드래그하여 피부색을 더 따뜻하게 만들어 보세요.

이 숏이 은은하게 빛나 보이도록 미드톤 디테일의 값을 바꿔 볼 겁니다. 이전 과에서 가장자리를 
선명하게 만들기 위해 이 방식을 사용했습니다. 이 경우에는 마이너스 값을 적용해 봅시다.

3 Midtone Detail의 값을 왼쪽으로 드래그하면 이미지가 부드러워지고 살짝 빛나는 효과를 
가져옵니다.

이렇게 영상을 부드럽게 만들 때는 미묘한 조정이 필요합니다. 너무 과하게 작업하면 사람의 
피부가 가짜처럼 보이기 때문입니다.

4 밸런싱만 마친 이미지와 스타일을 가미한 이미지를 비교하기 위해 스타일 노드 위의 02를 
클릭하여 비활성화하거나 [Cmd+D] 키(macOS) 혹은 [Ctrl+D] 키(Windows)를 누르세요. 

보정을 추가할 때마다 노드를 별도로 만들면 이렇게 보정 결과를 비교하기 좋습니다.

5 스타일을 가미한 영상으로 돌아가려면 스타일 노드 위 02를 클릭하거나 [Cmd+D] 키(macOS) 
혹은 [Ctrl+D] 키(Windows)를 다시 누르세요.
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이 숏의 영상룩이 훌륭하기 때문에 이 효과를 같은 장면 속 다른 유사 숏에도 적용할 수 있습니다. 
이 과의 후반부에서 보정 효과를 한 클립에서 다른 클립으로 복사하는 방법을 다룰 예정이지만, 
지금은 프라이머리 보정에 대해 한 가지 더 알아보겠습니다. 이번 작업은 약간 어려울 수 있습니다.

프라이머리 색보정 작업에 커브 사용하기
이번 실습에서는 복잡한 문제를 가진 다른 숏을 다뤄볼 것인데, 보정을 하려면 더 섬세한 조정 
작업이 필요합니다. 이번에도 뉴트럴 그레이딩을 먼저 마친 다음 조정 작업을 진행하겠습니다. 
그러나 이번에는 프라이머리 커렉터를 사용하는 대신 커스텀 커브를 사용하여 조정 작업을 
해보겠습니다.

1 33번 썸네일을 선택하세요.

2 클립을 점검하기 위해 재생 버튼을 클릭하세요.

이번 경우에는 클립 중간쯤 소녀가 등장하는 부분의 프레임을 사용하여 색보정을 해보는 것이 
좋겠습니다.

3 뷰어의 플레이헤드를 클립 중간으로 드래그하여 소녀가 공중에 떠 있는 부분까지 가져가세요.

작업 전 작업 후
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이전 과에서 사용했던 방식을 그대로 사용하겠습니다. 즉 루미넌스를 먼저 보정한 후 색의 
불균형 문제를 해결해 보겠습니다. 이 숏에서 ‘골치 아픈 문제’는 바로 빛이 혼합되어 들어오고 
있다는 점입니다. 천장 불빛의 일부가 형광이고 초록빛을 발산하고 있습니다. 이 부분은 마지막에 
보정하겠습니다. 보정할 것입니다.

이미지 내에 수정할 부분이 몇 군데 보입니다. 콘트라스트도 낮은데 이는 퍼레이드 스코프에서  
중간 부분에 몰려 있는 트레이스를 통해 다시 한번 확인할 수 있습니다. 파랑 계열은 약하고 
형광등에서 나오는 초록 계열은 매우 강합니다. 검정 부분 또한 회색처럼 보이고 진해질 필요가 
있습니다. 이 부분이 바로 수정이 필요한 사항들입니다.

참고 해상도가 낮은 컴퓨터에서 커브 팔레트를 표시하려면 Curves 버튼을 
눌러야 할 수도 있습니다.

커스텀 커브 그래프를 사용하면 이미지 내 특정 톤의 범위를 놀라울 정도로 유연하게 조정할 
수 있습니다. X 축은 이미지의 톤 값을 표현하는데, 왼쪽 끝은 가장 어두운 섀도우 영역, 오른쪽 
끝은 가장 밝은 하이라이트 영역의 값입니다. Y 축은 출력 또는 오프셋으로서 어두워지는 
조정은 그래프의 아래쪽에, 밝아지는 조정은 그래프의 위쪽에 값이 표시됩니다.

정보 톤의 값 또는 톤의 범위는 밝기의 값과 관련된 용어입니다.

톤
 범

위
 오

프
셋

이미지 톤 범위

하이라이트

중간톤

섀도우 
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정보 컬러 페이지의 각 클립에는 실행 취소/재실행 내역이 담겨 있습니다.  
Edit > Undo를 선택하면 현재 선택된 클립이 무엇인지에 따라 각각 다른 방식을 
사용하여 실행 취소를 수행합니다.

일단 낮은 콘트라스트를 해결하기 위해 커스텀 커브 그래프의 끝점을 드래그하여 블랙 포인트와 
화이트 포인트를 조정하세요.

4 마우스 포인터를 커스텀 그래프 왼쪽 아래에 있는 컨트롤 포인트 위에 갖다 대세요.

이 점이 블랙 포인트 컨트롤입니다. 리프트 마스터휠의 기능과 비슷한 것으로서 이 점을 조정해서 
클립의 블랙 포인트를 높이거나 낮출 수 있습니다.

5 이 점을 오른쪽으로 드래그하여 스티로폼 지지대가 더 어둡게 보이도록, 그러나 약간의 디테일은 
간직할 정도로 만드세요. 이렇게 하면 퍼레이드의 트레이스는 바닥 근처에 오게 될 겁니다.

블랙 포인트를 오른쪽으로 움직이면서 블랙 포인트, 즉 영상 내의 가장 어두운 부분을 더 어둡게 
만드세요.

6 이제 마우스 포인터를 커스텀 그래프 오른쪽 위에 있는 컨트롤 포인트 위로 가져가세요.

이 점이 화이트 포인트 컨트롤입니다. 게인 마스터휠과 비슷한 기능을 지원하는 이 점을 조정해서 
클립의 화이트 포인트를 높이거나 낮출 수 있습니다.

7 이 점을 왼쪽으로 드래그하여 천장의 밝은 불빛이 더 밝게 보이도록, 그러나 디테일이 사라져 
버리지는 않을 정도로 맞추세요. 이렇게 하면 퍼레이드의 트레이스는 꼭대기 근처에 오게 될 
겁니다.
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이 컨트롤 포인트를 왼쪽으로 드래그하면 화이트 포인트, 즉 영상 내의 가장 밝은 부분이 
밝아집니다.

방금 한 것처럼 이 두 개의 점을 움직이면 Contrast 슬라이더를 사용하여 콘트라스트 값을 
올리거나 Gain과 Lift 마스터휠을 조정하는 것과 같은 효과가 나타납니다.

8 View >Bypass All Grades를 선택하거나 [Shift+D] 키를 눌러 작업 전 이미지를 확인하세요. 그런 
다음 [Shift + D] 키를 다시 한번 눌러 보정된 클립과 원래 클립을 비교해 보세요.

이제 색의 균형을 맞춰보겠습니다. 커스텀 커브는 기본 설정에 의해 모든 색 계열과 루미넌스를 
통합해서 조정하지만, 이 컨트롤의 링크를 해제하여 각 요소를 따로 조정할 수 있습니다.

9 컨트롤의 링크를 해제하기 위해 커브 컨트롤 영역에서 링크 버튼을 클릭하세요

천장을 보면 더 밝아진 것을 확인할 수 있습니다. 하지만 흰색으로 보여야 할 천장이 아직은 
베이지색에 가깝게 보입니다. 이 현상이 나타나는 이유는 빨강과 초록 계열이 너무 과하기 
때문입니다. 퍼레이드 그래프를 보면 하이라이트 영역에서 파랑 계열이 빨강이나 초록보다 매우 
낮은 것으로 보입니다. 링크가 해제된 컨트롤을 사용하여 파랑 계열만 강화하면 천장의 색 
균형을 잡을 수 있습니다.

10 커브 컨트롤 영역에서 B(초록 계열) 버튼을 클릭하면 커브 에디터의 초록 커스텀 커브가 
나타납니다.

11 파랑 컨트롤 포인트를 왼쪽으로 드래그하여 천장이 흰색으로 보이도록 만드세요. 퍼레이드 
스코프의 파랑 트레이스가 이제 빨강과 초록 트레이스와 비슷한 높이로 올라갈 겁니다. 
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12 View > Bypass All Grades를 선택하거나 [Shift+D] 키를 여러 번 누르면서 원래 클립과 보정된 
클립을 비교해 보세요.

세컨더리 커브를 사용하여 까다로운 빛 문제 해결하기 
타임라인에 있는 클립의 밸런싱이 끝났다면 다음 할 일은 빛이 들쑥날쑥한 영역들을 보정하는 
것입니다. 등장인물의 이마가 번들거리거나 눈이 지나치게 어두워 보이는 경우, 혹은 이 숏처럼 형광 
불빛으로 인해 천장에 초록빛이 감돌 수도 있습니다. 작은 부분 하나를 수정하기 위해 숏 전체의 
초록 계열 값을 낮추기보다는 문제가 되는 영역만 분리해서 보정하는 것이 성능 면에서 더 
효과적입니다. 노드 그래프에서 새 노드를 하나 추가하여 조정 작업을 분리해 보겠습니다.

1 노드 그래프에서 Node 01을 우클릭하여 Add Node > Add Serial을 선택하세요.

이 노드가 클립의 제일 위에 얹힐 투명한 레이어라고 생각하면 됩니다. 색 조정 작업은 노드에 
적용되는 것이지, 클립에 적용되는 것이 아닙니다. 결과적으로 DaVinci Resolve에서 이루어지는 
조정 작업은 영상 파일 자체에 영향을 주지 않습니다. 이는 언제든지 활성화/비활성화할 수 
있기 때문입니다.

작업 전 작업 후
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정보 새로운 노드를 추가해야 하는지, 아니면 현재 작업 중인 노드에서 계속 
작업해야 하는지 어떻게 알 수 있을까요? 정해진 답은 없습니다. 노드를 빵 
부스러기의 자취라고 생각해 보세요. 클립에서 이전에 적용한 색의 상태로 
되돌아가야 할 필요가 있다면, 새 노드를 추가하세요.

초록빛을 보정하기 위해 방금 추가한 두 번째 노드를 사용할 것입니다.

2 노드 그래프에서 02 노드를 더블 클릭하여 이 노드가 확실히 선택되도록 하세요.

3 타임라인의 썸네일, 갤러리, 노드 그래프를 숨기고 뷰어를 크게 볼 수 있도록 [Option+F] 키
(macOS) 또는 [Alt+F] 키(Windows)를 누르거나 Workspace > Viewer Mode > Enhanced Viewer를  
선택하세요.

10과에서 기둥의 파란 색조를 낮추고 싶었던 경우처럼 초록 불빛 같은 특정 색조의 채도를 
낮추고 싶을 때는 Hue vs Sat 커브를 사용하면 됩니다.

4 커브 컨트롤 위쪽에 보이는 Curves 팝업 메뉴를 클릭하세요.

5 팝업 메뉴에서 Hue Vs Sat을 선택하세요.

이 커브를 사용해서 초록 색조를 선택 후 채도를 낮추면 천장이 흰색으로 보이도록 만들 수 
있습니다. 여기 있는 초록색 부분처럼 흐릿한 색들을 작업할 때는 색조를 선택하기 위해 채도를 
일시적으로 올려주는 것이 도움이 됩니다.

6 프라이머리 커렉터 아랫부분에 있는 조정값 영역에서 1을 클릭 후 Sat을 오른쪽으로 끝까지 
증가시켜 보세요.

7 초록색이 좀 더 도드라지게 보입니다. 이제 뷰어에서 천장의 초록 불이 보이는 지점 두어 군데를 
클릭하세요.
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뷰어에서 클릭할 때마다 선택된 색조를 표시하기 위해 커브를 따라 점이 추가됩니다.

8 선택된 초록 색조의 채도를 낮추기 위해 가운데 있는 점들을 그래프의 아랫부분으로 잡아당겨 
드래그하세요. 양쪽 끝점 두 개는 제자리에 둡니다.

그래프에서 점들을 낮은 곳으로 끌어 내리면 해당 색조의 채도가 낮아집니다. 양쪽 끝점 두 
개는 채도를 낮추고자 하는 색조의 범위를 정의합니다. 초록색을 완전히 없애려는 의도가 
아니라면, 양 끝점의 간격을 넓혀서 해당 색조가 더 많은 색을 포함하도록 색조 범위를 변경할 
수 있습니다.

9 왼쪽 끝점을 더 왼쪽으로 드래그하면 초록 색조의 범위가 넓어집니다.
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10 프라이머리 커렉터의 아래쪽에 있는 조정값 영역에서 Sat 레이블을 더블클릭하면 채도가 원래 
값으로 돌아갑니다.

방금 한 변경 작업을 비교하기 위해 변경 사항이 적용된 02 노드를 비활성화시킬 수 있습니다.

11 타임라인의 썸네일, 갤러리, 노드 그래프를 다시 보려면 [Option+F] 키(macOS) 또는 [Alt+F] 키
(Windows)를 누르거나 Workspace > Viewer Mode > Enhanced Viewer를 선택하세요.

12 노드 그래프에서 Node 02 노드를 선택한 상태에서 노드의 왼쪽 아래에 있는 02를 클릭하거나 
[Cmd+D] 키(macOS) 또는 [Cmd+D] 키(Windows)를 누르면 색조 커브 조정을 하기 전 이미지가 
보입니다. 보정된 클립을 보고 싶다면 다시 [Cmd+D] 키(macOS) 또는 [Ctrl+D] 키(Windows)를 
누르세요.

노드를 사용하면 색조정 작업을 매우 유연하게 관리할 수 있습니다. 단순한 그레이딩 작업을 위해서는 
기본 노드 하나만 사용해도 무방합니다. 그레이딩 작업을 완료하기까지 보통 12개 정도의 노드를 
추가하게 됩니다. 노드를 사용하면 찾고자 하는 보정 작업으로 재빨리 접근할 수 있을 뿐 아니라 
다양한 방식으로 색보정 작업을 통합할 수 있습니다.

작업 전 작업 후
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유사한 숏에 색보정 작업 복사하기
여러 카메라로 촬영한 동영상을 하나의 타임라인에 합쳐 색보정하는 일은 정말 어려습니다. 각 숏이 
자체적으로 문제가 없어야 할 뿐 아니라, 바로 전에 올 숏과 바로 다음에 올 숏과 비교했을 때도 
문제가 없어야 합니다. 두 개 이상 숏의 영상룩과 느낌을 블렌딩하는 작업을 숏 매칭이라고 부릅니다.

숏 매칭 혹은 장면 밸런싱의 핵심은 간단합니다. 예를 들어, 실생활에서 대화를 나누면서 주위를 
둘러봤을 때 눈에 들어오는 사물의 모습들은 일관성이 있습니다. 어떤 외부 요소로 인해 인위적으로 
빛을 변화시키지만 않는다면(예를 들어 불이 켜진다든지 구름이 태양을 가리는 경우) 색의 채도, 
피부의 색조, 밝기 정도가 어느 정도 일관적입니다. 촬영하는 영상을 실제처럼 보이게 만들고 싶다면 
숏 매칭 및 장면 밸런싱을 통해 이런 일관성을 연출해야 합니다.

이번 실습에서는 DaVinci Resolve가 숏 매칭을 위해 제공하는 몇 가지 간단한 도구들을 살펴보고 
연속된 숏을 매끄럽게 연결하기 위해 해당 도구들을 사용해 보겠습니다.

1 썸네일 타임라인에서 15번 썸네일을 선택하세요.

이 숏은 스케이팅 공원에 앉아 있는 소년들을 촬영한 두 번째 숏입니다. 같은 카메라로 동시에 
촬영한 숏들을 매칭시키는 것은 제일 간단한 경우에 속합니다. 14번, 15번 썸네일을 매칭시키는 
것이 바로 이 경우입니다. 14번 썸네일은 이미 밸런싱이 되었으므로 15번에도 같은 보정 효과를 
적용하면 됩니다.

2 [=] 키를 누르거나 Color > Apply Grade from One Clip Prior를 선택하세요.

이전 클립의 그레이딩이 복사되어 현재 선택된 클립으로 붙여넣기 됩니다. 이 방법은 여러 개의 
숏이 모두 같은 소스에서 나온 경우에 사용하기 좋습니다.

또 하나의 쉬운 밸런싱 기술을 살펴봅시다.

3 썸네일 타임라인에서 08번 썸네일을 선택하세요.
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이 숏은 앞에서 색보정을 했던 것으로 소녀가 나오는 장면입니다. 06, 07, 08번 썸네일은 점프 
컷이고 아마 같은 녹화 세션에서 촬영된 것 같습니다. 노드 에디터에 노드 한 개만 있을 때는 
보정 내용을 노드 간에 복사 및 붙여넣기가 비교적 쉽습니다.

4 노드 그래프에서 Node 01을 선택 후 [Cmd + C] 키(macOS) 또는 [Ctrl + C] 키(Windows)를 눌러 
해당 노드의 설정값을 복사하세요.

5 01번 썸네일을 선택하세요. 노드 그래프에서 Node 01을 선택 후 [Cmd + V] 키(macOS) 또는 
[Ctrl + V] 키(Windows)를 눌러 해당 노드의 설정값을 붙여넣기 하세요.

08번 클립의 Node 01에 적용되었던 색보정 설정이 07번 클립으로 복사 및 붙여넣기 되었습니다. 
마우스 가운데 버튼을 사용하여 비슷한 작업을 해봅시다.

6 06번 썸네일을 선택하세요.

7 버튼이 세 개인 마우스의 가운데 버튼을 사용해 08번 클립의 06번 썸네일을 클릭하세요.

08번 클립의 색보정 설정을 06번 클립에 복사했습니다.

8 이 세 개의 숏으로 구성된 시퀀스를 재생해 보세요.

숏들이 모두 하나의 연결된 시퀀스처럼 느껴질 겁니다. 밝기, 색조, 채도가 모두 일관적입니다. 
관객은 주의가 조금도 흐트러지지 않은 채 즐겁게 이 영상을 관람할 수 있을 겁니다.

클립 간 색보정 설정을 복사하는 일은 숏 매칭 작업 중 가장 단순하면서도 자주 하는 작업입니다. 
그러나 DaVinci Resolve에는 이것 말고도 숏 매칭을 보조해줄 여러 가지 도구가 있습니다.
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스틸 저장 및 적용하기
이 클립에서 저 클립으로 노드를 복사해서 적당한 위치에 붙여넣는 대신, 작업한 그레이딩 설정을 
갤러리에 저장해서 필요할 때마다 불러올 수 있습니다.

1 앞서 그레이딩 작업을 마친 소녀의 익스트림 클로즈업 장면인 04번 썸네일을 선택하세요.

이 숏에서 작업했던 그레이딩을 저장하기 위해 스틸 이미지 하나를 갤러리에 저장해야 합니다.

2 현재 뷰어에서 우클릭하여 Grab Still을 선택하세요.

레퍼런스 스틸이 갤러리에 저장됩니다. 이 스틸에는 해당 숏에 적용된 보정 사항을 다시 
만들어내기 위한 모든 정보가 포함되어 있습니다. 스틸의 이름을 지정해 주면 나중에 여기에 
저장된 보정 내용을 쉽게 파악할 수 있습니다.

3 스틸을 우클릭한 후 Change Label을 선택하세요.

4 Magic Hour라고 입력하세요.

갤러리에 저장된 스틸을 사용하면 같은 색보정 설정을 한 개 혹은 여러 개의 클립에 쉽게 적용할 
수 있습니다. 저장 및 붙여넣기는 한 번에 한 개의 노드에만 적용할 수 있지만, 갤러리의 스틸에는 
해당 영상룩을 구성하는 모든 노드가 포함되어 있습니다.

5 03번 썸네일을 클릭하세요.



331

유
사

한
 숏

에
 색

보
정

 작
업

 복
사

하
기

타임라인에서 여러 개의 썸네일을 선택한 후 갤러리에서 불러온 그레이딩을 적용할 수 있습니다.

6 [Cmd] 키(macOS)를 누른 채 02번 썸네일을 클릭하거나, [Ctrl] 키(Windows)를 누른 채 02번 
썸네일 클릭하면 해당 썸네일이 선택됩니다.

7 갤러리에서 해당 스틸을 우클릭한 후 Apply Grade를 선택하세요.

두 개의 클립에 같은 그레이딩이 적용되었습니다. 클립 세 개를 재생해보면 모두 일관적인 
영상룩을 제공한다는 사실을 확인할 수 있습니다. 다음으로는 스틸의 이미지를 어떻게 활용하는지 
배워보겠습니다.

숏 비교하기
숏 매칭을 잘하려면 몇 개의 레퍼런스 숏을 제대로 골라 이들을 대표 스틸로 갤러리에 저장한 다음, 
다른 숏들을 이 레퍼런스 스틸과 매칭시켜야 합니다. 갤러리에 저장된 스틸을 다른 숏들과 비교하면서 
프로젝트 전체의 컬러 일관성을 향상시킬 수 있습니다.

1 스케이팅 공원에서 손톱을 색칠하고 있는 소녀들의 와이드 숏인 05번 썸네일을 선택하세요.
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이 와이드 숏의 오디오는 소녀들이 손톱 다듬는 것에 관해 계속 얘기하는 내용이지만 실제 이 
숏은 스케이트를 타고 있는 장면의 일부입니다. 따라서 익스트림 클로즈업 숏에 작업했던 것과 
비슷한 색상 톤과 따뜻함이 느껴지도록 보정해야 합니다. 그러나 이 숏은 익스트림 클로즈업 
숏이 촬영된 시간과는 다른 시간대에, 다른 스케이팅 공원에서 촬영되었을 가능성이 매우 
큽니다. 먼저 두 개의 숏을 비교해 봅시다.

2 05번 썸네일이 04번 썸네일의 색보정과 어떻게 다른지 비교하기 위해 Magic Hour라고 이름 
붙였던 스틸을 더블 클릭하여 뷰어에서 확인해 보겠습니다.

뷰어는 세로로 분할되도록 기본 설정되어 있습니다. 타임라인에 있는 숏, 즉 05번 썸네일이 
왼쪽에 나타납니다. 갤러리에서 선택된 스틸은 오른쪽에 나타납니다.

3 Workspace > Viewer Mode > Enhanced Viewer를 선택하거나 [Option + F] 키(macOS) 혹은 
[Alt + F] 키(Windows)를 누르면 뷰어의 크기가 확장됩니다.

4 뷰어에서 왼쪽으로 드래그하였다가 오른쪽으로 드래그하면 스틸과 현재 타임라인의 클립 간에 
와이프(Wipe) 됩니다.

와이드 숏의 시멘트와 스틸에 있는 시멘트를 비교해 보면 예상대로 타임라인 클립의 시멘트가 
더 차가워 보입니다. 따라서 갤러리에 저장해 두었던 Magic Hour의 그레이드를 여기에 적용해 
봅시다.

5 Workspace > Viewer Mode > Enhanced Viewer를 선택하거나 [Option + F] 키(macOS) 혹은 
[Alt + F] 키(Windows)를 누르면 갤러리가 나타납니다.

6 갤러리에서 해당 Magic Hour 이미지를 우클릭한 후 Apply Grade를 선택하세요.
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이제 스틸에 적용되었던 색보정과 동일한 보정이 타임라인 클립에 적용되었습니다. 노드 그래프를 
살펴보면, Magic Hour의 영상룩을 지닌 두 개의 노드가 이 패널에 재구성된 것이 보입니다. 
그러나 다른 시간대와 다른 장소에서 촬영한 숏들이 그렇듯, 해당 영상룩을 이 영상에 적용하고 
나니 그 느낌이 원래 영상룩과 약간 달라졌습니다. 원래보다 조금 더 따뜻한 느낌입니다.

7 뷰어에서 왼쪽으로 드래그하였다가 오른쪽으로 드래그하면서 두 숏의 따뜻함 정도를 비교해 
보세요.

타임라인에 있는 클립이 레퍼런스 스틸보다 더 따뜻한 느낌이므로 컬러휠을 사용하여 조금 
차갑게 만들면 좋을 것 같습니다.

8 노드 그래프에서 Node 02를 선택하세요.

9 Offset 컬러휠에서 컬러 포인트를 파랑 방향으로 드래그하여 타임라인에 있는 클립의 시멘트가 
레퍼런스 스틸 이미지에 있는 시멘트와 같아지도록 만들어 보세요.

10 뷰어에서 와이핑을 비활성화하고 싶다면 뷰어의 왼쪽 위 모서리에 있는 Image Wipe 버튼을 
클릭하세요.

갤러리와 레퍼런스 스틸을 사용하면 색보정 작업의 방향을 분석하고 관련 정보를 제공해 주기 
때문에 숏 매칭이 쉬워집니다. 사람의 눈은 한계가 있어서 숏들이 서로 매칭된 것처럼 보이기 
마련이므로 이런 시각적 장애를 최소화하려면 스코프를 사용해야 합니다. 레퍼런스 스틸과 스코프를 
함께 사용하면 숏 매칭 작업이 더 정확해지고 프로젝트 전체의 컬러 일관성이 완벽하게 유지됩니다.

복습하기
1 컬러 페이지의 Parade 스코프에 있는 1023선은 무엇을 의미하나요?

2 커스텀 커브는 빨강, 초록, 파랑 채널만 조정할 수 있습니다. T(진실) 또는 F(거짓)로 답하세요.

3 스틸을 갤러리에 저장하는 방법은 무엇인가요?

4 RGB 피커가 뉴트럴 픽셀 위에 있을 때 빨강, 초록, 파랑의 값은 무엇이 되어야 합니까?

5 Hue Vs Sat 커브를 조정하면 어떤 일이 벌어지나요?
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정답
1 Parade 스코프의 1023 선은 완전한 흰색을 의미합니다. 1023 선 위로 올라가는 신호는 클리핑 

되거나 디테일이 손실됩니다.

2 F. 컬러 페이지에서 커스텀 커브를 사용하여 빨강, 초록, 파랑 채널뿐 아니라 밝기도 조정할 수 
있습니다.

3 뷰어에서 마우스를 우클릭 후 Save Still을 선택하면 원하는 스틸을 갤러리에 저장할 수 있습니다.

4 RGB 피커를 뉴트럴 픽셀 위에서 움직여 보면 RGB 값이 빨강, 초록, 파랑의 값이 서로 같거나 
비슷하게 표시됩니다.

5 Hue Vs Sat 커브를 사용하여 특정 색조의 채도를 증가 또는 감소시킬 수 있습니다.
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세컨더리 조절 기능 
사용하기 

프라이머리 색보정은 전체 이미지를 조정하는 
반면 세컨더리 색보정은 이미지의 특정 부분을 
따로 분리해 작업할 수 있습니다.

예를 들어, 차량 색상을 숏의 나머지 부분에 
영향을 끼치지 않고 파란색에서 빨간색으로 
바꾸거나 배우의 피부에 따뜻한 느낌과 채도를 
추가할 수 있으며, 비네트를 생성할 경우 
시청자들의 관심을 숏의 특정 부분에 집중시킬 
수 있습니다. DaVinci Resolve에는 수많은  
강력한 도구들이 탑재되어 있습니다.

이번 과에서는 퀄리파이어(Qualifier)를 사용하여 
색상을 기반으로 숏의 요소들을 분리하는 
방법과 기본적인 기하학적 형태를 적용해 해당 
프레임 영역을 분리하는 방법을 배워볼 수 
있습니다. 그런 다음 트래커를 사용하여 숏 
안에서 움직이는 요소를 추적 및 색보정할 수 
있습니다. 

예상 소요 시간

이 과를 학습하는 데는 약 30분 
정도의 시간이 소요됩니다.

학습 목표

퀄리파이어 사용하기 336

아웃사이드 노드 사용하기 341

퀄리파이어와 파워 윈도우 결합하기 342

복습하기 347
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퀄리파이어 사용하기
퀄리파이어(Qualifier) 팔레트를 사용하면 숏에서 원하는 색상을 선택해 나머지 푸티지와는 개별적으로  
색보정 작업을 진행할 수 있습니다. 팔레트에서는 색조, 휘도, 채도를 사용해 다양한 방법으로 색상을 
선택할 수 있습니다. 이런 세부적인 수준의 컨트롤을 사용하면 숏에 서로 비슷한 색상 요소가 섞여 
있더라도 깨끗하게 분리 또는 키잉 작업할 수 있습니다. 

정보 퀄리파이어는 키를 생성하는 목적으로만 사용됩니다. 퀄리파이어 자체는 
색보정 도구가 아니며 색보정 팔레트를 조절해야만 이들의 효과가 나타납니다.

1 DaVinci Resolve 15을 열고 지금까지 작업해온 Gnarly in Pink 프로젝트를 여세요.

2 Gnarly in Pink 타임라인을 열면 해당 타임라인이 뷰어에 로딩됩니다.

3 Color 페이지를 클릭한 다음 썸네일 12를 클릭하세요.

작업 요청이 많이 들어오는 스타일 중 하나인, 한가지 색상만 그대로 유지하고 나머지는 흑백으로 
처리하는 효과를 이 숏에 적용해 보겠습니다. 이런 효과는 기존의 수많은 영화에 사용되었으며, 
아마 다른 응용 프로그램을 사용해 이런 효과를 생성해보았을 것입니다. 여기서 가장 중요한 
과정은 그대로 유지하려는 색상만 깨끗하게 분리하는 것입니다.

4 가운데 팔레트에서 Qualifier 아이콘을 클릭하세요.
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이 클립에서는 분홍색으로 나타나는 헬멧과 의상 색상을 그대로 유지시켜 보겠습니다.

퀄리파이어 팔레트 선택 시 마우스 포인터를 뷰어 위로 가져가면 스포이드 아이콘이 나타나는데, 
원하는 색상을 선택하면 해당 색상을 그대로 보존할 수 있습니다.

5 가운데 있는 여자 아이의 헬멧 뒷면을 클릭하세요.

정보 스포이드 아이콘은 퀄리파이어 팔레트에서만 사용되는 것이 아닙니다. 
컬러 페이지 하단에 다른 팔레트가 열려 있다면 그것에도 영향을 미칩니다. 
만약 이미지를 클릭했을 때 커스텀 커브가 열려 있으면 커브에 컨트롤 포인트가 
추가됩니다.

뷰어에 있는 클립은 그대로지만 퀄리파이어 팔레트에서 변경된 사항을 확인할 수 있습니다. 
이미지를 클릭하면 지금까지 변경한 정보가 설정에 반영됩니다. 이제 선택한 부분을 조절해 
깨끗하게 만드는 작업이 필요합니다. 이를 위해 먼저 뷰어 출력에 선택한 부분이 나타나도록 
하세요.

6 뷰어 좌측 상단에 있는 지팡이 모양의 Highlight 아이콘을 클릭하세요.

그러면 선택한 부분이 회색 배경 위에 나타납니다. 보시다시피 선택한 부분이 그렇게 깔끔하게 
나타나지는 않습니다. 다양한 방법을 사용해 이런 현상을 개선할 수 있습니다. 첫 번째 방법으로 
부가적인 샘플 컬러를 퀄리파이어 팔레트에 추가할 수 있습니다. 
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정보 뷰어 우측 상단에 있는 세 개의 아이콘을 사용해 선택 영역이 표시되는 
방식을 변경할 수 있습니다. 표준 그레이 스케일 하이라이트 아이콘 옆에 
Highlight B/W 아이콘을 사용해 이미지를 흑백 매트로 출력할 수도 있습니다. 
예전에 합성 프로그램을 사용해 키잉 관련 경험이 있는 사용자들에게는 친숙한 
기능일 수 있습니다.

7 팔레트의 Selection Range에 있는 색상 범위 추가 버튼을 클릭하세요. 

색상 범위 추가 버튼을 사용해 부가적인 색상을 선택한 범위에 합칠 수 있습니다.

8 뷰어에서 헬멧 주변을 몇 번 클릭해 분홍색을 샘플링할 수 있습니다. 이 단계에서는 하이라이트 
뷰를 일시적으로 해제해 잘못된 색상이 선택되는 일을 쉽게 방지할 수 있습니다.

정보 [Cmd + Z] 키(macOS) 또는 [Ctrl + Z] 키(Windows)를 눌러 잘못 선택된 
영역을 취소할 수 있습니다.

아직 완벽하지는 않지만 좀 더 많은 부분이 선택된 것을 확인할 수 있습니다.
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모든 범위를 선택한 다음 퀄리파이어 팔레트에서 색조, 채도, 휘도값을 조절해 선택 범위를 
세밀하게 조정할 수 있습니다. 퀄리파이어 컨트롤은 아주 정교하고 강력한 기능을 제공합니다. 
서로 다른 숏이 각각의 파라미터에 어떻게 반응하는지 알아가는 데는 시간이 좀 걸립니다. 가장 
좋은 방법은 변경 작업을 직접 해보는 것입니다.

9 Hue의 Width 항목과 Saturation 아래쪽에 있는 Low 및 High 항목을 조절해 선택 범위를 조정할 
수 있습니다. 

정보 이름 왼쪽에 있는 빨간 점을 클릭해 일부 슬라이더를 시험 삼아 On/Off 
해보는 것이 도움이 됩니다. 이를 통해 선택 영역이 어떻게 개선되는지를 확인할 
수 있습니다.

선택 부분을 깔끔하게 정리하는 마지막 단계에서는 이미지 매트를 조절합니다. 이 기술은 
지금까지 해온 색상 변경 작업에서만큼 색상 선택에 좌우되지는 않습니다.
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10 뷰어 우측 상단에 있는 Highlight B/W 아이콘을 클릭하세요.

11 Matte Finesse 컨트롤에 있는 Clean Black 및 Clean White를 조절해 원치 않는 흰색 또는 
검은색의 작은 반점을 제거할 수 있습니다. 

Matte Finesse 컨트롤을 조정하는 이유는 바로 깨끗한 흑백 이미지를 생성하기 위함입니다. 
회색 영역은 주로 투명한 영역에서 볼 수 있는데, 현재 이 숏에는 나타나지 않았습니다.

12 Matte Finesse 컨트롤의 두 번째 페이지를 클릭한 뒤 Mode 항목을 Grow로 설정하세요.

Clean Black과 Clean White 파라미터가 헬멧 주변의 매트를 지나치게 줄일 수 있습니다. 그로우 
파라미터를 통해 매트 크기를 키울 수 있습니다. 이제 그레이딩 작업을 시작할 준비가 
완료되었습니다.

13 Radius 파라미터 값을 4까지 높여 매트 크기를 키우세요. 

14 지팡이 모양의 Highlight 아이콘을 클릭해 Highlight 뷰를 해제하세요.

선택한 영역에 원하는 모든 색상이 포함되어 있는지 확인하려면 해당 영역의 색상을 변경해보세요. 
가장 좋은 방법은 Color Wheels 팔레트 아래쪽에 있는 Hue 설정값을 드래그하는 것입니다.

15 Color Wheels 아래쪽에 있는 조절 스트립에서 Hue 설정값을 좌우로 드래그하면 뷰어에 
나타나는 분홍색이 다른 색상으로 변하는 것을 확인할 수 있습니다.
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16 조절 스트립에서 Hue 라벨을 더블 클릭해 설정값을 초기화하세요.

선택 영역에 문제가 발생할 경우 퀄리파이어 도구로 돌아간 다음 앞서 소개된 세 가지의 선택 
영역 정리 방법 중 하나를 선택해 사용하세요.

아웃사이드 노드 사용하기
가끔은 선택 영역 이외의 부분도 관심을 가지고 작업해야 합니다. 예를 들어, 이 숏에서 헬멧은 
분홍색으로 남기고 나머지 색상은 모두 다른 색상으로 조정해보겠습니다. 이 작업은 분홍색 영역을 
먼저 선택한 후에 진행하는 것이 수월합니다. 아웃사이드 노드를 추가하고 퀄리파이어 키를 사용해 
반전된 원본 노드를 생성하세요.

1 노드 에디터에서 노드 01을 선택하고 해당 노드를 우클릭한 뒤, Add Node > Add Outside를 
선택하거나 [option] 키(macOS) 또는 [Alt + O] 키(Windows)를 누르세요.

이제 두 번째 노드가 노드 그래프에 나타납니다. 이전에 생성한 노드와 마찬가지로 녹색 RGB 
입/출력점을 통해 선행 노드와의 연결을 공유합니다. 하지만 이번엔 새로운 연결을 볼 수 
있는데요, 키 입/출력을 위한 파란색 삼각형 아이콘이 나타납니다. 이 키는 퀄리파이어 도구를 
사용하여 분리한 이미지 영역에 해당합니다. 아웃사이드 노드를 생성하면 이전 노드의 키를 
전달받아 해당 영역이 자동으로 반전됩니다.

2 노드 02를 선택한 다음 조정 컨트롤 스트립에서 Sat 필드값을 0으로 드래그하세요.
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이미지 속 흑백 부분의 콘트라스트를 증가시켜 드라마틱한 느낌을 연출할 수 있습니다.

3 노드 02를 선택한 다음 조정 컨트롤 스트립에서 Contrast 슬라이더를 1.2로 드래그하세요.

키 데이터를 다시 사용할 수 있는 기능은 노드 기반 워크플로의 장점입니다. 키 하나만 수행하면 
되기 때문에 그레이딩 작업 과정이 빨라지며, 레이어 기반 시스템에 비해 낮은 컴퓨터 처리 
능력이 요구됩니다.

퀄리파이어와 파워 윈도우 결합하기
파워 윈도우는 퀄리파이어와 마찬가지로 수정하려는 이미지의 특정 영역을 선택할 수 있습니다. 
하지만 파워 윈도우는 색조 선택에 의존하는 퀄리파이어와는 달리 가리고자 하는 부분을 나타내는 
프레임 내 스플라인 형태에 의존합니다.

이 두 가지 도구를 함께 사용하면 조정하고자 하는 프레임 영역을 좀 더 정확하게 수정할 수 있습니다. 
한 이미지에서 여러 개의 색조를 조정해야 하는 경우도 종종 발생합니다. 퀄리파이어 팔레트에서 
선택한 부분을 깔끔하게 정리하는 데 집중하다 보면 키잉 품질이 저하될 가능성도 있기 때문에 
때론 파워 윈도우를 사용하여 중점적으로 다룰 부분이 속한 프레임 영역을 자세히 표시하는 것이 
좋습니다.

1 타임라인에서 클립 07을 클릭하세요.

여기서는 분홍 상자의 색상을 방 분위기에 맞게 변경하도록 하겠습니다.

2 노드 그래프에서 노드 01을 선택하고 해당 노드를 우클릭한 뒤, Add Node > Add Serial을 
선택하거나 [option + S] 키(macOS) 또는 [Alt + S] 키(Windows)를 누르세요.

3 툴바에서 퀄리파이어 버튼을 누른 다음 퀄리파이어의 Selection Range에서 스포이드 아이콘을 
클릭하세요.
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4 뷰어에서 스포이드 아이콘을 사용하여 여자아이 옆에 있는 상자를 클릭하세요.

정보 만약 퀄리파이어가 작동하지 않는다면 이는 퀄리파이어 팔레트의 
Selection Range에 있는 Highlight + 도구가 활성화되어 있기 때문일 수 
있습니다. 일반 퀄리파이어 선택 도구로 전환해 새로운 영역을 선택하세요.

5 뷰어에서 하이라이트 모드를 활성화하면 선택한 퀄리파이어의 결과를 확인할 수 있습니다.

6 HSL Qualifier 설정에서 Hue Center와 Width를 증가시켜 선택한 부분을 깔끔하게 정리할 수 
있습니다.

7 팔레트의 메인 영역에서 Saturation/Luminance 컨트롤을 좀 더 조정한 다음 Matte Finesse 
컨트롤을 사용해 선택 영역을 조정하세요.

다시 말씀드리지만 퀄리파이어는 시행착오를 거치면서 직접 경험해봐야 가장 효율적으로 
사용할 수 있습니다. 그럼에도 불구하고 상자를 방 안의 다른 분홍색 물체들로부터 완벽하게 
분리하기는 어렵다는 사실을 바로 눈치챌 수 있습니다. 그중 배경에 걸려 있는 옷들이 가장 
방해가 되겠네요.

비슷한 색상으로 인해 작업이 복잡해질 경우, 다른 것은 모두 무시하고 피사체(여기서는 상자)에서  
가장 깨끗한 부분을 선택하는 데 집중하세요.
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8 가운데 팔레트에 있는 툴바에서 Window 팔레트 아이콘을 클릭하세요.

9 파워 윈도우 목록 중에서 Curve 버튼을 클릭해 활성화하세요.

10 커브 버튼 옆쪽을 더블 클릭해 해당 윈도우 라벨을 Box로 표기하세요.

11 마우스 포인터를 뷰어로 가져가세요. 

팔레트에서 윈도우가 활성화된 상태에서 마우스를 뷰어 위로 가져가면 펜 도구가 나타나 커스텀  
윈도우 형태를 그릴 준비가 되었음을 알려줍니다.

12 상자 주변을 클릭하면서 형태를 그리되 최종 선택 영역에 넣지 않을 부분은 제외시키세요.

13 첫 번째 포인트를 클릭해 닫으면 커스텀 형태가 완성됩니다. 

형태가 만들어지고 나면 파워 윈도우를 통해 상자 부분 이외의 나머지 이미지 영역을 제외시킬 
수 있습니다.

14 뷰어에서 하이라이트 모드를 비활성화하세요.

15 컬러휠 팔레트 하단의 조정 컨트롤 스트립에서 나머지 숏에 나타나는 톤과 비슷한 파란색으로 
변할 때까지 Hue 컨트롤을 드래그하세요.
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퀄리파이어와 파워 윈도우를 함께 사용할 경우 색조 요소를 기반으로 선택한 부분을 깨끗하게 
만드는 동시에 해당 영역에서 방해가 되는 요소를 신속하게 제외시킬 수 있습니다. 이 두 가지 
도구를 함께 사용할 경우엔 상자 주변의 선을 그렇게 정확하게 그릴 필요가 없습니다. 두 개의 
도구를 조합하여 시간을 절약하고 가장 깨끗한 키를 얻을 수 있습니다.

분홍색 헬멧 트래킹하기
첫 번째 예시에서는 헬멧 하나만 분홍색으로 남기고 나머지 이미지는 흑백으로 처리하고자 했지만, 
셔츠와 바지가 분홍색으로 남아 있는 바람에 의도대로 되지 않았습니다. 이제는 세컨더리 색보정 
기술에 대한 이해가 좀 더 깊어졌으니 숏 가운데 있는 여자아이의 헬멧을 트래킹할 수 있습니다.

1 타임라인에서 클립 12를 클릭하세요.

2 퀄리파이어가 포함된 노드 01을 더블 클릭하세요.

3 툴바에서 Window 버튼을 클릭하세요.

4 원형(Circle) 아이콘을 클릭하면 뷰어에 해당 윈도우가 추가됩니다.

5 원형 윈도우 이름을 Helmet으로 변경하세요.

6 뷰어에서 원의 중심을 드래그해 화면 가운데 있는 소녀의 헬멧 위로 가져가세요.
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7 원 주변에 있는 포인트 중 하나를 드래그하여 헬멧 크기에 맞게 조절하세요.

8 Softness는 1로 줄입니다.

9 툴바에서 Tracker 버튼을 클릭한 다음 Tracker Forward 버튼을 클릭하세요.

10 클립을 재생해 전체 파일에서 트래킹이 올바르게 진행되는지 확인하세요. 

퀄리파이어, 파워 윈도우, 트래커 팔레트 등의 도구 사용법을 익히면 세컨더리 색보정 작업 시 
이미지의 최종 영상룩을 다채롭게 제어할 수 있습니다. 하지만 이러한 도구를 함께 사용해야만 
진정한 잠재력이 발휘됩니다.



347

복
습

하
기

복습하기
1 컬러 페이지 뷰어의 좌측 상단에 있는 하이라이트 버튼을 클릭하면 어떻게 되나요?

2 색상 분리 시 컬러 페이지의 퀄리파이어는 색조 요소를 기반으로 합니다. T(진실) 또는 F(거짓)로  
답하세요. 

3 컬러 페이지에서 아웃사이드 노드의 역할은 무엇인가요?

4 컬러 페이지에서 파워 윈도우를 사용할 경우 스플라인 모양 또는 루미넌스 값을 기반으로 
영역을 선택할 수 있습니다. T(진실) 또는 F(거짓)로 답하세요.

5 파워 그레이드 앨범에 스틸 이미지를 저장하면 나중에 현재 프로젝트 내에서만 해당 이미지에 
접속할 수 있나요?
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정답
1 컬러 페이지 뷰어 위에 있는 하이라이트 버튼을 클릭하면 퀄리파이어 또는 파워 윈도우에 의해 

선택된 픽셀이 나타납니다. 선택한 영역은 일반 색상으로 표시되며 모든 색상 조정의 영향을 
받습니다. 선택하지 않은 영역은 회색 픽셀로 나타나며 색상을 조절해도 아무런 영향을 받지 
않습니다.

2 F. 기본 퀄리파이어는 색조, 채도, 휘도를 기반으로 합니다.

3 아웃사이드 노드는 선행 노드의 알파 채널을 이어받아 선택한 영역을 반전시킵니다.

4 F. 파워 윈도우는 오직 스플라인 모양을 기반으로 해 영역을 선택합니다.

5 아니요. 파워 그레이드 앨범에 스틸 이미지를 저장하면 모든 프로젝트에서 해당 이미지에 접속 
가능합니다.
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창의적인 영상룩 
제작하기 

이제 프라이머리 도구와 세컨더리 도구 사용에 
어느 정도 익숙해졌으므로 창의적인 그레이딩 
작업 방식에 대해 알아볼 차례입니다. 장면  
속 컬러에 따라 관객에게 전달되는 느낌이 
달라집니다. 차가운 컬러톤은 음울한 분위기를 
암시하고 따뜻한 컬러톤은 모든 일이 순조롭게 
진행되고 있음을 보여줍니다.

각 장소 및 시대 배경에 맞는 뚜렷한 영상룩을 
생성함으로써 색상을 통해 장소와 시간을 
이야기할 수 있습니다. 최종적으로 그레이딩 
작업을 통해 프로젝트 스타일을 구성하고 기억할 
만한 독특한 영상룩을 생성할 수 있습니다.

이번 과에서는 세 종류의 독특한 영상룩을 
구축함으로써 이러한 작업 방식을 익혀볼 
것입니다.

예상 소요 시간

이 과를 학습하는 데는 약 30분 
정도의 시간이 소요됩니다.

학습 목표

흑백 장면 믹싱하기 350

LUT를 사용한 퀵룩 기능 352

블리치 바이패스 생성하기  357

프로젝트에 그레이딩 저장하기 360

복습하기 361
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흑백 장면 믹싱하기
이전 과에서 컬러휠 팔레트로 작업했을 때 채도 조정 컨트롤을 사용했었습니다. 이러한 간단한 
설정으로 컬러 강도를 조정하여 처음 촬영된 컬러보다 훨씬 높게 또는 낮게 설정 가능해 이미지를 
흑백으로 바꿀 수가 있습니다.

컬러 페이지에서는 흑백 이미지로 바꿀 수 있는 방법이 여러 가지 있습니다. 채도 조절 컨트롤을  
0으로 설정하면 흑백으로 바뀌지만, 유연한 조절은 불가능합니다.

RGB Mixer는 흑백 이미지에도 빨강, 초록, 파랑 채널의 강도를 개별적으로 조절할 수 있는 옵션을 
제공하여 매우 극명한 영상 결과를 얻을 수 있습니다. 새로운 버전을 생성하여 직접 이러한 작업을 
실험해 보세요.

1 DaVinci Resolve 15을 실행하고 지금까지 사용해온 Gnarly in Pink 프로젝트를 여세요.

2 Gnarly in Pink 타임라인을 열어 뷰어에 영상을 로딩합니다.

3 타임라인에서 썸네일 29를 선택하세요.

4 툴바에 있는 RGB Mixer 버튼을 클릭하여 RGB 믹서 팔레트를 여세요.

5 팔레트 맨 아래에 Monochrome 확인란을 선택하세요.
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이 확인란을 클릭하면 영상이 흑백으로 변합니다. 빨강, 초록, 파랑에 해당되는 출력 막대 아래에 있는 
다양한 컨트롤 기능으로 밝기를 조절하거나 비활성화할 수 있습니다. 이미지를 Monochrome으로  
설정하면 해당 이미지에 영향을 미치는 빨강, 초록, 파랑 채널만 조절할 수 있습니다.

6 RGB Mixer 빨강 출력 막대를 위로 끝까지 드래그한 다음 맨 아래로 드래그하여 내려보세요.

드래그와 함께 빨간색이 많은 이미지 영역이 변하는 것을 볼 수 있습니다.

뷰어 영상이 어떻게 변하는지 확인하면서 이를 여러 번 반복해보세요.

7 초록 막대와 파랑 막대 출력도 드래그하며 이미지가 어떻게 변화하는지 확인하세요.

컬러 채널을 조절할 때 일부 요소가 얼마나 크게 영향받는지 직접 확인하실 수 있습니다. 빨강 
출력을 조절하면 핑크색 헬멧 색상이 회색에서 흰색으로 변화합니다. 파랑 채널은 주로 하늘 
색상을 더욱 극적으로 만들기 위한 야외 촬영 숏에서 많이 조절됩니다.

8 빨강 출력은 약 -0.45로, 초록 출력은 -1.25로, 파랑 출력은 0.50 정도로 설정하세요.



352
제

13
과

 
창

의
적

인
 영

상
룩

 제
작

하
기

 
9 원하는 영상룩이 완성될 경우 뷰어를 우클릭하고 Grab Still을 선택하면 해당 이미지가 갤러리에 

저장됩니다.

보시다시피 작업하는 이미지의 흑백 버전에는 여러 가지가 있습니다. 컬러의 채도를 완전히 낮춰도 
RGB 채널의 주요한 부분은 제어가 가능합니다. 이러한 기술을 통해 높은 다이나믹 범위를 가진 
흑백 이미지를 신중하게 만들어낼 수 있습니다.

LUT를 사용한 퀵룩 기능
새로 생성한 버전의 이름이 설정되었으므로 LUT를 사용하여 새로운 영상룩을 생성할 수 있습니다. 
언뜻 보기에는 LUT를 클릭하면 이미지의 색상 및 밝기에 영향을 준다는 점에서 프리셋 기능과 매우 
비슷하다고 생각할 수 있습니다. 하지만 LUT는 색영역 변환 및 모니터 보정, 창의적인 영상룩에 
사용할 수 있는 매우 유용한 기능입니다.

게다가 LUT는 픽셀 데이터에 직접 영향을 준다는 점에서 큰 차이가 있습니다. 반면 프리셋은 해당 
색조와 밝기를 기반으로 픽셀이 변화하는 일련의 산출 값을 말하므로 LUT는 소스 이미지의 색조, 
채도, 밝기를 변경하는 방식으로 이미지 속 특정 RGB 설정값을 수학적으로 정확하게 수정하여 
새로운 RGB 설정값을 산출해 냅니다.

LUT 로딩하기
DaVinci Resolve는 바로 사용할 수 있는 다양한 LUT를 제공합니다. DaVinci Resolve와 LUT 워크플로가 
제공하는 장점 중 하나로 커스텀 LUT를 생성하여 다른 컬러리스트와 공유할 수 있는 기능과 서드파티 
개발자가 생성한 LUT를 추가하는 기능입니다.

먼저 서드파티 LUT를 설치해야 합니다. 많이 사용하는 LUT 생성 웹사이트에서 하나의 LUT를 
다운로드했다고 가정해 보겠습니다.

1 File > Project settings를 선택하고 프로젝트 설정에서 Color Management 카테고리를 클릭하세요.

2 Open LUT Folder 버튼을 클릭하세요.

LUT 목록 및 LUT 카테고리 폴더가 담긴 창이 나타납니다.

3 이 창에서 ‘LUT 트레이닝’ 폴더를 새로 생성하세요.
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4 두 번째 파인더(macOS) 창 또는 익스플로러(Windows) 창을 열고 R15 lessons > Lesson 13으로  
이동합니다.

5 Lesson_13 폴더에서 Lesson_13_LUT.cube 파일을 LUT 트레이닝 폴더로 드래그하여 옮기세요.

정보 DaVinci Resolve 15은 DaVinci Resolve .cube 포맷에서 LUT를 생성하고 
사용합니다. 이는 오픈 LUT 포맷으로 간단한 텍스트 에디터에서 기술적인 
정보를 확인할 수 있습니다.

6 DaVinci Resolve를 클릭하고 Color Management 프로젝트 설정창에서 Update Lists를 클릭하세요.

7 이 창에 있는 Save 버튼을 클릭합니다.

이제 LUT가 DaVinci Resolve에 로딩되어 LUT 브라우저에서 사용할 수 있습니다.

서드파티 소스에서 LUT를 다운로드할 시에 주의해야 할 점이 있습니다. 서드파티 LUT를 
적용하면 원래 의도했던 색조와 많이 차이가 나는 경우가 있기 때문에 주로 프로덕션 스튜디오 
내부에서 많이 사용됩니다. 후반 제작 회사들은 자사 작업 환경에 맞도록 정확하게 조절된 LUT를  
제공할 수 있습니다.
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모니터링용 LUT

일반적으로 LUT는 모니터링에 사용됩니다. 카메라로 영상 콘텐츠 캡처 시 영상 신호가 
나타나는 방식을 변경할 수 있습니다. 시네마틱한 비선형 감마 커브를 사용하여 영상 
신호를 캡처할 시에는 HD 모니터에 콘트라스트와 채도가 낮은 칙칙한 이미지가 나타나게 
됩니다. 모니터에 LUT를 적용할 시에 신호가 HD (Rec 709)로 나타나도록 신호를 변환할 
수 있으며 이는 색대비, 컬러, 채도를 더욱 뚜렷하게 나타냅니다. 프로젝트를 위한 특정 
영상룩이 있는 경우 커스텀 LUT를 생성하여 저장한 뒤, Blackmagic Design 카메라에 
업로딩하면 최종 영상룩과 비슷한 영상을 모니터로 확인하면서 촬영을 진행할 수 있습니다. 

카메라에 적용된 모니터링 LUT 기능은 캡처한 영상을 바꾸지는 않습니다. 이는 카메라 
뷰어에 나타나는 이미지에만 영향을 끼칩니다. 이 영상을 DaVinci Resolve로 옮기면 전체 
그레이딩 작업이 가능한 영상으로 사용하실 수 있습니다.

LUT 적용하기
LUT는 컬러 픽셀 데이터를 나타내는 방식을 신속하게 재측정하는 기능으로 다른 형태의 그레이딩을 
제공합니다. DaVinci Resolve에 LUT 설치가 완료되면 쉽고 편리하게 적용할 수 있습니다.

1 Color > Reset > All Grades and Nodes를 선택하면 빈 슬레이트가 나타납니다.

2 타임라인에서 썸네일 29를 선택하세요.

3 사용자 인터페이스 툴바 왼쪽 상단에 있는 LUTs 버튼을 누르면 LUT 브라우저가 나타납니다.

4 LUT 브라우저에서 LUT 트레이닝 카테고리를 선택합니다.

브라우저 속 LUT 썸네일 위로 마우스 포인터를 움직이면 모든 LUT를 미리보기할 수 있습니다.

5 브라우저에서 Lesson 13 LUT 썸네일에 마우스 포인트를 앞뒤로 움직이면 LUT를 미리보기할 
수 있습니다.

6 LUT 썸네일을 우클릭하고 Apply LUT to Current Node를 선택하세요.
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이제 해당 LUT가 적용되었습니다. LUT는 클립의 영상룩을 변경합니다. 갤러리 프리셋과 
마찬가지로 LUT 사용을 시작하여 클립의 그레이딩 작업을 계속 이어갈 수 있습니다.

정보 LUT는 하나의 노드에 나타나는 클립의 모습을 변경합니다. 노드 같은 
구조가 없으며 키와 매트처럼 세컨더리 그레이딩을 사용하지 않습니다.

7 node 01을 우클릭하고 메뉴에서 Add Node > Add Serial을 선택하거나 [Option+S] 키(macOS) 
또는 [Alt+S] 키(Windows)를 누르세요.

8 조정 컨트롤에 있는 콘트라스트 입력란을 드래그하여 콘트라스트를 약간 높입니다.

9 컬러휠 팔레트에서 Offset 휠을 노란색/주황색 방향으로 드래그하여 따듯한 분위기를 연출하세요.
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LUT 효과는 대개 사용하는 영상과 모니터와의 호환성에 의해 결정됩니다. LUT를 통해 의도한 
영상을 연출하려면 반드시 같은 종류의 카메라 모델에서 생성한 영상에 이를 적용하고 똑같이 
보정된 모니터를 사용해야 합니다. 같은 카메라와 모니터를 사용하지 않을 경우 의도한 LUT 
영상을 얻지 못하는 경우도 있습니다.

LUT 저장하기
일부 LUT의 커스텀 작업이 완료되면 나중에 다시 사용할 수 있도록 저장하는 것이 좋습니다. 
갤러리에 이를 저장하는 대신 LUT 브라우저에 저장해 보겠습니다.

1 썸네일 29를 우클릭하고 Generate 3D LUT (CUBE)를 클릭하세요.

2 새 이름으로 저장 입력란에 ‘Cold Air LUT’라고 입력한 뒤, LUT 트레이닝 폴더에 저장하세요.

3 Save를 클릭합니다.

이제 픽셀 컬러 데이터의 환경설정을 기반으로 한 LUT가 생성되었습니다. 제대로 생성되었는지 
확인하려면 노드 그래프에서 LUT 접속이 가능한지 확인하세요.

4 LUT 브라우저에서 LUT 트레이닝 카테고리를 마우스로 우클릭하고 Refresh를 선택하세요.

LUT 브라우저에 방금 생성한 LUT가 나타납니다.

이번 작업에서는 LUT를 사용해 클립의 영상룩을 생성해 보았습니다. 하지만 DaVinci Resolve  
15에서는 다양한 영상 처리 워크플로의 일부분에 LUT 기능을 사용할 수 있습니다. LUT는 모든 
클립과 모든 타임라인 출력, 뷰어, 비디오 모니터에 추가하여 사용할 수 있습니다.
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블리치 바이패스 생성하기 
이번에는 같은 숏에 블리치 바이패스(Bleach Bypass) 효과를 생성해 보겠습니다.

간혹 실버 리텐션(Silver Retention) 또는 ENR이라고도 불리는 블리치 바이패스 프로세스는 낮은 
채도와 높은 콘트라스트를 제공합니다. 이는 블리칭 과정을 건너뛰는 필름 현상 과정에서 유래된 
용어입니다. 이 효과는 <레즈>, <라이언 일병 구하기>, <세븐> 같은 많은 TV 프로그램 및 영화에서 
볼 수 있습니다.

1 Color > Reset > All Grades and Nodes를 선택하세요.

블리치 바이패스 영상룩은 낮은 색 채도를 사용하므로 마스터 컬러휠 아래 있는 컨트롤을 
사용해 채도값을 낮춥니다.

2 컬러휠 팔레트의 조정 컨트롤을 사용하여 채도값을 20으로 낮추세요.

지금까지는 커스텀 커브를 블랙/화이트 포인트와 색 균형을 조정하는 데만 사용해 왔습니다. 
블리치 바이패스 영상룩에는 커스텀 커브를 사용하여 콘트라스트를 높여보겠습니다.

툴바에서 커스텀 커브 버튼을 클릭하여 팔레트에 나타나도록 합니다.

커스텀 커브에 두 개의 포인트를 추가하는 방식으로 콘트라스트 값을 높일 수 있습니다. 여기서 
하나의 포인트는 낮은 섀도우 영역에 다른 하나는 높은 하이라이트 영역에 추가합니다.

3 커스텀 커브 라인에서 윗부분 3분의 1 정도에 해당하는 곳에 섀도우 조절을 위한 포인트를 
추가하세요.
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4 커스텀 커브 라인에서 아랫부분 3분의 1 정도에 해당하는 곳에 하이라이트 조절을 위한 포인트를 
추가하세요.

5 낮은 곳에 있는 컨트롤 포인트를 아래 첫 번째 그리드 라인으로 드래그하여 섀도우 값을 더욱 
진하게 합니다.

6 높은 곳에 있는 컨트롤 포인트를 위쪽 첫 번째 그리드 라인으로 드래그하여 하이라이트 값을 
더욱 높게 하세요.
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7 뷰어를 우클릭하고 Grab Still을 선택합니다.

 � 두 개의 포인트를 움직여 S자 모양으로 만들면 숏에 콘트라스트를 추가할 수 있고 낮은 
채도와 함께 간단한 블리치 바이패스 효과를 만들어낼 수 있습니다.

가색 이해하기

무지개 색깔을 모두 하나로 섞으면 무슨 색이 나올까요?

어떤 사람은 프리즘에서 빛이 굴절되는 것을 생각하고 모든 컬러를 합치면 흰색이 나올 
거로 생각할 수 있습니다. 어떤 사람은 페인트 팔레트에서 모든 색을 섞으면 나오는 것처럼 
어두운 진흙같이 될 거로 생각할 수도 있죠. 하지만 이에 대한 정답은 컬러를 가산혼합하는지 
감산혼합하는지에 따라 달라집니다. 가산혼합은 페인트와 프린트 매체에 사용되며 
감산혼합은 햇빛과 무대 조명, 컴퓨터 화면과 같은 빛을 기반으로 한 매체에 사용됩니다.

그레이딩은 컴퓨터 화면에서 이루어지기 때문에 가산혼합 시스템을 사용하지만, 그레이딩 
작업에서는 감산혼합 시스템의 컬러 디자인 방식을 생각하면 됩니다. 

예를 들어 감산혼합 공간에서 보색은 미적으로 보기 좋은 색채 배합을 제공하므로 이러한 
보색을 사용하여 원하는 영상룩을 생성하게 됩니다. 하지만 그레이딩 작업에서는 가산혼합 
컬러휠을 사용해 보색을 혼합하면 색상이 서로 중화됩니다. 노란색에 파란색을 추가하면 
흰색으로 되거나 다양한 회색이 나타나게 됩니다. 이는 색보정 워크플로에 있어 매우 중요한 
원칙입니다.
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프로젝트에 그레이딩 저장하기
새로운 프로젝트를 작업할 때 이전에 작업한 그레이딩을 불러오는 경우가 많습니다. 일반적으로 
시리즈물을 작업하는 경우 다음 편 작업할 때 이전과 비슷한 스타일의 영상룩을 사용하곤 합니다. 
또는 직접 생성한 특정 그레이딩이 마음에 들어 반복해서 사용하려는 경우도 있죠.

이전 작업에서는 스틸 갤러리를 사용하여 그레이딩을 저장하였는데요, 이번에는 갤러리에서 여러 
프로젝트에 걸쳐 그레이딩을 공유할 수 있는 방법을 알아보도록 하겠습니다.

1 인터페이스 왼쪽 상단에 있는 Gallery 버튼을 눌러 갤러리 페이지로 되돌아갑니다.

2 갤러리 페이지 왼쪽 상단에 있는 스틸 앨범 모양의 아이콘을 클릭하세요.

정보 스틸 목록이 너무 좁아 잘 읽을 수 없는 경우 분할 바를 오른쪽으로 
드래그하여 공간을 넓히세요.

패널 목록에서 PowerGrade 1 폴더를 찾을 수 있습니다. 이 폴더는 일반 폴더처럼 파일 저장이 
가능하지만, PowerGrade 폴더는 시스템 속 모든 프로젝트에서 공유되는 폴더입니다.

3 스틸 앨범에서 스틸 이미지 하나를 드래그하여 PowerGrade 앨범 아래로 옮기세요.

다음 프로젝트를 열면 컬러 페이지에 해당 그레이딩이 저장되어 나타납니다.

색상 이론을 이해하고 나면 컬러 그레이딩 기술을 사용하여 다양한 영상룩을 조합시킬 수 있습니다. 
LUT의 사용을 활용하거나, 직접 생성한 LUT를 엑스포트하여 다른 직원과 공유할 수도 있습니다. 
그레이딩 스틸 이미지를 저장해가며 작업하면 이전 버전의 클립을 신속하게 전환하여 확인 및 
승인할 수 있습니다.
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복습하기
1 이미지의 채도를 낮추는 것과 RGB 믹서로 흑백을 적용하는 것의 차이는 무엇인가요?

2 컬러 페이지에서 노드 합치기 기능은 색보정을 혼합합니다. T(진실) 또는 F(거짓)로 답하세요.

3 DaVinci Resolve 15에서 LUT가 저장된 하드 드라이브의 디렉토리를 어떻게 찾을 수 있나요?

4 컬러 페이지에서 노드 편집기에 노드를 추가하는 방법은 무엇인가요?

5 컬러 페이지에서는 콘트라스트 조절에 커스텀 커브만 사용할 수 있습니다. 커스텀 커브를 
사용하여 화이트 포인트 또는 블랙 포인트를 조절할 수 있습니다. T(진실) 또는 F(거짓)로 답하세요.
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정답
1 이미지의 채도를 낮추면 빨강, 초록, 파랑의 채도값 또한 똑같이 낮아집니다. RGB 믹서를 흑백으로 

설정하면 빨강, 초록, 파랑 채널의 밝기가 개별적으로 조절되어 흑백 이미지가 생성되므로 조절 
범위가 넓은 흑백 영상을 얻을 수 있습니다.

2 F. 노드 합치기 기능은 Fusion 페이지에서만 사용할 수 있으며 이미지 합성에 사용됩니다.

3 LUT가 저장된 장소를 찾으려면 프로젝트 설정의 Color Management 섹션에 있는 Open LUT 
폴더를 사용합니다.

4 컬러 페이지에 노드를 추가하려면 Color > Nodes > Add Serial node를 선택하거나, 노드 
편집기에 있는 노드를 우클릭하고 Add Node > Add Serial node를 선택하거나, [Option+S] 키
(macOS) 또는 [Ctrl+S] 키(Windows)를 누릅니다. 

5 F. 컬러 페이지에서는 커스텀 커브를 사용하여 블랙 포인트와 화이트 포인트를 조절할 수 있을 
뿐 아니라 콘트라스트 또한 조절할 수 있습니다.
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최종 프로그램 
딜리버리하기 

모든 사람의 워크플로가 각기 다르므로 Deliver 
페이지는 저해상도 편집 프록시부터 고화질의 
마스터 파일에 이르기까지 여러 가지 형태로 
출력을 생성할 수 있도록 지원합니다. 같은 
프로젝트에 있는 여러 개의 파일을 다양한 
해상도, 압축 포맷, 데스티네이션으로 동시에 
렌더링할 수 있습니다. Deliver 페이지에서 
제공하는 수많은 옵션을 보고 사용이 어렵다고 
생각하실 수 있는데요, 사실 그렇지 않습니다.

이번 과에서는 Deliver 페이지에서 고화질의 웹 
스트리밍 파일을 위한 출력과 시각 효과 작업 
파일 생성을 위한 커스텀 출력인 두 개의 다른 
출력을 생성해 볼 것입니다.

예상 소요 시간

이 과를 학습하는 데는 약 20분 
정도의 시간이 소요됩니다.

학습 목표

웹 스트리밍 파일 생성하기 364

커스텀 프리셋 생성하기 370

복습하기 373
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웹 스트리밍 파일 생성하기
홍보물을 포함한 거의 모든 프로젝트가 어떤 형태로든 웹 스트리밍 서비스로 딜리버리됩니다. 
DaVinci Resolve 15은 가장 많이 사용하는 파일 기반의 출력 포맷으로 출력할 수 있도록 사용자가 
선택한 출력 타입으로 모든 파라미터가 자동 설정되는 간단한 셋업과 프리셋을 제공합니다.

1 DaVinci Resolve에서 이전에 작업한 Age of Airplanes 프로젝트를 여세요.

2 Rough Cuts 빈에서 Fairlight 타임라인을 더블 클릭하여 타임라인 창에 영상을 로딩하세요.

지금 보이는 타임라인에서 Deliver 페이지 출력을 준비할 것입니다.

3 DaVinci Resolve 화면 맨 아래에 있는 Deliver 버튼을 눌러 해당 페이지를 엽니다.

Deliver 페이지는 5개 영역으로 구성되어 있습니다.

툴바를 사용하여 테이프 영상을 선택하거나 파일 기반의 출력을 위한 Render Settings를 
조절합니다. 기본 설정으로 선택되어 있는 Render Settings에서 출력 환경 설정을 위한 렌더링 
프리셋을 선택할 수 있습니다.

툴바 버튼은 파일 렌더링과 테이프 
출력 사이를 전환합니다.

뷰어에는 선택한 타임라인 
영상이 나타납니다.

Render Queue는 렌더링을 
기다리는 모든 작업을 포함합니다.

출력 포맷은 Render Settings에서  
설정합니다.

타임라인은 출력하는 타임라인을  
그래픽으로 표현합니다.
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4 Render Settings 상단에 있는 Vimeo 프리셋을 클릭하세요.

프리셋을 선택하면 DaVinci Resolve의 Render Settings가 데스티네이션 요구에 맞게 컨폼된 
파일을 출력하도록 설정됩니다. 여기서 작업을 멈추고 파일을 출력할 수도 있습니다. 출력 파일의 
데스티네이션만 설정하면 모든 파라미터 설정이 완료됩니다.

5 프리셋 아래 있는 Browse 버튼을 누르고 출력 파일의 위치를 선택한 다음 OK를 클릭하세요.

파일 출력에 필요한 설정을 마쳤지만, 프리셋에 적용 가능한 옵션을 다양하게 사용할 수 
있습니다. 스트리밍 파일 생성에 유용한 여러 옵션에 대해 알아보겠습니다.

6 Browse 버튼 아래에 있는 Video 탭을 클릭하면 비디오 관련 옵션이 나타납니다.

Video 탭에서 비디오 압축 및 포맷 파라미터를 사용자 지정할 수 있지만, 간단한 프리셋을 
선택하여 대부분 기본 설정을 작업에 맞게 최적화시킬 수 있습니다.

Vimeo 프리셋을 선택하면 웹 스트리밍 영상에 가장 많이 사용되는 파라미터를 지원하는 
QuickTime H.264가 포맷 및 코덱으로 선택됩니다. 프리셋은 또한 해상도와 프레임 속도 메뉴를 
현재 타임라인 설정에 맞게 설정합니다.



366
제

14
과

 
최

종
 프

로
그

램
 딜

리
버

리
하

기
 

비트 레이트 또는 데이터율 설정은 사용하려는 스트리밍 서비스에 따라 권장값이 달라집니다. 
예를 들어, 기본 설정값인 10000 kbs (10 Mbps) 레이트는 Vimeo 720p 비디오에서 최댓값이지만, 
다른 서비스에서 사용하기에는 너무 높을 수 있습니다. 일부 다른 웹 스트리밍 서비스에서 허용 
가능한 성능을 고려하여 비트 레이트를 약간 낮추도록 하겠습니다.

7 아래로 스크롤하여 Quality Kb/s 영역에서 Restrict to를 선택하고 설정 값은 7500 Kb/s로 
입력하세요.

싱글 패스 인코딩 또는 멀티 패스 인코딩을 수행할 수 있는 옵션도 있습니다. 대부분의 경우 
멀티 패스 인코딩을 사용합니다. 멀티 패스 인코딩은 첫 번째 패스를 사용하여 이미지에 관한 
정보를 수집한 뒤, 다음번 패스를 사용하여 효과적으로 프레임을 인코딩하며 프레임 속 움직임을 
기준으로 최적의 비트 수를 선택합니다. 가장 효과적인 방법 같지만, 싱글 패스를 선택하는 
주된 이유는 바로 시간을 절약하기 위해서입니다. 멀티 패스 인코딩은 싱글 패스 인코딩 방식보다 
두 배 또는 세 배의 처리 시간이 소요됩니다.

지금 작업하는 것은 단편 영상이므로 멀티 패스를 선택하겠습니다.

8 Passes 메뉴에서 Multiple을 선택하세요.

Encoding Profile에서 다른 설정 그룹으로 변경 가능하지만, 보통 기본 설정된 오토 프로필로 
작업을 시작하는 것이 좋습니다. 해당 영상이 어떤 장치에서 재생될지 알고 있는 경우에는 
Encoding Profile을 변경하는 것이 좋습니다. iPhone 또는 Android로 바로 전송하는 경우에는 
이 기기에 맞게 소비 전력이 낮은 베이스라인을 뜻하는 Base로 인코딩 프로필을 설정합니다. 
Vimeo에 업로딩하는 경우에는 이 영상이 원래 블루레이 디스크를 위한 디지털 포맷으로 
생성되었기 때문에 High를 선택합니다. High를 선택하면 가장 최상의 화질을 얻을 수 있지만, 
파일 크기가 크기 때문에 파일 디코딩 시 더 높은 컴퓨터 성능이 요구됩니다.

9 Encoding Profile 메뉴에서 High를 선택하세요.
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모든 비디오 설정이 완료되면 Audio 탭으로 넘어가세요.

10 Browse 버튼 아래에 있는 Audio 탭을 클릭하면 오디오 관련 옵션이 나타납니다.

일반적으로 QuickTime H.264 파일의 오디오는 대부분의 웹사이트에서 오디오 스트리밍에 
사용하는 AAC 압축 코덱을 사용합니다. 하지만 여기서 제공하는 몇 가지 옵션 사항으로 설정을 
선택할 수 있습니다.

Bit Rate Strategy 설정에서는 고정 비트레이트(Constant Bit Rate)와 가변 비트레이트(Variable 
Bit Rate)를 설정할 수 있습니다. 고정 비트레이트는 전체 오디오 파일에 걸쳐 고정된 비트레이트를 
제공합니다. 이 설정은 비트레이트가 예측 가능하기 때문에 주로 스트리밍 미디어 웹사이트 및 
팟캐스트 가이드라인에서 사용됩니다. 가변 비트레이트는 같은 품질의 오디오를 작은 파일로 
만들기 위해 데이터를 축소하는 인코딩 방식이며 비트레이트의 값이 상황에 따라 아주 
다양해집니다. 세 번째 옵션은 두 가지 비트레이트의 장점만 제공하는 방식이라 할 수 있습니다. 
Variable Bit Rate Constrained 옵션은 고정 비트레이트처럼 최대 목표 비트레이트 값(Kbps)을 
설정해 놓고 그 한도 내에서 가변 비트레이트의 효율성을 제공합니다.

11 Bit Rate Strategy 메뉴에서 Variable Bit Rate Constrained를 선택하세요.

이제 오디오와 비디오 인코딩 설정이 완료되었으니 출력할 파일명을 입력하세요.

12 Browse 버튼 아래 있는 File 탭을 클릭하면 이름 설정 옵션이 나타납니다.

13 Custom name 입력란에 ‘스트리밍용 트레이닝 영상’이라고 입력하세요.

Deliver 페이지에서 가장 간단한 작업을 수행하는 탭입니다. 파일을 출력하기 전에 한 가지만 
더 추가하도록 하겠습니다.
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워터마크 추가하기
타이틀과 비슷한 텍스트 기반의 워터마크를 영상 위에 오버레이하여 추가할 수 있습니다. 대부분의 
경우 워터마크는 영상 위에 ‘배포금지’라는 문구를 추가하거나, 타임코드를 추가하는 데 사용합니다. 
워터마크는 컬러 페이지에 있는 Data burn-in 컨트롤을 사용해 생성 및 포맷됩니다.

1 Render Settings 상단에 있는 Video 탭을 클릭하세요.

2 아래로 스크롤하여 Advanced settings 옆에 있는 화살표를 누르면 메뉴가 감춰집니다.

3 Data burn-in 메뉴를 Same as proejct로 설정하세요.

번인 컨트롤은 모든 페이지에서 접속할 수 있습니다.

4 Workspace > Data Burn-In을 클릭하면 Data Burn-In 창이 나타납니다.

데이터 번인 창 왼쪽에는 비디오 오버레이에 사용할 수 있는 데이터 종류 목록이 나타납니다. 
해당 확인란을 선택하여 활성화합니다.

5 번인 데이터 목록에서 Record Timecode 확인란을 선택하면 출력 영상 파일 위에 녹화 
타임코드가 오버레이됩니다.
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6 Custom Text1 확인란을 선택하여 워터마크 텍스트를 추가하세요.

7 Custom Output Text 입력란에 ‘배포금지’를 입력하세요.

8 Size 슬라이더를 오른쪽을 드래그하여 텍스트 크기를 55로 키우세요.

Data burn-In 설정에서 만들어지는 모든 변경 사항이 뷰어에 적용되어 나타납니다. 이제 Vimeo 
파일로 출력한 준비가 완료되었습니다.

9 번인 창을 닫고 Deliver 페이지로 되돌아가세요.

10 Render Settings 페이지 아래에 있는 Add to Render Queue 버튼을 클릭하세요.

해당 작업이 오른쪽 Render Queue로 옮겨집니다.
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Render Queue는 DaVinci Resolve에서 출력하려는 작업을 임시로 보관하는 공간입니다. Render 
Queue에 원하는 만큼의 작업을 추가할 수 있습니다. 파일을 바로 렌더링할 수도 있지만, 대기열에 
추가할 다른 작업을 준비해 보도록 하겠습니다.

커스텀 프리셋 생성하기
어떤 상황에서는 다른 사람이 작업할 수 있도록 타임라인 일부만을 렌더링해야 하는 경우가 있는데요. 
모션 그래픽을 받아야 하거나, 시각 효과에 통합해야 하는 클립이 있는 경우 타임라인의 한 부분을 
특정 포맷으로 렌더링할 필요가 있습니다.

특수 효과 기술자가 요구하는 포맷으로 타임라인의 한 부분을 렌더링해 보겠습니다. 이들은 고화질의 
렌더링을 요구하지만 DaVinci Resolve는 시각 효과 프리셋을 지원하지 않기 때문에 직접 프리셋을 
생성하고 나중에 사용할 수 있도록 이를 저장합니다.

1 Render Settings 상단에 있는 Custom 탭을 클릭하세요.

Custom을 클릭하면 Render Settings의 모든 설정 옵션을 사용할 수 있고 새로운 프리셋 생성을 
시작합니다. 먼저 타임라인에 있는 모든 클립을 개별적인 파일 또는 하나의 단일 파일로 렌더링할 
것인지 결정합니다.

2 설정 맨 위에 Single Clip 버튼을 클릭하면 하나의 영상 파일로 출력됩니다.

3 Video 탭을 클릭하고 Format 메뉴에서 EXR을 선택하세요.

EXR은 시각 효과 스튜디오에서 주로 요구하는 TIFF 같은 단일 파일 포맷입니다.

시각 효과 제공에 이러한 파일 포맷이 필요하기 때문에 워터마크 기능은 비활성화합니다.

4 Data Burn-In 메뉴로 스크롤 한 다음, None을 선택하세요.
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번인 기능이 비활성화되었어도 뷰어에 오버레이는 계속 나타납니다.

EXR 파일에는 오디오 트랙이 없기 때문에 Audio 탭은 건너뛰고 File 탭으로 넘어가세요.

5 File 탭을 클릭하여 파일명을 입력하세요.

6 Custom name 입력란에 Airplane VFX라고 입력합니다.

각각의 프레임이 EXR 파일로 출력되므로 시각효과 아티스트가 프레임 순서를 알 수 있도록 
프레임에 숫자를 입력합니다.

7 Use # digits in the filename에 숫자 4를 입력하세요.

이 숫자는 각 파일명 끝에 추가됩니다. 1000 프레임이 넘는 숏은 없으므로 많아야 4자리 숫자를 
사용하게 됩니다.

8 Each clip starts at frame 확인란을 선택하고 뒤의 숫자 입력란에 001을 입력하세요.

다음으로는 타임라인에서 한 개의 숏만 VFX 직원에게 전달할 것이기 때문에 렌더링하려는 
범위를 표시해야 합니다.

9 Deliver 페이지 타임라인에서 08_SOUTH_POLE_DC3 클립 위에 플레이헤드를 움직이세요.

10 Mark > Mark Clip을 선택하거나 [X] 키를 눌러 South Pole 클립 주변에 인/아웃 포인트를 
추가하세요.
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타임라인에 표시된 마크는 렌더링하려는 영역을 나타냅니다. 이제 이러한 설정을 자신이 직접 
제작한 VFX 프리셋에 저장할 수 있습니다.

11 Render Settings 상단에 있는 Options > Save as New Preset을 선택하세요.

12 Enter preset name 입력란에 VFX 출력이라고 입력한 뒤, OK를 클릭하세요.

새로운 프리셋 이름이 Render Settings 상단에 나타나 현재 사용 중인 설정을 확인할 수 
있습니다. 이는 프리셋 행에도 나타납니다.

모든 설정이 완료되면 Render Queue에 해당 작업을 추가합니다.

13 Render Settings 페이지 아래에 있는 Add to Render Queue 버튼을 클릭하세요.

이제 두 개의 작업이 추가되었습니다. DaVinci Resolve를 저장하고 종료한 뒤, 다시 작업을 
시작하면 Render Queue에 추가된 작업은 그대로 남습니다. 이번 작업으로 남아있는 디스크 
공간을 전부 써버릴 수는 없기 때문에 렌더링 작업은 하지 않겠습니다.



373

복
습

하
기

14 실제 프로젝트에서 Render Queue에 있는 작업을 렌더링할 경우에는 원하는 아이템을 선택합니다. 
Render Queue 아래 있는 Start Render 버튼을 누르면 렌더링이 시작됩니다. 작업이 하나씩 
렌더링되고 작업 완료가 표시됩니다.

15 이번에는 Render Queue에 있는 작업을 삭제하는 방법을 알아보도록 하겠습니다. 
 Render Queue 오른쪽 상단에 있는 팝업 메뉴를 클릭하세요.

16 메뉴에서 Clear All을 선택하면 현재 추가된 모든 작업이 삭제됩니다.

Deliver 페이지에서는 이 외에도 다양한 파일 포맷을 출력하고 다양한 워크플로를 지원하는 
옵션이 제공되지만, 여기서는 가장 많이 사용되는 워크플로와 커스텀 프리셋을 직접 설정하는 
방법을 알아보았습니다.

복습하기
1 DaVinci Resolve 15에서 영상에 워터마크를 추가하는 방법은 무엇인가요?

2 DaVinci Resolve의 Deliver 페이지에서 프리셋을 사용할 수 있는 두 가지의 온라인 서비스는 
무엇인가요?

3 온라인 서비스 출력과 기타 비선형 편집 프로그램 출력의 가장 큰 차이점은 무엇인가요?

4 직접 만든 커스텀 프리셋을 Deliver 페이지 어디에 저장할 수 있나요?

5 Render Settings를 조절한 뒤에 Resolve에서 프로젝트 출력을 하려면 어떻게 해야 하나요?



374
제

14
과

 
최

종
 프

로
그

램
 딜

리
버

리
하

기
 

정답
1 Workspace > Data Burn In을 선택합니다.

2 Deliver 페이지의 Render Settings에서 프리셋을 사용할 수 있는 온라인 서비스로는 YouTube와  
Vimeo가 있습니다.

3 온라인 서비스로 출력할 경우 단일 파일이 생성됩니다. 다른 편집 시스템으로 출력할 경우에는 
XML, AAF, EDL 포맷의 데이터 파일이 생성되며 각각의 타임라인 편집을 위한 미디어 파일도 
개별적으로 생성됩니다.

4 Deliver 페이지에 커스텀 프리셋을 저장하려면 Render Settings 오른쪽 상단에 작은 점으로 
표시된 옵션 메뉴를 선택하고 Save As New Preset을 선택하세요.

5 렌더링 작업을 선택하려면 Render Queue 버튼을 클릭한 다음 Render Queue 패널에서 Start 
Render를 클릭하세요.
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미디어와 
데이터베이스 
관리하기
다른 대부분의 편집/오디오 믹싱/컬러 그레이딩 
소프트웨어와는 달리 DaVinci Resolve 15은 산업 
표준 데이터베이스를 사용하여 모든 프로젝트, 
빈, 클립, 타임라인을 저장합니다. 기본적으로 
오디오나 비디오 미디어 파일이 아닌 모든 
아이템이 데이터베이스에 저장됩니다. 그 결과 
DaVinci Resolve는 한 시스템에서 다른 
시스템으로 프로젝트를 이동하거나, 백업 
프로젝트 생성 시 이를 약간 다르게 운영합니다. 
더욱 복잡해지는 것이 아니라 훨씬 간단한 다른 
방법입니다.

이번 과에서는 프로젝트와 미디어를 백업하고 
이동하는 방식 뿐만 아니라 DaVinci Resolve 
데이터베이스를 관리하는 방법을 배워볼 겁니다.

예상 소요 시간

이 과를 학습하는 데는 약 20분 
정도의 시간이 소요됩니다.

학습 목표

미디어 통합하기 376

새로운 하드 드라이브에 프로젝트 
및 미디어 복사하기  378

DaVinci Resolve 데이터베이스 작업하기 380

복습하기 383
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미디어 통합하기

참고 다음 예제에서는 두 번째 하드 드라이버를 사용하여 미디어를 통합해 
보겠습니다. 이번 프로젝트에서는 이 작업을 수행하는 것을 권장하지 않지만, 처리 
과정을 이해하기 위해 다음 설명을 읽어두는 것이 좋습니다.

데이터베이스 관리를 알아보기 전에 실제 미디어 관리에 대해 이야기해 보겠습니다.

거의 대부분의 프로젝트에는 미디어 관리가 필요합니다. 예를 들어 한 드라이브에서 다른 드라이브로 
미디어를 복사하거나, 파일을 다른 포맷으로 변경하는 간단한 작업일 수도 있습니다. 미디어 매니저는 
DaVinci Resolve에서 이런 작업을 수행하는 하나의 도구이며 미디어 복사, 이동, 통합에 사용할 수 
있습니다.

사용하는 드라이버에 완성된 원본 미디어 복사본을 저장할 수 없을 경우 통합 기능을 사용하여 
프로젝트에서 사용하지 않는 미디어를 삭제함으로써 이를 해결할 수 있습니다. 미디어 매니저의 
통합 기능을 사용하여 이미 사용 중인 미디어만 복사할 수 있습니다. 미디어가 많은 긴 프로젝트에서 
통합 기능을 사용하면 디스크 여유 공간을 확보하고 신속하게 백업 프로젝트를 만들 수 있습니다.

미디어 매니저는 프로젝트 안에서만 사용할 수 있으므로 Project Manager에 있는 멀티카메라 
프로젝트를 열어보겠습니다.

1 Age of Airplanes 클립이 열려있는 상태에서 Media 페이지 버튼을 클릭하고 미디어 풀에 있는 
Rough Cuts 빈을 클릭하세요. 전체 타임라인을 선택하세요.

2 File > Media Management를 선택합니다.

Media Management 창에서 Timelines를 선택합니다.

3 Copy 버튼을 클릭하세요.
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Copy를 선택하면 휴대용 드라이버에 저장된 미디어 파일 세트 복사본이 생성되고 원본 파일은 
원래 있던 곳에 그대로 있습니다.

4 Browse 버튼을 클릭하고 File Destination 창에서 미디어를 복사하려는 장소를 지정하세요. 
OK를 클릭합니다.

정보 Add New Folder 버튼을 클릭하면 생성하려는 통합 파일을 위한 폴더를 
새로 생성할 수 있습니다. 하드 드라이버의 최상위 디렉토리에 너무 많은 파일이 
생성되어 있으면 어떤 파일을 사용하고 삭제할지 알기 힘들 수 있습니다.

미디어 통합 옵션을 사용할 경우 어떤 파일을 유지할 것인지 결정하기 위해 하나 또는 여러 
개의 타임라인을 선택해야 합니다. 미디어 통합에는 두 가지 방식이 있습니다. 사용해 온 클립이 
있는 전체 타임라인을 복사하거나, 타임라인에서 핸들을 포함한 일부 사용 클립 부분만 복사하는 
방식입니다.

5 ‘Copy and trim used media keeping’을 선택하세요.

이 옵션을 선택하면 선택한 타임라인에서 사용한 클립 부분만 마스터 클립 파일로 트리밍됩니다.  
추후에 트리밍 또는 트랜지션 생성에 필요할 경우 클립 양면에 추가할 프레임 핸들 수를 입력하는 
입력란이 있습니다.

정보 H.264 같은 시간적 압축 방식의 인터프레임을 사용하는 압축 포맷에는 
Media Management 창의 ‘Trim unused media’ 옵션을 사용합니다.

6 프레임 핸들 추가 설정값으로 12를 입력하세요. 프로젝트가 초당 23.979 프레임으로 운영되고 
있기 때문에 이 설정값을 입력하면 클립 앞/뒤에 트리밍과 트랜지션을 위한 0.5초짜리 추가 
미디어가 활성화됩니다.

7 More Options를 클릭하면 더욱 다양한 설정을 볼 수 있습니다.
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8 ‘Relink to new files’를 선택하면 기존 미디어 대신 타임라인에 새롭게 복사된 미디어를 사용합니다.

이 작업을 완성하려면 Start 버튼을 클릭하여 미디어 통합을 시작하면 되지만, 여기서는 아직 작업을 
시작하지 않겠습니다.

통합 작업 과정을 시작하면 먼저 타임라인에 사용된 파일이 데스티네이션 드라이브로 복사되며 
그런 다음에 트리밍됩니다. 이는 현재 사용 중인 클립 범위와 클립 앞/뒤에 0.5초짜리 핸들 부분만 
디스크에 저장하기 위함입니다.

이제 빈에는 짧아진 새 미디어 파일이 연결된 클립이 저장되지만 모든 원본 클립은 본래 위치에 
그대로 저장됩니다. 이러한 원본 클립은 더 이상 필요하지 않다는 확신이 들 때 삭제할 수 있습니다.

새로운 하드 드라이브에 프로젝트 
및 미디어 복사하기 
미디어 통합을 통해 저장 공간을 최대한 확보할 수 있지만 이는 미디어에만 해당합니다. 사용하는 
타임라인과 클립, 메타데이터는 여기에 포함되지 않습니다. 단일 프로젝트와 프로젝트에 담긴 모든 
영상을 다른 컴퓨터에 복사, 백업, 이동할 수 있는 가장 간단한 방식은 DaVinci Resolve의 아카이브 
및 복원 기능을 사용하는 것입니다. 프로젝트를 아카이빙하면 다른 드라이브에 저장된 파일을 
포함한 모든 파일을 수집하고 이를 사용자가 선택한 데스티네이션 폴더에 프로젝트 파일과 함께 
저장할 수 있습니다. 프로젝트 아카이빙은 Project Manager 창에서 수행할 수 있습니다.

참고 아래 수행할 작업은 두 번째 하드 드라이브를 사용하여 미디어를 복사하고 
트랜스코딩하는 작업입니다. 두 번째 하드 드라이버가 없거나 미디어 트레이닝용 
미디어를 복사하고 이동하는데 디스크 공간을 낭비하고 싶지 않더라도 아래 설명을 
읽고 작업 방식을 숙지하는 것이 좋습니다.
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1 Project Manager를 열고 Age of Airplanes 프로젝트 썸네일을 마우스로 우클릭한 다음,  
Archive를 선택하세요.

2 Archive 창이 나타나면 프로젝트를 저장할 드라이브로 이동한 다음 Save를 클릭하세요.

모든 미디어 및 프로젝트 파일이 .dra 확장자를 가진 폴더에 복사됩니다. 이 폴더에는 다른 
컴퓨터에서 프로젝트를 여는데 필요한 모든 것이 포함되어 있습니다.

원본 미디어는 본래 위치에 저장되어 있어 안심할 수 있으며 두 세트의 미디어는 완벽하게 
동일합니다. 원본 미디어 파일을 삭제 할지 또는 나중에 작업 할지는 사용자의 결정에 
달려있습니다.

아카이브 폴더를 다른 컴퓨터에 복사할 경우 반드시 DaVinci Resolve에 복구한 다음 작업을 
시작해야 합니다.

참고 컴퓨터 아카이브에 폴더에서 프로젝트를 이미 가져왔기 때문에 다음에 
나오는 작업 절차는 교육을 위한 설명일 뿐 따라하지 않으셔도 됩니다.

3 아카이브 프로젝트를 복구하기 위해 Project Manager를 엽니다.

4 그런 다음, Project Manger를 마우스로 우클릭하고 Restore를 클릭하세요.

5 창이 나타나면 .dra 폴더로 이동하고 Open을 클릭하세요.

아카이브 프로젝트가 Project Manager에 열리면 작업을 시작할 수 있습니다.
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DaVinci Resolve 데이터베이스 작업하기
모든 프로젝트와 타임라인의 이동 및 백업은 데이터베이스 안에서 이루어져야 합니다. 프로젝트 및 
그와 관련된 모든 빈, 클립, 타임라인은 하드 드라이브에서 개별적으로 찾을 수 있는 파일 형태가 
아니기 때문에 반드시 DaVinci Resolve에서 열어야 합니다. 일반적인 방법보다 복잡해 보일 수는 
있지만 이런 작업 방식에는 장점이 많습니다. 데이터베이스를 사용하면 별도 작업 없이 프로젝트를 
짜임새 있게 관리할 수 있습니다. 데이터베이스에 이미 정보가 존재하므로 프로젝트 및 빈을 추적하는 데  
시간을 보내지 않아도 됩니다.

데이터베이스에 프로젝트를 저장할 수 있기 때문에 여러 개의 DaVinci Resolve 워크스테이션과 
연결되는 서버에 이를 저장할 수 있으며, 모든 컴퓨터에 저장된 프로젝트나 협업 중인 프로젝트에 
접속할 수 있는 유연성을 제공합니다.

데이터베이스 생성 및 전환하기
처음 DaVinci Resolve를 열 때 자동으로 디스크 데이터베이스가 생성되기 때문에 사용자는 
데이터베이스가 사용되고 있다는 것을 명백하게 알 수 있습니다. macOS에서 데이터베이스는 Library 
폴더에 저장되는 반면, Windows에서는 Program Data 폴더에 저장됩니다. 데이터베이스가 저장되는 
위치를 안다고 하더라도 데이터베이스 사용에서 가장 중요한 점은 폴더명 또는 파일명을 재설정 
또는 변경하거나, 삭제해서는 안 된다는 것입니다.

이번 과에서는 데이터베이스를 전환하는 방법, 자신만의 데이터베이스를 생성하는 방법, 운영 체제 
수준에서 데이터베이스를 바꾸지 않고 백업하는 방법을 배워볼 겁니다. 먼저 새로운 데이터베이스를 
생성해 보겠습니다.

1 Project Manager 왼쪽 상단에 있는 데이터베이스 버튼을 클릭하여 사용 가능한 데이터베이스 
목록을 여세요.

Local Database 아래에 해당 목록이 나타납니다. 이는 DaVinci Resolve을 처음 시작하면 갖게 
되는 기본 데이터베이스입니다.

2 New Database 버튼을 클릭하여 새로운 데이터베이스를 생성하세요.



381

D
aV

in
ci

 R
es

o
lv

e 
데

이
터

베
이

스
 작

업
하

기

New Database 창이 나타나며 상단에 두 가지의 옵션을 제공하는 탭이 나타납니다. Connect 
탭에서 연결되지 않은 기존 데이터베이스에 연결하거나, Create 탭에서 새로운 데이터베이스를 
생성할 수 있습니다. 예를 들어 매년 또는 매학기를 시작할 때 새로운 데이터베이스를 생성하면 
유용하게 사용할 수 있습니다. 새해를 시작한다고 가정하고 새로운 데이터베이스를 생성해 
보겠습니다.

3 New Database 창 상단에 있는 Create 탭을 클릭하여 새로운 데이터베이스 생성을 시작하세요.

4 Name 입력란에 resolve101을 입력하고 Location 입력란에 데이터베이스를 저장할 위치를 
지정하세요.

5 Documents > R15 lessons > Lesson 15으로 이동하세요.
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데이터베이스 창에 저장 위치가 추가되어 이제 DaVinci Resolve에 데이터베이스를 추가할 수 
있습니다.

6 데이터베이스 창에 있는 Create를 클릭하세요.

resolve101 데이터베이스가 Disk 목록에 나타납니다. 데이터베이스 목록에 나타나는 데이터베이스 
하나를 클릭하면 해당 데이터베이스로 전환됩니다. 새롭게 추가된 resolve101 데이터베이스는 
이미 선택되어 새로운 프로젝트에 사용할 준비가 완료되었습니다.

정보 규모가 작은 프로젝트의 데이터베이스는 커다란 프로젝트의 
데이터베이스보다 저장 및 처리 속도가 빠릅니다.

데이터베이스 백업하기
데이터베이스에 미디어가 포함되지 않더라도 프로젝트의 메타데이터는 모두 포함됩니다. 게다가 
지금까지 작업한 모든 프로젝트의 타임라인을 전부 포함합니다. 따라서 드라이브 고장 또는 작은 
사고나 실수로 인해 작업이 삭제되거나 사라지는 일을 방지하기 위해 해당 데이터베이스 백업 파일을 
주기적으로 생성하는 것이 좋습니다. 데이터베이스 매니저 창에서 데이터베이스를 편리하게 백업할 
수 있습니다.

참고 아래는 두 번째 하드 드라이브 또는 클라우드 기반의 저장 장치를 사용하여 
데이터베이스를 백업하는 방법을 설명합니다. 두 번째 하드 드라이버나 클라우드 
저장 장치가 없는 경우에도 아래 설명을 통해 백업 방법을 익혀두는 것이 좋습니다.

1 데이터베이스 목록에서 resolve101 데이터베이스가 선택되었는지 반드시 확인하세요.

2 화면 맨 위에 있는 백업 버튼을 클릭하세요.
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일반적으로 데이터베이스 크기는 수백 메가바이트부터 수배 기가바이트까지 그 범위가 
다양합니다. 하지만 미디어와는 달리 데이터베이스는 클라우드 백업 저장 장치나 로컬 하드 
드라이브에 쉽게 저장할 수 있습니다.

3 데이터베이스를 백업할 하드 드라이브나 클라우드 기반 저장 장치로 이동한 뒤, Save를 
클릭하세요.

4 데이터베이스가 저장되면 확인 버튼을 누르고 데이터베이스 버튼을 눌러 해당 창을 닫습니다.

백업 저장이 완료되면 .diskdb 파일이 생성됩니다. 이 파일에는 다른 드라이브에 복사할 수 있는 
모든 데이터베이스가 포함되어 있으므로, 예를 들어 새로운 컴퓨터를 구입한 경우, 새로운 하드 
드라이브에 기존 프로젝트를 옮길 수 있습니다. 새로운 컴퓨터에서는 DaVinci Resolve의 Restore 
버튼을 눌러 데이터베이스를 열고 사용하면 됩니다.

복습하기
1 Media Manager에서는 클립, 타임라인, 빈을 관리할 수 있습니다. T(진실) 또는 F(거짓)로 답하세요. 

2 Media Manager에서 선택된 미디어로 수행할 수 있는 세 가지의 작업으로는 무엇이 있나요?

3 Project Manager를 사용할 때 프로젝트 엑스포트와 프로젝트 아카이빙의 차이점은 무엇인가요?

4 Project Manager에서 데이터베이스를 어떻게 확인하나요?

5 여러 개의 데이터베이스를 사용하는 것의 장점은 무엇인가요?
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정답
1 F. Media Manager에서는 오직 미디어만 관리할 수 있습니다.

2 Media Manager에서 선택한 미디어는 복사, 이동, 트랜스코딩이 가능합니다.

3 프로젝트를 엑스포트하면 프로젝트 메타데이터만 포함된 DaVinci Resolve Project(DRP) 포맷의 
파일이 생성됩니다. 프로젝트 아카이빙은 DRA 확장자를 가진 폴더를 생성하며 여기에는 
프로젝트를 위한 DRP 파일과 함께 프로젝트가 담긴 모든 미디어 파일이 포함되어 있습니다.

4 DaVinci Resolve 15에 연결된 데이터베이스를 확인하려면 Project Manager 왼쪽 상단에 있는 
사이드바 버튼을 클릭하세요.

5 다른 데이터베이스를 생성하여 교육 환경에서 프로젝트를 연도별, 고객별, 학기별, 학생별로 
구분할 수 있습니다. 새로운 데이터베이스 생성에 어떤 기준을 사용하던지 매일 데이터베이스를 
백업하는 것이 좋습니다.

이제 모든 작업이 완료되었습니다.
이렇게 완벽 가이드로 배워보는 DaVinci Resolve 15의 모든 내용을 살펴보았습니다. 더욱 자세한 
편집, 시각 효과, 컬러 그레이딩, 오디오 믹싱 기능은 다양한 추가 공인 교재를 통해 더욱 자세하게 
배워보실 수 있습니다. 본 교재의 모든 학습 내용을 습득하면 DaVinci Resolve 공인 전문가가 되기 
위한 모든 준비를 완료한 것입니다. 아래 링크를 통해 온라인 시험을 보면 자격증을 취득하실 수 
있습니다.

Blackmagic Design 웹사이트의 사용자 포럼에 가입하여 DaVinci Resolve 커뮤니티에 참여하시기를 
권장 드립니다. 이 포럼에서는 편집, 색보정, 오디오 믹싱과 관련한 질문을 하실 수 있습니다.

DaVinci Resolve 15의 전문가용 비선형 편집 도구와 세계적 수준의 색보정 도구를 통해 직관적으로 
학습하고 창의적인 워크플로를 위한 핵심 도구로 사용할 수 있기를 기대합니다.

온라인 시험을 통해 여러분의 실력을 테스트해보세요.  — 테스트하러 가기 :  https://bit.ly/2FXh1Xh







전문 편집

Fusion 효과

색보정

Fairlight 오디오

DaVinci Resolve 15는 장편 영화 및 TV 프로그램, 광고 작업을 위한 세계 
최첨단의 편집, 시각 효과, 색보정, 오디오 후반제작 솔루션입니다. 
DaVinci Resolve의 혁신적인 워크플로에서는 클릭 한번으로 작업 간 
전환이 가능하여 여러 프로그램의 사용법을 익히거나 프로젝트를 
변환하여 이동할 필요가 없습니다. 기본적인 편집, 효과, 색보정, 오디오 
작업을 단계별로 설명하는 실무 가이드로, 지금 바로 할리우드 수준의 
영화 및 영상 제작을 시작할 수 있습니다.

소개 내용
• 프로젝트 설정하기, 미디어 불러오기, 메타데이터를 사용해 업무 속도 높이기.

• 선택 부분 표시하기, 타임라인에서 클립 편집하기, 콘텍스트 센서티브 트리밍.

• 타이틀 작업, 그래픽 추가, 효과 추가, 키프레임 애니메이션 효과 사용하기.

• 클립 리타이밍, 트랜지션 추가, 숏의 안정화, 사진에 애니메이션 효과 사용하기.

• Resolve의 전설적인 컬러 도구를 사용한 프라이머리 및 세컨더리 색보정.

• 숏 매칭, 컬러 매니지먼트 사용하기, 영상룩 생성하기.

•  파워 윈도우 사용하기, 숏에서 피사체 트래킹하기, 커브 사용하기, ResolveFX 
추가하기.

• 기본 Fusion 효과, 노드 트리 작업하기, 텍스트에 애니메이션 효과주기.

• Fairlight 오디오 도구를 사용한 오디오 편집 및 스위트닝, 오디오 믹싱.

• 웹방송과 방송 포맷 등 다양한 포맷으로 프로젝트 딜리버리하기.

• 작업 방식을 향상시킬 수 있는 수십 가지의 유용한 정보.

추천 사용자 
이 책은 초보자와 전문가 모두를 위한 책입니다. 초보자는 간단하고 명료한 설명을 
통해 기본적인 프로그램 사용법과 더욱 신속한 작업 방식을 배울 수 있습니다. 다른 
시스템을 사용해 온 전문가들은 기본 편집 및 트리밍 방식부터 오디오 작업, 텍스트 
및 효과 추가 방법에 이르는 모든 내용을 배워볼 수 있습니다. 수십 가지의 유용한 
전문 정보를 통해 작업 속도를 더욱 향상시킬 수 있습니다.

“DaVinci Resolve 15은 제가 필요로하는 모든 전문가용 도구를 단일 
프로그램에서 지원하는 유일한 비선형 편집 시스템입니다. 4K 및 멀티 포맷 
지원 기능과 함께 편집과 색보정, 효과, 최첨단 오디오 기능을 하나로 통합 
시킨 매우 혁신적이고 흥미로운 시스템입니다. 업계에 엄청난 파장을 불러올 
만한 프로그램입니다.”

<NCIS: 로스앤젤레스> 편집자, 에릭 윌슨

완벽 가이드로 배워보는




